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Эту книгу мы посвящаем нашим 

любимым дочкам и внучкам 

Анечке и Машеньке 

 

Введение  
 

Уважаемый читатель! Эта книга о том, как в домашних усло-

виях дополнить музыкальную композицию записью вокальной 

партии или партии в исполнении акустического музыкального 

инструмента, пользуясь элементарными средствами профессио-

нальных программ — виртуальной студии и звукового редактора.  

Книга адресована начинающим. И вот почему мы так считаем. 

1. Рассматривается конкретная задача (запись с микрофона звука 

и его последующее редактирование), которую неизбежно 

предстоит решать человеку, желающему на практике освоить 

возможности современной компьютерной студии.  

2. Приведены только те дополнительные сведения, которые 

нужны для решения поставленной задачи. 

3. При описании тех или иных операций мы не углубляемся 

в теорию, а ограничиваемся краткими пояснениями сути дела. 

4. Книга содержит главу, в которой имеются пошаговые инст-

рукции. Каждый существенный шаг проиллюстрирован при-

мером проекта. Примеры сохранены в файлах и находятся на 

диске, сопровождающем книгу. Смотрите, как сделали мы, 

повторяйте наши действия, а потом делайте лучше нас. 

5. В книге приведен краткий толковый словарь терминов, имею-

щих прямое отношение к аудиомузыкальным компьютерным 

технологиям.  

На протяжении полутора десятков лет мы пишем книги и ста-

тьи, посвященные применению компьютера в музыкальном твор-

честве. Эта книга — тридцать первая, изданная в России [1—30]
1
.  

                                                           
1 В квадратных скобках указаны номера позиций в списке литературы, приве-

денном в конце книги. 
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В основе наших книг лежит несложная на первый взгляд 

идеология. Компьютер — всего лишь новый инструмент музы-

канта и звукорежиссера. Инструмент-"демократизатор", делаю-

щий доступным для всех заинтересованных и способных людей 

результативное занятие музыкой. Инструмент, преумножающий 

возможности творческого человека, избавляющий его от рутинно-

го труда, но не лишающий счастья творить. Инструмент, вопло-

тивший в себе множество достижений науки, техники и техноло-

гии. Инструмент, овладение которым невозможно без серьезного 

обучения, не менее трудоемкого, чем обучение игре на скрипке, 

виолончели, фортепиано... 

На самом деле, до сих пор едва ли не каждое из этих утвержде-

ний является предметом явного или заочного спора. Причем, как 

ни странно, оппоненты в споре — сама система традиционного 

музыкального образования и люди, получившие это образование.  

Занятие музыкой всегда считалось уделом элиты. Но компью-

тер практически уравнял в праве быть причастными к миру со-

творения музыки всех талантливых людей вне зависимости от 

возраста, места проживания и принадлежности к той или иной 

социальной группе. 

Компьютер, оснащенный звуковой картой и программами, 

предназначенными для работы с музыкой и звуком (музыкальный 

компьютер), заменил собой и оркестр, и студию звукозаписи. 

Пользователя музыкального компьютера мы и называем компь-

ютерным музыкантом. Музыкантов в результате "непорочного 

зачатия" породила музыка, а компьютерные музыканты появи-

лись на свет, когда прекрасная музыка повстречалась с мощным 

компьютером.  

Косвенным образом мы судим о числе людей, разделяющих 

наше увлечение, по статистике посещаемости тематических сай-

тов, по количеству и тиражам книг, посвященных этой проблема-

тике. Компьютерных музыкантов очень много, не сосчитать. По-

чему применение компьютера в музыкальном творчестве столь 

заманчиво? Все просто. С помощью компьютера любой музы-

кально одаренный человек способен в одиночку и без дорого-

стоящего оборудования создать завершенное музыкальное про-

изведение, фонограмму, в техническом отношении не хуже тех, 
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что звучат по радио, на телевидении. Пользуясь компьютером  

и Интернетом, он может донести свое произведение до слушате-

ля вопреки недоступным для "простого смертного" радио и теле-

видению. 

Всех компьютерных музыкантов можно условно разделить на 

три группы. Первая (немногочисленная) группа — профессионалы, 

люди с музыкальным либо звукорежиссерским образованием (или  

с опытом работы в этих сферах), своевременно оценившие по досто-

инству возможности компьютера и не менее своевременно поста-

вившие эти возможности себе на службу. Таких людей отличает 

прагматичный подход к освоению музыкальных компьютерных тех-

нологий. Глубоко овладев определенным набором программ, они 

подолгу используют их в своей работе. При этом они не чураются 

чтения специализированных книг и журналов, понимая, что инфор-

мация лишней не бывает. 

Вторую (весьма обширную) группу можно охарактеризовать как 

"продвинутые любители". Музыка для них (точнее, для нас, ибо ав-

торы книги причисляют к этой категории и себя) — увлечение, а не 

профессия, хотя для некоторых со временем может стать и профес-

сией. Большинство здесь составляют склонные к музыкальному 

творчеству люди с техническим образованием. Музыкальный ком-

пьютер они уже достаточно давно осваивают самостоятельно, пре-

имущественно "методом научного тыка". Основные источники зна-

ний для них: личный опыт, англоязычные руководства пользователя 

программы, Интернет, реже книги. Многие из них не могут удер-

жаться от непрерывного следования за новинками, "пересаживаясь" 

на очередную версию программы чуть ли не в день ее выхода в свет.  

Большинство написанных нами книг ориентировано именно на 

представителей первой и второй групп пользователей. По-другому  

и быть не может, если, например, книга посвящена детальному опи-

санию одной из таких сложнейших программ, как Steinberg Cubase, 

Cakewalk SONAR, Sound Forge, Adobe Audition. Объем подобных 

книг приближается к психологическому пределу в 1000 страниц. 

Для изложения азов в них попросту невозможно выделить даже 

малую долю листажа. 

Но ведь процесс обновления поколений непрерывен. Еже-

дневно в ряды людей, увлеченных музыкально-компьютерным твор-



Введение 4 

чеством, вливаются новички. Это третья и самая многочисленная 

группа компьютерных музыкантов. Много школьников, студен-

тов. Особенно приятно, что встречаются и молодые музыканты, 

получившие прекрасное академическое музыкальное образова-

ние и осознавшие, что пора догонять "технарей" в деле освоения 

компьютера. 

Начинающим пользователям музыкального компьютера были 

адресованы несколько наших первых книг [1—4, 7]. В то время 

музыкальные компьютерные технологии находились в самом на-

чале своего развития. Русскоязычных книг на эту тему практиче-

ски не было. Да и мы как авторы были тоже начинающими.  

Со временем ситуация менялась. Изменялись программы. По-

степенно росли в объеме и затрагивали все более сложные во-

просы наши книги. В итоге освоить их стало под силу лишь 

очень хорошо подготовленным читателям, совершенствующимся 

пользователям музыкального компьютера, стремящимся "выжать" 

из программы все, на что она способна. Начинающий попросту 

увязнет во всевозможных тонкостях, позволяющих оптимизиро-

вать работу профессионала, но маскирующих принципиально важ-

ные для новичка сведения. Такие соображения привели нас к мыс-

ли о необходимости заняться книгами, адресованными именно 

начинающим. Довольно долго мы не могли решить ключевую 

проблему: на каких именно программах следует основываться? 

Может быть на простеньких бесплатных? Потом мы додумались 

до очень простой идеи. Нужно описывать процесс создания музы-

ки на базе одной из виртуальных студий и одного из звуковых 

редакторов профессионального уровня. Но при этом следует за-

действовать не все их возможности, а только основные, имею-

щиеся, в принципе, в любой программе подобного назначения  

(и в любых, даже относительно старых версиях рассматриваемых 

программ). Без освоения данного инструментария не обойтись. 

Если хотите стать компьютерным музыкантом, то вам так и так 

придется это сделать. Только в отличие от бесплатных программ 

в данном случае у вас есть перспектива. Разберетесь в элемен-

тарных средствах программ — можно перейти к изучению их 

более глубоких возможностей.  
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Таким образом, мы остановили свой выбор на двух програм-

мах: звуковом редакторе Adobe Audition и виртуальной студии 

Cakewalk SONAR. Обе программы доступны, стабильны, посто-

янно развиваются. И, что немаловажно, если вы со временем ре-

шите углубить свои познания и приобрести новые навыки, то най-

дете несколько книг [9, 15, 19, 26, 29, 30]
 
и статей [43, 50, 51, 54, 

57, 60—62, 77, 80, 90—92, 121, 123, 127, 129, 135, 139, 152, 160], 

содержащих описание ряда версий программ. Перечень публика-

ций имеется в списке литературы, приведенном в конце книги.  

А некоторые из них представлены и на диске, который ее сопро-

вождает. 

Мы различаем два аспекта применения компьютера в музы-

кальном творчестве. Первый — применение компьютера в про-

цессе сочинения, аранжировки и оркестровки музыкальных ком-

позиций. Второй — компьютерная запись и обработка звука. При 

создании музыкальных произведений эти две группы задач не-

разрывно связаны. Но решаются они специфическими методами, 

с помощью различных по возможностям и принципам функцио-

нирования программ. В итоге мы решили, что в серии "Для начи-

нающих" необходимо выпустить две книги, причем в той оче-

редности, которая соответствует логике работы над музыкальной 

композицией (конкретно, песней): сначала записывается и редак-

тируется аккомпанемент, а затем — вокал и партии акустических 

инструментов.  

Первой в этой мини-серии стала книга "Музыкальный компь-

ютер для начинающих" [30]. В ней мы подробно описали процесс 

создания музыкальной композиции исключительно в исполнении 

виртуальных музыкальных инструментов. Каждая партия такой 

композиции должна быть записана и отредактирована в MIDI-

секвенсоре. А MIDI-секвенсор входит в состав виртуальной сту-

дии. В качестве такой студии мы выбрали Cakewalk SONAR — 

довольно сложный и многофункциональный программный про-

дукт. Но если ограничиться использованием его элементарных 

средств, то работа по созданию музыкальной композиции ока-

жется по плечу не только профессионалу, но и начинающему 

компьютерному музыканту. Мы подумали, что читателям легче 
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будет освоить эту виртуальную студию, если процесс работы над 

композицией проиллюстрировать серией файлов, в которых ото-

бражается развитие проекта. В качестве примера мы взяли песен-

ку, сочиненную Юрием Петелиным для внучки. Шаг за шагом 

мы рассказывали и показывали, как исходно пустой шаблон проек-

та постепенно заполнялся музыкальной информацией: маркерами 

обозначались части композиции; подбирались голоса инструмен-

тов; вводились сначала символы аккордов, а затем и собственно 

аккорды; записывались партии мелодии, баса и ударных; услож-

нялась аранжировка; выполнялось предварительное сведение 

MIDI-средствами. Итогом процесса, описанного в книге "Музы-

кальный компьютер для начинающих", стал фрагмент (вступле-

ние, куплет и припев) будущей песни. 

Во второй книге (которую вы сейчас читаете) мы предлагаем 

путь решения одной из наиболее часто встречающихся в практи-

ке компьютерного музыканта задач — дополнения музыкальной 

композиции записью вокальной партии. А дорабатывать мы бу-

дем все ту же детскую песенку. То есть исходным материалом 

будет файл того проекта, который мы создали в процессе работы 

над предыдущей книгой. Из нескольких возможных вариантов 

мы посчитали наиболее разумным такой: запись вокальной пар-

тии проводить в той же программе, в которой создана MIDI-

минусовка (ведь Cakewalk SONAR позволяет работать не только 

с MIDI-, но и с аудиоданными). В этой же программе целесооб-

разно смонтировать вокальную партию из нескольких дублей. 

После чего нужно экспортировать ее в аудиофайл и только его 

загрузить для обработки в звуковой редактор Adobe Audition. 

Цель обработки — уменьшение уровня шума средствами Adobe 

Audition. Затем вокальную партию, обработанную шумоподави-

телем, следует сохранить в аудиофайле. После чего останется 

импортировать этот аудиофайл в проект SONAR, заменив исход-

ный трек с "шумным" вокалом. Теперь можно дорабатывать тре-

ки проекта как угодно. Если при создании аккомпанемента мы 

использовали Cakewalk SONAR в качестве MIDI-редактора, то 

теперь нам предстоит применить программу как виртуальную 

студию и аудиоредактор. И так же, как и в первой книге серии, 
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каждый существенный шаг мы иллюстрируем соответствующим 

файлом проекта. А файлы предоставляем в ваше распоряжение 

на диске, сопровождающем книгу. 

Пошаговому описанию процесса создания "минусовки" и до-

полнения ее вокальной партией в каждой из книг посвящено по 

одной главе (завершающей). А три предшествующих главы по-

строены по одному и тому же принципу:  

 элементарные сведения из области MIDI-технологий в первой 

книге, из области аудиотехнологий — во второй; 

 возможности программ, предназначенных для записи и редак-

тирования музыки, — в первой книге, для записи и обработки 

звука — во второй; 

 описание основных средств редактирования MIDI-композиций, 

имеющихся в Cakewalk SONAR, — в первой книге, основных 

средств обработки звука в Adobe Audition — во второй. 

Таким образом, материал книг и взаимосвязан, и не повторя-

ется. Взаимная связь заключается в том, что, во-первых, эти кни-

ги совместно дают читателю наиболее полную картину примене-

ния компьютера в процессе создания музыки, начиная с записи 

партий музыкальных инструментов и заканчивая записью во-

кальной партии и сведением композиции. Во-вторых, книги свя-

заны тем, что в них по отдельным шагам показана работа над од-

ной и той же конкретной композиций от "чистого листа" (пустого 

шаблона проекта) и до сведенной стереофонической фонограм-

мы, пригодной для записи на компакт-диск. Основную часть ма-

териала книг можно читать независимо друг от друга. Но вместе 

с тем, перед чтением книги "Домашняя звукозапись для начинаю-

щих" желательно ознакомиться с некоторыми разделами книги 

"Музыкальный компьютер для начинающих". Материал о подго-

товке Cakewalk SONAR к работе и вариантах структуры домаш-

ней студии изложен в книге, вышедшей первой, и в данной книге 

не повторяется. 

Весь музыкальный софт непрерывно развивается. Разработчики-

конкуренты одну за другой выпускают все новые и новые версии 

своих программных продуктов. Не составляет исключения и вирту-

альная студия Cakewalk SONAR. На момент написания книги "Му-

зыкальный компьютер для начинающих" самой "свежей" версией 
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программы была версия 8.5. Наиболее полный вариант версии про-

граммы, актуальной на момент написания этих строк, — SONAR X1 

Producer. Изменился графический интерфейс, появилось несколько 

новых изощренных средств редактирования. Но вас это не должно 

смущать. В обсуждаемых сейчас книгах мы рассматриваем исклю-

чительно элементарные средства программы. Они присущи не только 

самой новой версии, но и многим предшествующим. Мы обратим 

ваше внимание на возникшие отличия в тех случаях, когда из-за из-

менений графического интерфейса какие-либо инструменты пере-

местились — "спрятались" в другом меню или вместо отдельного 

окна заняли одну из его вкладок. 

Правда, есть одно "но". Проекты, созданные в предыдущих вер-

сиях  программы, без каких-либо потерь загружаются в SONAR X1, 

а вот обратная совместимость отсутствует. Если вы работали  

в SONAR X1 и сохранили проект в файле, то ни в одной из пре-

дыдущих версий программы открыть его не удастся. Мы не знаем, 

какой версией  программы пользуетесь вы. Поэтому примеры к кни-

ге решили задублировать. Файлы проектов, совместимые только 

с SONAR X1, находятся в папке EXAMPLES\SONAR X1, а файлы 

проектов, совместимые с любой версией программы, —  в папке 

EXAMPLES\SONAR. 

Еще несколько слов о логике изложения материала. Сначала мы 

разъясняем суть основ технологии компьютерной звукозаписи. За-

тем приводим обзор программ, в которых реализовано редактирова-

ние звука. При этом ограничиваемся программами двух классов: 

звуковые редакторы и плагины, в которых реализованы аудиоэф-

фекты и обработки. Далее мы знакомим вас с базовыми средствами 

звукового редактора Adobe Audition. Затем приводим пошаговое 

описание процесса дополнения MIDI-композиции вокальной парти-

ей (ее запись выполняется в Cakewalk SONAR, а в процессе редакти-

рования используется Adobe Audition). Текст мы иллюстрируем 

примерами, которые имеются на диске, сопровождающем книгу.  

Этой логике соответствует и структура книги: введение, 4 гла-

вы, заключение, два приложения и список литературы. Книгу со-

провождает компакт-диск в формате CD-ROM. 

В главе 1 рассмотрен материал, который обязательно следует 

знать начинающему компьютерному звукорежиссеру. Прежде 
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всего, мы поясняем смысл основных терминов: звуковые колеба-

ния, частота, период, амплитуда, высота тона, тембр, сигнало-

грамма, октава, порог слышимости, децибел, динамический диа-

пазон. Далее речь идет об аналого-цифровом и цифроаналоговом 

преобразователях (АЦП и ЦАП), причинах возникновения шума 

квантования, теореме Котельникова, определяющей частоту дис-

кретизации, и сути процессов, именуемых загадочными словами 

"дитеринг", "нойзшейпинг", "транкейт". 

Трудно заниматься записью и преобразованием звуковых дан-

ных вслепую, не измеряя их параметры, а значит и не представ-

ляя себе их свойства. Наибольшую пользу способны принести 

такие приборы, как: измеритель уровня сигнала, анализатор спек-

тра сигнала и анализатор качества стереосигнала. Мы знакомим 

вас с сущностью и особенностями применения их виртуальных 

аналогов, имеющихся в программе Adobe Audition. 

Программные звуковые редакторы позволяют компьютерному 

музыканту широко применять различные звуковые эффекты  

и обработки звука. Созданы тысячи специальных плагинов. Разо-

браться в них можно лишь при условии, что вы понимаете суть 

примененных алгоритмов и смысл многочисленных параметров. 

В этом вам помогут краткие сведения о фильтрации и динамиче-

ской обработке, а также обзор наиболее распространенных эф-

фектов, основанных на задержке, модуляции, преобразовании 

тона и искажении аудиосигнала.  

Микрофон и микшер — два основных прибора, без которых 

работа звуковой студии невозможна. Рассмотрен принцип дейст-

вия, параметры и особенности использования электродинамиче-

ского и конденсаторного микрофонов, устройство и назначение эле-

ментов типичного микшера. Эта информация пригодится вам, даже 

если в вашей домашней студии микшера нет: микшеры (правда, 

виртуальные) имеются в любой программе, предназначенной для 

работы со звуком. 

Глава 2 представляет собой обзор возможностей наиболее ин-

тересных звуковых редакторов и VST-плагинов (обработок и эф-

фектов): 

 Sony Sound Forge — один из звуковых редакторов-"долгожи-

телей", включающий весь набор средств, необходимых для 



Введение 10 

выполнения профессиональной цифровой звукозаписи, что 

позволяет превратить "сырой" аудиоматериал в завершенный 

аудиодиск; 

 Audacity — бесплатный звуковой редактор с открытым исход-

ным кодом, при относительной простоте интерфейса обеспе-

чивающий выполнение всех основных операций по обработке 

аудиоданных; особенностью программы является наличие 

русскоязычного варианта графического интерфейса; 

 Waves — плагины профессионального уровня, предназначен-

ные для преобразования звуковых данных, удобные в работе, 

содержащие много интересных пресетов; полный набор пла-

гинов столь обширен и разнообразен, что позволяет выпол-

нять в процессе редактирования, сведения и мастеринга прак-

тически все мыслимые операции; 

 Voxengo — плагины, отличающиеся высоким качеством пре-

образования аудиосигнала, разнообразием реализованных в них 

эффектов и обработок; созданы российским разработчиком и 

привлекли внимание зарубежных специалистов; 

 iZotope Ozone — плагин, предназначенный для выполнения 

мастеринга, объединяющий в себе 6 модулей обработок: со-

вмещенный с анализатором спектра параграфический эква-

лайзер, обладающий функцией "подгона" спектра обрабаты-

ваемой фонограммы под спектр образцовой; многополосный 

эксайтер, улучшающий "прозрачность" фонограммы; много-

полосная динамическая обработка; многополосный процессор 

стереофонического образа; мастеринговый ревербератор; пси-

хоакустический инструмент для повышения громкости фоно-

граммы; 

 Steinberg Virtual Guitarist, Steinberg Virtual Guitarist Electric 

Edition, ReFX Slayer, MusicLab RealGuitar, MusicLab RealStrat 

и MusicLab RealLPC — VST-инструменты, в которых смоде-

лированы акустические и электрогитары; 

 Fender G–DEC 3 — цифровой гитарный центр, объединяющий 

в себе усилитель, акустическую систему, эффект-процессор, 

сэмплер, аудиоплеер, MIDI-секвенсор, MIDI-синтезатор и ин-

терфейс для обмена MIDI- и аудиоданными с компьютером. 
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Мы не ставим перед собой задачу научить вас профессиональ-

ной работе с этими программными и аппаратными средствами, 

ограничившись пояснением принципа их применения. Но хотим, 

чтобы, узнав об их возможностях, вы увидели перспективы своего 

совершенствования в области компьютерной звукозаписи. 

В главе 3 мы знакомим вас с программой Adobe Audition  

в объеме, необходимом для того, чтобы можно было приступить 

к записи и редактированию фонограмм. Речь идет: 

 о самых важных настройках, выполняемых на этапе подготов-

ки программы к работе; 

 о структуре и основных инструментах главного окна; 

 об особенностях представления звуковой информации (сигнало-

грамма, сонограмма, спектрограмма, треки и блоки);  

 о технике выполнения самых необходимых операций: загруз-

ка, сохранение и воспроизведение аудиофайла; монтаж на од-

ном треке последовательности аудиофайлов; работа с сигна-

лограммой; редактирование отдельных звуковых отсчетов; 

запись звука с микрофона; 

 об основных приемах работы с аудиоданными в режиме ре-

дактирования отдельных сигналограмм: выбор масштаба ото-

бражения; выделение, вставка, удаление и перемещение ау-

диоданных; привязка границ выделенного фрагмента 

сигналограммы к характерным точкам шкалы времени; обра-

ботка стыков фрагментов, пауз и амплитуды аудиосигнала; 

формирование абсолютной тишины на заданном участке сиг-

налограммы; 

 об уменьшении уровня шума с помощью функции Noise 

Reduction; 

 об обработке эффектами, редактировании, микшировании и све-

дении проекта в мультитрековом режиме (включая работу с бло-

ками, автоматизацию, циклическую запись дублей). 

Подробно описан порядок записи альбома на компакт-диск  

и применения органайзера, предназначенного для создания ком-

фортной обстановки при работе с файлами и эффектами.  

Глава 4 посвящена пошаговому описанию работы по дополне-

нию MIDI-композиции записью вокальной партии. 
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Исходным материалом является MIDI-проект, содержащий 

аранжировку детской песенки. Проект появился как иллюстрация 

процесса создания MIDI-композиции, описанного в книге "Му-

зыкальный компьютер для начинающих". Запись вокальной пар-

тии проводится в той же программе (Cakewalk SONAR), в кото-

рой создана MIDI-минусовка.  

Фонограмма записывается с микрофона в циклическом режиме. 

Средствами Cakewalk SONAR отбираются лучшие дубли фрагмен-

тов вокальной партии. Из них монтируется вся партия. В целях 

уменьшения уровня шума полученный аудиофайл экспортирует-

ся из Cakewalk SONAR в Adobe Audition. После применения 

функции Noise Reduction обработанный аудиофайл импортирует-

ся в Cakewalk SONAR. К нему применяются фильтрация и дина-

мическая обработка. Добавляется искусственная реверберация. 

Итоговый проект, содержащий аккомпанемент и партию вокала, 

сводится в стереофонический аудиофайл. 

Все существенные шаги отображены в файлах, которые со-

хранены на диске, сопровождающем книгу. 

Приложение 1 представляет собой краткий толковый словарь му-

зыкально-компьютерных терминов (больше 170 словарных статей).  

В приложении 2 описано содержимое компакт-диска, сопровож-

дающего книгу, и приведен перечень файлов с примерами, храня-

щихся в папке EXAMPLES. Кратко пояснено назначение каждого 

файла. В целом примеры иллюстрируют всю последовательность 

действий, выполняемых в процессе записи и обработки вокальной 

партии, сведения проекта песни в сереофонический аудиофайл.  

Список литературы содержит библиографические сведения 

о наших книгах и статьях, посвященных применению компьютера 

в музыкальном творчестве. Большинство статей имеется на диске. 

Предметный указатель облегчает контекстный поиск и помо-

гает читателю получить более детальное по сравнению с оглавле-

нием представление о круге вопросов, рассматриваемых в книге. 



 

 

Это следует знать  
начинающему  
компьютерному  
звукорежиссеру 

Книга посвящена компьютерной обработке звука. Конечная 

наша цель — помочь вам научиться записывать песни в домаш-

них условиях. А во всякой песне, конечно же, есть вокальная 

партия или партия в исполнении реального акустического инст-

румента. Мало того, мы ставим перед собой и вами сверхзадачу: 

запись и редактирование звуковых данных должны выполняться 

с помощью элементарных средств профессиональной виртуаль-

ной студии. Но и эти элементарные средства вовсе не примитив-

ны. Напротив, они наукоемки и зачастую устроены очень непро-

сто. Значит, для их осмысленного применения нужно кое-что 

знать и понимать. Вот об этом мы и собираемся сейчас вам пове-

дать. Вообще-то обычно такой рассказ ведется на языке формул. 

Но мы постараемся без них обойтись, лишь иногда позволяя себе 

привлечь математику на уровне школьной программы класса пя-

того-шестого. Итак, приступим. 



Глава 1  14 

1.1. Аудиосигналы  

и их основные свойства 

Звуковые колебания, воздействующие на микрофон или излу-

чаемые громкоговорителем, называются акустическим сигналом 

и характеризуется звуковым давлением, интенсивностью (или 

силой) и звуковой мощностью. Звуковые волны, передаваемые по 

аналоговым цепям устройств записи и обработки, представляют 

собой электрические аудиосигналы, характеризуемые напряже-

нием, силой тока и электрической мощностью. 

Наиболее простые колебания — гармонические — можно пред-

ставить в виде синусоиды (рис. 1.1). Они характеризуются часто-

той f, периодом Т и амплитудой. Последнюю величину обозна-

чают U, если речь идет об электрическом сигнале, т. е. об из-

меняющемся во времени напряжении. 

Частотой колебаний называют количество полных колеба-

ний в секунду. За единицу измерения частоты принят 1 герц (Гц). 

Голос человека создает звуковые колебания частотой от 80 до 

12 000 Гц, а человеческий слух воспринимает звуковые колеба-

ния в диапазоне 20—20 000 Гц. 

Периодом колебаний называют время (в секундах), в течение 

которого происходит одно полное колебание. Чем больше часто-

та колебаний, тем меньше их период, т. е. T = 1/f, а f = 1/T.  

Амплитудой колебаний называют наибольшее отклонение ко-

леблющегося тела (либо точки графика колебаний) от первона-

чального положения (состояния покоя). Чем больше амплитуда 

звуковых колебаний, тем громче звук. 

U t( )

U

T

t
0

 

Рис. 1.1. Гармонические колебания 
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1.1.1. Тон и тембр 

Звуки музыки и человеческой речи представляют собой слож-

ные звуковые колебания, состоящие из множества простых коле-

баний, различных по частоте и амплитуде. В каждом звуке име-

ется только ему свойственное сочетание колебаний различной 

частоты и амплитуды. Поэтому форма колебаний одного звука 

речи заметно отличается от формы другого. В качестве примера 

сложного колебания на рис. 1.2 приведен музыкальный стерео-

фонический аудиосигнал.  

Способ отображения сигнала, использованный для получения 

рис. 1.2, принято называть сигналограммой. Аудиосигнал являет-

ся функцией времени. Сигналограмма представляет собой график 

этой функции. Чем больше амплитуда колебаний, тем громче 

звук. График в виде горизонтальной прямой с координатой 0 по 

вертикальной оси при линейной шкале либо –  (читается "минус 

бесконечность") при логарифмической шкале соответствует абсо-

лютной тишине. Сигналограмма широко используется в програм-

мах — звуковых редакторах. Она позволяет визуально ориентиро-

ваться в расположении нужных фрагментов записи. С ее помощью 

можно приблизительно оценить уровень аудиосигнала, а также 

выявить его фрагменты, записанные с перегрузкой аппаратуры.  

В литературе, посвященной программам — звуковым редакторам 

и виртуальным студиям, сигналограмма часто именуется волно-

вой формой. 

 

Рис. 1.2. Пример сигналограммы сложного колебания  
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С точки зрения восприятия гармонические звуковые колеба-

ния некоторой частоты характеризуются тоном. Громкость тона 

какой-либо данной высоты определяется амплитудой колебаний, 

а высота тона — частотой колебаний. Колебания высокой часто-

ты воспринимаются как звук высокого тона, колебания низкой 

частоты — как звук низкого тона.  

В музыкальной акустике принято делить частотный диапазон 

на октавы и доли октав. Понятие октава соответствует измене-

нию частоты в 2 раза. Весь диапазон звуковых частот охватыва-

ется примерно 10-ю октавами. Музыкальная шкала октавы под-

разделяется на 12 полутонов, что соответствует тонам звуков 

смежных клавиш рояля. Каждый полутон, в свою очередь, делит-

ся на 100 центов. 

1.1.2. Порог слышимости  

и уровень громкости 

Источник звуковых колебаний излучает энергию. Эта энергия 

переносится в окружающее пространство. Количество звуковой 

энергии, проходящей в одну секунду через поверхность площадью 

1 м
2
, расположенную перпендикулярно направлению распростра-

нения звуковых колебаний, называют интенсивностью (силой) 

звука. 

Человек слышит звук в чрезвычайно широком диапазоне ин-

тенсивностей. Одна из опорных величин этого диапазона — 

стандартный порог слышимости, т. е. эффективное значение 

звукового давления, создаваемого гармоническими звуковыми 

колебаниями частоты 1000 Гц, едва слышимыми человеком со 

средней чувствительностью слуха. 

Порогу слышимости соответствует звуковое давление pзв0 = 

= 2  10
–5

 Па. 

Верхний предел диапазона определяется значением 

pзв. макс = 20 Па. При восприятии звука такой интенсивности у че-

ловека появляются болевые ощущения. 

Один из законов акустики гласит, что величина слухового 

ощущения пропорциональна не амплитуде звукового давления 

pзв, а логарифму отношения pзв/pзв0. Поэтому звуковое давление  
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и интенсивность звука часто оценивают в логарифмических  

единицах по отношению к стандартному порогу слышимости: 

Nа = 20lg(pзв/pзв0). 

ПРИМЕЧАНИЕ  

В деле количественной оценки различных свойств звука и звуко-
технической аппаратуры особое место занимает логарифмиче-
ская единица "децибел". Бел — логарифмическая единица изме-
рения разности уровней одноименных энергетических (например, 
мощность) или силовых (например, напряжение, сила тока) вели-
чин. Из-за своей "крупности" единица "Бел" не нашла широкого 
применения, а вот ее десятая доля (0,1 Б — децибел, дБ, dB) за-
няла свое место в практике измерений. Например, при сравнении 
мощностей P2 и P1 используется выражение DP = 10lg(P2/P1) дБ. 
На практике проще измерить напряжение или силу тока, тогда по-
сле подстановки мощности, выраженной через эти величины,  
с применением закона Ома соотношение приобретает вид: 
DU = 20lg(U2/U1) дБ и DI = 20lg(I2/I1) дБ. 

Если ухо человека воспринимает одновременно два или не-

сколько звуков различной громкости, то более громкий звук за-

глушает (поглощает) слабые звуки. Происходит так называемая 

маскировка звуков, и ухо воспринимает только один, более гром-

кий звук. Сразу после воздействия на ухо громкого звука снижа-

ется восприимчивость слуха к слабым звукам. Эта способность 

называется адаптацией (приспособлением) слуха. 

При высоких уровнях громкости проявляются нелинейные 

свойства слуха, выражающиеся в том, что наряду с чистым то-

ном человек слышит и его высшие гармоники (колебания, часто-

ты которых кратны частоте основного тона). 

Слуховой аппарат человека обладает определенной инерцион-

ностью. Ощущение возникновения звука, а также его прекраще-

ния появляется не сразу. 

Восприятие направлений (локализация источников звука в про-

странстве) возможно благодаря бинауральному эффекту и объяс-

няется временны́м и интенсивностным различиями сигналов, 

воздействующих на левое и правое ухо человека. 

Локализация источников звука с частотами ниже 150 Гц прак-

тически невозможна. Поэтому не имеет смысла в процессе пано-

рамирования смещать от центра панорамы бас и низкочастотные 
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ударные инструменты. На стереоэффект такое смещение все рав-

но не окажет позитивного влияния, а мощность усилителей  

и низкочастотных акустических систем правого и левого каналов 

будет использоваться неравномерно. По этой же причине иногда 

вместо двух сверхнизкочастотных акустических систем (сабву-

феров) применяется одна, на которую подается суммарный сиг-

нал правого и левого стереоканалов. 

Точность оценки человеком направления на источник звука  

в горизонтальной плоскости составляет 3—4 . Из этого следует, 

что при сведéнии фонограммы нет смысла размещать источники 

звука на стереопанораме очень близко друг к другу. Если панорама 

задается в безразмерных единицах от –64 до 64 (или от 0 до 127), 

то целесообразно разносить источники звука не меньше чем на 3—

5 единиц.  

Аудиосигнал является случайным процессом. Его акустические  

и электрические характеристики непрерывно изменяются во времени. 

Под динамическим диапазоном аудиосигнала понимают лога-

рифм отношения максимального звукового давления к минималь-

ному или логарифм отношения соответствующих напряжений. 

Не следует смешивать два различных понятия: динамический 

диапазон аудиосигнала и динамический диапазон канала обработ-

ки (записи/передачи). Очевидно, что обработка и передача аудио-

сигнала без искажений возможна, если динамический диапазон 

канала обработки больше, чем динамический диапазон аудиосиг-

нала. Так как для реальных акустических сигналов это условие  

в ряде случаев не выполняется, то необходима предварительная 

обработка аудиосигнала — сужение его динамического диапазона. 

1.2. Оцифровка звука 

Для получения приемлемого качества записи компьютерной 

музыки необходимо пользоваться аппаратурой, способной его 

обеспечить. К параметрам, от которых это зависит, относятся,  

в первую очередь: 

 разрядность аналого-цифрового и цифроаналогового преобра-

зователей звуковой карты; 

 диапазон частот дискретизации. 
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Разрядность звуковой карты существенно влияет на качество 

звука. Речь здесь идет о разрядности аналого-цифрового преобра-

зователя (АЦП, или ADC — Analog/Digital Converter) и цифро- 

аналогового преобразователя (ЦАП, или DAC — Digital/Analog 

Converter). 

Современные компьютерные звуковые карты оборудованы  

24-битными ЦАП/АЦП. Звуковые редакторы, работая с любыми 

звуковыми картами, в том числе 16-битными, в процессе преоб-

разований отсчетов сигнала используют арифметику с разрядно-

стью двоичного представления чисел, превышающей 16. Это по-

зволяет уменьшить погрешность, накапливающуюся в процессе 

выполнения сложных алгоритмов обработки, которая в против-

ном случае проявлялась бы как искажение звука. 

1.2.1. Аналого-цифровое преобразование 

Почему же столь важно наличие большого числа разрядов в уст-

ройствах ЦАП и АЦП? Дело в том, что непрерывный (аналого-

вый) аудиосигнал преобразуется в цифровой с некоторой погреш-

ностью. Эта погрешность тем больше, чем меньше уровней 

квантования сигнала, т. е. чем дальше отстоят друг от друга допус-

тимые значения квантованного сигнала. Число уровней квантова-

ния в свою очередь зависит от разрядности ЦАП/АЦП. Погреш-

ность, возникающую в результате замены аналогового сигнала 

рядом квантованных по уровню отсчетов, можно рассматривать 

как его искажение, вызванное воздействием помехи. Эту помеху 

принято образно называть шумом квантования.  

Шум квантования представляет собой разность соответствую-

щих значений реального и квантованного по уровню сигналов.  

В случае превышения сигналом значения самого верхнего 

уровня квантования ("старшего" кванта), а также в случае, когда 

значение сигнала оказывается меньше нижнего уровня квантова-

ния ("младшего" кванта), т. е. при цифровом ограничении сигна-

ла, возникают искажения, более заметные по сравнению с шумом 

квантования. Для исключения искажений этого типа динамиче-

ские диапазоны сигнала и АЦП должны соответствовать друг 

другу: значения сигнала должны располагаться между уровнями, 
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соответствующими младшему и старшему квантам. При записи 

внешних источников звука это достигается с помощью регули-

ровки их уровня, кроме того, применяется сжатие (компрессия) 

динамического диапазона, о котором речь пойдет в разд. 1.4.2. 

В звуковых редакторах есть операция нормализации амплиту-

ды сигнала. После ее применения наименьшее значение сигнала 

станет равным верхнему уровню младшего кванта, а наиболь- 

шее — нижнему уровню старшего кванта. Таким образом, сигнал 

сверху и снизу будет защищен от ограничения промежутками 

шириной в один квант. 

В процессе работы АЦП происходит не только квантование 

сигнала по уровню, но и его дискретизация во времени. Сигнал, 

непрерывно изменяющийся во времени, заменяют рядом отсче-

тов этого сигнала. Обычно отсчеты сигнала берутся через одина-

ковые промежутки времени. Интуитивно ясно, что если интерва-

лы между отсчетами слишком велики, то при дискретизации 

может произойти потеря информации: важные изменения сигна-

ла могут быть "пропущены" преобразователем, если они про-

изойдут не в те моменты, когда были взяты отсчеты. Получается, 

что отсчеты следует брать с максимальной частотой. Естествен-

ным пределом служит быстродействие преобразователя. Кроме 

того, чем больше отсчетов приходится на единицу времени, тем 

больше памяти требуется для хранения информации. 

Проблема разумного компромисса между частотой взятия от-

счетов сигнала и расходованием ресурсов устройств преобразо-

вания и передачи информации возникла задолго до того, как на 

свет появились первые звуковые карты. В результате исследова-

ний было сформулировано правило, которое принято называть 

теоремой Котельникова. 

Если поставить перед собой задачу обойтись без формул и 

серьезных научных терминов вроде "система ортогональных 

функций", то суть теоремы Котельникова можно объяснить сле-

дующим образом. Сигнал, представленный последовательностью 

дискретных отсчетов, можно вновь преобразовать в исходный 

(непрерывный) вид без потери информации только в том случае, 

если интервал между соседними отсчетами не превышает поло-
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вины периода самого высокочастотного колебания, содержаще-

гося в спектре сигнала. 

Из сказанного следует, что восстановить без искажений можно 

только тот сигнал, спектр которого ограничен некоторой часто-

той Fmax. Теоретически все реальные сигналы имеют бесконечные 

спектры. Спектры реальных сигналов, хотя и не бесконечные, 

могут быть весьма широкими. Для того чтобы при дискретизации 

избежать искажений, вызванных этим обстоятельством, сигнал 

вначале пропускают через фильтр, подавляющий в нем все час-

тоты, превышающие заданное значение Fmax, и лишь затем произ-

водят дискретизацию. Согласно теореме Котельникова, частота 

дискретизации, с которой следует брать отсчеты, составляет 

Fд = 2Fmax. Теорема справедлива для идеальных условий. Учиты-

вая реальные свойства сигналов и устройств преобразования, час-

тоту дискретизации следует выбирать с некоторым запасом по 

сравнению со значением, полученным из предыдущего выражения. 

В стандарте CD Digital Audio частота дискретизации равна 

44,1 кГц. Для цифровых звуковых магнитофонов (DAT) стан-

дартная частота дискретизации составляет 48 кГц. Современные 

звуковые карты, как правило, способны работать в широком диа-

пазоне частот дискретизации (до 192 кГц). 

В последнее время становится все более популярным стандарт 

DVD-audio, где частота дискретизации может быть равной 

44,1/48/88,2/96/192 кГц, разрядность представления звуковых 

данных — 16/20/24 бит, количество каналов — до 6. 

1.2.2. Цифроаналоговое преобразование 

Для воспроизведения звукового сигнала, записанного в циф-

ровой форме, необходимо преобразовать его в аналоговый  

сигнал. 

Цифроаналоговое преобразование в общем случае выполняет-

ся в два этапа. На первом этапе из потока цифровых данных  

с помощью цифроаналогового преобразователя выделяют отсче-

ты сигнала, следующие с частотой дискретизации. На втором 

этапе путем сглаживания (интерполяции) из дискретных отсчетов 

формируется непрерывный по времени аналоговый сигнал.  
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Довольно часто изготовители, доказывая преимущество своих 

звуковых карт, подчеркивают такое обстоятельство, как наличие 

у звуковой карты цифрового входа и/или выхода. Действительно, 

если звуковая карта имеет выход, на который сигналы поступают 

не в аналоговой (после ЦАП), а в цифровой форме, это позволяет 

уменьшить искажения, связанные с дополнительными преобра-

зованиями при дальнейшей цифровой обработке сигнала вне зву-

ковой карты. 

В соответствии с идеей виртуальной студии звукозаписи вся 

обработка должна выполняться средствами одного персонального 

компьютера. С помощью этого же компьютера можно получить  

и конечный продукт — компакт-диск. ЦАП высокого качества 

нужен только для мониторинга, т. е. для того, чтобы слышать 

происходящее в виртуальной студии. Наличие цифрового выхода 

в виртуальной студии дает преимущества только тогда, когда тре-

буется выполнить запись на DAT или подключить высококачест-

венные акустические мониторы, снабженные цифровым входом. 

Наличие цифрового входа в виртуальной студии может быть 

актуальным в том случае, если вас не устраивает качество работы 

встроенного АЦП звуковой карты и вы хотите использовать бо-

лее эффективный внешний АЦП.  

ПРИМЕЧАНИЕ  

Подробную информацию об АЦП вы найдете в нашей книге [29]. 

1.2.3. Дитеринг и нойзшейпинг. Транкейт 

Шум квантования. Как с ним бороться? Если для представле-

ния звука использовать 24- или 32-битные отсчеты, то о шуме 

квантования можно забыть (так он слаб). Да вот беда — основным 

потребительским аудиоформатом является формат компакт-

дисков: 16 бит/44,1 кГц/стерео. Поэтому разрядность представле-

ния звуковых данных приходится понижать. Даже при 16-битном 

разрешении звука шум квантования неуловимо мал, тем не менее 

он обладает одной пренеприятнейшей особенностью: этот шум 

коррелирован (жестко связан) с полезным сигналом. Именно шум 

квантования принимает самое активное участие в формировании 
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негативного образа цифрового звука в умах людей, считающих 

его "плоским", "металлическим", "пластмассовым" и т. п. Как 

только раньше не называли 16-битный звук! Так было до появле-

ния специальных методов обработки цифрового звука, называе-

мых дитерингом (dithering) и нойзшейпингом (noise shaping). 

Суть дитеринга состоит в том, что до понижения разрядности  

к полезному сигналу подмешивается очень слабый специфичный 

шум. В результате шум квантования попросту забивается этим 

шумом, который в силу своих статистических свойств гораздо 

меньше воздействует на человека. Конечно, в результате получа-

ется более шумная запись, но шум этот, как и шум квантования, 

практически неуловим на слух. 

Еще один метод борьбы с шумом квантования — нойзшей- 

пинг — заключается в применении специальных алгоритмов ок-

ругления значений звуковых отсчетов при понижении разрядности. 

После применения нойзшейпинга большая часть энергии шума 

квантования сосредоточена в области высоких частот, к которым 

человеческий слуховой аппарат наименее восприимчив. Обычно 

нойзшейпинг применяется совместно с дитерингом. Подробнее 

о нойзшейпинге и дитеринге читайте в книгах [12, 29]. 

Транкейт (от англ. truncate — усекать) — то, что раньше мы 

называли понижением разрядности цифрового звука. Был сигнал 

24-битным, стал 16-битным — произошел транкейт. С одной сто-

роны, понижение разрядности цифрового звука — дело обычное. 

Стоило ли вводить специальный термин? Однако термином trun-

cate обозначают целый комплекс проблем, возникающих при ра-

боте с цифровым звуком, разрядность которого выше 16. Прежде 

всего, это неконтролируемое вами понижение разрядности (оно 

происходит втайне от вас или вы просто не обратили на него 

внимания). Допустим, сигнал проходит через три соединенных 

последовательно цифровых устройства обработки звука. Пусть 

для их соединения используется цифровой интерфейс S/PDIF. 

Внешне все кажется нормальным: три красивых прибора соеди-

нены стандартными кабелями, все работает. Что еще нужно?  

Но тот, кто коммутировал эти устройства между собой, не учел, что 

только первый и последний приборы данной цепочки 24-битные, 
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а средний — 16-битный. Эти приборы легко нашли общий язык: 

каждый из 24-битных приборов при установлении связи по S/PDIF 

выяснил, что подключен к 16-битному устройству, и переклю-

чился в соответствующий режим. В результате при передаче сиг-

нала от первого устройства ко второму произошел транкейт, при-

чем персонал студии этого даже не заметил. А как вы уже знаете, 

шум квантования 16-битного сигнала — вещь не очень приятная. 

Если в процессе обработки фонограммы транкейт происходит 

неоднократно, то качество звучания будет постепенно снижаться.  

Вы скажете, что у вас нет своей цифровой студии с оборудо-

ванием стоимостью в десятки тысяч долларов. Но проблема 

транкейта может подстерегать вас и в персональной студии 

звукозаписи на базе PC. Обработали свой 24-битный WAV-файл 

16-битным плагином реверберации — вот вам и транкейт. 

Единственный способ борьбы со случайным транкейтом: вни-

мательно читайте инструкции, поставляемые с оборудованием. 

Что же касается программ, в частности плагинов (подключаемых 

модулей), то для их контроля есть специальные утилиты. Об од-

ной из таких утилит мы рассказали в книге [12]. 

1.3. Измерители и анализаторы 

параметров звука 

Заниматься записью и преобразованием звуковых данных всле-

пую, не измеряя их параметры, а значит и не представляя себе их 

свойства, нет никакого смысла. В распоряжении современного 

звукооператора имеется много самых разнообразных измеритель-

ных приборов (индикаторов), позволяющих оперативно контроли-

ровать ход записи и редактирования звука. С помощью этих при-

боров можно своевременно обнаружить искажения, выявить то 

место в студийном комплексе, где они возникают, и выработать 

правильное решение, направленное на их устранение. И даже ко-

гда аппаратура работает нормально, если вы хотите получить звук 

высокого качества, без измерений не обойтись.  

Наибольшую пользу способны принести измерительные при-

боры, которые визуализируют какие-либо параметры звуковых 
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колебаний. К ним можно отнести: измеритель уровня аудиосиг-

нала, анализатор спектра аудиосигнала и анализатор качества 

стереосигнала.  

1.3.1. Измеритель уровня аудиосигнала 

Уровень аудиосигнала характеризует сигнал в определенный 

момент и представляет собой выраженное в децибелах выпрям-

ленное и усредненное за некоторый предшествующий промежуток 

времени напряжение аудиосигнала. 

Теоретически, проще всего усреднять мгновенное значение 

выпрямленного напряжения с постоянным весовым коэффициен-

том. Однако слуховое ощущение в каждый текущий момент оп-

ределяется не только мгновенным значением сигнала в этот мо-

мент, но и предыдущими его значениями. Наиболее подходящее 

приближение, достаточно хорошо соответствующее реальным 

свойствам человеческого слуха, дает экспоненциальная весовая 

функция. 

Вид зависимости уровня сигнала от времени определяется как 

особенностями самого аудиосигнала, так и выбранным интерва-

лом усреднения. При малых значениях интервала усреднения 

речь идет о квазипиковых измерителях (часто их обозначают как 

PEAK). Большое значение интервала усреднения свидетельствует 

о том, что вы имеете дело со среднеквадратическим измерителем 

уровня (RMS
1
-измерителем уровня). По квазипиковому индика-

тору удобно следить за максимальным уровнем сигнала (чтобы 

не допустить перегрузку устройства записи или усиления звука), 

однако реальную громкость сигнала он практически не отобра-

жает. RMS-измеритель плохо реагирует на пики сигнала, однако 

вполне адекватно отражает именно громкость, субъективно вос-

принимаемую слуховым аппаратом человека. 

Изменяющееся во времени выпрямленное напряжение, усред-

ненное за определенный период с заданным множителем веса и 

выраженное в децибелах, называется динамическим уровнем ау-

диосигнала. 

                                                           
1 RMS (Root Mean Square) — среднеквадратическое значение. 
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ПРИМЕЧАНИЕ  

Хотя в книге мы знакомим читателей с несколькими программами, 
предназначенными для работы с цифровым звуком, в качестве 
основы для обучения элементарным операциям мы решили вы-
брать звуковой редактор Adobe Audition. Такой выбор не случаен. 
Мы убеждены, что Adobe Audition (и ее прототип Cool Edit Pro) — 
одна из самых наукоемких и универсальных программ. Материал 
об Adobe Audition выделен в особую главу. Но уже с этого раздела 
мы начнем обращаться к тем или иным средствам Adobe Audition. 
Конечно, до их применения программу нужно установить, настро-
ить и освоить хотя бы на уровне выполнения элементарных опе-
раций (см. разд. 3.2). 

Предположим, что ваша аппаратно-программная студия вклю-

чена, на вход звуковой карты подается аудиосигнал, входной  

и выходной порты Adobe Audition должным образом сконфигу-

рированы (см. разд. 3.1). Таким образом, созданы все необходи-

мые условия для того, чтобы можно было познакомиться с изме-

рителем уровня, имеющимся в Adobe Audition.  

Для точной установки уровня записи звуковой редактор Adobe 

Audition предоставляет очень удобный инструмент — панель  

Levels. По умолчанию в нижней части окна расположены инди-

каторы уровня сигнала в двух стереоканалах и шкала-линейка 

(рис. 1.3). По умолчанию же установлены пределы шкалы 0 и  

–72 дБ (числа от 0 до –69). Диапазон отображаемых уровней 

можно менять. Для этого нужно щелкнуть на шкале правой кноп-

кой мыши и выбрать значение отображаемого диапазона уровней  

в контекстном меню (от 24 до 120 дБ).  

Имеющаяся в Adobe Audition панель измерителя уровня удоб-

на тем, что в отличие от аналогичных элементов других звуковых 

редакторов и виртуальных студий ее размер можно увеличить, 

растягивая шкалу хоть на всю ширину экрана монитора. За счет 

этого вам удастся действительно измерять уровень, а не просто 

пользоваться панелью как индикатором наличия сигнала.  

 

Рис. 1.3. Измеритель уровня аудиосигнала Adobe Audition 
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Сделайте на шкале двойной щелчок или выберите пункт  

Options > Metering > Monitor Record Level главного меню — 

линейка "оживет". Если для звуковых данных установлен стерео-

фонический формат, на ней будут индицироваться уровни сигналов 

левого и правого звуковых каналов. Две ярких полоски будут удли-

няться или сокращаться в соответствии с изменением уровня сигна-

ла в соответствующем канале. Чтобы вы смогли уследить за пико-

выми значениями уровней, индикаторы ненадолго их запоминают. 

Если формат звуковых данных монофонический, то вместо двух 

трепещущих полосок вы будете наблюдать только одну. 

В процессе записи аудиосигнала ваша главная задача — сле-

дить, чтобы индикаторы уровня не доходили до 0 дБ, но в то же 

время не были малыми. 

Правее отметки 0 друг над другом расположены два квадрати- 

ка — индикаторы перегрузки (клиппирования сигнала) левого  

и правого каналов. Они загораются, если амплитуда сигнала дости-

гает максимальной допустимой величины или превышает ее. Уро-

вень 0 дБ соответствует максимальному допустимому значению 

цифрового отсчета звукового сигнала. Если эта величина будет 

превышена записываемым сигналом, то произойдет переполнение 

разрядной сетки аналого-цифрового преобразователя (АЦП). На 

слух этот факт воспринимается как очень заметное искажение сиг-

нала, особенно если переполнение разрядной сетки будет происхо-

дить часто или надолго. Не случайно индикаторы перегрузки сиг-

нализируют о ней тревожным красным цветом. 

Если источник звука позволяет повторять записываемую фоно-

грамму (например, при записи с компакт-диска), то лучше будет, 

если вы предварительно прослушаете всю фонограмму. Причем 

всякий раз после срабатывания индикаторов перегрузки следует: 

1. Остановить воспроизведение. 

2. Регулировкой на микшере звуковой карты (с помощью вирту-

ального микшера) немного уменьшить уровень сигнала. 

3. Сбросить индикаторы перегрузки (щелчками погасить их). 

4. "Отмотать" фонограмму назад (установить маркер перед тем 

местом сигналограммы, в котором наблюдалась перегрузка). 

5. Вновь проконтролировать подозрительное место фонограммы. 
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При записи с микрофона невозможно в точности предугадать 

закономерность изменения громкости записываемого звука. Но все 

же следует сделать пробу, отрепетировать то, что вам предстоит 

записывать (речь, вокал или игру на музыкальном инструменте). 

При этом можно в небольших пределах изменять расстояние  

от источника звука до микрофона и их взаимное расположение,  

а также громкость, с которой извлекается звук. Попутно неплохо 

было бы так сориентировать микрофон, чтобы в него не проникал 

звук от источника шума (если таковой имеется в помещении, где 

происходит запись). 

Подобрав с помощью микшера нужный уровень, снова сде-

лайте двойной щелчок на индикаторах уровня или нажмите 

кнопку  (Stop) на транспортной панели. 

Панель Levels, как и некоторые другие панели главного окна 

программы, можно перемещать с помощью мыши. Возможно, ра-

бота с измерителем уровня покажется вам более удобной, если па-

нель Levels размещена вертикально.  

Перед началом сеанса записи вам следует произвести необхо-

димую коммутацию и установить оптимальный уровень входного 

сигнала с помощью микшера, встроенного в звуковую карту. 

1.3.2. Анализатор спектра аудиосигнала 

Спектральная форма представления сигнала сложна для по-

нимания начинающими любителями компьютерной обработки 

звука. Но спектральный анализ и синтез — это основа основ со-

временной компьютерной обработки звука. От него никуда не 

денешься. 

Хочется обратить ваше внимание на одно парадоксальное об-

стоятельство. Теоретические основы спектрального анализа 

французский ученый Жан Батист Жозеф Фурье разработал более 

двухсот лет назад — в 1807 году. Представляете уровень матема-

тической грамотности населения в то время, за 5 лет до Бородин-

ского сражения? Студенты образца 2011 года — и те, бывает, при-

ходят в ужас, увидев в экзаменационном билете слово "Фурье". 

Утешением всем нам может служить лишь то, что теории Фурье 

не поняли даже такие его современники и великие математики, 
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как Лагранж, Лаплас, Лежандр и Эйлер. Так что если и вы не все 

поймете, то окажетесь в одной компании с мудрейшими. А это 

уже не так обидно.  

Здесь мы ограничимся лишь пояснением основных терминов. 

Подробно (с формулами и графиками) о преобразованиях Фурье 

рассказано в книге [29].  

Классический спектр  

Начать разбираться в сущности спектральных представлений 

лучше с разложения периодического сигнала в ряд Фурье. Лю-

бую периодическую функцию (с ограничениями абстрактного 

характера) можно разложить в ряд по тригонометрическим 

функциям — представить суммой слагаемых, каждое из которых 

есть косинусоидальное колебание с амплитудой ck и начальной 

фазой k.  

Совокупность коэффициентов ck называется амплитудным 

спектром сигнала, а коэффициентов k — фазовым спектром. 

Основной математической операцией при расчете коэффици-

ентов Фурье является вычисление определенного интеграла. Час-

тоты всех синусоидальных колебаний, из которых составляется 

периодическая функция s(t), кратны основной частоте F = 1/T. 

Отдельные составляющие называются гармониками. Колебание  

с частотой F называется первой гармоникой (k = 1), с частотой  

2F — второй гармоникой (k = 2) и т. д. 

Ряд Фурье дает разложение периодической функции по триго-

нометрическим функциям. Это разложение можно применить  

и к непериодической функции, которую рассматривают как пре-

дельный случай периодической функции при неограниченном 

возрастании периода. Если T   (читается: "T стремится к бес-

конечности"), то ряд Фурье превращается в интеграл Фурье. Не-

периодическая функция может быть представлена только суммой 

бесконечно большого числа бесконечно близких по частоте ко-

лебаний с бесконечно малыми амплитудами. Интеграл Фурье 

представляет непериодическую функцию суммой синусоид и ко-

синусоид с непрерывной последовательностью частот. Иногда 

говорят, что в составе непериодического сигнала есть колебания 



Глава 1  30 

всех частот. В случае непериодического сигнала говорить об ам-

плитудах отдельных спектральных составляющих нет смысла, 

т. к. это бесконечно малые величины.  

Текущий спектр  

Классическое определение спектра основывается на преобразо-

вании Фурье, причем интегрирование по времени выполняется  

в бесконечных пределах и спектр зависит только от частоты. Од-

нако бесконечная длительность какого-либо процесса — это абст-

ракция, не имеющая ничего общего с реальностью. 

Если анализируемая функция есть отображение некоторого 

физического процесса, то сведения о спектре мы получаем лишь 

в результате наших наблюдений. Следовательно, при анализе 

спектра мы можем выполнить вычисления лишь от момента на-

чала наблюдения до текущего момента времени t, а не до момен-

та, устремленного в бесконечное будущее. 

Текущий спектр определяется как результат преобразования 

Фурье, но с переменным верхним пределом интегрирования,  

в качестве которого фигурирует текущее время. Поэтому теку-

щий спектр является функцией не только частоты, но и времени. 

Ранее мы воспользовались понятием периодической функции. На 

самом деле периодическая функция — лишь весьма полезная мате-

матическая абстракция. Ведь всякий природный процесс имеет на-

чало и конец.  

Принято называть циклический процесс периодическим, если 

он длится достаточно долго. Мерилом длительности служит чис-

ло "периодов", которое должно быть намного больше единицы. 

Периодичность процесса проявляется лишь с течением времени, 

когда прорисовываются его характерные черты. Текущий спектр 

и отражает это развитие процесса. Таким образом, периодиче-

ский процесс — это предел, к которому может стремиться с те-

чением времени реальный повторяющийся процесс. Аналогично 

и спектр (в его классическом определении) такого процесса есть 

предел, к которому стремится текущий спектр при увеличении 

времени интегрирования до бесконечности. Например, при ин-

тегрировании в бесконечных пределах спектр синусоиды пред-
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ставляет собой единственную линию на частоте, равной частоте 

этой синусоиды. 

Но как на практике измеряется текущий спектр, например, той 

же синусоиды? Мы включаем анализатор спектра, а спустя какое-

то время выключаем его. Получается, что измеряется спектр не 

бесконечного синусоидального колебания, а его более или менее 

протяженного отрезка. Это значит, что фактически исследуется 

спектр прямоугольного импульса с синусоидальным заполнением. 

Сказанное объясняет причину того, что даже для синусоидального 

колебания при уменьшении времени интегрирования спектральная 

линия расширяется, появляются боковые лепестки спектральной 

функции, ее нули все более отдаляются друг от друга. Ведь именно 

так и должен вести себя спектр прямоугольного импульса при 

уменьшении его длительности [10, 12].  

Таким образом, текущий спектр в большей степени отражает 

свойства сигналов, проявляющиеся в реальных условиях их гене-

рирования и обработки, нежели спектр, полученный на беско-

нечном временном интервале. 

Мгновенный спектр 

Текущий спектр — только мостик от частотного к временнóму 

описанию процесса. Не только спектр, вычисленный на беско-

нечном временном интервале, но и текущий спектр — слишком 

грубый инструмент в тех случаях, когда анализируемый процесс 

не стационарен. А музыкальный аудиосигнал является ярким 

примером нестационарного случайного процесса: его среднее 

значение и диапазон изменения амплитуды непрерывно изменя-

ются. Для того чтобы сблизить частотное и временное представ-

ления сигнала, было введено понятие мгновенного спектра. 

Мгновенный спектр — это спектр короткого отрезка процесса, 

непосредственно предшествующего данному моменту времени.  

В этом определении мы имеем дело со скользящим интегрирова-

нием: интервал интегрирования имеет постоянную длину, но пе-

ремещается по оси времени. А вот относительно текущего вре-

мени этот интервал расположен неизменно.  

Страшно далеко это определение спектра от того, что давно 

придумал великий математик! И все же в руках звукорежиссера 
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именно мгновенный спектр является наиболее эффективным ин-

струментом анализа свойств записываемого или уже записанного 

звука. Музыка, создаваемая с помощью синтезатора, отличается 

особенно заметной нестационарностью тембра. Может быть, 

именно поэтому в звуковых редакторах уже давно используются 

средства анализа текущего и мгновенного спектров. 

Взвешенный спектр 

Вы познакомились с тремя подходами к вычислению спек-

тра. Но это еще не финал. Продолжим погружение в суть спек-

тральных преобразований. И вновь речь пойдет о влиянии вре-

мени на результаты спектрального анализа. 

Как вычисляется одна точка графика спектра? Исчерпываю-

щий ответ на этот вопрос дают формулы. Но прибегать к ним не 

хочется, лучше попытаемся разъяснить суть дела обычными сло-

вами.  

Итак, сначала выбирается частота f0. Реальный или виртуаль-

ный генератор формирует синусоиду этой частоты и условно 

единичной амплитуды. Исследуемый сигнал нормируется по ам-

плитуде. Начиная с какого-то определенного момента t0, с шагом 

t (чем меньше t, тем лучше) в моменты времени t0, t1, t2, t3,… ti, 

…, tN–1 с этой синусоидой и исследуемым сигналом проделыва-

ются следующие операции: 

1. Берется отсчет синусоиды. 

2. Берется отсчет исследуемого сигнала. 

3. Эти отсчеты перемножаются. 

4. Результаты перемножения суммируются с накоплением. 

В некоторый момент процесс измерения спектра на частоте f0 

завершается. Накопленная сумма делится на общее число отсче-

тов. Вычисленное значение запоминается и, возможно, отобра-

жается как одна точка графика. Затем накопленная сумма обну-

ляется, значение частоты изменяется на величину f (выбирается 

новое значение частоты — f1). И вся последовательность опера-

ций повторяется до тех пор, пока "пробежкой" по ряду частот f0, f1, 

f2, ..., fN–1 не будет перекрыт весь заданный диапазон. 

Описанная процедура вычисления спектрального коэффици-

ента одновременно есть не что иное, как вычисление взаимокор-
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реляционной функции исследуемого сигнала и синусоиды задан-

ной частоты. Иными словами, в процессе вычисления спектраль-

ной составляющей выясняется степень сходства исследуемого 

сигнала со стандартным (базисным) сигналом, в данном случае — 

с синусоидой. Или можно сказать так: выясняется, в какой про-

порции синусоида "содержится" в исследуемом сигнале. 

Если исследуемый сигнал уже записан и в нашем распоряже-

нии есть цифровой анализатор спектра, способный сколь угодно 

долго хранить результаты промежуточных вычислений, то изме-

рение текущего и мгновенного спектров вполне осуществимо по 

описанной выше процедуре. 

Уместен вопрос: насколько адекватен описанный математиче-

ский алгоритм тому спектральному анализу, который проводится 

реальными анализаторами спектра, и тому, который выполняется 

органами слуха и мозгом человека? Ответ: не вполне. 

Основная проблема состоит в том, что и прибор, анализирую-

щий спектр, и человек обладают конечной памятью. Былые со-

бытия, подробности хода любого процесса постепенно стираются 

из нее. Это означает, что чем больше удалены в прошлое отсчеты 

анализируемого сигнала, тем меньший вклад они вносят в накоп-

ление той самой суммы произведений отсчетов, которая в конце 

концов определяет значение спектрального коэффициента. 

Учет реальных свойств памяти анализаторов спектра осуществ-

ляется с помощью весовых функций. Весовая функция описывает 

зависимость вклада предшествующих отсчетов исследуемого сиг-

нала в вычисляемый спектр. Наглядное представление о весовой 

функции дает форма так называемого спектрального окна. При 

анализе текущего спектра начало спектрального окна совпадает  

с началом отсчета времени, а конец приходится на текущий мо-

мент времени. Текущее время идет вперед, правая граница спек-

трального окна смещается, поэтому каждому конкретному мо-

менту времени завершения анализа соответствует своя ширина 

спектрального окна. Если вычисляется мгновенный спектр, то 

спектральное окно скользит вдоль оси времени, не изменяя своей 

ширины.  

Тот спектральный анализ, о котором мы вели речь до сих пор, 

соответствует спектральному окну прямоугольной формы: весовая 
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функция равна единице в пределах спектрального окна и равна 

нулю вне его. Однако в большей степени суть реального спек-

трального анализа отражает экспоненциальная весовая функция. 

Прямоугольное и экспоненциальное спектральные окна ис-

пользуются при вычислении спектра наиболее часто. Первое  

соответствует идеальному анализатору с бесконечно большой 

памятью, второе удачно отражает свойства человеческого мозга  

и реальных анализаторов спектра на основе резонансных фильт-

ров. Вместе с тем, хотя не столь широко, применяются и другие 

весовые функции. Трудно дать конкретные рекомендации по по-

воду предпочтительности использования той или иной из них. 

Пожалуй, единственный совет может состоять в том, что следует 

остановиться на какой-то одной весовой функции. Только тогда  

у вас будет уверенность в том, что различия результатов анализа 

обусловлены различием свойств сигналов, а не методов расчета. 

Целесообразно также выбирать одну и ту же весовую функцию, 

когда при работе с одним и тем же сигналом вы решаете несколько 

задач, в которых применяются спектральные преобразования. 

Быстрое преобразование Фурье 

До сих пор, знакомясь с сущностью спектральных представ-

лений, мы предполагали, что сигнал является аналоговым, т. е. 

описывается непрерывной функцией. На самом деле компьютер 

способен обрабатывать только цифровые сигналы — дискретные 

по времени и квантованные по уровню. Поэтому аналоговый сиг-

нал подвергается аналого-цифровому преобразованию (АЦП). 

Затем с сигналом в цифровой форме производятся все необходи-

мые операции, в частности спектральный анализ, причем вместо 

обычного спектрального преобразования производится так назы-

ваемое дискретное преобразование Фурье (ДПФ). Непрерывное 

время и непрерывная частота заменяются на соответствующие 

дискретные величины, а вместо интегрирования выполняется 

суммирование. 

Для вычисления дискретного преобразования Фурье последо-

вательности N элементов требуется выполнить N
2
 операций  

с комплексными числами. Если длины обрабатываемых массивов 

цифровых отсчетов звуковых колебаний имеют порядок тысячи  
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и более, то использовать эти алгоритмы дискретного спектраль-

ного анализа затруднительно (особенно в реальном времени). 

Выходом из положения явился алгоритм быстрого преобразова-

ния Фурье (БПФ). Значительно сократить число выполняемых 

операций здесь удается за счет того, что обработка входного мас-

сива сводится к нахождению ДПФ массивов с меньшим числом 

элементов. 

Приближенно можно считать, что объем вычислений по алго-

ритму БПФ пропорционален произведению N  log2N, где N — 

количество отсчетов сигнала. А если решать задачу расчета спек-

тра "в лоб", не пользуясь алгоритмами быстрых преобразований, 

то объем вычислений ориентировочно будет пропорционален 

произведению N  N. Если бы не БПФ, то для фильтрации, спек-

трального анализа и синтеза сигналов не хватило бы быстродей-

ствия самого современного компьютера. 

Спектральный анализ в Adobe Audition 

В составе звукового редактора Adobe Audition предусмотрены 

два разных средства спектрального анализа: окно Frequency 

Analysis, предназначенное для проведения спектрального анали-

за, который условно можно назвать классическим, и главное окно 

программы в режиме Spectral Frequency Display, позволяющем 

не только анализировать мгновенный спектр, но и редактировать 

аудиосигнал, представленный в таком виде. Рассмотрим оба этих 

средства. 

Окно спектрального анализатора Frequency Analysis (рис. 1.4) 

открывается командой Window > Frequency Analysis главного 

меню. 

Когда вы открываете окно Frequency Analysis, происходит 

предварительный расчет спектра короткого фрагмента аудиосиг-

нала, начало которого совпадает с позицией маркера (вертикаль-

ной желтой пунктирной линией) на сигналограмме. Если же  

в главном окне программы выделен фрагмент сигналограммы 

(или даже вся сигналограмма), анализируется выборка сигнала, 

расположенная посередине выделенного фрагмента. Это соответ-

ствует измерению единственного значения мгновенного спектра. 
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Рис. 1.4. Окно спектрального анализатора Adobe Audition 

Если анализировать спектр в процессе воспроизведения аудио-

сигнала, то картинка оживет: в окне Frequency Analysis будет ото-

бражаться последовательность графиков мгновенного спектра. 

Аналогичный результат можно получить и не включая режим вос-

произведения. При открытом окне Frequency Analysis в главном 

окне программы следует захватить мышью и буксировать влево 

или вправо один из желтых треугольников, расположенных над  

и под рабочим полем и жестко связанных с маркером. 

Чтобы выполнить спектральный анализ всего выделенного 

звукового фрагмента (или всей сигналограммы), нажмите кнопку 

Scan selection. Спустя некоторое время после завершения расчета 

спектра изображение изменится. Полученный результат прибли-

женно соответствует классическому спектру: измерение произво-

дится на большом, хотя, разумеется, не бесконечном интервале.  

Расчет спектра выполняется раздельно для правого и левого 

каналов. На графике кривые спектрограмм для разных каналов 

отображаются разными цветами. 
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Если окно с графиком спектра покажется мелковатым, вы мо-

жете увеличить его традиционным способом — с помощью мыши.  

А теперь рассмотрим график внимательнее.  

По горизонтальной оси откладывается частота в герцах, по 

вертикальной — уровень компонентов сигнала на этой частоте. 

При установленном флажке Linear View горизонтальная ось 

размечается в линейном масштабе. В линейном масштабе удобнее 

рассматривать весь спектр в целом, включая его высокочастотную 

область. Если этот флажок снят, то по горизонтали устанавливает-

ся логарифмический масштаб, позволяющий наблюдать в деталях 

низкочастотную часть спектра.  

Слева под шкалой частот располагается поле Cursor, в котором 

отображаются значения спектральной функции сигналов правого и 

левого каналов для той частоты, на которую в данный момент на-

целен указатель мыши (сама частота также отображается в этом 

поле). Сказанное справедливо при условии, что указатель мыши 

находится в пределах координатного поля. При перемещении ука-

зателя мыши значения параметров изменяются. Если указатель 

мыши находится вне пределов координатного поля, то значения 

трех отображаемых параметров не меняются, причем они соответ-

ствуют той частоте, при которой указатель мыши, покидая коор-

динатное поле, пересек его границу. 

В поле Frequency отображаются частоты спектральных со-

ставляющих сигналов левого и правого каналов, в окрестностях 

которых сосредоточена максимальная энергия (частоты макси-

мальных пиков на графике). Здесь же указывается условное 

обозначение высоты тона, соответствующего частоте максиму-

ма спектральной функции (отдельно для правого и левого кана-

лов). Используются стандартные обозначения нот: C, D, E, F, G, 

A, B (на рис. 1.4 это F). Рядом с обозначением ноты расположе-

ны числа: 

 номер октавы: 0 — субконтроктава, 1 — контроктава, 2 — 

большая октава, 3 — малая октава и т. д. (на рис. 1.4 это 1); 

 расстройка относительно точного значения высоты предпола-

гаемого тона в центах (цент — сотая доля полутона) с указа-

нием знака расстройки (на рис. 1.4 это -14 для левого и -15 для 

правого каналов). 
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На рис. 1.4 измеренная частота максимума спектральной функ-

ции для левого канала составляет 43,281 Гц — несколько мень- 

ше частоты ноты F1, которая в соответствии со стандартом 

"A4 = 440 Гц" равна 43,654 Гц. Следовательно, высота тона (F1 -14), 

которая оказалась на 14 центов ниже тона F1, распознана про-

граммой верно.  

Частоты максимумов спектральной функции для сигналов право-

го и левого каналов могут быть различными. В верхней части окна 

отображается высота тона, соответствующая сигналу в левом канале. 

В правом верхнем углу окна расположена группа Hold, 

включающая четыре цветные кнопки выбора цвета, которым 

отображаются огибающие спектральных функций.  

Нажав кнопку Advanced, можно увеличить число доступных 

опций окна. Но уже это для продвинутых пользователей.  

В Adobe Audition используется еще одна наглядная форма 

отображения спектра. Команда View > Spectral Frequency Display 

включает режим отображения мгновенного спектра сигнала  

в виде градаций яркости и цвета (сонограммы). На рис. 1.5 пока-

зан пример распределения мгновенного спектра аудиосигнала. 

 

Рис. 1.5. Представление мгновенного спектра в виде сонограммы;  
пример спектра аудиосигнала, содержащего аномалию 
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О чем говорит картинка, которую мы видим в режиме Spectral 
Frequency Display? Как можно использовать информацию, полу-
ченную путем наблюдения мгновенного спектра? 

По горизонтальной оси отложено время, по вертикальной — часто-
та. Цвет и яркость отображения зависят от уровня спектральной со-
ставляющей в анализируемом аудиосигнале на той или иной частоте 
(чем ярче — тем выше уровень). Что касается цвета, то, например, по 
умолчанию нулевой уровень соответствует черному цвету, по мере 
увеличения уровня появляется красный цвет, а максимальный уровень 
отображается белым цветом. Цветовую гамму можно сменить, вос-

пользовавшись опциями диалогового окна Spectral Control (открыва-

ется командой Window > Spectral Controls главного меню). 
Рассматривая сонограмму, можно составить представление  

о частотной области сосредоточения основной доли энергии сиг-
нала в различных точках сигналограммы. Эта информация по-
лезна при сведéнии нескольких треков в микс. Желательно, что-
бы спектры сигналов треков существенно не перекрывались по 
частоте. Добиться этого можно путем фильтрации. В процессе 
обработки сигналов фильтрами можно увидеть и сравнить с по-
мощью сонограмм спектр сигнала, полученного в результате об-
работки, со спектром исходного сигнала и тем самым оценить, 
верно ли ведется обработка. 

Чрезвычайно важно то обстоятельство, что Adobe Audition  

в режиме Spectral Frequency Display позволяет не только на-

блюдать за спектром сигнала, но и редактировать его. Не понра-

вившийся вам чем-либо фрагмент можно выделить и основатель-

но с ним поработать (вплоть до вырезания). В качестве примера 

на рис. 1.5 показан мгновенный спектр небольшого участка ау-

диофайла (короткий фрагмент дикторского текста). Области  

с относительно широким спектром (светлые) соответствуют сло-

вам, с узким (темные) — паузам между ними. Видно, что в конце 

первой фразы (где расположен указатель мыши) мгновенный 

спектр шире, чем в ближайших окрестностях. В этом месте на-

блюдается некий неестественный, подозрительный выброс. Ши-

рокий спектр всегда соответствует быстрому перепаду значений 

сигнала или короткому импульсу. Скорее всего, в этом месте есть 

щелчок. При других формах отображения аудиосигнала заметить 

его было бы очень трудно. 
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Изучая спектральное представление, можно обнаружить лю-

бые ненормально быстрые перепады значений сигнала. Часть из 

них может быть вызвана внешними причинами: щелчки, трески, 

дефекты речи и т. п. Иногда скачки значений отсчетов появляют-

ся в самой программе в результате неграмотного монтажа фоно-

граммы. Например, монтируются фрагменты разных сигналов  

и хотя бы один из них имеет постоянное смещение или сверхниз-

кочастотную составляющую. Или при нарезке фрагментов звуко-

оператор не позаботился о том, чтобы точки разрезов совпадали  

с нулевыми точками звуковой волны.  

В Adobe Audition спектральное представление в режиме Spectral 

Frequency Display обладает уникальным свойством! С помощью 

инструмента  (Lasso Selection Tool) вы можете выделить в соно-

грамме фрагмент любой конфигурации и затем вырезать его, тем 

самым редактируя частотно-временное распределение энергии ау-

диосигнала. В этом режиме доступны также инструменты  

(Effects Paintbrush) и  (Spot Healing Brush). Ими прямо на соно-

грамме можно делать "мазки", как обычной кисточкой (рис. 1.6).  

В результате к "подкрашенным" областям будут применены алго-

ритмы сглаживая различных дефектов записанного звука. 

  

Рис. 1.6. В режиме Spectral Frequency Display  
мгновенный спектр доступен для редактирования 
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На этом мы завершаем рассказ о сущности и разновидностях 

спектральных представлений аудиосигнала. Однако не спешите 

стирать из памяти полученные теоретические сведения. На преоб-

разовании сигнала в спектральной области основан один из основ-

ных видов обработки аудиосигналов — фильтрация. О фильтрации 

мы тоже поговорим, но позже. 

1.3.3. Анализаторы моносовместимости  
и качества стереосигнала 

Если вы планируете воспроизводить звуковой материал в мо-

нофоническом режиме (например, по телевидению либо посред-

ством звукоусилительной аппаратуры клубов или концертных 

залов), то в его моносовместимости должны быть уверены. Мо-

носовместимость важна и при передаче музыкальных компози-

ций по радио, даже если передача ведется радиостанцией, осуще-

ствляющей стереофоническое вещание. Все дело в том, что 

определенная часть аудитории любой радиостанции до сих пор 

принимает ее программы с помощью монофонических приемни-

ков. Разработчики существующих стандартов формирования сте-

реосигналов исходили из необходимости обеспечить совмести-

мость стереофонической радиопередачи с монофоническим 

оборудованием. Не случайно в эфир передаются не сигналы левого 

и правого каналов (L и R), а их сумма (L + R) и разность (L – R). 

Другими словами, стереозвук кодируется в системе M/S (Mid/Side — 

центральный/боковой каналы). 

В низкочастотный тракт монофонического приемника попада-

ет лишь суммарный сигнал (Mid), и вы можете, хоть и в монофо-

ническом формате, но все же без каких-либо других потерь слы-

шать все звучащие инструменты и голоса, в какой бы точке 

исходной стереопанорамы они ни находились. 

В декодер стереофонического радиоприемника попадают и сум-

марный (Mid), и разностный (Side) сигналы. Там они разводятся по 

двум каналам обработки. В одном канале сигналы, поступившие из 

эфира, складываются, а в другом — вычитаются. В результате 

формируются сигналы левого и правого каналов. 

Несовместимость музыкальной композиции с монофониче-

ским оборудованием появляется тогда, когда компоненты звуко-
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вого сигнала левого и правого каналов оказываются в противофа-

зе. В этом случае при суммировании звуковые компоненты, на-

ходящиеся в противофазе, "гасят" друг друга, в результате чего 

возникают неприятные на слух искажения. Партии некоторых 

инструментов могут вообще "исчезнуть" из композиции. В пер-

вую очередь это утверждение относится к партиям, панорамиро-

ванным в центр. В виртуальных студиях такая ситуация является 

следствием применения специальных эффектов, изменяющих 

фазу звукового сигнала. 

Определить на слух моносовместимость фонограммы спосо-

бен далеко не каждый человек. Для этой цели есть специальные 

устройства — контрольные дисплеи стереозвука, или стереого-

ниометры, позволяющие анализировать множество параметров 

звукового сигнала, в том числе фазовые соотношения между од-

ноименными спектральными компонентами в разных каналах. 

Сначала познакомимся с принципом действия стереогонио-

метра. Для этого, прежде всего, нужно разобраться в том, что та-

кое фигуры Лиссажу
1
, как они получаются и какую информацию 

в себе несут. 

Фигурами Лиссажу называются траектории точки, одновре-

менно совершающей гармонические колебания в двух взаимно 

перпендикулярных направлениях. Траектория точки — замкну-

тая кривая, форма которой зависит от соотношений амплитуд, 

частот и начальных фаз колебаний. 

Во времена, когда об электронно-счетных частотомерах никто 

даже не мечтал, да и позже, когда они все еще оставались боль-

шой редкостью, с помощью фигур Лиссажу измеряли неизвест-

ную частоту колебания, сравнивая ее с частотой эталонного ко-

лебания. 

Измерительным прибором может служить осциллограф. На 

пластины, отклоняющие светящуюся точку экрана в вертикаль-

ном направлении, как обычно, подают исследуемое колебание. 

Но, в отличие от традиционного режима работы прибора, на го-

ризонтально-отклоняющие пластины электронно-лучевой трубки 

                                                           
1 Названы в честь французского математика XIX в. Жюля Антуана Лиссажу, 

впервые изучившего их. 
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не подают сигнал, создающий временнýю развертку наблюдаемого 

процесса. Вместо него подключают эталонное гармоническое  

колебание. Наблюдая фигуры Лиссажу, сравнивая их с образцо-

выми изображениями и подсчитывая узловые точки, определя- 

ют разность фаз, отношение амплитуд и отношение частот коле-

баний. 

Описанный принцип действия лежит в основе стереогонио-

метра (конечно, в наши дни вместо осциллографа используются 

другие, специально разработанные приборы, либо их виртуаль-

ные аналоги).  

Обычно в стереогониометрах предусмотрено два режима ра-

боты: на виртуальные отклоняющие пластины подаются либо 

суммарный и разностный сигналы, либо сигналы левого и право-

го каналов.  

С точки зрения информативности такие способы отображения 

результатов измерения равноценны. Ведь между парой сигналов 

L и R, с одной стороны, и их суммой и разностью, с другой сто-

роны, есть однозначная линейная связь. Изображения одного  

и того же процесса, полученные в двух системах координат, ока-

зываются очень похожими друг на друга и отличаются, в основ-

ном, направлениями своих осей. Иными словами, пользователю 

предлагается выбрать более привычный вариант отображения 

результатов измерений. 

В Adobe Audition есть возможность контроля моносовмести-

мости сигнала с помощью встроенного в программу виртуально-

го стереогониометра — окна Phase Analysis (рис. 1.7), открываемо-

го командой Window > Phase Analysis главного меню. 

Виртуальный стереогониометр (фактически фазовый анализа-

тор), о котором сейчас пойдет речь, обладает функциональными 

возможностями, реализованными далеко не во всех его "желез-

ных" собратьях (разве что в самых дорогих). С помощью окна 

Phase Analysis можно: 

 проводить анализ в реальном времени; 

 получать усредненную картину для всей сигналограммы; 

 наблюдать мгновенную диаграмму, соответствующую поло-

жению указателя текущей позиции; 
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 исследовать выделенные фрагменты сигналограммы, имею-

щие произвольную протяженность во времени; 

 отображать результаты измерений в семи различных системах 

координат.  

Кроме координатного поля, в окне Phase Analysis еще есть 

только три элемента. 

 Normalize — кнопка, нажав которую вы нормализуете резуль-

таты измерения параметров сигнала таким образом, что изо-

бражение займет максимальную допустимую область коорди-

натного поля. 

 Раскрывающийся список, предназначенный для переключения 

системы координат. Выбрать можно из семи вариантов. Однако 

реальной информативностью обладают варианты: Mid/Side (цен-

тральный/боковой каналы, или моно/стерео); Left/Right (ле-

вый/правый). 

 Samples — раскрывающийся список, позволяющий задать ко-

личество отсчетов в анализируемом сигнале, на основе которых 

программа выполнит быстрое преобразование Фурье и вычис-

лит фазовые сдвиги. Чем больше число, выбранное в этом спи-

ске, тем выше точность вычислений, но и тем больше времени 

они займут. 

Итак, с технической точки зрения применение окна Phase Anal-

ysis не составляет труда: открыли — и смотрите. Вопрос  

в том, что можно здесь увидеть.  

Для того чтобы помочь вам освоить виртуальный стереогонио-

метр, приведем вид фигур Лиссажу (в системе координат M/S) для 

нескольких характерных случаев. 

При широкой стереобазе фонограмма является моносовмес-

тимой, если координатное поле окна Phase Analysis заполнено 

сложным рисунком с приблизительно одинаковыми размерами 

по различным направлениям (рис. 1.7, а). 

У фонограммы, характеризующейся узкой стереобазой, при-

знак моносовместимости заключается в том, что фигуры на коор-

динатном поле в основном вытянуты вдоль вертикальной оси 

(рис. 1.7, б). 
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 а     б 

Рис. 1.7. Моносовместимая фонограмма с широкой (а)  
и узкой (б) стереобазой 

 а    б 

Рис. 1.8. Панорама сдвинута вправо (а),  
мононесовместимая фонограмма (б) 

Если бóльшая ось изображения на координатном поле откло-

нена от вертикали (а в системе координат L/R — от диагонали), 

то это признак нарушения стереобаланса: например, панорама 

сдвинута вправо (рис. 1.8, а). 

Фонограмма мононесовместима, когда изображение на коор-

динатном поле растянуто вдоль горизонтального направления 

(рис. 1.8, б). 



Глава 1  46 

В некоторых других звуковых редакторах (например, Sound 

Forge [25]) наряду со стереогониометром доступно еще одно (ме-

нее наглядное) средство оценки степени моносовместимости — 

коррелометр. Он вычисляет нормированный коэффициент вза-

имной корреляции сигналов левого и правого каналов. Говоря 

упрощенно, коэффициент взаимной корреляции характеризует 

степень сходства двух сигналов, в частности: если он равен 1 — 

эти сигналы максимально похожи друг на друга (т. е. тождест-

венно равны), –1 — сигналы противоположны друг другу (оди-

наковы во всем, кроме знака), 0 — сигналы совершенно не похо-

жи друг на друга. Сигналы в стереоканалах порождены общими 

источниками звука, а отличаются только из-за того, что звуковые 

волны приходят в разные уши (или разные микрофоны) и раз- 

ными путями. Поэтому нормальным для них является высокая 

степень сходства, при которой текущее значение коэффициента 

взаимной корреляции приближается к единице. Если в результате 

некорректного преобразования (чаще всего после фильтрации 

или обработки эффектами, основанными на задержке сигнала) 

возникает заметный фазовый сдвиг (рассогласование во времени) 

между сигналами левого и правого каналов, то значения коэффи-

циента корреляции будут близки к 0. Наконец, если допущена 

грубейшая ошибка и канальные сигналы находятся в противофа-

зе (инвертированы друг по отношению к другу), то этот "все-

знающий" коэффициент будет отрицательным и близким к –1. 

1.4. Эффекты и обработки 

Программные звуковые редакторы позволяют компьютерно-

му музыканту широко применять в музыкальных композициях 

различные звуковые эффекты и приемы обработки звука. Далее 

мы будем различать эффекты и обработки. В чем разница меж-

ду ними?  

Обработки — это преобразования исходного аудиосигнала, 

направленные на повышение его качества (в некотором огово-

ренном смысле). Примеры обработок: 

 шумоподавление для избавления от помех, сопровождающих 

полезный аудиосигнал; 
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 динамическая обработка уровня сигнала, позволяющая устра-

нить случайные перепады громкости; 

 фильтрация спектральных составляющих, необходимая для 

подчеркивания характерного тембра инструмента или голоса, 

а также для обеспечения "прозрачности" звучания композиции. 

Эффекты — это тоже обработки, но такие, в результате которых 

у звука появляются свойства, исходно у него отсутствовавшие. 

Применение эффектов не всегда приводит к улучшению объектив-

ных свойств звука. Например, эффект дистошн, широко исполь-

зуемый гитаристами, на самом деле не что иное, как специально 

организованное сильнейшее искажение исходного сигнала, подоб-

ное возникающему при перегрузке усилителя. Но применительно  

к гитаре и для определенных музыкальных стилей такой эффект 

оказывается уместным и позволяет получить желаемый эстетиче-

ский результат. 

Как правило, эффекты имитируют (иногда утрированно) какие-

либо природные процессы и явления, сопровождающие излучение, 

распространение звуковых колебаний и восприятие их человеком. 

Например, эффект эхо имитирует отражение звука от преграды, 

эффект дилэй — многолучевой характер распространения звука  

в ограниченном пространстве, эффект реверберация — способ-

ность помещения многократно переотражать звуковые волны, 

с одной стороны, накапливая энергию звуковых колебаний, а с 

другой — постепенно поглощая эту энергию, превращая ее в теп-

ло, нагревающее поверхности помещения. 

В ряде случаев бывает очень трудно отличить эффект от обра-

ботки. Скажем, за счет фильтрации можно так исказить голос 

человека, что он будет восприниматься звучащим из телефонной 

трубки. Обработка это или эффект? 

Иногда эффекты и обработки применяются совместно. Напри-

мер, лучшие алгоритмы реверберации учитывают различия в по-

глощении средой распространения звуковых волн разной длины: за 

счет использования частотного фильтра эффектом обрабатывается 

не весь спектр сигнала, а только его определенная часть.  

Эффекты и обработки могут быть встроены в программу и не-

отделимы от нее. В таком случае они способны функционировать 
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лишь в составе конкретного музыкального или звукового редак-

тора, виртуальной студии. 

Эффекты и обработки могут быть реализованы в виде специа-

лизированных программ. Чтобы выполнить нужные преобразо-

вания, аудиоданные потребуется импортировать в подобную про-

грамму. 

Однако наибольшее распространение получили аудиоплагины — 

модули, подключаемые к базовой программе (программе-хосту). 

Такое решение позволяет практически безгранично наращивать 

возможности основной программы. Программа как бы непрерыв-

но обновляется и совершенствуется без каких-либо изменений  

в ее коде и пользовательском интерфейсе.  

1.4.1. Наиболее важные  

звуковые эффекты 

Звуковые эффекты могут быть созданы аппаратным путем,  

и тогда их можно использовать в реальном времени, как, напри-

мер, позволяют высококачественные звуковые карты. Для этого  

в их состав включен цифровой сигнальный процессор (Digital 

Signal Processor, DSP). Принцип его действия основан на аналого-

цифровом преобразовании сигнала с последующей обработкой, 

использующей несколько алгоритмов цифровой фильтрации и циф-

ровой задержки. Выбор эффектов и управление их параметрами 

производятся по интерфейсу MIDI с помощью контроллеров. 

В составе большинства музыкальных редакторов имеется соот-

ветствующий интерфейс, позволяющий различными способами 

управлять контроллерами эффектов. Чаще всего это делается путем 

"рисования" графика (огибающей) изменения параметра эффекта. 

Контроллер эффекта может быть также ассоциирован с одним из 

регуляторов виртуального микшера, входящего в состав музы-

кального или звукового редактора.  

В компьютерных студиях звуковые эффекты часто создаются 

программным способом. И реализация эффектов, и управление 

ими осуществляются с помощью звуковых редакторов. Обработ-

ке подвергается предварительно записанный в цифровой форме 

звуковой сигнал. Недостаток программной реализации некото-
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рых звуковых эффектов — невозможность их применения в ре-

альном времени в процессе записи. А достоинство заключается  

в том, что отказ от обработки в реальном времени позволяет 

применять самые сложные алгоритмы, требующие больших вре-

менны́х затрат, поэтому число различных звуковых эффектов  

и вариантов каждого эффекта в этом случае значительно превы-

шает то, что достижимо при аппаратной реализации. Кроме того, 

имеется возможность практически неограниченного "вложения" 

эффектов один в другой. Предел устанавливается не технически-

ми (точнее, не математическими) возможностями, а здравым 

смыслом и эстетическими критериями.  

В продвинутых программах-хостах эффекты, в основном, 

применяются в реальном времени. О том, как воспользоваться 

ими, мы расскажем на страницах книги. Но сначала нужно полу-

чить хотя бы исходные представления о сущности основных зву-

ковых эффектов: вибрато, тремоло, дилэй, флэнжер, фейзер, хо-

рус, реверберация и др. 

Вибрато 

В самом общем смысле суть эффекта вибрато заключается  

в периодическом изменении одного из параметров звукового ко-

лебания (амплитуды, частоты или фазы). Изменение параметра 

происходит с очень малой частотой — единицы герц. Различают 

амплитудное, частотное, тембровое и фазовое вибрато. В любом 

случае результатом является обогащение спектра исходного зву-

кового колебания.  

Амплитудное вибрато и тремоло 

Амплитудное вибрато включает в себя собственно амплитуд-

ное вибрато и тремоло. 

Сущность амплитудного вибрато — периодическое изменение 

амплитуды звукового сигнала. Частота, с которой это происхо-

дит, должна быть очень небольшой (от долей герца до 10—12 Гц). 

Если частота вибрато находится вне этих пределов, то необходи-

мый эстетический эффект не достигается.  

Тембр сигнала с амплитудным вибрато богаче тембра исход-

ного сигнала. С таким спектром можно проделывать различные 
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манипуляции, например, изменять уровни спектральных состав-

ляющих с помощью фильтров. 

Особой разновидностью амплитудного вибрато является тре-

моло. Отличительные признаки тремоло: максимальная глубина 

и импульсная форма результирующего сигнала. 

Частотное вибрато 

Суть частотного вибрато заключается в периодическом изме-

нении частоты звукового колебания.  

В музыке частотное вибрато получило широкое распростране-

ние лишь после создания электронных музыкальных инструмен-

тов. Реализовать этот эффект на адаптеризованных акустических 

инструментах (например, на акустической гитаре, снабженной 

звукоснимателем) довольно сложно. Правда, конструкция соло-

гитары дает такую возможность. Натяжение всех ее струн можно 

одновременно изменять с помощью специального механизма — 

подвижной подставки для крепления струн и рычага. Частотное 

вибрато здесь исполняется вручную.  

Реализация частотного вибрато в электромузыкальных инст-

рументах и синтезаторах проста и естественна. Работу всех узлов 

электронных музыкальных синтезаторов, как аппаратных, так  

и реализованных программным путем, синхронизирует опорный 

генератор. Если изменять его частоту, то будут изменяться часто-

ты и всех синтезируемых колебаний. В радиотехнике этот про-

цесс называется частотной модуляцией. Если изменение частоты 

производится по периодическому закону, то в результате получа-

ется частотное вибрато. По существу, при частотном вибрато 

также расширяется спектр исходного сигнала, тембр перестает 

быть постоянным и периодически изменяется во времени.  

Красивое звучание получается только в том случае, когда глу-

бина частотного вибрато невелика. Частотное вибрато исполь-

зуется и само по себе, и входит составной частью в более слож-

ные звуковые эффекты. 

Тембровое вибрато 

Эффект тембрового вибрато также предназначен для измене-

ния спектра звуковых колебаний. Физическая сущность этого 

эффекта состоит в том, что исходное колебание с богатым тем-
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бром пропускается через полосовой частотный фильтр, у которо-

го периодически изменяется либо частота настройки, либо поло-

са пропускания, либо по различным законам изменяются оба  

параметра. При этом фильтр выделяет из всего спектра исходно-

го колебания те частотные составляющие, которые попадают  

в "мгновенную" полосу его пропускания. Так как полоса пропус-

кания "дышит" по ширине и "гуляет" по частоте, тембр сигала 

периодически изменяется. 

Кроме автоматического тембрового вибрато используют руч-

ное (чаще даже "ножное" — с управлением от педали). Такой 

вариант эффекта известен под названием "вау-вау".  

Эффекты, основанные на задержке сигнала 

В этом разделе мы познакомим вас с такими эффектами, как 

дилэй, флэнжер, фейзер, хорус и реверберация. 

Дилэй 

Потребность в эффекте дилэй (delay) возникла с самого начала 

применения стереофонии. Сама природа слухового аппарата че-

ловека предполагает в большинстве ситуаций поступление в мозг 

двух звуковых сигналов, отличающихся временами прихода. Ес-

ли источник звука находится "перед глазами": на перпендикуля-

ре, проведенном к линии, проходящей через уши, то прямой звук 

от источника достигает обоих ушей в одно и то же время. Во всех 

остальных случаях расстояния от источника до ушей различны, 

поэтому одно либо другое ухо воспринимает звук первым.  

Дилэй применяется, прежде всего, в том случае, когда запись 

голоса или акустического музыкального инструмента, выполнен-

ную с помощью единственного микрофона, "встраивают" в сте-

реофоническую композицию. Этот эффект служит основой тех-

нологии создания стереозаписей. Но можно применять дилэй  

и для получения эффекта однократного повторения каких-либо 

звуков.  

Какая именно задержка должна быть выбрана? Ответ на этот 

вопрос определяется несколькими факторами. Прежде всего, 

следует руководствоваться эстетическими критериями, художе-

ственной целью и здравым смыслом. Для коротких и резких зву-
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ков время задержки, при котором основной сигнал и его копия 

различимы, меньше, чем для протяженных звуков. Для произве-

дений, исполняемых в медленном темпе, задержка может быть 

больше, чем для быстрых композиций. 

Исходный сигнал и его задержанную копию можно раздельно 

направить в разные стереоканалы или смешать в различных про-

порциях. Суммарный сигнал можно направить в один из стерео-

каналов либо в оба. 

В звуковых редакторах дилэй реализуется программно (мате-

матически) путем изменения относительной нумерации отсчетов 

исходного сигнала и его копии. Возможны такие, например, раз-

новидности задержки, при которых формируются несколько за-

держанных на различное время копий сигнала.  

В виртуальных дилэях, как и в их аппаратных прототипах, 

обязательно имеются регуляторы глубины и частоты модуляции 

задержанного сигнала, а также регулятор коэффициента обрат-

ной связи (feedback). Суть обратной связи состоит в том, что сиг-

нал с выхода дилэя подается опять в линию задержки. Регулято-

ром обратной связи в данном случае устанавливается время 

затухания. Чтобы однократное повторение превратилось в на-

стоящее повторяющееся эхо, коэффициент обратной связи надо 

увеличить. Как правило, и в реальных, и в виртуальных устрой-

ствах также имеется регулятор, позволяющий подобрать такое 

время задержки, чтобы оно соответствовало темпу композиции.  

Флэнжер и фейзер  

Звуковые эффекты флэнжер (flanger) и фейзер (phaser) также 

основаны на задержке сигнала.  

Как мы уже сказали, дилэй имитирует эффект неодновремен-

ного восприятия мозгом человека звуковых сигналов. Эффект 

повторного звучания может быть вызван и распространением 

звука от источника к приемнику различными путями (например, 

звук может приходить, во-первых, напрямую и, во-вторых, отра-

зившись от препятствия, находящегося чуть в стороне от прямого 

пути). В обоих случаях время задержки остается постоянным.  

В реальной жизни этому соответствует маловероятная ситуация, 

когда источник звука, приемник звука и отражающие предметы 
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неподвижны друг относительно друга. При этом частота звука не 

изменяется, каким бы путем и в какое бы ухо он ни приходил. 

Если же какой-либо из трех элементов подвижен, то частота 

принимаемого звука не может оставаться равной частоте пере-

данного звука. Это проявление того самого эффекта Доплера, 

который в учебниках традиционно иллюстрируется изменением 

высоты звучания гудка при движении паровоза. 

Итак, реальные музыкальные звуки при распространении пре-

терпевают не только расщепление на несколько звуковых волн  

и различную (для каждой из них) задержку, но и неодинаковое 

изменение частот для разных спектральных составляющих. 

И флэнжер, и фейзер имитируют (каждый по-своему) прояв-

ления взаимного перемещения упомянутых трех элементов: ис-

точника, приемника и отражателя звука. По сути, оба эффек- 

та представляют собой сочетание задержки звукового сигнала  

с частотной или фазовой модуляцией. Разница между ними чисто 

количественная. Флэнжер отличается от фейзера тем, что для 

первого эффекта время задержки копии (или времена задержки 

копий) и изменение частот сигнала значительно большие, чем 

для второго.  

Значения времени задержки, характерные для флэнжера, су-

щественно превышают период звукового колебания, поэтому для 

реализации эффекта используют многоразрядные и многоотвод-

ные цифровые линии задержки. С каждого из отводов снимается 

свой сигнал, который в свою очередь подвергается частотной мо-

дуляции. 

Для фейзера, наоборот, характерно столь малое время задерж-

ки, что оно оказывается сравнимым с периодом звукового коле-

бания. При таких малых относительных сдвигах принято гово-

рить уже не о задержке копий сигнала во времени, а о разности 

их фаз. Если эта разность фаз не остается постоянной, а изменя-

ется по периодическому закону, то мы имеем дело с фейзером. 

Так что можно считать фейзер предельным случаем флэнжера. 

Но если внимательно перечитать этот абзац, то можно понять, 

что фейзер — это фазовое вибрато. 



Глава 1  54 

Хорус 

Хорус (chorus) проявляется как эффект исполнения одного  

и того же звука или всей партии не одним инструментом (или 

певцом), а несколькими. Искусственно выполненный эффект мо-

делирует звучание настоящего хора. Сомнений в том, что хоро-

вое пение или одновременное звучание нескольких музыкальных 

инструментов украшает и оживляет музыкальное произведение, 

вероятно, нет ни у кого. 

С одной стороны, голоса певцов и звуки инструментов при 

исполнении одинаковой ноты должны звучать одинаково, к это-

му стремятся и музыканты, и дирижер. Но из-за индивидуальных 

различий источников звук все равно получается разным. 

В пространстве, тракте звукоусиления и слуховом аппарате чело-

века эти немного неодинаковые колебания взаимодействуют, об-

разуются так называемые биения. Спектр звука обогащается и, 

самое главное, течет, переливается. Предельным случаем хоруса 

является одновременное звучание двух источников, слегка отли-

чающихся по частоте, — унисон. 

Хорус настолько украшает звучание инструментов, что ныне 

он стал одним из эффектов, имеющихся практически в каждом 

синтезаторе и во многих звуковых картах. 

Обработка аудиосигнала в звуковых редакторах позволяет по-

лучить массу разновидностей этого эффекта. Вместе с тем не 

следует чрезмерно увлекаться им, т. к. это может привести  

к ухудшению разборчивости звучания голоса, к "засорению" аку-

стической атмосферы композиции. 

Реверберация  

Реверберация (reverb) — один из наиболее интересных и по-

пулярных звуковых эффектов. Сущность реверберации в том, что 

исходный звуковой сигнал смешивается с его копиями, задер-

жанными относительно него на различные интервалы времени. 

Этим реверберация напоминает дилэй. Отличие в том, что при 

реверберации число задержанных копий сигнала может быть 

значительно больше, чем при дилэе. Теоретически число копий 

может быть бесконечным. Кроме того, при реверберации чем 

больше время запаздывания копии сигнала, тем меньше ее ам-
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плитуда (громкость). Эффект зависит от того, каковы временны́е 

промежутки между копиями сигналов и какова скорость умень-

шения уровней их громкости. Если промежутки между копиями 

малы, то получается собственно эффект реверберации. Возникает 

ощущение объемного гулкого помещения. Звуки музыкальных 

инструментов становятся сочными, объемными с богатым тем-

бровым составом. Голоса певцов приобретают напевность, при-

сущие им недостатки становятся малозаметными. 

Ревербератор отличается от цифрового устройства, реализую-

щего дилэй, только тем, что содержит обратную связь (feedback), 

необходимую для формирования затухающих повторений сигна-

ла, а также тем, что временной интервал между соседними по-

вторениями значительно меньше, чем в случае дилэя.  

Цепь обратной связи отсылает часть сигнала с выхода обратно 

в линию задержки, тем самым получается повторяющееся эхо. 

Коэффициент обратной связи должен быть меньше единицы, 

иначе каждое новое эхо будет возрастать по уровню, а не зату-

хать. Может получиться эффект, подобный самовозбуждению 

акустической системы. 

В некоторых виртуальных ревербераторах предусмотрен мо-

дулятор фазы. Его действие проявляется в том, что при коротком 

времени затухания возникает едва заметное изменение тона.  

Сверточный ревербератор 

Информация об акустических свойствах любого помещения 

содержится в его импульсной характеристике — зарегистриро-

ванном отклике на импульсный акустический сигнал. Если у вас 

есть библиотека импульсных характеристик, то звук, синтезиро-

ванный или записанный в домашней студии, вы можете воспро-

изводить так, как будто он звучит совершенно в других условиях, 

например, в каком-либо из всемирно известных концертных за-

лов или оперных театров.  

Для того чтобы можно было воспользоваться импульсной ха-

рактеристикой в подобных целях, необходима программа, которая 

выполняла бы особую математическую операцию — цифровую 

свертку обрабатываемого сигнала и импульсной характеристики. 

Устройства, реализующие такую обработку, часто называют кон-
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вольверами. Сверточный ревербератор и есть не что иное, как 

конвольвер, дополненный средствами редактирования импульс-

ной характеристики, сервисными функциями и элементами регу-

лировки некоторых параметров обработки. 

Итак, сверточный ревербератор — это ревербератор, основан-

ный на цифровой свертке (Convolution) обрабатываемого звуко-

вого сигнала с импульсной характеристикой (Impulse Response) 

концертного зала (или моделируемого реального звукотехниче-

ского прибора). Здесь присутствуют два ключевых термина: им-

пульсная характеристика и свертка. Применение сверточного ре-

вербератора невозможно без понимания их смысла. Попытаемся 

вкратце пояснить. 

В теоретической радиотехнике для расчета отклика некоторой 

линейной электрической цепи на поступающий сигнал разработа-

но несколько способов. Если рассматривается нестационарный 

переходный процесс (а реверберация как раз таковым и являет-

ся), то адекватным математическим аппаратом будет описание 

электрической цепи ее импульсной характеристикой. При этом 

сигнал на выходе цепи получают путем свертки импульсной ха-

рактеристики с входным сигналом. 

По существу, импульсная характеристика — это тот сигнал, 

который появится на выходе цепи в результате воздействия на ее 

вход единичного импульса, длительность которого стремится  

к нулю, а величина — к бесконечности. Подобный идеализирован-

ный импульс назвают дельта-импульсом. Он является математиче-

ской абстракцией — в природе таких сигналов не существует.  

Но можно сформировать очень короткий импульс, приближаю-

щийся по свойствам к дельта-импульсу. 

Итак, мы пропускаем через исследуемую цепь короткий им-

пульс, в результате чего получаем импульсную характеристику 

(и, конечно, так или иначе ее фиксируем). 

Но это только полдела. Нас ведь интересует отклик цепи не на 

тестовый импульс, а на некий реальный сигнал непредсказуемой 

формы. Тут физика на время отходит в сторонку и уступает место 

математике. Любую сложную функцию, любой сигнал (напри-

мер, звук оркестра, играющего на сцене концертного зала) можно 

представить в виде множества дельта-импульсов, сдвинутых во 
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времени друг относительно друга. Если считать, что рассматри-

ваемая цепь линейна, то справедлив принцип суперпозиции:  

результирующий выходной отклик на весь сигнал равен сумме 

элементарных откликов на каждый из дельта-импульсов, описы-

вающих его. В свою очередь, математической операцией, позво-

ляющей вычислить результирующий отклик по элементарным от-

кликам, является свертка сигнала с импульсной характеристикой. 

Что же представляет собой свертка? Прежде всего, свертка — 

это операция, выполняемая над двумя сигналами (или парой 

"сигнал—импульсная характеристика"; характеристика — тоже 

сигнал, но только зафиксированный в памяти вычислительного 

устройства). В результате формируется третий сигнал — свертка 

двух исходных. 

Первое значение свертки получают так: для каждого момента 

времени (на интервале существования сигналов) отсчет одного 

сигнала умножают на отсчет второго сигнала, результаты умно-

жений складывают. Чтобы получить второе значение свертки, 

один из сигналов предварительно сдвигают на время, равное ин-

тервалу между отсчетами, затем опять следует серия перемноже-

ний и суммирование. Остальные значения свертки получают ана-

логичным образом: сдвиг, перемножения, суммирование, сдвиг, 

перемножения, суммирование и т. д. 

Особенность применения поясненных методов для реализации 

звуковых эффектов состоит в том, что не всегда импульсная ха-

рактеристика здесь описывает свойства именно электрической 

цепи. Чаще она несет в себе информацию об акустических свой-

ствах того или иного помещения. Разумеется, результаты акусти-

ческих измерений преобразуются сначала в электрическую, а за-

тем и в цифровую форму. 

Вернемся к сверточному ревербератору. Его основное назна-

чение — выполнять свертку любого звукового сигнала, посту-

пающего на его вход (например, оцифрованного звука голоса 

певца), с заранее загруженной импульсной характеристикой. Что 

это означает на практике? Если в сверточный ревербератор за-

грузить импульсную характеристику определенного концертного 

зала, то после обработки записи, которая на самом деле сделана  

в домашней студии, у слушателей появится впечатление, что 
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композиция исполняется в этом зале. Ведь в импульсной харак-

теристике как раз и учтены все особенности отражения и погло-

щения звукового импульса именно в соответствующем ей зале. 

Получить импульсную характеристику зала довольно трудно. 

При ее регистрации источник звука (акустическую систему) рас-

полагают на сцене, а микрофон (иногда несколько микрофо- 

нов) — в зрительном зале. Микрофон должен быть поднят над 

полом на ту же высоту, на которой обычно находятся уши зрите-

ля. Звук, который генерируется источником, как правило, не 

должен иметь тональную окраску. Хорошо, если это действи-

тельно будет очень короткий импульс (щелчок). Звук, принятый 

микрофоном, записывают и редактируют, например, в программе — 

звуковом редакторе. Полученные звуковые отсчеты сохраняют  

в WAV-файле. Их совокупность фактически и есть импульсная 

характеристика, используемая при выполнении свертки.  

Кроме воссоздания акустической атмосферы конкретных кон-

цертных залов есть еще одно, не менее заманчивое применение 

сверточных ревербераторов. Если в такой программный ревербе-

ратор загрузить импульсную характеристику какого-либо реаль-

ного ревербератора, то вы получите возможность обрабатывать 

ваши записи этим прибором, не имея его на самом деле. Пред-

ставьте: не требуется покупать дорогой аппарат, пользуясь вме-

сто прибора его моделью! Нужно всего лишь раздобыть соответ-

ствующую импульсную характеристику. 

Дистошн 

Дистошн (distortion) — преднамеренное искажение формы аудио-

сигнала, придающее ему резкий, скрежещущий оттенок. Чаще всего 

дистошн применяется в качестве гитарного эффекта. Получается пере-

грузкой усилителя вплоть до появления в усилителе ограничений  

и даже его самовозбуждения. Благодаря этому сигнал становится по-

хож на прямоугольный, отчего в нем появляется много новых гармо-

ник, резко расширяющих спектр. Этот эффект применяется в несколь-

ких вариациях (фуз, овердрайв и т. п.), различающихся:  

 способом ограничения сигнала (обычное или сглаженное, весь 

спектр или полоса частот, весь амплитудный диапазон или его 

часть); 
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 соотношением исходного и искаженного сигналов в выходном 

миксе; 

 частотными характеристиками усилителей (наличие/отсутствие 

фильтров на выходе). 

Вокодер 

Вокодер (voice coder) — устройство синтеза речи на основе 

произвольного входного сигнала с богатым спектром. Речевой 

синтез обычно реализуется при помощи формантных преобразо-

ваний: выделение из сигнала с достаточным спектром нужного 

набора формант с нужными соотношениями придает сигналу 

свойства соответствующего гласного звука. 

ПРИМЕЧАНИЕ  

Под формантой понимают определенную область резонанса,  
в которой усиливается ряд гармоник звука, производимого голо-
совыми связками, т. е. в спектре звука форманта является доста-
точно отчетливо выделяющейся областью усиленных частот.  

Изначально вокодеры применялись для передачи кодирован-

ной речи. Путем анализа исходного речевого сигнала из него  

выделяется информация об изменении положений формант при  

переходе от звука к звуку. Эта информация кодируется и переда-

ется по линии связи, а на приемном конце блок управляемых 

фильтров и усилителей синтезирует речь заново. 

Подавая на блок речевого синтеза сигнал, например электро-

гитары, и произнося слова в микрофон блока анализа, можно по-

лучить эффект "говорящей гитары". При подаче сигнала с синте-

затора получается "голос робота". А если подать сигнал, близкий 

по спектру к колебаниям голосовых связок, но отличающийся по 

частоте, то изменится регистр голоса — мужской на женский или 

детский, и наоборот. 

Один из наиболее интересных плагинов-вокодеров рассмотрен 

в разд. 2.4. 

Изменение высоты тона 

Большинство реальных и виртуальных устройств обработки 

звука имитируют эффекты, существующие в природе. Но устрой-

ства изменения высоты тона (Pitch Shifter) относятся к совершенно 
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особому типу процессоров, поскольку сигнал, получаемый в ре-

зультате их работы, не имеет аналога в окружающем мире. 

Pitch Shifter делает интересное преобразование: он позволяет 

получить копию входного сигнала, высота тона которой может 

отличаться от исходной на величину от нескольких центов до 

октавы и более. 

Общий принцип действия эффекта Pitch Shifter: сигнал запи-

сывается в память с фиксированной скоростью, а считывание 

может производиться быстрее или медленнее — в зависимости от 

того, вверх или вниз относительного входного сигнала должен 

быть изменен тон. 

Сигнал с измененной высотой тона можно задержать по отно-

шению к входному. Это используется для более натурального ими-

тирования искусственного унисона: два инструмента играют одно 

и то же, но есть небольшая разница во времени и высоте.  

На эфекте преобразования высоты тона построены гармониза-

торы, формирующие для записанной вокальной партии дополни-

тельные голоса в соответствии с последовательностью MIDI-

аккордов. В разд. 2.5 мы рассмотрели два плагина-гармонизатора. 

О многих виртуальных модулях аудиоэффектов вы можете уз-

нать из книг [7, 14, 17, 26, 27, 29]. 

На этом мы завершаем рассказ об основных эффектах, имею-

щихся в виртуальных студиях, и переходим к обработкам. 

1.4.2. Наиболее важные обработки  

Из обработок, реализованных в звуковых редакторах, чаще все-

го применяются на практике две их разновидности: частотная 

фильтрация и преобразование динамического диапазона (динами-

ческая обработка). Подробную информацию о них вы можете най-

ти в книгах [25, 26, 28, 29] и статьях [51, 54, 68, 69, 156, 160, 164],  

а сейчас мы ограничимся лишь самыми необходимыми сведениями. 

Частотная фильтрация 

Фильтрация — это процесс обработки электрического звуко-

вого сигнала частотноизбирательными устройствами с целью из-
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менения спектрального состава (тембра) сигнала. Задачами такой 

обработки могут быть: 

 амплитудно-частотная коррекция сигнала (усиление или ос-

лабление отдельных частотных составляющих); 

 полное подавление спектра сигнала или шумов в определен-

ной полосе частот. 

Например, если микрофон, акустическая система или еще какой-

либо элемент звукового тракта имеют неравномерную амплитуд-

но-частотную характеристику, то эти неравномерности можно  

в определенных пределах сглаживать с помощью фильтров. Если 

в результате анализа спектра выяснилось, что в некоторой облас-

ти частот в основном сосредоточена энергия помех, а энергии 

сигнала совсем немного, то посредством фильтрации можно по-

давить все колебания в этом диапазоне частот. 

Для осуществления фильтрации созданы самые различные 

устройства: отдельные корректирующие и формантные фильтры, 

устройства для разделения звука на несколько каналов по частот-

ному признаку (кроссоверы), двухполосные и многополосные 

регуляторы тембра (эквалайзеры), фильтры присутствия и т. д. 

Фильтры, реализованные программным путем в составе звуковых 

редакторов, основаны на спектральном анализе. Любой реальный 

сигнал может быть представлен в виде набора коэффициентов раз-

ложения в ряд по гармоническим функциям. Фильтрация сводится  

к умножению спектральных коэффициентов на соответствующие 

значения передаточной функции фильтра. Если спектр представлен 

в комплексной форме, то сигнал описывается совокупностью ампли-

тудного и фазового спектров (АС и ФС), а фильтры — амплитудно-

частотными и фазочастотными характеристиками (АЧХ и ФЧХ). 

АЧХ представляет собой зависимость коэффициента передачи 

фильтра от частоты. ФЧХ отражает сдвиг фазы выходного сигнала 

по отношению ко входному в зависимости от частоты. В этом случае 

фильтрация эквивалентна перемножению АС на АЧХ и алгебраиче-

скому сложению ФС с ФЧХ. 

В зависимости от расположения полосы пропускания на оси 

частот фильтры подразделяются на 4 группы:  

 фильтры нижних частот (ФНЧ, Low Pass), рис. 1.9; 

 фильтры верхних частот (ФВЧ, High Pass), рис. 1.10;  
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Рис. 1.9. АЧХ фильтра  
нижних частот 

 

Рис. 1.10. АЧХ фильтра  
верхних частот 

 

Рис. 1.11. АЧХ полосового  
фильтра 

 

Рис. 1.12. АЧХ режекторного 
фильтра 

 

 полоснопропускающие (полосовые) фильтры (Band Pass), 

рис. 1.11;  

 полоснозадерживающие (режекторные) фильтры (Band Stop), 

рис. 1.12. 

На всех рисунках по горизонтальной оси отложено значение 

частоты, а по вертикальной — значение передаточной функции 

K(f) в зависимости от частоты. Тот участок АЧХ, где коэффици-

ент передачи не равен нулю, соответствует полосе пропускания 

фильтра. В полосе задерживания (или подавления), напротив, 

коэффициент передачи фильтра должен быть минимальным  

(в идеальном случае нулевым). Полосы пропускания и задержи-

вания граничат на частоте среза АЧХ. Используются следую-

щие обозначения: fср — частота среза АЧХ в ФНЧ и ФВЧ; fср.н  

и fср.в — нижняя и верхняя частоты среза АЧХ в полоснопропус-

кающих и полоснозадерживающих фильтрах. Характеристики, 

представленные на рис. 1.9—1.12, — идеальные. На самом деле 

невозможно реализовать АЧХ, изменяющуюся скачкообразно 

при переходе от полосы пропускания к полосе задерживания.  
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К тому же реальные фильтры, строго говоря, не позволяют обес-

печить равенство передаточной функции нулю вне полосы про-

пускания. Звуковые колебания в полосе задерживания, хотя  

и значительно ослабленные, все равно проникают через фильтр.  

Реальные фильтры нижних и верхних частот характеризуются 

следующими основными параметрами: 

 частотой среза; 

 шириной полосы пропускания; 

 неравномерностью характеристики в полосе пропускания; 

 крутизной ската характеристики в области перехода от полосы 

пропускания к полосе задерживания. 

Для полосового фильтра добавляется еще два параметра:  

 центральная частота, или частота настройки фильтра — час-

тота, расположенная посередине между частотами fср.н и fср.в; 

 добротность, под которой понимают отношение центральной 

частоты фильтра к его ширине полосы пропускания.  

Работая с виртуальными студиями, вы будете часто пользо-

ваться эквалайзерами. 

Эквалайзер — это устройство, объединяющее в себе несколь-

ко фильтров и предназначенное для изменения спектральных 

свойств (тембра) обрабатываемого сигнала. Известны несколько 

типов эквалайзеров, различных по назначению и по устройству: 

 графический эквалайзер; 

 параметрический эквалайзер; 

 фильтр присутствия. 

Графический эквалайзер — это набор полосовых фильтров  

с фиксированными центральными частотами и переменным ко-

эффициентом усиления, которым можно управлять при помощи 

слайдера (ползунка). В качестве регуляторов принято использо-

вать именно ползунки, т. к. положение их ручек представляет со-

бой некое подобие графика АЧХ эквалайзера. Именно поэтому 

такие эквалайзеры принято называть "графическими" — пользо-

ватель как бы рисует ползунками нужную ему кривую АЧХ.  

Итак, графический эквалайзер — это набор полосовых фильт-

ров, которые полностью отделяют друг от друга определенные 

полосы частот. Для того чтобы иметь возможность управлять 
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частотной характеристикой во всей области звуковых частот,  

такие фильтры соединены параллельно. На вход всех фильтров 

подается один и тот же сигнал, и задача каждого фильтра — уси-

лить или ослабить "свой" участок спектра в соответствии с поло-

жением регулятора коэффициента усиления (ползунка).  

Частоты, на которых осуществляется регулирование в графиче-

ских эквалайзерах, унифицированы и выбираются из ряда стан-

дартных частот, перекрывающих весь звуковой диапазон и от-

стоящих друг от друга на некоторый интервал. Этот интервал 

может составлять октаву, ее половину или треть. Наибольшие воз-

можности, естественно, имеют третьоктавные графические эква-

лайзеры, которые в силу этого и получили наибольшее распро-

странение.  

Обычно графические эквалайзеры применяются для обработ-

ки суммарного сигнала, "доводки" общей картины, а не фильтра-

ции отдельных составляющих. С помощью графического эква-

лайзера можно приближенно сформировать нужную АЧХ 

системы обработки звука или акустической системы: поднять 

усиление в одних областях спектра и уменьшить его в других. 

Однако графический эквалайзер мало пригоден для ювелирной 

частотной коррекции. Ведь центральные частоты фильтров неиз-

менны, они могут и не совпадать в точности с теми частотами, на 

которых следует подчеркнуть или, напротив, подавить спек-

тральные составляющие. В подобных случаях на помощь прихо-

дит параметрический эквалайзер.  

Параметрический эквалайзер позволяет управлять не только 

коэффициентом усиления фильтра, но и его центральной частотой, 

а также добротностью (по существу, шириной полосы пропускания). 

При наличии некоторого опыта вы сможете точно устанавливать 

значения этих параметров, так чтобы подчеркнуть звук отдельного 

инструмента или удалить помеху (например, фон от промышленной 

электрической сети с частотой 50 Гц или колебания на частоте са-

мовозбуждения акустической системы) с минимальным влиянием 

на остальные элементы звукового образа. 

Для формирования АЧХ сложного вида применяются мно- 

гополосные параметрические эквалайзеры, параметры каждого  
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из которых можно изменять независимо; иногда их называют па-

раграфическими эквалайзерами.  

Фильтр присутствия (presence) позволяет добиться впечатле-

ния, что звучащий инструмент (или певец) находится в одной 

комнате со слушателем. На самом деле это не что иное, как регу-

лируемый полосовой фильтр, центральная частота которого на-

ходится где-то в диапазоне от 2 до 6 кГц. 

Кроссовер — это устройство, которое разделяет входной сигнал 

на несколько выходных, причем каждый выходной сигнал содер-

жит колебания только определенного диапазона частот. Кроссовер 

представляет собой набор из нескольких полосовых фильтров, 

фильтра нижних частот и фильтра верхних частот (по количеству 

выходных каналов) с общим входом и отдельными выходами. Хо-

тя кроссоверы и не являются эквалайзерами в прямом значении 

этого слова, их работа основана на тех же принципах. 

В звуковых редакторах кроссоверы применяются в целях 

разделения широкополосного сигнала на несколько частотных 

полос для дальнейшей раздельной обработки полос различными 

эффектами или одним и тем же эффектом, но с различными па-

раметрами. 

Динамическая обработка 

В зависимости от выполняемых функций различают следую-

щие приборы динамической обработки: 

 ограничители уровней (лимитеры); 

 компрессоры динамического диапазона; 

 экспандеры динамического диапазона; 

 пороговые шумоподавители (гейты). 

Ограничитель уровня (лимитер) — это авторегулятор уровня, 

у которого коэффициент передачи изменяется так, что при пре-

вышении номинального уровня входным сигналом уровень вы-

ходного сигнала остается практически постоянным, близким  

к номинальному значению. При уровне входного сигнала, не пре-

вышающем номинальное значение, ограничитель уровня работа-

ет как обычный линейный усилитель. Лимитер должен реагиро-

вать на изменение уровня мгновенно.  
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Компрессор — устройство, коэффициент передачи которого 
возрастает по мере уменьшения уровня входного сигнала. Дейст-
вие компрессора приводит к повышению средней мощности и, 
следовательно, громкости звучания обрабатываемого сигнала,  
а также к сжатию его динамического диапазона. 

Экспандер динамического диапазона имеет амплитудную ха-
рактеристику, обратную по отношению к амплитудной характе-
ристике компрессора. Экспандер применяют в том случае, когда 
требуется расширить динамический диапазон. Система, состоя-
щая из последовательно включенных компрессора и экспандера, 
называется компандером. Компандер позволяет снизить уровень 
шумов в трактах записи или передачи звуковых сигналов. 

Пороговый шумоподавитель (гейт) — это авторегулятор,  

у которого коэффициент передачи изменяется так, что при уров-

не входного сигнала меньше порогового амплитуда сигнала на 

выходе близка к нулю. При входном сигнале, уровень которого 

превышает пороговое значение, пороговый шумоподавитель ра-

ботает как обычный линейный усилитель. 

В состав любого прибора динамической обработки входят два 

функциональных элемента — основной канал и канал управле-

ния. Задача канала управления — обнаружить момент пересече-

ния аудиосигналом порогового значения, измерить уровень ау-

диосигнала относительно порога и выработать управляющее 

напряжение. Результат обработки зависит от вида характеристи-

ки регулируемого элемента основного канала. Например, если  

с ростом управляющего напряжения, подаваемого на регулируе-

мый элемент, его коэффициент передачи уменьшается, то полу-

чается компрессор, если увеличивается — экспандер.  
Инерционность устройств динамической обработки оценива-

ют на основе анализа двух временны́х характеристик — времени 
срабатывания и времени восстановления. 

Для регулируемых звеньев всех устройств динамической об-
работки (кроме гейта) срабатыванием принято считать реакцию 
устройства на увеличение уровня сигнала, а восстановлением — 
на его уменьшение.  

Для гейта срабатыванием принято считать уменьшение усиле-

ния при пропадании полезного сигнала, а восстановлением — 

восстановление усиления при появлении полезного сигнала. 
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Одной из наиболее часто применяемых разновидностей дина-

мической обработки является компрессия — сжатие динамическо-

го диапазона в сочетании с последующим усилением. Субъективно 

компрессия проявляется как увеличение громкости звука, он ста-

новится более "плотным". И это не удивительно. Ведь в результате 

компрессии можно достичь увеличения средней мощности неис-

каженного сигнала. Результат компрессии зависит от правильного 

выбора значений нескольких основных параметров. К важнейшим 

из них относятся: 

 порог срабатывания (threshold); 

 коэффициент компрессии, или коэффициент сжатия (compression 

ratio); 

 компенсирующее усиление (makeup gain); 

 время атаки (attack time); 

 время восстановления (release time). 

Порог срабатывания определяет уровень, при превышении 

которого компрессор начинает управлять усилением (иногда го-

ворят, что он находится в активном состоянии). До тех пор пока 

значение уровня сигнала меньше порогового, компрессор не воз-

действует на сигнал (находится в пассивном или выключенном 

состоянии). От величины порога зависит, коснется ли обработка 

только отдельных пиков, или сигнал будет подвергаться ком-

прессии постоянно. 

Коэффициент компрессии (сжатия) определяет степень сжа-

тия динамического диапазона сигнала, имеющего уровень выше 

порогового. Например, коэффициент компрессии 2:1 означает, 

что изменение уровня входного сигнала на 2 дБ вызовет измене-

ние уровня выходного сигнала только на 1 дБ. На практике часто 

применяется именно такое отношение, хотя иногда приходится 

устанавливать более высокие значения. Если коэффициент ком-

прессии установлен, скажем, в пропорции 20:1 и больше, то по-

лучается режим ограничения. Это значит, что если на входе  

появляется сигнал, превышающий установленный уровень, то 

сигнал на выходе практически не будет усилен. Абсолютному 

ограничению соответствует коэффициент компрессии :1.  

Компенсирующее усиление бывает необходимо для того, что-

бы восполнить изменение уровня сигнала, имеющее место при 
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некоторых видах динамической обработки. Например, если огра-

ничить сигнал на уровне –5 дБ, то его динамический диапазон 

станет уже, а звук — тише. Вот здесь-то и поможет усиление 

сигнала на 5 дБ. 

Время атаки определяет, насколько быстро компрессор будет 

реагировать на сигналы с уровнем выше порогового. При боль-

ших значениях параметра компрессор, вероятнее всего, не будет 

успевать отслеживать резкие увеличения уровня входного сигна-

ла. В сигнале на выходе компрессора будут присутствовать пики. 

Если значение параметра невелико, то можно практически ис-

ключить возникновение пиков сигнала при скачкообразном уве-

личении его уровня. Однако при этом звучание может стать не-

достаточно акцентированным. 

Время восстановления — это время, за которое компрессор 

выходит из активного состояния после падения уровня сигнала 

ниже порогового. Если время восстановления слишком велико, 

то компрессор дольше находится в активном состоянии и воздей-

ствует на динамический диапазон даже тогда, когда это нежела-

тельно. Это дает заметный на слух эффект пульсации звука, т. к. 

компрессия не приводит к сглаживанию сигнала. При малом 

времени восстановления обеспечивается более существенное 

сглаживание. Но в тех ситуациях, когда уровень входного сиг-

нала постоянно колеблется в окрестностях порогового значе-

ния, возможно возникновение эффекта "захлебывания". Подбор 

оптимального времени восстановления основан на поиске ком-

промисса.  

Неопытный вокалист обычно допускает большие перепады  

в громкости. В результате некоторые слова тонут в общем звуча-

нии музыки, а другие, наоборот, слишком слышны. Поэтому при 

записи вокала часто используется компрессия. 

Если у вокалиста есть проблемы с шипящими звуками, а сме-

на типа микрофона и его расположения не приводит к исправле-

нию ситуации, то при сведе́нии стоит использовать компрессор  

в режиме деэсера, в котором устраняются свистящие и шипящие 

согласные в вокальной партии. Если путем фильтрации при по-

мощи внешнего эквалайзера подавить все низкие частоты, посту-

пающие на вход канала управления, компрессор будет реагиро-
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вать только на высокочастотные звуки. В таком случае сигнал, 

управляющий компрессором, формируется только из компонен-

тов исходного аудиосигнала, составляющих свист и шипение.  

В этом и заключается принцип действия деэсера. Выбор частот-

ных составляющих, на которые надо повлиять, производится на 

слух. Эквалайзер, включенный в канал управления компрессо-

ром, должен усиливать частоты в области 4—10 кГц. Однако 

нужно подобрать точную АЧХ. 

1.5. Микрофон и микшер  

Микрофон и микшер — это два основных прибора, без которых 

работа звуковой студии невозможна. Микрофон воспринимает 

звук и преобразует звуковые колебания в электрическую форму. 

На микшер возложено решение сразу нескольких задач. Он по-

зволяет подключать микрофоны и другие источники аудиосигна-

ла; измерять и регулировать уровни сигналов, регулировать их 

тембр; смешивать сигналы в различных пропорциях; направлять 

входные и смикшированные сигналы на разные выходы, под-

ключать эффекты и обработки, подавать в необходимых случаях 

на микрофоны питающее напряжение. Практически со всеми пе-

речисленными задачами (кроме обеспечения микрофонов пита-

нием) способны справляться виртуальные микшеры, входящие  

в состав виртуальных студий и звуковых редакторов. 

1.5.1. Микрофоны и их параметры 

Существуют несколько различных типов микрофонов, отли-

чающихся конструкцией и принципом преобразования звуковых 

колебаний в электрические. Остановимся только на микрофонах 

электродинамических и электростатических, т. к. микрофоны 

других типов не обеспечивают необходимое качество. Электро-

динамические микрофоны бывают катушечными и ленточными. 

К электростатическим микрофонам относятся конденсаторные  

и их особая разновидность — электретные микрофоны. 

Принцип действия электродинамического микрофона заклю-

чается в том, что колебания звукового давления вынуждают дви-
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гаться диафрагму и связанную с ней катушку индуктивности  

(в катушечных микрофонах) или ленту (в ленточных). Движение 

этих элементов в поле постоянного магнита приводит к возник-

новению на концах катушки или ленты электродвижущей силы, 

изменение которой и несет в себе информацию. 

Конденсаторному микрофону необходим внешний источник 

питания. Жестко натянутая мембрана под действием изменяюще-

гося звукового давления совершает колебательные движения от-

носительно неподвижного электрода. Эти два элемента состав-

ляют конденсатор, являясь его обкладками. При колебаниях 

мембраны емкость конденсатора изменяется. В электрической 

цепи появляется переменный ток, пропорциональный звуковому 

давлению.  

Электретные микрофоны по принципу действия являются те-

ми же конденсаторными, однако напряжение на обкладках кон-

денсатора обеспечивается не внешним источником, а электриче-

ским зарядом мембраны или неподвижного электрода. Материал 

этих элементов обладает электретным свойством — способно-

стью сохранять заряд длительное время. 

К основным характеристикам и параметрам микрофонов, оп-

ределяющим их качество, относятся следующие. 

 Чувствительность. Микрофон должен улавливать слабые 

звуки, не маскируя их собственными шумами. Как правило, 

предпочтение следует отдавать микрофонам с высокой чувст-

вительностью. Лучшие образцы микрофонов снабжены пере-

ключателем чувствительности. 

 Динамический диапазон. Микрофон должен "слышать" тихие 

звуки и не перегружаться от громких. 

 Частотная характеристика. Если заранее неизвестны час-

тотные характеристики источника звука, т. е. вы, например, не 

знаете, какой голос у исполнителя — бас или сопрано, то 

предпочтительнее микрофон с равномерной частотной харак-

теристикой, который одинаково хорошо воспринимает звуко-

вые колебания всех частот. Но для записи голоса конкретного 

человека или звука определенного музыкального инструмента 

лучше использовать микрофон, подчеркивающий те характер-

ные составляющие, которые определяют красоту звучания. 
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 Уровень собственных шумов микрофона. Чем он меньше, тем 

лучше. 

 Характеристика направленности — зависимость чувстви-

тельности микрофона от направления на источник звука. По 

виду характеристики направленности микрофоны делят на три 

основных типа: 

 ненаправленные (характеристика направленности — ок-

ружность) — хороши для записи группы певцов или инст-

рументов; 

 двусторонне направленные (характеристика направленно-

сти — "восьмерка") — применяются при записи диалога 

или дуэта; 

 односторонне направленные (кардиоидные и суперкардио-

идные; характеристика направленности напоминает сер-

дечко) — почти не воспринимают звуки, приходящие со 

всех направлений, кроме одного основного; используются  

в сложных акустических условиях. 

Лучшие микрофоны имеют переключатель характеристики 

направленности, поэтому их можно применять в любых усло-

виях. 

Микрофон — не тот элемент звуковой студии, на котором 

следует экономить. Ведь от него в первую очередь зависит каче-

ство записанного звука, а значит и ваш успех. Поэтому к приоб-

ретению микрофона нужно отнестись очень серьезно.  

Занимаясь оснащением студии и выбирая между динамиче-

скими и конденсаторными микрофонами, многие звукорежиссе-

ры отдают предпочтение последним. Высокая чувствительность, 

широкий частотный и динамический диапазоны, способность 

воспринимать малейшие оттенки голоса — для студии это плю-

сы. Основной недостаток конденсаторных микрофонов: им тре-

буется внешний источник питания. Поэтому непосредственно  

к звуковой карте подключить конденсаторный микрофон если и не 

невозможно, то, во всяком случае, трудно. При работе с конденса-

торным микрофоном обязательно потребуется специальное согла-

сующее устройство, совмещенное с источником питания. Эти эле-

менты имеются и в составе микшера. Постоянное напряжение 
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питания подается к микрофону по тем же проводам, по которым 

от микрофона к усилителю идет электрический сигнал. Необхо-

димая развязка достигается включением разделительных конден-

саторов. Поскольку вместо четырех проводников в схеме под-

ключения микрофона явно имеются только два, а еще два как бы 

присутствуют незримо, то такую схему принято образно назы-

вать фантомным питанием. 

Итак, есть несколько вариантов подключения микрофона  

к звуковой карте. 

 Динамический микрофон подключается либо непосредственно 

к микрофонному входу звуковой карты, либо к микрофонному 

входу микшера, выход которого в свою очередь подключается 

к линейному входу звуковой карты. Второй вариант предпоч-

тительнее, т. к. позволяет получить меньший уровень шумов. 

 Конденсаторный микрофон подключается к микрофонному 

входу микшера (или микрофонного усилителя), в котором 

имеется источник фантомного питания. Выход микшера или 

микрофонного усилителя подключается к линейному входу 

звуковой карты. 

Для борьбы с помехами от электромагнитных излучений при 

соединении микрофона с микшером, как правило, применяется 

симметричная коммутация. Сигнал от источника (микрофона)  

к приемнику (микшеру) передается не через одножильный экра-

нированный кабель, а через экранированную витую пару прово-

дов. По одному проводу сигнал передается без изменений. Этот 

сигнал, как и провод, называют "горячим", "плюсовым". По дру-

гому проводу идет тот же сигнал, только в противофазе. Этот 

сигнал, как и провод, называют "холодным", "минусовым". Про-

вода (даже экранированные), хотим мы того или нет, играют роль 

антенны — воспринимают помехи. Получается, что оба сигнала 

приходят на симметричный вход микшера вместе с помехами.  

Но на входе микшера производится вычитание второго сигнала  

из первого, при этом полезные сигналы складываются, а помехо-

вые — вычитаются, практически компенсируя сами себя.  

При несимметричной коммутации сигнал от микрофона по-

ступает на вход звуковой карты через одножильный экраниро-
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ванный кабель. Такое техническое решение отличается от сим-

метричной коммутации простотой и меньшей стоимостью, но не 

обеспечивает должного подавления помех от электромагнитных 

излучений. В микрофонных и линейных входах мультимедийных 

звуковых карт, как правило, используется несимметричная ком-

мутация. 

Остановитесь на варианте, подходящем для вас, и подключите 

микрофон к звуковой карте. 

1.5.2. Как устроен микшер 

В тех случаях, когда приходится проводить запись или сведé-

ние сигналов, поступающих от нескольких различных источни-

ков, очень трудно обойтись без микшера (микшерного пульта). 

На страницах книги вы встретитесь с виртуальными микшерами  

и их элементами, реализованными программно. Микшеры, ис-

пользуемые в современных виртуальных студиях, по возможно-

стям, да и по дизайну, очень напоминают настоящие аппаратные 

микшеры. Поэтому есть смысл познакомиться со структурой  

и назначением основных элементов типичного микшера. 

Микшер позволяет решать несколько задач, среди них: 

 микширование (смешивание) в заданных пропорциях сигна-

лов, поступающих от различных источников; 

 согласование уровня сигнала источника с чувствительностью 

и динамическим диапазоном устройства записи, обработки, 

усиления; 

 измерение уровня выходного микса (а в ряде ситуаций —  

и канальных) сигналов; 

 оперативное регулирование уровней сигналов; 

 эквализация (корректирование частотных характеристик сиг-

налов); 

 направление сигналов на внешние устройства динамической 

обработки и эффект-процессоры, регулирование уровней сиг-

налов, посылаемых на эти устройства и возвращаемых с них;  

 коммутация сигналов; 

 переключение фазы канального сигнала; 
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 формирование микса, направляемого на контрольные монито-

ры или в наушники исполнителей; 

 заглушение (мьютирование) отдельных каналов и переключе-

ние их в режим Solo. 

Внешний вид типичного микшера показан на рис. 1.13. 

Условно в микшере можно выделить следующие элементы. 

 Секция канальных модулей. Каждый из канальных модулей 

(иногда его называют входным каналом микшера) содержит эле-

менты коммутации и регулировки, с помощью которых ведется 

раздельная обработка канальных сигналов. 

 Шины параллельного подключения эффектов (шины AUX).  

С их помощью один или несколько каналов подключаются  

к внешним устройствам обработки сигналов с последующим 

возвратом обработанного сигнала в общий микс. 

 Мастер-модуль. В нем канальные сигналы и сигналы, возвра-

щенные с внешних устройств обработки, объединяются в одну 

или несколько пар стереосигналов, производятся измерение  

и регулировка уровня смикшированного сигнала. 

 Модуль формирования контрольного сигнала. Здесь формиру-

ется микс, поступающий на вход усилителя, подключенного  

к контрольным мониторам или наушникам. 

 

Рис. 1.13. Типичный микшер 



Это следует знать начинающему компьютерному звукорежиссеру 75 

Канальный модуль 

На панели канального модуля сосредоточено большинство 

элементов управления микшером. Канальный модуль позволяет: 

 подключать к микшеру источник звука (микрофон, а также 

электрогитару, синтезатор, магнитофон, CD-плеер и другие 

линейные источники сигналов); 

 управлять уровнем громкости источника; 

 осуществлять коррекцию частотных характеристик сигнала  

с помощью эквалайзера; 

 направлять сигналы на выходы системы (основной и мони-

торный); 

 направлять сигналы на дополнительные шины подключения 

эффектов (шины AUX). 

В каждом канальном модуле есть средства выбора различных 

источников (микрофонный/линейный) и предоставляется возмож-

ность установить предварительное усиление для каждого из них.  

Канальный эквалайзер служит для управления частотной ха-

рактеристикой входного сигнала как в целях ее коррекции, так  

и для достижения определенного художественного эффекта. 

Фейдер канала позволяет оперативно регулировать уровень 

сигнала. 

Для подключения источников сигнала предусмотрены гнезда 

разъемов различных типов. Как минимум, имеются трехконтакт-

ный разъем типа XLR (подключается микрофон) и гнездо для 

моноджека (подключаются линейные источники сигнала). Селек-

тор входа (переключатель MIC/LINE) определяет, какое гнездо 

разъема и какие элементы усиления будут использованы данным 

каналом. 

Кнопка ослабления сигнала (имеется не на всех микшерах) по-

зволяет понижать уровень сигнала (на 20—30 дБ) до того, как он 

попадет на какой-либо усилительный элемент микшера. Это по-

зволяет избежать перегрузок от сигналов повышенного уровня. 

В некоторых микшерах имеется переключатель фазы, предна-

значенный для исправления последствий неверной коммутации 

проводов или для изменения фазы, когда размещение системы  

из нескольких микрофонов этого требует. Одному положению 
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переключателя соответствует нулевой сдвиг фазы, второму — 

сдвиг фазы на 180  (иными словами, сигнал инвертируется). Этот 

переключатель, как правило, действует только на сбалансирован-

ный микрофонный вход и не влияет на вход линейный. 

Фантомное питание подается только на сбалансированный 

микрофонный вход и является источником питания конденсатор-

ных микрофонов. Название фантомное объясняется тем, что для 

подачи напряжения питания не требуются дополнительные про-

водники. Питание 48 В подается на конденсаторный микрофон 

по сигнальным проводникам. Для разделения цепей постоянного 

и переменного тока применяются конденсаторы. Пользоваться 

выключателем фантомного питания следует предельно осторож-

но. Если микрофонный вход скоммутирован с несбалансирован-

ным источником сигнала, случайное включение фантомного пи-

тания может привести к поломке прибора, т. к. на него будет 

подано напряжение 48 В. На сбалансированные источники сиг-

нала фантомное питание не оказывает негативного воздействия. 

Регулятор предварительного усиления (GAIN) позволяет при-

вести в соответствие уровни источника сигнала и микшера. Тем 

самым компенсируется, например, разброс в громкостях звуча-

ния голосов певцов и в уровнях сигналов различных источников 

(микрофон, гитара и т. п.). 

Предварительное усиление необходимо регулировать при нажа-

той кнопке Solo. Эта кнопка позволяет выделить канальный сигнал 

из общего микса, проверить уровень и оценить качество звука  

в канале независимо от общего микса. Кнопка Solo имеется не на 

всех микшерах. Усиление на входе следует отрегулировать таким 

образом, чтобы пиковые отметки индикатора уровня находились 

на границе красной зоны (0 VU), но не оставались в ней подолгу. 

Эквалайзер микшера обычно имеет три полосы частот: ниж-

нюю, среднюю и верхнюю. В не очень дорогих микшерах ис-

пользуются полупараметрические эквалайзеры. В них для всех 

или некоторых полос можно выбрать частотный диапазон, с ко-

торым будет работать эквалайзер. Полупараметрический эква-

лайзер, в отличие от параметрического, не позволяет регулиро-

вать добротность фильтра. С перестройкой центральной частоты 



Это следует знать начинающему компьютерному звукорежиссеру 77 

фильтра эквалайзера изменяется полоса пропускания, и в полу-

параметрическом эквалайзере скомпенсировать это изменение 

невозможно. 

В дорогих микшерах используются параметрические эквалай-

зеры, позволяющие независимо регулировать и центральную час-

тоту, и добротность (полосу пропускания). 

Для поиска частоты эквализации есть смысл усиливать сигнал, 

тогда станут заметны изъяны звука на этой частоте. Для дости-

жения тонального баланса целесообразно применять не усиление 

частот того сигнала, который вы хотите выделить (что может вы-

звать его искажение), а наоборот, подавление частот остальных 

сигналов. 

После эквалайзера (а в некоторых микшерах и до него) сигнал 

поступает на разрыв и затем на фейдер канала. 

Разрыв (Insert) представляет собой гнездо разъема типа "стерео-

джек" с несколько необычно скоммутированными контактными 

группами. Если в гнездо не вставлена ответная часть разъема, то 

сигнал проходит с выхода эквалайзера на вход фейдера. Однако 

если ответная часть разъема вставлена в гнездо, то цепь действи-

тельно оказывается разорванной. Вместо нее по подключенному 

к ответной части разъема кабелю с двумя сигнальными провод-

никами сигнал с выхода эквалайзера сначала попадает на вход 

внешнего устройства обработки, например, ревербератора (дан-

ная линия называется посылом), а затем возвращается в микшер 

по линии, которая называется возвратом. Именно за счет нали-

чия гнезда разъема Insert, посыла и возврата каждый канал мож-

но обработать эффектами независимо от других каналов. 

После разъема Insert (либо после эквалайзера) сигнал поступа-

ет на фейдер канала, предназначенный для оперативного регули-

рования уровня канального сигнала. В недорогих микшерах дан-

ный регулятор управляется вращающейся ручкой. Но более 

удобна слайдерная (движковая) конструкция фейдера. Положе-

ние канальных фейдеров друг относительно друга создает общее 

представление о соотношении уровней сигналов в каналах. Фейдер 

обычно имеет маркировку его оптимального положения (0 дБ). 

Для повышения уровня оставлен некоторый запас (10—15 дБ),  
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но в основном предусматривается его уменьшение. Когда фейдер 

находится в положении – , сигнал максимально ослаблен. 

После фейдера в схеме пульта расположен регулятор панора-

мы (PAN), определяющий баланс сигнала между левым и правым 

выходами. Обычно регулятор панорамы является источником 

сигнала для главного стереовыхода. 

Префейдерные посылы используются для организации мони-

торинга. Сигнал снимается до того, как он пройдет фейдер кана-

ла, поэтому уровень отбираемого сигнала не зависит от положе-

ния фейдера канала. Это удобно с той точки зрения, что 

мониторный микс для артистов, находящихся на сцене (или для 

исполнителя и звукооператора), и звук в зрительном зале (или на 

входе записывающего устройства) становятся независимыми. 

Однако при необходимости корректировок приходится манипу-

лировать и фейдером канала, и префейдерными ручками AUX. 

Постфейдерный посыл (сигнал, снимаемый после фейдера ка-

нала) используется для эффектов. Пропорции между уровнем сиг-

нала, подаваемого на внешние приборы обработки звука, и уров-

нем сигнала в канале при этом сохраняются. 

Как правило, микшеры позволяют подключать шины AUX как 

до, так и после фейдера. Делается это с помощью специального 

переключателя или перемычки. 

Шины. Подключение эффектов  

В ряде моделей микшеров имеются коммутаторы, которые 

определяют маршрут дальнейшего прохождения сигнала и на-

правляют его на различные выходные шины. 

Кроме основных шин, в микшере есть дополнительные шины 

AUX, позволяющие организовать мониторинг (озвучивание всей 

сцены или подачу миксов на индивидуальные мониторные сис-

темы, например, в наушники исполнителей) и подключить до-

полнительные приборы обработки. Любая шина AUX является 

общей для всех каналов — сигналы направляются на один и тот 

же прибор, где они обрабатываются. 

Для последовательного подключения эффекта, действующего 

только на один канал, служит разрыв (Insert). 
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Последовательные эффекты или обработки заменяют исход-

ный сигнал собственным. Такими эффектами могут быть, напри-

мер, хорус, флэнжер, а обработками — эквалайзер, гейт, ком-

прессор. Последовательные эффекты включаются в разрыв в тех 

случаях, когда нужно обработать ими сигнал только одного кана-

ла. Для одновременной обработки эффектом нескольких источ-

ников можно подключать их через шины AUX. Необработанный 

звук при этом можно получить путем регулировки баланса или 

глубины эффекта на самом приборе обработки. 

Параллельные эффекты не заменяют исходный сигнал собст-

венным, а лишь добавляют к исходному сигналу его обработан-

ный вариант. Параллельные эффекты подключают через шины 

AUX, причем эффект оказывается доступным для всех каналов  

и для каждого из них можно установить свою глубину эффекта. 

После обработки эффектом параллельного действия сигнал воз-

вращается на основную шину микшера, где смешивается с ос-

тальными сигналами. В результате в общем миксе присутствуют 

и исходный сигнал, и обработанный. 

Степень обработки эффектом сигнала того или иного канала 

устанавливают регулятором уровня посыла.  

Обычно у эффектов имеется регулятор Dry/Wet. Он может на-

зываться и по-другому, но его суть от этого не меняется — это 

отношение исходного и обработанного сигналов на выходе эф-

фекта. Желательно, чтобы на выходе эффекта, подключенного  

к шине AUX, был только обработанный сигнал. В противном 

случае исходный сигнал вернется в общий микс, где смешается  

с таким же сигналом с выхода аудиотрека. Понятно, что за счет 

сложения двух одинаковых сигналов увеличится их общая гром-

кость. Это в лучшем случае. А в худшем вы получите совершен-

но непрогнозируемый результат за счет того, что фаза необрабо-

танного сигнала на выходе эффекта в принципе может отличаться 

от фазы этого же сигнала на выходе аудиотрека. 

Если эффектом требуется обработать только один канал, то 

эффект можно включить в разрыв (Insert) и добиться требуемого 

соотношения между обработанным и необработанным сигналами 

регулировкой Dry/Wet. 
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Мастер-модуль 

В мастер-модуле микшера сосредоточены регуляторы уровня 

левого и правого каналов, регулятор панорамы стереомикса, из-

меритель уровня сигнала на выходе микшера. Здесь же, как пра-

вило, находится и регулятор уровня микса, поступающего на тот 

выход микшера, к которому подключены контрольные мониторы 

или наушники. 

Разумеется, от модели к модели микшера состав элементов 

коммутации и управления варьируется. Микшеры отличаются 

количеством каналов (и моно, и стерео), но рассмотренные эле-

менты, как правило, есть во всех микшерах. 

Практически все MIDI- и аудиоредакторы содержат виртуаль-

ные микшеры, более или менее успешно имитирующие своих 

железных собратьев. Ко многим звуковым картам прилагаются 

драйверы, по существу являющиеся специализированными вир-

туальными микшерами.  

Автоматизация 

Наиболее совершенные (как правило, цифровые) аппаратные 

микшеры (и все микшеры виртуальные) обладают функцией  

автоматизации. Поддержка микшером автоматизации означает, 

что оператор может заранее записать, отредактировать и затем 

автоматически воспроизвести все свои манипуляции с элемента-

ми управления микшера. Перемещения регуляторов, рукояток, 

слайдеров и изменения состояний переключателей, имеющихся 

на панели микшера, преобразуются в нестандартные MIDI-сооб-

щения (данные автоматизации), которые, в свою очередь, запоми-

наются в устройстве, подобном секвенсору. В нужное время 

включается воспроизведение автоматизации, данные из секвен-

сора поступают на соответствующие исполнительные элементы 

(электронные или механические). Оператор отдыхает, а невиди-

мые руки вращают рукоятки и передвигают слайдеры. 

Автоматизированный микшер превращается и в мощнейший 

инструмент создания сложных сценариев развития событий во 

время живого выступления, и в средство динамического управ-

ления параметрами мультитрековой композиции при ее сведении. 
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Автоматизированными могут быть не только микшеры, но и са-

мые разные приборы обработки звука, устройства для создания 

звуковых и световых эффектов и т. п. 

Развитые музыкальные и звуковые редакторы, к которым отно-

сятся Cakewalk SONAR и Adobe Audition, имеют в своем составе 

автоматизируемые виртуальные микшеры. Кроме того, посредст-

вом автоматизации можно управлять и параметрами эффектов 

реального времени виртуальных инструментов. 

В виртуальных студиях для хранения данных автоматизации 

используются специальные сообщения, которые описывают поло-

жение узловых точек, формирующих огибающие автоматизации. 

Огибающие автоматизации — квазинепрерывные графики (выгля-

дят как непрерывная линия, хотя, на самом деле, сообщения запи-

сываются и воспроизводятся в дискретные моменты секвенсорного 

времени), описывающие поведение того или иного автоматизи-

руемого параметра во времени. Огибающие автоматизации обра-

зуются путем линейной интерполяции значений автоматизируемо-

го параметра в узловых точках. 

В книге «Музыкальный компьютер для начинающих» [30] мы 

рассмотрели несколько вариантов структуры домашней компью-

терной студии. В любом случае ее центром является компьютер, 

оснащенный звуковой картой или внешним звуковым модулем,  

а также виртуальной студией. Кроме этих элементов желательно 

иметь MIDI-клавиатуру для поочередной записи в реальном вре-

мени музыкальных партий. Не обойтись без наушников или мо-

ниторных колонок — нужно же слышать, что вы записываете  

и редактируете. Для записи вокала и партий в исполнении аку-

стических музыкальных инструментов требуется микрофон. 

Микшер при домашней звукозаписи не является необходимым 

элементом. Ведь условия домашней студии все равно не позво-

ляют организовать одновременную многомикрофонную запись 

нескольких исполнителей.  

Итак, мы завершаем главу, в которой кратко рассмотрели наи-

более существенные элементы аудиомузыкальных технологий из 

тех, что задействованы в программах, с которыми вы познакоми-

тесь в следующих главах. Это позволит не отвлекаться на неод-

нократное разъяснение смысла терминов и технических решений. 



 

 

Возможности программ, 
предназначенных  
для обработки звука 

В этой обзорной главе мы познакомим вас с несколькими наи-

более интересными компьютерными программами, имеющими 

прямое отношение к обработке звука. Они принадлежат к раз-

личным классам программ, поэтому отличаются выполняемыми 

функциями, и естественно, их возможности неравноценны и по-

рой несравнимы. 

В первую очередь следует упомянуть о виртуальных студиях, 

которые обязательно содержат компоненты, предназначенные 

для работы с аудиоматериалом (не менее важной составляющей 

любой виртуальной студии является подсистема записи и редак-

тирования MIDI-композиций). С возможностями виртуальных 

студий Steinberg Cubase, Image Line FL Studio, Propellerhead Rea-

son и Cockos REAPER мы познакомили читателей в книге "Му-

зыкальный компьютер для начинающих" [30] и сейчас не станем 

повторяться. Работу со звуковыми данными в виртуальной сту-

дии Cakewalk SONAR Producer Edition мы рассмотрим в гл. 4. 

Виртуальные студии способны на многое, но, тем не менее, су-

ществуют и программы, специально предназначенные для записи  
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и обработки звука — звуковые редакторы. С двумя из них — Sony 

Sound Forge и Audacity — мы познакомим вас в этой главе. В гл. 3 

мы рассмотрим те средства звукового редактора Adobe Audition, 

которые понадобятся для обработки вокальной партии в ходе соз-

дания песни. 

Вычислительная техника и математические методы обработки 

звука постоянно совершенствуются. Это создает условия для раз-

вития потребностей компьютерных музыкантов. Уже давно воз-

можности виртуальных студий и звуковых редакторов в основ-

ном расширяются не путем бесконечной переработки их базовых 

средств, а за счет создания все новых и новых подключаемых 

модулей — плагинов. К настоящему моменту их накопилось 

столько, что одна из проблем, с которой обязательно столкнется 

новичок, — как бы не утонуть в море плагинов. Дело в том, что 

ряд крупных фирм кроме самих плагинов создали специальные 

пакеты средств, позволяющих программистам даже среднего 

уровня разрабатывать собственные плагины [144]. Фактически 

при этом в различных сочетаниях комбинируются стандартные 

готовые блоки, реализующие те или иные функции. Причем ясно, 

что по законам конкурентной борьбы в такие конструкторы их 

"прародителями" заложены не самые эффективные алгоритмы. 

Это вызвало появление тысяч и тысяч плагинов посредственного 

качества, отличающихся в основном графическим оформлением 

интерфейса. Но, к счастью, и оригинальных плагинов, с высокой 

точностью обрабатывающих звуковые данные, не так уж и мало. 

С некоторыми из них мы познакомим вас в этой главе. 

Одна из наиболее сложных для решения в домашней студии 

задач — запись вокала. В следующих главах мы подробно рас-

смотрим этот вопрос, а в этой главе познакомим вас с програм-

мами, способными гармонизировать вокальную партию.  

Еще труднее записать партии в исполнении традиционных му-

зыкальных инструментов. Ведь в жилой комнате обычной квар-

тиры невозможно обеспечить студийные акустические условия. 

Пожалуй, единственной не выходящей за грани реальности зада-

чей можно считать запись гитары. Но и тут без помощи компью-

тера все равно не обойтись. К счастью, есть специальные аппа-
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ратно-программные комплексы, об одном из которых (Fender G–

DEC 3) мы также расскажем. 

Что ж, приступим. 

2.1. Звуковые редакторы 

К звуковым редакторам мы относим программы, предназна-

ченные для выполнения комплекса операций: 

 запись звука; 

 редактирование аудиоданных, представленных в цифровой 

форме (включая монтаж, микширование, шумоподавление, ди-

намическую обработку, фильтрацию, обработку эффектами); 

 сведение отдельных аудиофайлов в стереофоническую или 

многоканальную фонограмму; 

 мастеринг; 

 запись альбома на диск (прожиг). 

Насчитывается несколько десятков программ, которые в со-

стоянии справиться со всеми перечисленными операциями или 

хотя бы с большей их частью. Но не каждая программа делает 

это с высоким качеством, не все они работают надежно, не у вся-

кой программы удобный интерфейс. Развитие музыкальных при-

ложений различными фирмами — состязание не менее увлека-

тельное, чем футбол. Только конкурирующие команды состоят 

не из полевых игроков и тренеров, а из математиков, программи-

стов, музыкантов и звукорежиссеров. Как в любом соревновании, 

здесь есть свои лидеры. Если говорить о тройке сильнейших, то 

это без сомнения Steinberg WaveLab, Adobe Audition и Sony 

Sound Forge. 

На время подготовки рукописи книги программа Steinberg 

WaveLab (http://www.steinberg.net/en/) существует в двух моди-

фикациях: профессиональная программа WaveLab 7 (стоимость 

749 долл.) и облегченная версия WaveLab Elements 7 (стоимость 

99 долл.). Профессиональная версия программы в силу ее высо-

кой стоимости и сложности приобретения в нашей стране в ос-

новном используется в коммерческих студиях. Облегченная вер-

сия не получила распространения из-за того, что по своим 
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возможностям существенно уступает даже некоторым бесплат-

ным программам. Триал-версия (с ограниченным сроком функ-

ционирования) доступна лишь зарегистрированным владельцам 

лицензионной программы предыдущей версии. Ко всему прочему 

не только по современной версии, но и по давнишним версиям 

WaveLab отсутствует русскоязычная литература. Поэтому мы не 

можем рекомендовать эту программу начинающим компьютер-

ным музыкантам. 

Звуковому редактору Steinberg WaveLab ни чем не уступает  

(а кое в чем и превосходит его) программа Adobe Audition. В ча-

стности, так же как и в Steinberg WaveLab, в ней можно создавать 

и сводить мультитрековые проекты. В Интернете имеется русскоя-

зычная страница http://www.adobe.com/ru/, на которой доступна 

демоверсия программы. Там же приведен обширный список рос-

сийских фирм, представляющих продукты Adobe. Стоимость про-

граммы составляет 247 долл. 

Интерфейс программы логичен и интуитивно понятен. Рабо-

тает она устойчиво. На русском языке издано несколько книг  

(в частности, есть наши книги [8, 10, 12, 15, 29] и статьи [43, 123, 

139, 152, 162]), в которых описана работа с программой. Поэтому 

именно эту программу мы выбрали для решения задачи обработ-

ки звука в ходе записи вокальной партии. Ее базовые возможно-

сти описаны в гл. 3.  

Сейчас мы предлагаем вам материал обзорного характера, 

прочитав который вы сможете составить общее представление  

о третьем "марафонце" — звуковом редакторе Sony Sound Forge. 

2.1.1. Sony Sound Forge  

Программа Sound Forge включает в себя весь набор средств, 

необходимых для выполнения профессиональной цифровой зву-

козаписи, что позволяет превратить "сырой" аудиоматериал  

в завершенный аудиодиск. Используя этот набор, вы можете бы-

стро и качественно создавать и редактировать не только стерео-

фонические, но и многоканальные звуковые файлы. В программе 

предусмотрены эффективные средства для анализа, записи и ре-
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дактирования звука; перевода в цифровую форму и реставрации 

старых фонограмм; моделирования акустических свойств окружаю-

щей среды; проектирования звука для мультимедиаприложений; 

подготовки диска к тиражированию.  

Для Sound Forge характерны высокие качество, скорость вы-

полнения и точность алгоритмов обработки звука. Программа 

имеет удобный пользовательский интерфейс с доступом почти ко 

всем функциям через настраиваемые панели инструментов, каче-

ственное графическое представление волновой формы (сигнало-

граммы) в процессе редактирования и воспроизведения. 

Sound Forge позволяет работать по недеструктивной техноло-

гии, при которой все операции проводятся с копиями файлов, что 

исключает возможность случайного повреждения оригинала. 

Программа предоставляет мощные средства для реставрации  

и очистки фонограмм от нежелательных шумов, щелчков, фона 

переменного тока. 

Sound Forge позволяет проводить спектральный анализ звука, 

показывая спектральную картину всего файла или выделенного 

участка. Дает возможность отслеживать изменение спектра звука 

при воспроизведении. Спектр сигнала может быть представлен  

в виде обычной амплитудно-частотной спектральной функции, не-

скольких одновременно отображаемых слоев (мгновенных спек-

тров, привязанных к шкале времени) или цветного графика — со-

нограммы. Sound Forge обеспечивает редактирование сэмплов, 

которые можно использовать затем в сэмплерах. Программа по-

зволяет открывать видеоролики, добавлять и редактировать зву-

ковую дорожку, синхронизировать звук с изображением.  

В Sound Forge предусмотрены все необходимые программные 

средства для записи звука с любых источников. Кроме "ручного" 

управления записью можно применять различные режимы авто-

матической записи. Например, можно заранее задать дату и вре-

мя начала/завершения сеанса записи, либо перевести программу 

в режим ожидания — запись автоматически начнется, когда поя-

вится аудиосигнал, и прекратится, когда сигнал пропадет. 

Стереофонические и многоканальные аудиофайлы можно ре-

дактировать с высокой точностью (рис. 2.1).  
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Рис. 2.1. Нетрудно "перерисовать" отдельные звуковые отсчеты 

При редактировании используются знакомые пользователям 

Windows операции вырезания, копирования и вставки звуковых 

данных. Для удобного переноса данных между каналами и фай-

лами в программе реализована технология Drag and Drop (пере-

таскивание).  

Sound Forge поддерживает представление звуковых данных  

с разрешением до 24 бит с фиксированной запятой и до 32/64 бит 

с плавающей запятой при частоте сэмплирования до 192 кГц, что 

обеспечивает чрезвычайно высокую верность воспроизведения 

оцифрованного звука.  

В программу встроен мощный и гибкий виртуальный эффект-

процессор. В вашем распоряжении больше сорока профессио-

нальных студийных эффектов и обработок, в том числе: норма-

лизация, эквалайзер, дилэй, хорус, универсальная динамическая 

обработка, гейт, изменение высоты тона, флэнжер и вибрато. 

Sound Forge снабжен многополосным компрессором, позволяю-



Возможности программ, предназначенных для обработки звука 89 

щим эффективно влиять на динамический диапазон сигнала  

в определенных частотных полосах. 

Из эффектов можно образовывать цепочку, применять их  

к аудиофайлам или к выделенным фрагментам аудиофайлов путем 

пересчета аудиоданных и в реальном времени при воспроизве-

дении аудиофайла. Sound Forge поддерживает DX- и VST-плагины 

(в том числе, обеспечивает автоматизацию управления парамет-

рами плагинов), что практически безгранично увеличивает число 

доступных аудиоэффектов. Можно преобразовывать сразу несколь-

ко аудиофайлов по однотипному алгоритму любой сложности  

в режиме автоматической пакетной обработки. 

Sound Forge поддерживает множество видеоформатов, обес-

печивает покадровую синхронизацию изображения и звука. Воз-

можен импорт flash-файлов (SWF). 

Sound Forge позволяет загружать и редактировать многока-

нальные WMA-аудиофайлы и экспортировать многоканальные 

аудиофайлы в surround-файлы. 

Приобрести программу или скачать ее свежую демоверсию 

можно на сайте http://www.sonycreativesoftware.com/. 

Sound Forge существует в двух вариантах: профессиональном 

Sound Forge Pro (стоимость 374,95 долл.) и облегченном Sound 

Forge Audio Studio (стоимость 64,95 долл.). 

Кроме моно- и стереозвука можно работать с трехканальным  

и квадрофоническим звуком, а также со звуком surround-

форматов 5.1 (рис. 2.2), 7.1 и вообще с многоканальным звуком 

при числе каналов до 32.  

Обязательное условие — наличие подключения к Интернету 

при инсталляции программы, поскольку не все необходимые 

компоненты есть на диске с дистрибутивом. С вашего разреше-

ния программа автоматически свяжется с нужным ресурсом, за-

грузит и установит все, чего ей не хватает для полного счастья. 

Кроме базового набора операций редактирования программа 

предоставляет много дополнительных функций редактирования 

(например, автоматическое удаление фрагментов тишины в соот-

ветствии с заданными условиями; преобразование разрядности 

представления аудиоданных; устранение постоянной составляю-

щей из аудиосигнала; вставка фрагмента тишины; инвертирова-
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ние аудиосигнала; изменение длительности фонограммы без изме-

нения высоты тона; смена направления воспроизведения аудио-

файла), доступ к которым осуществляется из меню Process. 

Команды, обеспечивающие доступ к встроенным эффектам  

и обработкам Sound Forge, собраны в меню Effects. Здесь есть  

и все традиционные эффекты, и некоторые эффекты, с трудом 

поддающиеся классификации.  

В ревербераторе Sony Acoustic Mirror реализована цифро- 

вая свертка аудиосигнала с импульсной характеристикой. Если  

в Sony Acoustic Mirror загрузить импульсную характеристику оп-

ределенного концертного зала, то после обработки записи, кото-

рая на самом деле сделана в домашней студии, у слушателей поя-

вится впечатление, что она исполняется в этом зале. Если в Sony 

Acoustic Mirror загрузить импульсную характеристику какого-

либо реального ревербератора, то вы получите возможность об-

рабатывать записи этим прибором, не имея его на самом деле.  

 

 

Рис. 2.2. Изюминка программы:  
поддержка многоканального звука  
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В наши дни пользователю доступно бессчетное множество 

эффектов и обработок, реализованных в форме подключаемых 

модулей — плагинов. В Sound Forge предусмотрены средства  

и технологии их применения. Среди них окно Audio Plug-In 

Chainer, предназначенное для создания цепочки плагинов и об-

работки ею аудиофайла (по существу, окно выполняет функцию 

виртуальной рэковой стойки). 

Параметры плагинов можно автоматизировать с помощью 

огибающих (графиков, описывающих закон изменения значения 

параметра во времени, рис. 2.3). В Sound Forge можно автомати-

зировать DX-плагины (удовлетворяющие спецификации DirectX 

не ниже версии 8.0) и VST-плагины. Среди модулей, поставляе-

мых с программой, более полутора десятков автоматизируемых.  

 

 

Рис. 2.3. Автоматизация параметров эффектов в действии  
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Пакетная обработка — это поочередная автоматическая обра-

ботка нескольких аудиофайлов в соответствии со сценарием.  

В Sound Forge пакетная обработка может быть применена для 

конвертирования формата множества аудиофайлов, обработки 

множества файлов цепочками из нескольких плагинов, переиме-

нования полученных файлов, внесения в файлы дополнительной 

информации (метаданных). Пакетная обработка реализуется  

с помощью окна Batch Converter, позволяющего составлять сце-

нарий обработки.  

В программе имеется развитый виртуальный измерительный 

инструментарий.  

Для контроля аппаратуры и экспериментального исследования 

возможностей программы необходимы тестовые сигналы самой 

различной структуры. В Sound Forge встроено несколько генера-

торов тестовых сигналов: генератор звуков тонального набора; 

генератор сигналов с частотной модуляцией; генератор сигналов 

различной структуры, включая шумовые. 

Пользователям Sound Forge доступны такие средства анали- 

за, как: 

 оценка статистических свойств аудиосигнала; 

 количественный анализ параметров сигналограммы и уровня 

записанного аудиосигнала; 

 визуальный анализ стереофонических свойств и моносовмес-

тимости аудиосигнала; 

 качественный и количественный анализ спектра аудиосигнала. 

В окнах Hardware Meters и Channel Meters реализованы из-

мерители уровня практически всех типов, находящих применение 

в студийной аппаратуре. Кроме того, здесь же имеются коррело-

метр и стереогониометр, предназначенные для оценки стереофо-

нических свойств аудиосигнала. 

В окне Spectrum Analysis вы можете анализировать классиче-

ский, текущий, мгновенный и взвешенный спектры аудиосигна-

ла, пользуясь различными алгоритмами и способами отображе-

ния результатов измерений (рис. 2.4). Это, например, позволяет 

выявлять и узкополосные помехи, и малозаметные щелчки с по-

мощью спектрального анализа в обычном режиме и в режиме 

отображения сонограммы (рис. 2.5). 
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Рис. 2.4. Многоканальный анализатор спектра 

 

Рис. 2.5. Сонограмма 

Sound Forge располагает эффективными средствами для рес-

таврации и очистки фонограмм от нежелательных шумов, щелч-

ков, фона переменного тока и т. п. Команды и подменю для дос-

тупа к ним собраны в меню Tools. 
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Как видите, даже простое перечисление основных функций 

программы, дополненное минимальными комментариями, зани-

мает довольно много места. А ведь любое окно, в котором реали-

зована та или иная функция, состоит, как правило, из нескольких 

вкладок. Причем на каждой из них вы увидите не меньше десятка 

элементов, состояние которых существенно влияет на результаты 

редактирования аудиофайла. Для того чтобы программа работала 

эффективно, ее нужно настроить. Так вот, только лишь основные 

установки собраны аж на двенадцати вкладках окна Preferences, 

а общее число элементов, притаившихся здесь, трудно сосчитать! 

Смотреть же на вкладку General этого окна без содрогания и во-

все невозможно: на ней около четырех десятков флажков.  

Даже собственно запись звука можно выполнять четырьмя ме-

тодами в пяти режимах. А кроме традиционных операций дест-

руктивного редактирования (копирование, удаление, вставка, 

микширование и т. п.) в программе в полной мере реализован ме-

тод редактирования недеструктивного, основанный на разметке 

аудиофайла маркерами и регионами с последующим составлени-

ем списков их воспроизведения или "удаления". С некоторыми из 

типов измерителей уровня, эмулированных в программе, вряд ли 

знакомы инженеры даже наиболее крупных отечественных ра-

диостанций (хотя бы по той причине, что такие измерители соот-

ветствуют стандартам Британской вещательной корпорации 

(British Broadcasting Corporation, BBC).  

Программа наукоемка. Многие ее функции основаны на серьез-

ных математических методах или имитируют сложные физические 

процессы и явления. Словом, программа непроста, но она может 

сделать вас всемогущим магом, способным творить со звуком чу-

деса. Нужно лишь в ней как следует разобраться. Если вы реши-

тесь на этот подвиг, то вам поможет наша книга "Sound Forge 9. 

Запись и обработка звука" [25], а также статьи [111, 139, 152, 162]. 

2.1.2. Audacity 

При обработке звука наиболее востребованными функциями 

можно считать следующие: 

 нелинейный монтаж (удаление фрагментов аудиофайлов, их 

перемещение и т. п.); 
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 замена сигнала в паузах тишиной; 

 нормализация; 

 динамическая обработка; 

 фильтрация; 

 шумоподавление, удаление щелчков; 

 применение плагинов (обработок и эффектов, созданных раз-

личными производителями); 

 анализ сигнала во временной и спектральной областях. 

Все эти и многие другие функции имеются в бесплатном зву-

ковом редакторе с открытым исходным кодом, который называ-

ется Audacity. Большинство бесплатных программ выпускаются 

для операционной системы Linux. Достоинство Audacity в том, 

что этот редактор выпускается также для платформ Windows  

и Mac OS X. Имеется поддержка русского языка! Интерфейс очень 

прост и понятен. Дистрибутив занимает всего около 10 Мбайт и 

доступен для скачивания на сайте http://audacity.sourceforge.net.  

На момент написания книги актуальна версия 1.3.12. 

Установка Audacity выполняется без проблем. Если в на-

стройках Windows выбрана страна Россия, то сразу после запуска 

Audacity предложит установить русский язык интерфейса. Одна-

ко некоторые пункты меню все-таки оказываются англоязычны-

ми. Также на момент написания книги руководство пользователя 

Audacity есть только на английском языке. 

При первом запуске Audacity произойдет сканирование дос-

тупных плагинов. Audacity поддерживает плагины формата 

LADSPA (Linux Audio Developer's Simple Plugin API), применяе-

мого на платформе Linux столь же широко, как VST на платфор-

ме Windows. Audacity также поддерживает плагины Nyquist. 

Фактически это текстовые файлы, расширение которых заменено 

с TXT на NY. Такой файл содержит текст программы на специ-

альном языке высокого уровня Nyquist. 

Также программа поддерживает плагины Vamp (http://vamp-

plugins.org), предназначенные исключительно для анализа зву-

ковых данных.  

Все плагины, поставляемые вместе с Audacity, по умолчанию 

размещаются в папке C:\PROGRAM FILES\AUDACITY\PLUG-INS. 
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В Audacity имеется поддержка VST-плагинов. Обычно в при-

ложениях с поддержкой VST можно выбирать каталоги с VST-

плагинами, но с Audacity дело обстоит несколько сложнее. При 

первом запуске Audacity будет сканировать текущую папку  

с плагинами (C:\PROGRAM FILES\AUDACITY\PLUG-INS),  

папку C:\PROGRAM FILES\STEINBERG\VSTPLUGINS, а также 

папки, пути к которым хранятся в системных переменных  

Windows HKEY_CURRENT_USER\Software\VST\VSTPluginsPath и 

HKEY_LOCAL_MACHINE\Software\VST\VSTPluginsPath. Кроме того, 

Audacity будет сканировать папку, путь к которой можно задать  

в переменной окружения VST_PATH. Но начинающим пользовате-

лям компьютера это вряд ли по силам. 

Если у вас установлены VST-плагины, способные функциони-

ровать только с определенным хостом (например, со Steinberg 

Cubase), то могут возникнуть неприятности. Audacity может за-

вершить свою работу с ошибкой. Чтобы избежать этого, можно 

временно (пока планируете работать в Audacity) изменить имя 

папки C:\PROGRAM FILES\STEINBERG\VSTPLUGINS. 

На рис. 2.6 показано главное окно программы. В нем распо-

ложены: 

 главное меню; 

 панели с инструментами и настройками программы; 

 секция дорожек (треков), которая содержит шкалу времени  

и модули дорожек. 

В Audacity нет двух разных режимов (для редактирования 

звуковых данных и для сведения мультитрекового проекта).  

Если в первый раз загрузить аудиофайл командой Файл > Открыть 

главного меню, то он займет первый по счету трек в проекте. 

Если повторно воспользоваться данной командой и загрузить дру-

гой аудиофайл, то откроется новый экземпляр программы, в кото-

ром загруженный файл будет единственным файлом в проекте. 

Для загрузки нескольких файлов в один проект (на разные тре- 

ки) следует пользоваться командой Файл > Импортировать >  

Звуковой файл главного меню. Треки в программе называются 

"дорожками".  
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Рис. 2.6. Главное окно звукового редактора Audiacity 

Добавлять дорожки в текущий проект также можно путем пе-

ретаскивания (Drag and Drop) аудиофайлов средствами Windows 

в главное окно программы. Модуль каждой дорожки визуально 

разделен на две области. Слева располагается заголовок дорожки 

с ее основными характеристиками, а справа — сама дорожка, со-

держащая клипы — отрезки, заполненные звуковыми данными, 

которые могут отображаться в виде сигналограммы или спектра. 

При импорте аудиофайлов каждому файлу соответствует свой 

клип. По умолчанию клипы импортируемых аудиофайлов распо-

лагаются на разных дорожках. Клипы можно перемещать вдоль 

шкалы времени и с одной дорожки на другую. 

Одна из дорожек имеет статус текущей (ее модуль выделен жел-

той рамкой). Чтобы сделать нужную дорожку текущей, щелкните  

в любом ее месте. Некоторые операции (например, разделение кли-

па) выполняются только по отношению к текущей дорожке. 
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Панели инструментов могут располагаться как над секцией 

дорожек, так и под ней (вы можете разместить панели инстру-

ментов, как захотите: в левой части каждой панели имеется поле, 

которое можно захватить мышью и перенести панель). Включать/ 

выключать отображение разных панелей инструментов следует  

с помощью соответствующих команд подменю Вид > Панели 

главного меню программы. На панели управления располагают- 

ся кнопки управления записью и воспроизведением проекта.  

На панели устройств можно выбрать выходной и входной порты 

звукового интерфейса, используемые для воспроизведения и запи-

си звука. На панели микшера можно регулировать уровни воспро-

изводимого и записываемого сигналов, выбирать входы звукового 

интерфейса. На панели индикаторов отображаются уровни вос-

производимого и записываемого сигналов. Название панели выде-

ления говорит само за себя. Панель редактирования содержит на-

бор инструментов для выполнения операций над выделенными 

фрагментами клипов (таких как копирование, вырезание, вставка  

и т. д.) На панели инструментов расположены инструменты выде-

ления, масштабирования, перемещения клипов, редактирования 

амплитудных огибающих клипов и редактирования сигналограм-

мы клипа на уровне отельных звуковых отсчетов. 

К выделенному фрагменту клипа можно применять различные 

эффекты и обработки, выбираемые в подменю Эффекты главного 

меню. Если нет выделенного фрагмента, то эффект будет приме-

нен сразу ко всем звуковым данным проекта. Подменю Эффекты 

включает как встроенные эффекты Audacity (их около 40, в том 

числе фильтрация, динамическая обработка, тремоло, ревербера-

ция, фейзер, вокодер), так и все доступные плагины. 

Командой Файл > Импортировать > MIDI главного меню  

в проект импортируют MIDI-файл. Однако импортированные  

в проект MIDI-данные невозможно редактировать и воспроизво-

дить. Информация о нотах размещается на специальной дорожке. 

Отображаются MIDI-данные в виде отпечатков клавиш. Вы мо-

жете использовать эту информацию исключительно для того, 

чтобы сравнивать расположение звуков своего проекта с распо-

ложением нот. 
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С помощью команд меню Создание можно генерировать раз-

личные звуковые сигналы. Среди них не требующие пояснений 

сигналы Волна, Импульс, Тишина, Тоновые сигналы телефона, 

Шум, а также несколько необычные сигналы: 

 Click Track — клип с сигналом метронома. 

 Pluck — клип с одиночным звуком (щипком) струны заданной 

высоты и длительности. 

 Rissest Drum — клип с одиночным звуком барабана с задан-

ными характеристиками. 

Меню Анализ содержит команды доступа к имеющимся  

в программе средствам анализа свойств аудиосигналов. 

 Контраст — открывает окно Contrast Analysis, позволяющее 

провести специфический тест. Он должен помочь решить: го-

дится некая аудиозапись (например, аудиокнига или аудио-

учебник иностранного языка) для прослушивания или нет. 

Фоновая музыка или шумы (улицы, помещения и т. д.) долж-

ны быть как минимум на 20 дБ тише речи диктора. 

 Построить график спектра — открывает окно Частотный 

анализ, позволяющее не только проанализировать спектр 

сигнала, но и построить график автокорреляционной функции. 

С помощью последней можно, например, выявить наличие 

очень слабого периодического сигнала на фоне сильного шума. 

 Найти перегрузки — функция поиска мест, в которых сиг-

нал, скорее всего, был клиппирован. Результатом работы ал-

горитма поиска будут пометки на дорожке пометок. 

 Beat Finder — функция выявления ритма. Находит в выде-

ленном аудиоматериале всплески громкости и создает соот-

ветствующие пометки. 

 Regular interval labels — создает равномерный ряд пометок. 

 Silence Finder — осуществляет поиск и маркировку пометка-

ми фрагментов с тишиной. Функция может быть полезна при 

реставрации магнитофонных записей или записей с пласти-

нок. После того как вы оцифровали всю ленту/пластинку (за-

писали ее в один аудиоклип), запустите функцию поиска ти-

шины, и она разметит границы дорожек в исходной записи. 

 Sound Finder — поиск и маркировка пометками звуков, когда 

в записи присутствует преимущественно тишина. 
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Несмотря на свою внешнюю простоту, программа позволяет 
выполнять основные операции по обработке звука и поддерживает 
плагины разных форматов. Более того, в Audacity встречаются  
и такие функции, которых нет в коммерческих звуковых редакторах. 

Описание работы с Audiacity вы можете найти в книге [29]  
и в статье [140]. 

2.2. Плагины эффектов и обработок 

Вы уже знаете, что в виртуальных студиях и звуковых редак-
торах предусмотрена возможность расширения функций путем 
подключения к ним дополнительных модулей — плагинов. Пла-
гин — нечто несамостоятельное, некий подключаемый "довесок" 
к программе или устройству, благодаря чему эта программа или 
устройство получает новые возможности. Приложение-хост — 
это та программа, которая позволяет подключать к себе плагины 
(в данной книге в качестве приложения-хоста рассматривается 
Cakewalk SONAR). Взаимодействие хоста с плагином регламен-
тируется интерфейсом прикладного программирования (Application 
Programming Interface, API). В настоящее время наиболее попу-
лярными "музыкальными" API на платформе PC можно считать 
DX и VST.  

DX — технология, обеспечивающая взаимодействие прило-

жений-хостов с виртуальными эффектами и инструментами (син-

тезаторами; сэмплерами; эффектами, управляемыми по MIDI,  

и др.) посредством интерфейса прикладного программирования 

Microsoft DirectX. После установки DX-плагинов в систему они 

становятся доступными из любых приложений, позволяющих 

использовать данную технологию [7, 14].  

В равной степени распространены VST-плагины. VST (Virtual 

Studio Technology) — API фирмы Steinberg. Эта технология из-

начально разрабатывалась для применения в программных про-

дуктах Steinberg [20, 28]. VST-инструменты (VSTi) — это, по 

существу, плагины, управляемые по протоколу MIDI.  
Наиболее мощные по возможностям и качеству звучания (по-

этому и наиболее популярные) плагины поддерживают оба стан-
дарта — и DX, и VST. Поэтому в дальнейшем мы будем говорить 
только о VST-плагинах.  
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В данном разделе мы познакомим вас с двумя постоянно раз-

вивающимися универсальными пакетами плагинов, снискавшими 

мировое признание (Waves и Voxengo). Кроме того, мы расска-

жем о многофункциональном плагине iZotope Ozone, который 

один стоит целого пакета.  

2.2.1. Плагины Waves 

По отзывам многих специалистов, плагины Waves 

(http://www.waves.com/) отличаются высоким качеством преоб-

разования звуковых данных, удобны в работе и содержат много 

интересных пресетов (предварительно заданных схем настроек). 

Полный набор плагинов столь обширен и разнообразен, что по-

зволяет выполнять в процессе редактирования, сведения и масте-

ринга практически все мыслимые операции. Существуют поряд-

ка 40 пакетов (Bundles) Waves, отличающихся стоимостью и 

перечнем входящих в них плагинов. Сделано это для того, чтобы 

удовлетворить потребности пользователей, решающих различные 

задачи. Разброс цены велик: от 87 долл. (пакет Waves GTR Solo 

Bundle) до 6330 долл. (пакет Waves Mercury Bundle). 

Первая проблема, с которой вы столкнетесь после инсталля-

ции плагинов из любого пакета (например, Waves Platinum Native 

Bundle, 2610 долл.), состоит в том, как в них сориентироваться. 

Все-таки больше 100 наименований — это многовато! Но если 

присмотреться к названиям, то можно заметить, что часть из них 

повторяется. Точнее, отдельные названия похожи друг на друга  

и отличаются только наличием дополнительного слова "Mono" 

или сокращения "m/s". Например, MetaFlanger, MetaFlanger Mono 

и MetaFlanger m/s. Это означает, что некоторые из плагинов су-

ществуют не в одном, а в двух или трех вариантах: 

1. Стереофонический плагин, в котором звуковые данные разде-

лены для обработки в двух стереоканалах (в левом L и в пра-

вом R), например, MetaFlanger. 

2. Плагин, в названии которого имеется сокращение "m/s" также, по 

сути, является стереофоническим. Поток звуковых данных в нем 

разделен на два канала: суммарный канал, в котором обрабатыва-

ется сумма сигналов левого и правого стереоканалов (L + R),  
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и разностный, в котором обрабатывается их разность (L – R). 

Сумму сигналов (L + R) называют монофонической компо-

нентой, или средним каналом (обозначается "M", от mid — 

срединный), разность сигналов (L – R) — стереофонической 

компонентой (обозначается "S", от side — сторона). Подобный 

формат представления аудиосигнала применяется в радиове-

щании в целях обеспечения возможности приема стереофони-

ческих программ монофоническими приемниками. В режиме 

Mid/Side обработка звука выполняется отдельно для монофо-

нической и стереофонической компонент, что позволяет полу-

чать эффекты, недостижимые в режиме stereo. Примером та-

кого плагина может служить MetaFlanger m/s. 

3. Монофонический плагин (в названии имеется слово "Mono"). 

В нем стереофонический сигнал перед обработкой преобразу-

ется в монофонический (сигналы левого и правого каналов 

суммируются: L + R), например, MetaFlanger Mono. 

С точки зрения методики применения соответствующие пла-

гины перечисленных трех классов ничем не отличаются друг от 

друга. Поэтому есть смысл ограничиться рассмотрением только 

стереофонических плагинов. "Вычеркнув" плагины классов 

"Mono" и "m/s", мы существенно сократим список. Он станет 

обозримым, т. к. будет насчитывать порядка 50 позиций. Сгруп-

пируем плагины по функциональному признаку.  

Первая группа — измерители и анализаторы: PAZ Analyzer, 

PAZ Frequency, PAZ Meters, PAZ Position. Они предназначены 

для точного анализа и визуального отображения параметров зву-

ковых данных в ходе сведения и мастеринга: 

 PAZ Meters — измеритель уровня; 

 PAZ Frequency — анализатор спектра, совмещенный с изме-

рителем уровня; 

 PAZ Position — объединенный с измерителем уровня дисплей 

стереофонического позиционирования, позволяющий также 

оценивать моносовместимость аудиосигнала; 

 PAZ Analyzer — комплексный анализатор, объединяющий  

в себе функции трех плагинов. 

Чем сложнее функции плагина, тем больше ресурсов компью-

тера он потребляет. Поэтому разработчики рекомендуют выби-
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рать плагин исходя из реальных потребностей: если нужно всего 

лишь измерить уровень сигнала, то ни к чему задействовать мно-

гофункциональный анализатор PAZ Analyzer, достаточно будет  

и PAZ Meters. 

Вторая группа — эквалайзеры: REQ 2 bands, REQ 4 bands, 

REQ 6 bands, Q1 Paragraphic EQ, Q10 Paragraphic EQ, Q2 Para-

graphic EQ, Q3 Paragraphic EQ, Q4 Paragraphic EQ, Q6 Paragraphic 

EQ, Q8 Paragraphic EQ, LinEq Broadband, LinEq Lowband. 

Основой идеологии продукции Waves является обеспечение мак-

симальной гибкости применения плагинов. Именно по этой при-

чине, например, параметрический эквалайзер Renaissance Equa-

lizer представлен в трех вариантах: 

 REQ 2 bands — двухполосный;  

 REQ 4 bands — четырехполосный;  

 REQ 6 bands — шестиполосный. 

Фактически все три плагина построены на основе одного ба-

зового 6-полосного эквалайзера. 

В семейство плагинов Q Paragraphic EQ также входят пара-

метрические эквалайзеры с различным числом полос: от Q1 Para-

graphic EQ (однополосный эквалайзер) до Q10 Paragraphic EQ 

(десятиполосный эквалайзер). 

В пакет входят совершенно уникальные обработки, среди ко-

торых нельзя не выделить плагины LinEq Lowband, LinEq Broad-

band. По сути это многополосные графические эквалайзеры. Од-

нако от плагинов семейства Q Paragraphic EQ эквалайзеры LinEq 

Lowband и LinEq Broadband отличаются очень существенно: они 

не вносят фазовые искажения, т. к. синтезированы на основе 

цифровых фильтров с конечной импульсной характеристикой 

(КИХ-фильтров) [29]. 

Третью группу составляют плагины, реализующие разновид-

ности динамической обработки: 

 RComp — компрессор из набора Renaissance Collection, в ко-

тором имитируются устройства с традиционным составом 

элементов управления; 

 RDeEsser — деэсер из набора Renaissance Collection; 
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 DeEsser — деэсер; 

 C1 comp — компрессор/экспандер; 

 C1 gate — гейт/экспандер; 

 RVox — вокальный компрессор, лимитер, гейт; 

 AudioTrack — эквалайзер, компрессор, гейт; 

 C1 comp-sc — компрессор/экспандер/деэсер с доступом к ка-

налу управления; 

 C1 comp-gate — универсальный процессор динамической об-

работки; 

 C4 — четырехполосный динамический процессор; 

 LinMB — пятиполосный динамический процессор с мини-

мальными фазовыми искажениями; 

 RChannel — четырехполосный динамический процессор из 

набора Renaissance Collection. 

В четвертую группу входят эффекты, основанные на задержке 

сигнала (ревербераторы, дилэи, флэнжеры, фейзеры), а также 

эффекты, в которых производится комплексная модуляция пара-

метров звукового сигналa. 

Эффекты реверберации и дилэя: 

 TrueVerb — ревербератор, обеспечивающий высокую досто-

верность моделирования акустических свойств помещения; 

 RVerb — ревербератор из набора Renaissance Collection;  

 SuperTap 2 – Taps Mod, SuperTap 6 – Taps Mod — многоот-

водные линии задержки (дилэи). 

Кроме того, в группе имеются плагины, реализующие более 

сложные эффекты, связанные с комплексной модуляцией таких 

параметров, как время задержки, амплитуда, фаза, спектр и про-

странственные характеристики стереосигнала: 

 MetaFlanger — флэнжер, фейзер, хорус и преобразователь ши-

рины стереобазы; 

 MondoMod — комплексная амплитудная, частотная и про-

странственная модуляция сигнала; 

 Enigma — эффекты на основе фильтра с модуляцией парамет-

ров и цепи обратной связи. 
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Пятую группу составляют плагины, ориентированные на пре-

образование свойств стереосигнала:  

 S1-MS Matrix — преобразователь стереосигнала в формат 

Mid/Side; 

 S1-Imager — преобразователь стереообраза; 

 S1-Shuffler — преобразователь стереообраза с компенсацией 

сужения стереобазы для низкочастотных звуков. 

В шестую группу входят плагины, предназначенные для сдвига 

высоты тона: UltraPitch Shift, UltraPitch 3 - Voice, UltraPitch 6 - Voice.  

UltraPitch 3 - Voice, UltraPitch 6 - Voice (рис. 2.7) являются 

гармонизаторами с коррекцией формант (в том числе реализован 

эффект "смены пола" вокалиста). Возможно панорамирование  

и задержка (с модуляцией) каждого голоса по отдельности, полу-

чение хоруса. 

Сюда же можно отнести и плагин Doppler, позволяющий ими-

тировать эффект Доплера, одним из внешних проявлений которо-

го является изменение высоты тона.  

 

Рис. 2.7. Панель гармонизатора UltraPitch 6 - Voice  



Глава 2  106 

В седьмую группу входят максимайзеры (максимизирующие 
средний уровень сигнала) и эксайтеры (улучшающие восприятие 
низкочастотных компонентов звука при воспроизведении фоно-
грамм через акустические системы низкого качества): L1 Ultra-
maximizer, L2, MaxxBass, RBass. В эту группу условно можно 
включить также плагин IDR, предназначенный для корректного 
снижения разрядности представления аудиоданных. 

Наконец, последняя, восьмая группа состоит их плагинов, способ-
ствующих устранению различных импульсных, тональных и шумо-
вых помех в аудиосигнале: X-Click, X-Crackle, X-Hum, X-Noise. 

ПРИМЕЧАНИЕ  

Заметим, что названия окон плагинов несколько отличаются от 
тех имен, под которыми плагины фигурируют в списке, доступном 
из программы-хоста. Отыскивать и подключать необходимые пла-
гины предстоит именно по приведенным выше именам. 

В пакет Waves IR360 входит уникальный плагин Waves IR-1 — 
сверточный ревербератор, точно воссоздающий акустическую 
атмосферу помещения на основе его заранее зарегистрированной 
импульсной характеристики. Плагин является специализирован-
ным вычислителем, выполняющим математическую операцию 
свертки обрабатываемого аудиосигнала и импульсной характери-
стики. Его основное отличие от большинства других аналогич-
ных по принципу действия плагинов — способность обрабаты-
вать звуковые данные в многоканальных (surround) форматах. 

Конечно, рассмотреть (даже поверхностно) в рамках краткого 
обзора перечисленные плагины немыслимо. Детальное описание 
полусотни плагинов пакета Waves Platinum Native Bundle 4 вы 
найдете в нашей книге "Профессиональные плагины для SONAR 
и Cubase" [14]. Познакомиться с их основными функциями мож-
но в статьях [66–70, 153, 160]. Отдельная статья [81] посвящена 
сверточному ревербератору Waves IR-1.  

2.2.2. Плагины Voxengo 

Плагины Voxengo (http://www.voxengo.com/) отличаются вы-
соким качеством преобразования аудиосигналов, разнообразием 
реализованных в них эффектов и обработок. Они созданы россий-
ским разработчиком Алексеем Ванеевым и привлекли внимание 
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зарубежных специалистов. Язык интерфейса — английский. На 
панели плагинов вынесено много элементов регулировки, что,  
с одной стороны, позволяет настроить множество параметров для 
ювелирной обработки аудиосигналов, а с другой — затрудняет 
их освоение. В качестве примера на рис. 2.8 представлена панель 
сверточного ревербератора Voxengo Pristine Space.  

 

Рис. 2.8. Панель плагина Voxengo Pristine Space 

По рисунку вы можете судить, сколь сложно это виртуальное 

устройство. Но результаты оно позволяет получить удивитель-

ные. Не случайно владельцы прав на одну из самых известных  

в мире виртуальных студий Cakewalk SONAR включили в нее 
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сверточный ревербератор Perfect Space-Convolution Reverb, прото-

типом которого является именно плагин Voxengo Pristine Space. 

Уж они-то, безусловно, способны отличить хороший продукт от 

плохого, да и выбор у них колоссальный. 

До выхода в свет нашей книги [29] описаний плагинов 

Voxengo на русском языке не существовало.  

На момент подготовки рукописи насчитывается более 40 плаги-

нов и утилит Voxengo. Стоимость одного плагина от 39,95 долл. 

(Voxengo Deconvolver) до 119 долл. (Voxengo Pristine Space). Сре-

ди плагинов есть бесплатные. 

На сайте http://www.voxengo.com/ плагины Voxengo распре-

делены по девяти функциональным группам. 

1. Эквалайзеры. 

2. Ревербераторы. 

3. Трековые плагины. 

4. Компрессоры. 

5. Мастеринговые плагины. 

6. Дилэи, эхо, модуляторы. 

7. Модели гитарных усилителей. 

8. Гармонические "улучшители" (эксайтеры-энхансеры). 

9. Утилиты, шумоподавители, измерители. 

Классификация со временем меняется. В ряде случаев одни  

и те же программы входят в разные группы.  

Конечно, подсчет и распределение плагинов по группам не 

самое главное. Для начала важно составить о них хотя бы об-

щее представление, получить исходную информацию для раз-

мышлений о соответствии того или иного конкретного плагина 

вашим задачам и требованиям. Чтобы охарактеризовать разра-

ботки Алексея Ванеева в целом, поясним смысл всех программ, 

перечисленных в алфавитном порядке (если в скобках после 

названия плагина указано free, это означает, что плагин бес-

платный). 

1. Voxengo Analogflux Suite — набор программ, моделирующих 

искажения, характерные для аналоговых устройств обработки 

звука: TapeBus — магнитофона; Delay, Chorus — ретрореализа-
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ции дилэя, реверберации, хоруса. Кроме того, в набор входят: 

Impulse — простой процессор свертки, позволяющий модели-

ровать различные типы реверберации; Insert — обработка, 

придающая цифровому звуку субъективные свойства звука 

аналогового (так называемую "теплоту"). 

2. Voxengo Beeper (free) — вспомогательный плагин, позволяю-

щий вставлять в демопроект короткие сигналы (гудок, шум, аб-

солютную тишину). Это поможет защитить ваш материал от  

несанкционированного использования. Применение плагина 

безопасно для принципиально важного материала, поскольку он 

никак не влияет на звучание обрабатываемого проекта в про-

межутках между вставляемыми сигналами. Вы можете опреде-

лить продолжительность и громкость сигнала, частоту гудка, 

период между сигналами. Также возможно случайное варьиро-

вание параметров. 

3. Voxengo BMS — плагин, предназначенный для использования 

в процессе сведения и мастеринга композиций в surround-

формате (поддерживаются многоканальные системы вплоть 

до 7.1). BMS — сокращение от bass management system (сис-

тема управления низкими частотами). В плагине реализована 

обработка, позволяющая извлечь низкочастотные компоненты 

аудиосигнала из всех широкополосных каналов (центрально-

го, фронтальных левого и правого, тыловых левого и правого). 

Затем извлеченные сигналы можно смикшировать и сформи-

ровать на их основе сигнал канала низкочастотных эффектов 

(LFE). 

4. Voxengo Boogex (free) — модель гитарного усилителя, позво-

ляющая придать звуку гитары и небольшие мягкие искажения, 

и искажения в стиле heavy metal. Плагин в качестве составного 

элемента содержит сверточный ревербератор, позволяющий 

использовать импульсные характеристики реальных усилите-

лей и акустических систем. Отличительная черта плагина — 

очень малая задержка при обработке сигнала. Например, для 

частоты дискретизации 44,1 кГц она составляет 2,1 мс. 

5. Voxengo Crunchessor — универсальный трековый компрес- 

сор, предназначенный для профессионального редактирования 
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звуковых данных. Одно из преимуществ плагина — простота 

настройки в сочетании с высоким качеством обработки звука. 

Наряду с компрессией в плагине производится обработка, мо-

делирующая ламповую технику. В составе плагина имеется 

несколько универсальных фильтров. Плагин способен вос-

принимать сигналы, поступающие на вход бокового канала 

управления (Side Chain). Предусмотрена поддержка многока-

нальных форматов, а стереофонические аудиофайлы могут 

обрабатываться не только в виде сигналов левого и правого 

каналов, но также как сигналы каналов Mid (монокомпонента) 

и Side (стереокомпонента).  

6. Voxengo CurveEQ — многополосный графический эквалайзер 

с линейной фазочастотной характеристикой (ФЧХ). График 

АЧХ эквалайзера легко редактируется мышью, а сама АЧХ  

аппроксимируется сплайнами. На дисплее одновременно ото-

бражаются спектры исходного, преобразованного сигналов  

и АЧХ эквалайзера. Имеется возможность формировать АЧХ 

фильтра, согласованного со спектром обрабатываемого сигнала.  

Это свойство плагина позволяет применять его для шумоподав-

ления и для подгонки тембра обрабатываемой музыкаль- 

ной композиции под тембр композиции, принятой в качестве 

образца. 

7. Voxengo Deconvolver — не плагин, а самостоятельное приложение, 

обеспечивающее восстановление импульсной характеристи-

ки для сверточных ревербераторов, записанной с помощью 

тестового сигнала неимпульсного характера. Приложение 

также предназначено для преобразования форматов и пара-

метров файлов, в которых хранятся импульсные характе- 

ристики. 

8. Voxengo Elephant — восьмиканальный лимитер, предназна-

ченный для мастеринга. Отличительная особенность — малая 

заметность нежелательных эффектов, характерных для многих 

виртуальных приборов динамической обработки. Кроме того, 

в плагине имеются: подавитель постоянной составляющей, 

анализатор статистических свойств аудиосигнала и блок, реа-

лизующий дитеринг и нойзшейпинг. 
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9. Voxengo EssEQ (free) — семиполосный графический эквалай-

зер, в котором используются цифровые фильтры с конечной 

импульсной характеристикой. За счет этого эквалайзер имеет 

линейную ФЧХ, что положительно сказывается на качестве 

обработки аудиосигнала: звук с насыщенным тембром не ут-

рачивает прозрачность. 

10. Voxengo GlissEQ — пятиполосный параметрический эква-

лайзер, моделирующий аналоговую обработку, совмещенный 

с анализатором спектра. Отличительная особенность — воз-

можность автоматического динамического управления уров-

нем эквализации. Что это означает? В обычном параметриче-

ском эквалайзере, установив, например, на частоте 100 Гц 

усиление на 6 дБ, вы именно это усиление и получите в лю-

бой момент времени. В Voxengo GlissEQ предложен другой 

подход. Установив это же значение, вы не обязательно полу-

чите усиление на 6 дБ. Усиление будет зависеть от характера 

обрабатываемого материала. 

11. Voxengo HarmoniEQ — семиполосный параграфический эк-

валайзер, имеющий простой и интуитивно понятный интер-

фейс. Плагин сочетает обычную эквализацию с алгоритмом 

гармонического энхансера.  

12. Voxengo Impulse Modeler — не плагин, а самостоятельное 

приложение, являющееся средством синтеза импульсных ха-

рактеристик помещений (от малых комнат до больших залов 

любой геометрической формы) в целях дальнейшего их ис-

пользования в сверточных ревербераторах. Для формирова-

ния импульсной характеристики в координатном поле изо-

бражается план помещения (с учетом расположения окон), 

задается отражающая/поглощающая способность материала 

стен, позиционируются источники тестового импульсного 

акустического сигнала и его приемники (микрофоны). После 

этого программа выполняет необходимые вычисления и ге-

нерирует импульсную характеристику, соответствующую за-

данной вами модели помещения. Импульсная характеристика 

сохраняется в файле. 

13. Voxengo Lampthruster — пятиполосный параметрический эк-

валайзер, моделирующий аналоговую обработку. Интерфейс 
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плагина можно переключать из режима графического управ-

ления АЧХ эквалайзера в режим управления с помощью 

вращающихся регуляторов. 

14. Voxengo Latency Delay (free) — плагин для компенсации за-

держки, создаваемой VST-плагинами и VST-инструментами  

в реальном времени, информация о которой не передается 

программе-хосту. Voxengo Latency Delay сам вносит задерж-

ку в 10 000 отсчетов и задерживает аудиосигнал на 10 000 –

 <указанное значение отсчетов>. Программа-хост должна 

поддерживать компенсацию задержки. 

15. Voxengo LF Max Punch — эксайтер низких частот, сочетаю-

щий функции полосового фильтра, компрессора и дистошна. 

Плагин позволяет усилить различимость басов и получить 

ряд низкочастотных эффектов, ассоциирующихся с магнит-

ной лентой. 

16. Voxengo Marquis Compressor — компрессор, который одина-

ково хорошо подходит как для обработки треков, так и для 

мастеринга. В нем реализован особый алгоритм детектирова-

ния сигнала, с помощью которого достигается открытый, яр-

кий звук. 

17. Voxengo MSED (free) — виртуальное кодирующее и декоди-

рующее устройство, позволяющее преобразовывать аудиосиг-

налы левого и правого стереоканалов в пару сигналов среднего 

(Mid, монокомпонента) и бокового (Side, стереокомпонента) 

каналов. Также выполняется обратное преобразование. Каж-

дый сигнал можно инвертировать. Сигнал, представленный  

в форме Mid/Side, затем можно особым образом обрабатывать, 

например, применяя к моно- и стереокомпонентам неодинако-

вые эффекты либо одни и те же эффекты, но с различными 

значениями параметров. 

18. Voxengo OldSkoolVerb (free) — простой ревербератор, пред-

назначенный в основном для обработки материала, не содер-

жащего ярко выраженных перкуссионных звуков. Наиболее 

соответствует задаче имитации расположения музыкальных 

инструментов в помещении с определенной акустической ат-

мосферой.  
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19. Voxengo Overtone GEQ (free) — семиполосный графический 

эквалайзер с поддержкой многоканальности (вплоть до 8 кана-

лов ввода/вывода, в зависимости от возможностей программы-

хоста). В плагине реализованы расширенные возможности 

внутренней маршрутизации каналов. До эквализации применя-

ется дополнительная обработка гармоник (используется семь 

модулей обработки гармоник на каждую полосу эквалайзера). 

В итоге получается сложная гармоническая окраска звука.  

20. Voxengo PHA-979 — фазовращатель с линейной ФЧХ.  

Позволяет компенсировать относительные фазовые сдвиги  

в сигналах, записанных от одного источника посредством не-

скольких микрофонов, корректировать стереополе (в частности, 

для устранения мононесовместимости сигнала, образовавшейся 

в результате его обработки различными расширителями сте-

реобазы). 

21. Voxengo Polysquasher — мастеринговый компрессор, отли-

чающийся тем, что сохраняет прозрачность звука. 

22. Voxengo Pristine Space — процессор свертки с 8 независи-

мыми каналами обработки. Позволяет реализовать высоко-

качественную реверберацию. Совместим с Voxengo Impulse 

Modeler. 

23. Voxengo r8brain (free) — не плагин, а самостоятельное при-

ложение, предназначенное для преобразования частоты дис-

кретизации. 

24. Voxengo r8brain PRO — не плагин, а самостоятельное прило-

жение, предназначенное для профессионального преобразо-

вания частоты дискретизации. Высокое качество обеспечива-

ется за счет промежуточного преобразования к наименьшей 

общей кратной частоте дискретизации. Возможна организа-

ция пакетного преобразования. Приложение поддерживает 

много форматов аудиофайлов (в том числе многоканальные) 

и все стандартные частоты дискретизации. 

25. Voxengo Recorder (free) — плагин, предназначенный для запи-

си сигнала с выхода канала или шины в аудиофайл.  

26. Voxengo Redunoise — система шумоподавления с высоким 

разрешением и возможностью детальной настройки большо-
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го числа параметров. Эффективна в отношении широкопо-

лосного шума. 

27. Voxengo Soniformer — мастеринговый многополосный ком-

прессор/экспандер с графическим управлением, позволяю-

щий получить нужный спектральный баланс. 

28. Voxengo Sound Delay (free) — многоканальный плагин для 

задержки звука. Задержку можно определять в миллисекун-

дах или в сэмплах с высоким уровнем точности. Плагин реа-

лизует только основную функцию линии задержки: формиро-

вание однократно задержанного аудиосигнала (без обратной 

связи или модуляции). Также возможны внутреннее кодиро-

вание/декодирование Mid/Side и независимая задержка сиг-

налов в каналах Mid и Side. 

29. Voxengo SPAN (free) — анализатор спектра на основе БПФ. 

Работает в реальном времени. Представляет собой существен-

но упрощенный вариант профессиональных плагинов Voxengo 

GlissEQ и Voxengo CurveEQ, который, однако, обладает не 

меньшими, чем эти плагины, возможностями для выполнения 

своей главной задачи — спектрального агнализа. 

30. Voxengo Stereo Touch (free) — предназначен для преобразо-

вания монофонического аудиосигнала в псевдостереофони-

ческий посредством кодирования/декодирования Mid/Side. 

Основан на классических алгоритмах создания стереоэффек-

та за счет применения задержки и фильтрации. Плагином 

можно обрабатывать и стереосигнал. Но следует учитывать, 

что при этом сигналы обоих каналов обрабатываются неза- 

висимо друг от друга как моносигналы, а потом два полу-

чившихся стересигнала смешиваются в один. Разработчик 

рекомендует использовать плагин для обработки звука аку-

стической гитары, электрогитары с овердрайвом, синтезатор-

ных подкладов. 

31. Voxengo Tempo Delay (free) — модуль задержки, величина 

которой связана с темпом проекта. Дополнительно имеются 

эквалайзер и секция эффекта тремоло. Фактически в плагине 

реализованы две линии задержки, поэтому вместо одного 

общего регулятора времени задержки предусмотрены два: 

Delay и Length. Они позволяют независимо выбирать величи-
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ну двух интервалов: между исходным сигналом и его первой 

задержанной копией; между повторами сигнала.  

32. Voxengo TransGainer — в плагине реализован алгоритм 

управления огибающей аудиосигнала, который воздействует 

не на уровень сигнала, а на характер переходного процесса, 

соответствующего изменению уровня. Это позволяет раз-

дельно регулировать громкость звука в фазе атаки и под-

держки. Данную обработку можно использовать вместо гейта 

и экспандера для реставрации зашумленных фонограмм и 

уменьшения длительности хвоста реверберации.  

33. Voxengo Transmodder — группа частотных фильтров с дина-

мическим управлением параметрами. Управляющий сигнал 

вырабатывается анализатором переходного процесса. Плагин 

воздействует на звук в фазе атаки. Дает хорошие результаты 

при работе с ударными, гитарой и басом. 

34. Voxengo Tube Amp (free) — в плагине моделируется несим-

метричное ограничение, присущее предварительному усили-

телю, схема которого собрана на электронной лампе (трио-

де). Звук, получаемый в результате обработки этим плагином, 

можно варьировать от умеренного теплого овердрайва до 

грубых искажений. Помимо этого в плагине имеется ФНЧ  

с крутизной спада АЧХ –6 дБ/октава, встроенный в модель 

лампы и способный имитировать работу низкокачественного 

усилителя. 

35. Voxengo VariSaturator — основное назначение плагина за-

ключается в реализации эффекта насыщения, характерного 

для ламповых схем. Но его функциональные возможности 

шире, т. к. моделируются два механизма возникновения на-

сыщения: в каскаде высококачественного лампового усили-

теля и в цифровой схеме. Моделируемые модули включены 

последовательно. Плагин можно использовать для увеличе-

ния громкости аудиосигнала без увеличения значений его 

пиковых уровней. Он позволяет придать звуку тонкую гар-

моническую окраску, что делает обработанные партии му-

зыкальных инструментов более заметными и привлекатель-

ными. 
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36. Voxengo Vintage Modulator — плагин реализует основанные 

на модуляции эффекты, характерные для раритетных эффект-

поцессоров. На каждый из каналов, образующих стереопару, 

приходится по 4 операторных модуля, что позволяет, напри-

мер, получить убедительно звучащий хорус. Доступны эф-

фекты флэнжер и фейзер (впечатление от фейзера разработчик 

характеризует как "ошеломляющее"). Особенностью плагина 

также является возможность формирования модулированного 

сигнала, опережающего во времени необработанный сигнал. 

Это способствует получению большого разнообразия тем-

бров за счет микширования таких сигналов в различных про-

порциях. 

37. Voxengo Voxformer — многофункциональный процессор об-

работки вокала. Содержит: два простых в управлении во-

кальных компрессора; гейт; специальный модуль "насыще-

ния"; фильтр присутствия; деэсер с переключаемыми 

центральной частотой и порогом срабатывания.  

38. Voxengo Warmifier — плагин, моделирующий обработку зву-

ка в ламповых устройствах. Позволяет придать звуку харак-

терную теплоту. 

Теперь вы знакомы с перечнем существующих плагинов  

Voxengo и знаете, для решения каких задач предназначен каждый 

из них. В книге [29] вы можете найти подробное описание 17 

наиболее интересных на наш взгляд плагинов Voxengo. Основные 

возможности нескольких плагинов Voxengo рассмотрены в статьях 

[83, 84, 142]. 

2.2.3. iZotope Ozone 

Американская компания iZotope, Inc. (http://www.izotope.com) 

выпускает несколько программных продуктов и является вла-

дельцем множества различных технологий, на которые другие 

компании приобретают лицензии и используют эти технологии  

в своих продуктах. Одна из наиболее известных разработок 

iZotope — плагин Ozone, предназначенный для выполнения мас-

теринга (стоимость 224 долл.). В iZotope Ozone реализовано 

множество высококачественных алгоритмов обработки сигнала. 
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Начиная с самой первой версии в Ozone используется 64-

битное внутреннее представление звуковых отсчетов. Это исклю-

чает накопление погрешностей из-за многократных обработок  

и округлений сигнала.  

В плагине имеется шесть модулей-обработок: 

 PARAGRAPHIC EQUALIZER — совмещенный с анализато-

ром спектра параграфический эквалайзер, обладающий функ-

цией "подгона" спектра вашей фонограммы под спектр образ-

цовой; 

 MULTIBAND HARMONIC EXCITER — многополосный 

эксайтер; 

 MULTIBAND DINAMICS — многополосная динамическая 

обработка; 

 MULTIBAND STEREO IMAGING — многополосный про-

цессор стереофонического образа; 

 MASTERING REVERB — мастеринговый ревербератор; 

 LOUDNESS MAXIMIZER — психоакустический инструмент 

для повышения громкости. 

Порядок, в котором сигнал проходит через модули, задается 

пользователем. Ненужные модули могут быть отключены.  

Все модули Ozone что называется "приспособлены" друг  

к другу. Это позволяет избежать нежелательных эффектов, обычно 

возникающих при использовании цепочек из нескольких разных 

плагинов (когда у разных многополосных плагинов не совпадают 

частоты кроссоверов и т. п.).  

Каждому модулю на панели плагина соответствует по три 

элемента: 

 большая круглая кнопка, с помощью которой выбирается 

вкладка с параметрами модуля; 

 Active — переключатель активности модуля; если он вклю-

чен, то сигнал обрабатывается модулем, если выключен — 

сигнал модулем не обрабатывается (модуль находится в ре-

жиме Bypass); 

 горизонтальный регулятор — степень влияния модуля на об-

рабатываемый сигнал. 
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Рис. 2.9. Менеджер пресетов iZotope Ozone 

С помощью кнопки PRESETS открывается менеджер пресе-

тов (рис. 2.9). При выборе пресета тут же становятся доступными 

его основные регуляторы — макрофейдеры, которые варьируют 

характер звучания пресета в неких пределах. Макрофейдеры мо-

гут иметь интуитивно понятное название (например, Loudness — 

громкость), однако в действительности каждый такой регулятор 

может управлять одновременно множеством параметров несколь-

ких разных модулей. 

Пресеты рассортированы по нескольким папкам: 

 General Purpose Mastering — пресеты общего назначения, 

названия которых соответствуют характеру их звучания (на-

пример,Vinyl Master — мастеринг для виниловой пластинки);  

 Genre-Specific Mastering — пресеты для различных музы-

кальных жанров (Country, Drum&Bass, Electro, Hip-Hop, House, 

Jazz, Pop, Raggae и др.); 
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 Instruments and Busses — пресеты для использования Ozone 

в качестве обработки треков с партиями различных инстру-

ментов и вокала; 

 Post and Broadcast — пресеты для обработки саундтреков  

к фильмам, радио-, ТВ-передачам, аудиокнигам и т. п. (на-

пример, Dialog - Center — пресет для подчеркивания диалога 

в центре стереопанорамы); 

 Special Effects — пресеты для создания спецэффектов (напри-

мер, Bad Phone — типичное звучание телефона);  

 Utility — пресеты-утилиты для решения конкретных задач 

(например, EQ - 50 Hz Hum — подавитель фона 50 Гц от 

промышленной сети). 

ПРИМЕЧАНИЕ  

Пресетов в Ozone очень много, и они обеспечивают решение прак-
тически всех основных задач, связанных со сведением и мастерин-
гом. Прежде чем пытаться "с нуля" создавать какие-то собственные 
пресеты, настоятельно рекомендуем перепробовать все пресеты, 
которые уже есть. Целесообразно взять за основу какой-либо из за-
водских пресетов и уже путем его осторожной модификации доби-
ваться желаемого звучания. 

Ряд элементов управления являются общими для всех вкладок 

модулей (см. рис. 2.10). К таковым, например, относится кнопка 

Graph, нажатием которой открывается панель со схемой прохожде-

ния сигнала. Каждому модулю на схеме соответствует квадрат. 

Квадраты активных модулей ярко-зеленые, неактивных — темно-

зеленые, полупрозрачные. Кроме модулей обработки сигнала на 

схеме присутствуют квадраты спектроанализатора Spectrum, стерео-

гониометра и коррелометра PhaseMeter, преобразователя стереокана-

лов Chan. Ops.. Последний позволяет преобразовывать стереосигнал  

в моно, менять местами левый и правый стереоканалы, смещать фазу. 

Спектроанализатор совмещен с параграфическим эквалайзером 

(вкладка PARAGRAPHIC EQUALIZER). Cтереогониометр, корре-

лометр и преобразователь стереоканалов фактически располагаются 

на вкладке модуля MULTIBAND STEREO IMAGING. 

С помощью мыши квадраты-модули можно расставлять в про-

извольном порядке, за исключением многополосных модулей. 
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Эти модули можно менять местами только в пределах зоны дей-

ствия кроссовера (Multi-band). Зато саму эту зону тоже можно 

переместить в произвольное место цепи обработки. 

Вкратце познакомимся с модулями плагина. 

Модуль PARAGRAPHIC EQUALIZER 

Параграфический эквалайзер состоит из восьми параметриче-

ских фильтров (рис. 2.10). Каждому фильтру соответствует кру-

жок с номером. Перемещая кружок мышью вверх/вниз, можно 

изменять уcиление/ослабление сигнала на центральной частоте 

или на частоте среза. Перемещая кружок мышью влево/вправо, 

можно изменять центральную частоту или частоту среза. Как  

в графическом редакторе, с помощью мыши можно выделить 

сразу несколько кружков. Выделенные кружки можно переме-

щать все разом. 

 

Рис. 2.10. Параграфический эквалайзер iZotope Ozone 
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Справа и слева вокруг выделенного кружка присутствуют ре-

гуляторы в виде скобок: [ ]. Захватив любой из них мышью и пе-

ремещая его в горизонтальном направлении, можно изменять 

добротность фильтра.  

У модуля PARAGRAPHIC EQUALIZER имеется одна интерес-

ная функция. Заключается она в подгонке спектра вашей фонограм-

мы под спектр образцовой. Сначала нужно дать Ozone "послушать" 

образец фирменной фонограммы, а затем — свою фонограмму.  

После этого программа настроит специальный фильтр Matching та-

ким образом, чтобы спектр вашей фонограммы был похож на спектр 

образцовой. Фильтр Matching представляет собой эквалайзер с ли-

нейной ФЧХ, у которого более 8 000 частотных полос! 

Модуль LOUDNESS MAXIMIZER 

LOUDNESS MAXIMIZER (рис. 12.11) — это максимайзер, 

включающий в себя сразу два прибора: пиковый лимитер с пред-

сказанием и оптимизатор уровня сигнала. По логике, его нужно 

применять последним в цепи обработок. 

 

Рис. 2.11. Модуль LOUDNESS MAXIMIZER 
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Регулятор Threshold задает порог срабатывания лимитера. Ре-

гулятор Margin задает уровень, к которому должен стремиться 

сигнал. Между этими регуляторами расположена гистограмма 

распределения уровней аудиосигнала. 

Кнопкой-переключателем Mode выбирается алгоритм работы 

лимитера. 

ПРИМЕЧАНИЕ  

Справа от элементов настройки максимайзера расположены эле-
менты настройки алгоритмов финальной обработки звукового сиг-
нала (мастеринга), которые фактически не относятся ни к одному 
из модулей. Мы понимаем, что мастеринг фонограмм для начи-
нающего компьютерного музыканта — слишком сложная задача, 
поэтому в данной книге не касаемся его. Теория и инструментарий 
мастеринга описаны в книге [29]. 

Модуль MASTERING REVERB 

Мастеринговый ревербератор нужен для того, чтобы немнож-

ко "размочить" слишком сухой микс (с недостаточным количест-

вом реверберации), сделать его более воздушным и объемным. 

То есть в данном случае реверберацию следует рассматривать не 

как эффект, а как обработку. Соответственно применяется масте-

ринговая реверберация в очень малых, еле уловимых на слух ко-

личествах. 

В верхней части вкладки MASTERING REVERB (рис. 2.12) 

находится анализатор спектра. На нем можно выделить ту час-

тотную полосу сигнала, которая будет обработана реверберато-

ром. В нашем примере это полоса от 283 Гц до 5,31 кГц. Пере-

ключателем Room/Plate выбирается тип реверберации. Dry — 

уровень исходного сигнала, Wet — уровень обработанного сиг-

нала в общем миксе. Room Size — параметр, связанный с разме-

ром моделируемой комнаты, от которого зависит длительность 

хвоста реверберации, Room Damping — степень поглощения 

звукового сигнала стенами, Pre-delay (ms) — задержка перед 

возникновением реверберационных отражений, Width — пара-

метр, связанный с шириной комнаты, от которого зависит общее 

время реверберации. 

Опция Solo Reverb Signal включает такой режим, при кото-

ром слышен только обработанный ревербератором сигнал. 



Возможности программ, предназначенных для обработки звука 123 

 

Рис. 2.12. Мастеринговый ревербератор iZotope Ozone 

 

Рис. 2.13. Кроссовер iZotope Ozone 

В правой части модуля MASTERING REVERB расположены 

коррелометр (Correlation) и стереогониометр (Phase). 

В модулях MULTIBAND HARMONIC EXCITER, MULTIBAND 

DYNAMICS и MULTIBAND STEREO IMAGING, к ознакомле-

нию с которыми мы сейчас перейдем, реализованы многополосные 

обработки. Дело в том, что разные частотные полосы отвечают за 

разные субъективные характеристики звучания фонограммы. Об-

рабатывая частотные полосы раздельно, можно влиять на одни 

характеристики фонограммы, не задевая при этом другие. Неотъ-

емлемой составной частью каждого из них является кроссовер. 
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Кроссовер предназначен для разделения спектра сигнала на раз-

ные частотные полосы. На нем базируются все многополосные 

обработки.  

На всех вкладках, относящихся к многополосной обработке, 

верхняя часть отведена под параметры кроссовера, совмещенного 

с анализатором спектра (рис. 2.13). 

Границы частотных полос можно перемещать мышью. Для 

каждой из частотных полос можно независимо включить режимы 

соло (кнопка s, от solo) и обхода (кнопка b, от bypass). 

Если вы изменяете параметр какого-либо модуля, то он при 

этом получает статус активного. Визуально это выглядит так, 

словно соответствующий регулятор берется в белые квадратные 

скобки: [ ]. Допустим, вы тронули регулятор степени компрессии, 

относящийся к одной из частотной полос. Он получил статус ак-

тивного. На дисплее кроссовера значение этого параметра пред-

ставлено в виде белой горизонтальной линии, которую можно 

перемещать по вертикали. У других частотных полос имеются 

такие же белые линии. С помощью этих линий можно регулиро-

вать такие же параметры, как и тот, что в данный момент являет-

ся активным (в нашем примере это степень компрессии), но уже 

для других частотных полос. 

Модуль MULTIBAND HARMONIC EXCITER 

Модуль MULTIBAND HARMONIC EXCITER — эксайтер. 

Эксайтер представляет собой психоакустическую обработку, 

обогащающую сигнал искусственно сгенерированными ВЧ-

гармониками. Эксайтер позволяет превратить "бубнящий" звук  

в "прозрачный" и "четкий". Параметры многополосного эксайте-

ра показаны на рис. 2.14. Для каждой частотной полосы можно 

регулировать два параметра эксайтера: Amt — уровень гармо-

ник; Mix — отношение уровней обработанного и необработанно-

го сигнала в общем миксе. 

Переключатель Retro/Tape/Tube/Warm (соответственно рет-

ро/магнитная лента/ламповый/теплый) изменяет характер звуча-

ния эксайтера.  
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Рис. 2.14. Многополосный эксайтер iZotope Ozone 

 

Рис. 2.15. Многополосный лимитер/компрессор/экспандер iZotope Ozone 
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Модуль MULTIBAND DYNAMICS 

Модуль MULTIBAND DYNAMICS (рис. 2.15) совмещает  

в себе многополосный лимитер, компрессор и экспандер.  

Регулятором Mix задается процентное соотношение уровней 

обработанного и необработанного сигналов в общем миксе.  

Регулятор Gain задает уровень усиления сигнала. Кнопка-

переключатель Band/Global задает режим работы упомянутых 

регуляторов: относятся ли они только к текущей частотной поло-

се (Band) или к работе модуля в целом (Global). Опция Auto gain 

compensation включает автоматическую регулировку уровня 

сигнала (т. е. регулятор Gain можно установить в нейтральное 

положение и не трогать). 

Правее расположены три пары регуляторов Thres (порог сра-

батывания) и Ratio (коэффициент компрессии/экспандирования). 

Относятся эти пары регуляторов соответственно к лимитеру 

(Lim.), компрессору (Comp.) и экспандеру (Exp.). 

Кнопка-переключатель Attack/Release Settings: Show / Hide 

открывает доступ к дополнительным парам регуляторов: Attack — 

время атаки и Release — время восстановления для лимитера 

(Lim.), компрессора (Comp.) и экспандера (Exp.). 

Правее регуляторов расположена гистограмма распределения 

уровней аудиосигнала. Она позволяет правильно выбрать пороги 

срабатывания компрессора и лимитера. Еще правее расположен 

индикатор степени ослабления сигнала компрессором/лимитером 

(на этот индикатор на рис. 2.15 наведен указатель мыши). Еще 

правее расположена редактируемая амплитудная характеристика 

модуля. Заметим, что все, о чем здесь говорилось ранее, относит-

ся только к текущей частотной полосе. 

Модуль MULTIBAND STEREO IMAGING 

Многополосный процессор стереофонического образа 

MULTIBAND STEREO IMAGING (рис. 2.16) имеет всего по 

две регулировки на каждую частотную полосу: Widening — сте-

пень расширения стереобазы и Delay — задержка между стерео-

каналами. Group all band delays — группировка регуляторов 

Delay. 
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Рис. 2.16. Многополосный процессор стереофонического образа 

В правой части расположены: коррелометр (Correlation),  

стереогониометр (Phase). Они не имеют прямого отношения  

к процессору стереофонического образа и отображают парамет-

ры сигнала в том месте цепи обработки, куда вставлены соответст-

вующие модули. Это же можно сказать и о преобразователе стерео-

каналов. Show Channel Ops. — показать опции преобразователя 

стереоканалов: Mono — преобразовать в моно, Switch L/R — поме-

нять стереоканалы местами, Invert L — инвертировать левый канал 

(т. е. сдвинуть фазу на 180º), Invert R — инвертировать правый 

канал, Rotate phase 90º — сдвинуть фазу на 90º. Преобразователь 

стереоканалов позволяет исправлять совсем уж грубые ошибки, 

когда стереоканалы перепутаны местами или их фазы сильно от-

личаются. 

Итак, мы познакомили вас с возможностями многофункцио-

нального плагина iZotope Ozone. Этих знаний хватит для того, 

чтобы не заблудиться в кажущейся непроходимой чаще его вкла-

док, кнопок и регуляторов. Но от поверхностного знакомства  

с плагином до способности применять на практике его широчай-

шие возможности — дистанция огромного размера. Если у вас 
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возникнет необходимость и желание ее преодолеть, то вашим 

спутником и помощником может стать наша книга "Звукозапись 

на компьютере" [29], адресованная совершенствующимся ком-

пьютерным музыкантам.  

2.3. Помощники гитариста 

Гитара… Признаемся, что и сами мы не равнодушны к ней.  

И понимаем, что гитара — один из наиболее популярных, где-то 

даже культовый инструмент. Одновременно это и одно из наибо-

лее доступных, демократичных средств музицирования: не со-

считать людей, умеющих или мечтающих научиться играть на 

гитаре. 

2.3.1. Виртуальные гитары 

и виртуальные гитаристы 

Компьютерная запись реальной гитары — дело не такое про-

стое, как может показаться на первый взгляд. Здесь есть о чем 

поговорить с заинтересованными людьми. Поэтому несколько 

лет назад мы написали книгу "Музыкальный компьютер для ги-

тариста" [17], в которой обсудили особенности возможных спо-

собов компьютерной записи гитарного аккомпанемента.  

В качестве средства записи реальной гитары мы рассмотрели 

виртуальную портастудию
1
 Cakewalk Guitar Tracks Pro, которая 

представляет собой существенно упрощенный вариант виртуаль-

ной студии Cakewalk SONAR. 

Для тех, кто не умеет играть на гитаре, но очень хочет ис-

пользовать в своих композициях гитарные партии, мы подробно 

описали несколько вариантов решения проблемы. Сейчас эта 

книга уже практически недоступна, поэтому здесь мы повторим 

свои советы, сократив пояснения и комментарии, но дополнив 

информацию с учетом прошедшего времени и происшедших 

событий.  

                                                           
1 Портастудия (сокр. от "портативная студия") — аппаратное или программное 

устройство для многоканальной записи звука.  
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Рис. 2.17. Rhythm'n'Chords 2.3 Pro: записываем последовательность  
аккордов и указываем стиль исполнения 

Первый вариант — воспользоваться MIDI-плагином 

Rhythm'n'Chords 2.3 Pro (разработан в России специалистами 

фирмы MusicLab, Inc., www.musiclab.com). Он замечателен тем, 

что на уровне MIDI-сообщений в деталях моделирует множество 

приемов и нюансов игры на гитаре. Плагин сопровождается биб-

лиотекой стилей, насчитывающей около 1400 ритмических ри-

сунков. Rhythm'n'Chords Pro предназначен для использования со-

вместно с программой Cakewalk SONAR 3.x. В окне плагина для 

особо придирчивых ревнителей точной имитации игры на гитаре 

найдется много элементов регулировки, управляющих различными 

параметрами модели виртуального исполнителя. Но несмотря на 

это на элементарном уровне работать с ним легко: достаточно за-

писать последовательность аккордов, выбирая их в меню, и ука-

зать стиль исполнения (рис. 2.17). Rhythm'n'Chords Pro — MIDI-

плагин, а значит, в нем нет и не может быть собственного набора 

звуков. Играть он будет теми звуками, которые вы сумеете найти.  

ПРИМЕЧАНИЕ  

Недостаток этого MIDI-плагина заключается в том, что он работа-
ет не со всеми виртуальными студиями и даже не со всеми вер-
сиями программы Cakewalk SONAR. Разработчики отказались от 
обновления плагина под очередные версии Cakewalk SONAR. 
Вместо этого они развивают группу VST-инструментов, модели-
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рующих как акустические, так и электрогитары. К настоящему мо-
менту имеется три таких инструмента: MusicLab RealGuitar, 
MusicLab Real Strat и MusicLab RealLPC. Но библиотека стилей, 
созданная для Rhythm'n'Chords, не сгинула бесследно. В виде 
библиотеки MIDI-паттернов она доступна в любом из трех VST-
инструментов, причем ее применение даже упростилось. 

Второй вариант решения проблемы создания гитарной партии 

"негитаристом" — применение VST-инструментов, также моде-

лирующих игру на гитаре, но при этом обладающих собственны-

ми голосами. 

Здесь выбор достаточно широк. В книге [17] мы рассказали  

о работе с четырьмя принципиально разными виртуальными ин-

струментами: Steinberg Virtual Guitarist, Steinberg Virtual Guitarist 

Electric Edition, ReFX Slayer и MusicLab RealGuitar. 

 

Рис. 2.18. Окно VST-инструмента Steinberg Virtual Guitarist 

Steinberg Virtual Guitarist (рис. 2.18) решает "в лоб" задачу 

достоверного моделирования гитары. По сути, это интеллекту-

альный плеер, воспроизводящий фрагменты (паттерны) заранее 
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исполненных гитарных партий. Разработчики программы проде-

лали титаническую работу. Каждый из стилей исполнения запи-

сан во всех тональностях, да так что в каждой тональности обыг-

рываются около полутора десятков аккордов разных типов!  

Основу инструментов составляют "исполнители" — храня-

щиеся на диске записи завершенных фрагментов партий гитарно-

го аккомпанемента, сыгранных гитаристами-мастерами на реаль-

ных гитарах лучших фирм в студийных условиях. Имеющаяся 

библиотека позволяет аранжировать аккомпанемент в любом из 

наиболее распространенных музыкальных стилей. При таком 

подходе к моделированию гитары основные задачи пользователя 

сводятся к выбору стиля да к записи на MIDI-трек секвенсора 

необходимой последовательности аккордов. 

Такого же плана и VST-инструмент Virtual Guitarist Electric 

Edition (рис. 2.19). Правда, в нем упор сделан на партии в испол-

нении электрогитар. 

 

Рис. 2.19. Окно VST-инструмента Virtual Guitarist Electric Edition 
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Рис. 2.20. Виртуальный процессор гитарных эффектов 

Кроме того, в комплексе с инструментом функционирует VST-

плагин, в котором реализуются различные эффекты, типичные 

гитарные "примочки" (рис. 2.20). 

Музыканты, впервые попробовавшие плагины серии Virtual 

Guitarist в деле, как правило, приходят в восторг. Еще бы! Ощуще-

ние всесильности, вот что это такое. Виртуозно играешь, играть не 

умея! Но некоторое время спустя происходит отрезвление. Гото-

вых стилей много, но все же их набор конечен. А создание собст-

венных конструкций оказывается делом хлопотным, потому что 

плагины для этого не особенно и предназначались.  

Разработчики перестали поддерживать эти VST-инструменты. 

Их лицензионные версии приобрести не удастся, хотя "народ-

ные" версии по-прежнему распространены в Интернете.  

На смену им ненадолго пришла программа Virtual Guitarist 2, 

которая включает 32 новых стиля вдобавок к 56 стилям Virtual 

Guitarist и Virtual Guitarist Electric Edition (общий объем сэмплов 
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6,8 Гбайт). Редактор партий позволяет управлять каждой отдель-

ной фразой и обеспечивает широкие возможности по созданию 

новых риффов. Смоделированы также новые усилители и высо-

кокачественные эффекты. Однако и эту программу сейчас не 

отыскать, разве что в каком-либо комиссионном магазине.  

ПРИМЕЧАНИЕ  

Будьте осторожны при ее приобретении! Для установки лицензи-
онной версии требуется специальный аппаратный USB-ключ (диск 
без ключа — пустая трата денег), а взломанные пиратами версии 
Virtual Guitarist 2 не появились. В Интернете, в файлообменных 
сетях периодически циркулирует лицензионный диск с полным 
контентом Virtual Guitarist 2. Но с него даже демоверсию не удаст-
ся установить, не разрешив инсталляцию специального средства, 
предназначенного для защиты от несанкционированного исполь-
зования программ Steinberg. Для тех программ Steinberg, которые, 
возможно, уже установлены на вашем компьютере, последствия 
такого разрешения непредсказуемы. 

На сайте Steinberg с трудом удается обнаружить лишь редкие 

случайно сохранившиеся упоминания о программах Virtual Gui-

tarist, Virtual Guitarist Electric Edition и Virtual Guitarist 2 (а также 

об аналогичной по принципу действия программе Virtual Bassist). 

Вероятно, дело в том, что фактическим разработчиком программ 

являлась компания Wizoo Sound Design GmbH, которая сначала со-

трудничала со Steinberg Media Technologies в форме "стратегическо-

го альянса", а в 2005 году была приобретена компанией Digidesign, 

входящей в состав Avid Technology (http://www.avid.com/) — миро-

вого производителя цифровых аудиосистем. Wizoo переименова-

на в Advanced Instruments Research Group и в настоящее время 

работает над созданием музыкальных инструментов нового поко-

ления, которые будут интегрированы в профессиональные про-

граммно-аппаратные комплексы Pro Tools. Короче говоря, хотя 

все эти виртуальные гитаристы и басисты фирмы Steinberg и ла-

комые блюда, отведать их нынешнему поколению начинающих 

компьютерных музыкантов вряд ли удастся. Исчезли они почти 

без следа. И вряд ли это произошло случайно. Для полной свободы 

творчества нужны инструменты, в которых элементарным куби-

ком, образующим партию, был бы не паттерн с жестко зафикси-
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рованной структурой, а отдельный аккорд или, еще лучше, звук. 

Чтобы можно было самому создать любой стиль. 

Когда потребность имеется, она рано или поздно будет удов-

летворена. Есть такие инструменты! 

В книге [17] описана работа с двумя VST-инструментами 

(ReFX Slayer и MusicLab RealGuitar), по-разному решающими 

задачу "понотного" и "поаккордного" исполнения партии гитары. 

VST-инструмент ReFX Slayer (http://refx.com/) моделирует 

различные "тяжелые" электрогитары. Есть там и "чистые" гита-

ры, свободные от каких-либо обработок, но как раз они-то звучат 

ненатурально. Да и о какой достоверности можно и нужно гово-

рить, слыша, например, рев гитары, подключенной к перегру-

женному усилителю? Главное, чтобы эффект впечатлял. И эф-

фекты действительно впечатляют. Их здесь довольно много: до 

16 типичных гитарных "примочек". Отметим, что разработчики 

смоделировали в плагине не только саму гитару, как таковую, но 

еще и целый ряд компонентов, влияющих на характер звука, на-

чиная от "исполнителя" и заканчивая комбо-усилителем. Вы обя-

зательно найдете применение всем этим воистину высоковольт-

ным электрическим гитарам. Напомним, что Slayer в качестве 

VST-инструмента входит в поставку виртуальной студии FL Studio. 

С ним мы познакомили читателей в книгах [17, 24, 30].  

На фоне остальных плагинов "гитарного назначения" хотим 

выделить особо VST-инструмент MusicLab RealGuitar, различные 

версии которого подробно описаны в книгах [17, 27]. RealGuitar 

основан на высококачественных сэмплах гитары и воплощает  

в себе совершенно новый подход к имитированию гитарного зву-

чания и исполнения. RealGuitar — первый инструмент, реали-

зующий принцип "нота-сэмпл" с переключением сэмплов при 

нажатии клавиш и моделирующий те характерные приемы игры 

на конкретном музыкальном инструменте (в данном случае, на 

гитаре), которые невозможно исполнить обычным способом на 

MIDI-клавиатуре. 

Так же как и в Virtual Guitarist, в RealGuitar (рис. 2.21) звуки 

заранее сыграны профессиональными музыкантами и сохранены 

в виде сэмплов. Но есть одно существенное отличие. Этот VST-

инструмент действительно представляет собой гитару, а не гита-
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риста. Не некий виртуальный музыкант, а вы сами, играя на вирту-

альной гитаре, чрезвычайно похожей по звучанию на реальную, 

будете складывать из отдельных звуков аккорды, а из аккордов 

партии. А плагин RealGuitar поможет исполнить гитарную пар-

тию естественно и с мастерством. 

Основные цели создания плагина — максимальное приближе-

ние звучания виртуального синтезатора гитары к звучанию на-

стоящей акустической гитары, правдоподобное исполнение ги-

тарных приемов при игре на MIDI-клавиатуре. 

RealGuitar базируется на собственных высококачественных 

сэмплах, полученных путем записи звучания реальных инстру-

ментов. Сэмплы характерной игры профессиональных гитари-

стов записаны для каждого лада на каждой из шести струн. Из 

этих звуков плагин автоматически формирует заданные пользо-

вателем аккорды. Инструмент снабжен банком звуков гитар семи 

типов. Среди них имеются гитары со стальными и нейлоновыми 

струнами, двенадцатиструнная гитара. 

 

Рис. 2.21. MusicLab RealGuitar —  
почти настоящая акустическая гитара 
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Аккорды можно записывать в виде MIDI-сообщений на треке 

секвенсора программы-хоста, к которому в качестве виртуально-

го выходного MIDI-порта подключен плагин. Аккорды также 

отображаются в виде отпечатков пальцев на виртуальном гитар-

ном грифе на панели RealGuitar. Любой аккорд можно взять  

в нескольких позициях, причем вы легко сумеете выбрать допус-

тимые позиции, пользуясь виртуальным каподастром. Важно, что 

в любом случае звучат именно те ноты, которые в точности соот-

ветствуют выбранной позиции. 

Особенность современной версии RealGuitar в том, что в ней пре-

дусмотрена работа этого VST-инструмента под управлением встро-

енного менеджера паттернов. Паттерн выступает в качестве источ-

ника MIDI-сообщений, в которых закодированы ритм и характер 

звукоизвлечения, а естественность звучания обеспечивается VST-

инструментом RealGuitar. Паттерны можно переносить на MIDI-трек 

и "размножать" их там, формируя прообраз партии гитары. 
В комплекте с RealGuitar поставляется внушительная библио-

тека стилей (1273 стиля). Тем не менее, может оказаться, что вам 
и этого не хватит, а захочется сделать что-то свое. Для записи 
произвольного ритма в программу внедрена специальная таблица 
ударов Stroke Map, преобразующая стандартные сообщения типа 
Note в различные гитарные приемы исполнения аккордов, запи-
санных на MIDI-треке хоста или взятых на клавиатуре. На основе 
запрограммированных ударов можно создавать собственные сти-
левые шаблоны. RealGuitar также позволяет формировать партии 
для другого синтезатора, подключенного к треку хоста (с помо-
щью функции MIDI Out). 

Впоследствии специалисты фирмы MusicLab, Inc. 

(www.musiclab.com) разработали еще два виртуальных инстру-

мента, достоверно моделирующих гитары. Но на этот раз не аку-

стические, а электрогитары. Речь идет о программах MusicLab 

RealStrat VSTi (рис. 2.22, а) и MusicLab RealLPC VSTi (рис. 2.22, б), 

предназначенных в основном для исполнения соло на леген- 

дарных гитарах Fender Stratocaster и Gibson's Les Paul Custom.  

С позиций применения эти два инструмента можно считать иден-

тичными: они имеют одинаковые элементы управления. Если  

не принимать во внимание дизайн панелей, то отличие заключается 

лишь в том, что плагины играют голосами разных реальных гитар. 



Возможности программ, предназначенных для обработки звука 137 

 а 

 б 

Рис. 2.22. RealStrat VSTi (а) и RealLPC VSTi (б) 
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Высококачественные сэмплы записаны непосредственно с дат-

чиков электрогитар в "сухом" виде: без какой-либо предваритель-

ной обработки. Это позволяет создать любой желаемый гитарный 

звук, подключая ваши привычные виртуальные гитарные "примоч-

ки" и симулятор усилителя/акустической системы.  

В состав каждого из инструментов включен модуль Pattern 

Manager с полной библиотекой паттернов MusicLab Guitar Pattern 

Library, что облегчает создание партий гитарного аккомпанемента.  

Все основные отличия RealStrat и RealLPC от RealGuitar прояв-

ляются в режиме Solo. В этом режиме доступны порядка 30 спе-

цифических гитарных эффектов (штрихов, приемов игры), таких 

как тремоло, трель, флажолет, слэп, слайд, бэнд и т. д. Причем 

предусмотрено несколько вариантов управления ими (от клавиш, 

контроллеров, педали, в зависимости от значения Velocity).  

RealStrat и RealLPC — уникальные инструменты для живого 

исполнения на MIDI-клавиатуре солирующих гитарных партий. 

У них уже есть приверженцы в музыкальном мире, в совершен-

стве освоившие игру на этих в чем-то экзотических инструмен-

тах. А мы советуем вам со временем научиться использовать 

RealStrat и RealLPC при создании аранжировок для записи пар-

тии соло-гитары, управляя инструментом посредством MIDI-

сообщений, заранее записанных на треке программы-хоста. 

Если вы захотите освоить богатейшие возможности программ 

RealStrat и RealLPC, то необходимый для этого материал найдете 

в книге "Сочинение и аранжировка музыки на компьютере" [27]. 

Мы не противопоставляем и никогда не противопоставляли 

виртуальные синтезаторы и компьютерные модели музыкальных 

инструментов аппаратным синтезаторам и акустическим инстру-

ментам. Бесспорно, было бы очень хорошо, если бы партии гита-

ры исполнялись на настоящем, а не на виртуальном инструменте. 

Но если вы хотите, чтобы запись звучала достойно, то придется 

позаботиться о выполнении нескольких условий: 

 инструмент (а в случае электрогитары еще и обработки, уси-

литель, акустическая система) должен быть профессиональ-

ным, а значит дорогим; 

 условия записи живой гитары должны быть студийными: ти-

шина, хороший инструментальный микрофон, малошумящий 
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предварительный усилитель, многоразрядный прецизионный 

аналого-цифровой преобразователь, — а значит, это будет 

стоить огромных денег! 

К тому же исполнитель должен владеть гитарой мастерски,  

а значит, он должен быть высокооплачиваемым. 

Если вы можете позволить себе все перечисленное — отлич-

но. Однако в реальной жизни большинства из нас все обстоит 

сложнее и прозаичнее. Что же делать? Либо оставьте мечту  

о создании композиций, звучание которых могло бы приблизиться 

к лучшим образцам. Либо обратитесь к музыкальному компьюте-

ру — поручите виртуальным гитаристам играть на виртуальных 

гитарах. Либо найдите компромиссное решение, позволяющее 

обойти хотя бы часть трудностей.  

Об одном подобном решении мы сейчас как раз и расскажем. 

Для себя мы его "открыли", можно сказать, случайно: в поисках 

подарка для одного из музыкально одаренных юных членов на-

шей семьи. Оказалось, что в природе существуют особые компь-

ютерные MIDI- и аудиоинтерфейсы, гитарные аппаратно-

программные комплексы. Они разработаны известнейшей фир-

мой, специализирующейся на гитарах и гитарном оборудовании, 

в 2010 году с успехом демонстрировались на одной их крупней-

ших мировых выставок. Однако о них мало что знают не только 

музыканты, но и продавцы-консультанты музыкальных магази-

нов. Неудивительно, ведь комбо-усилитель, управляемый ком-

пьютером, — вещь достаточно новая и малоосвоенная. Русско- 

язычных руководств пользователя, естественно, при них нет, да  

и англоязычные весьма куцы и трудны для понимания. Сразу 

видно, что писались не "компьютерщиками", а "гитаристами". 

Так что материал, который мы сейчас вам предлагаем, по-своему 

уникален. Знакомьтесь: цифровой гитарный центр Fender G–DEC 3. 

2.3.2. Fender G–DEC 3 — цифровой 

гитарный центр 

Цифровой гитарный центр Fender G–DEC 3 (рис. 2.23) разра-

ботан в 2010 году калифорнийской корпорацией Fender Musical 

Instruments Corporation Corona. Информацию о нем можно найти 
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на сайте http://www.fender.com/. Для краткости далее мы будем 

называть этот программно-аппаратный комплекс "G–DEC 3". 

G–DEC 3 можно назвать музыкальным компьютером "с ги-

тарным уклоном". Гитарный центр совмещает в себе сразу  

несколько приборов.  

 

Рис. 2.23. Цифровой гитарный центр Fender G–DEC 3 

Во-первых, это компактный комбо-усилитель: в едином кор-

пусе размешается усилитель (мощностью 15 или 30 Вт) и акусти-

ческая система (как известно, электрогитара сама по себе — без 

усилителя и динамиков — не звучит). 

Во-вторых, в G–DEC 3 встроен цифровой процессор эффек-

тов. Среди них: овердрайв, фуз, вибрато, дилэй, реверберация, 

имитация различных усилителей и многие другие. Причем для 

обработки гитарного сигнала можно применять не какой-либо 

один эффект, а несколько эффектов, включенных в цепочку. 

В-третьих, в G–DEC 3 встроен цифровой тюнер, позволяющий 

идеально точно настроить каждую струну подключенной гитары. 

В-четвертых, G–DEC 3 оснащен процессором, памятью  

(250 Мбайт встроенной и до 8 Гбайт сменной в виде SD-карт), 
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аналогоцифровым и цифро-аналоговым преобразователями, а также 

синтезатором, управляемым по интерфейсу MIDI. Это позволяет 

хранить и воспроизводить аудиофайлы в формате WAV и MP3  

и MIDI-файлы в формате MID, превращая G–DEC 3 в MIDI-

секвенсор и аудиоплеер. Получается прекрасное средство для 

репетиций и упражнений в импровизации: воспроизводите ак-

компанемент, записанный в секвенсоре, и подыгрываете ему на 

гитаре. Записанный в памяти аккомпанемент в терминологии 

устройства называется звуковой дорожкой (Band). 

В-пятых, "внутри" G–DEC 3 имеется сэмплер, посредством 

которого вы можете записать (а в дальнейшем и перенести на 

компьютер с помощью сменных SD-карт) сыгранную на гитаре 

партию. Причем предусмотрены два режима записи: в первом 

записывается только ваша игра, а во втором ваша игра наклады-

вается на запись, воспроизводимую посредством секвенсо-

ра/аудиоплеера. 

В-шестых, G–DEC 3 снабжен разъемом интерфейса USB 2. На 

инсталляционном диске (либо на сайте разработчика) вы найдете 

ASIO-драйвер Fender Universal ASIO, после установки которого 

появляется возможность загрузки из компьютера в память G–

DEC 3 файлов с расширением WAV, MP3 и MID. Интерфейс 

USB 2 обеспечивает управление параметрами эффектов и редак-

тирование содержимого медиабиблиотек, хранящихся на дисках 

компьютера, в памяти G–DEC 3 и на сменной карте памяти. Де-

лается это либо кнопками управления, расположенными на кор-

пусе G–DEC 3, либо с помощью программы Fender FUSE (кроме 

нее и драйверов на инсталляционном диске имеется облегченная 

версия популярной виртуальной студии Ableton Live).  

Если установить драйвер Fender Universal ASIO, то G–DEC 3 

будет восприниматься компьютером как устройство, позволяю-

щее воспроизводить проекты виртуальных студий (например  

Cakewalk SONAR), содержащие аудио- и MIDI-треки.  

Цифровой гитарный центр Fender G–DEC 3 производится  

в двух модификациях: G–DEC 3 Fifteen (мощность усилителя  

15 Вт, стоимость 399,99 долл.) и G–DEC 3 Thirty (мощность уси-

лителя 30 Вт, стоимость 549,99 долл.). 
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Рис. 2.24. Панель управления Fender G–DEC 3 

Познакомимся с назначением элементов, имеющихся на пане-

ли управления устройства (рис. 2.24).  

Начнем с простого. По левую сторону панели расположены: 

 INPUT (позиция A) — разъем для подключения электрогитары; 

 GUITAR TONE (позиция B) — регулятор усиления гитарного 

сигнала на входе усилителя. 

С правой стороны панели находятся: 

 BAND LEVEL (позиция L) — регулятор уровня громкости 

воспроизведения звуковой дорожки;  

 VOLUME (позиция M) — регулятор уровня громкости сигна-

ла на выходе усилителя — общий для гитары и звуковой до-

рожки; 

 SD (позиция N) — слот для подключения сменной карты па-

мяти SD; поддерживаются карты объемом до 8 Гбайт; 

 PHONES (позиция O) — разъем для подключения стереофо-

нических наушников, динамик при этом отключается; 

 USB (позиция P) — разъем интерфейса USB 2. 

В центре панели находятся элементы управления цифровой 

"начинкой" устройства.  

На дисплее (позиция G) отображаются сведения о воспроиз-

водимой звуковой дорожке — название и номер в переделах от 0 

до 99 (вcтроенный секвенсор/плеер рассчитан на хранение не бо-

лее 100 файлов — MIDI, WAV, MP3) и состав цепочки активных 

в данный момент эффектов. В его нижней части отображается 

информация о текущем назначении четырех многофункциональ-

ных (программируемых) кнопок, расположенных под дисплеем 

(позиция H). 

Последовательный перебор файлов со звуковыми дорожками, 

пресетов эффектов и редактирование их параметров осуществ-
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ляются с помощью вращающегося переключателя, так называе-

мого энкодера (позиция K). 

Теперь познакомимся с кнопками, расположенными слева от 

дисплея и имеющими фиксированное назначение: 

 START-STOP (позиция C) — включение/выключение вос-

произведения звуковой дорожки; 

 QUICK ACCESS (позиция D) — быстрый доступ к папкам,  

в которых сгруппированы файлы разных типов (MIDI, WAV, 

MP3), и к меню смены звуковой дорожки; для выхода из ре-

жима быстрого доступа нужно кратковременно нажать кнопку 

EXIT/HOLD FOR UTIL (позиция J); 

 TAP / HOLD FOR TUNER (позиция E) — переключение из 

режима воспроизведения в режим тюнера и обратно; чтобы 

включить тюнер, нужно нажать и удерживать эту кнопку, для 

обратного перехода достаточно ее кратковременного нажатия. 

Позиция F — это группа кнопок, относящихся к Phrase Sampler — 

модулю записи (сэмплирования) партии, сыгранной на гитаре: 

  — включение/выключение режима воспроизведения запи-

санного сэмпла; 

  — включение/выключение режима записи сэмпла; 

  — включение/выключение режима записи сэмпла с на-

ложением на звуковую дорожку. 

Под дисплеем расположена группа кнопок (позиция H), на-

значение которых зависит от выбранного режима. Будем назы-

вать их программируемыми кнопками. Их функции отображают-

ся на дисплее в нижней строке. Содержимое дисплея, в свою 

очередь, зависит от того, какая из этих кнопок нажата.  

Справа от дисплея (позиция K) расположена ручка энкодера. 

Поворачивая ее, поочередно выбирают объекты из той категории, 

которая отображена на дисплее. Например, в режиме воспроиз-

ведения звуковой дорожки выбирают воспроизводимые файлы. 

Кнопка SAVE (позиция I) окрашивается в красный цвет, если 

внесено какое-либо изменение в настройки текущего пресета.  

С ее помощью можно сохранить пользовательский пресет. О том, 

как это делается, мы расскажем чуть позже. 

Кнопка EXIT/HOLD FOR UTIL (позиция J) предназначена 

для возврата в режим воспроизведения из других режимов. А при 



Глава 2  144 

длительном удержании этой кнопки устройство перейдет в сер-

висный режим, в котором можно, например, управлять такими 

функциями системы, как импортирование пресетов и контроль 

использования памяти. 

Теперь познакомимся с элементами, расположенными на зад-

ней панели устройства (их немного, поэтому обойдемся без рисун-

ка). В левой части задней панели располагаются: клавиша включе-

ния устройства POWER ON/OFF, разъем для подключения 

сетевого шнура INPUT POWER и отсек предохранителя FUSE.  

В правой части находятся 3 разъема: AUX IN, GUITAR  

и FOOTSWITCH. 

AUX IN — гнездо для подключения стереофонического кабеля 

с разъемом типа "мини-джек". Это дополнительный вход канала 

усиления звуковой дорожки. К нему можно подключить какой-

либо внешний источник аудиосигнала, например, MP3-плеер.  

К разъему GUITAR можно подключить вторую гитару. Чув-

ствительность этого дополнительного входа усилителя ниже, чем 

чувствительность входа на передней панели. Если ваша гитара 

формирует сигнал, имеющий большую амплитуду, то при подклю-

чении ее к разъему INPUT (на передней панели) могут возникнуть 

искажения. В таком случае попробуйте подключить ее к разъему 

GUITAR.  

ПРИМЕЧАНИЕ  

На громкость звучания гитары, подключенной к разъему GUITAR, 

регулятор GUITAR TONE не влияет. 

На задней панели имеется также разъем FOOTSWITCH для 

подключения ножного переключателя (footswitch). С его помо-

щью гитарист (а у него во время игры обе руки заняты) ногой 

может оперативно управлять эффектами и переключать режимы 

гитарного центра. 

Для использования совместно с Fender G-DEC 3 пригоден 

только ножной переключатель Fender Footswitch ULT-4, Model 

0994070000 (рис. 2.25). В комплект поставки цифрового гитарно-

го центра он не входит. Его нужно приобретать отдельно (стои-

мость 75 долл.).  
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Рис. 2.25. Ножной переключатель Fender Footswitch ULT-4 

Переключатель полезен при сценическом выступлении,  

а в условиях домашней студии без него вполне можно обойтись. 

Тем более что купить его не так-то просто. Когда мы решили 

приобрести Fender G–DEC 3, оказалось, что в петербургском от-

делении развитой сети, специализирующейся на музыкальном 

оборудовании (http://www.muztorg.ru/), этот гитарный центр 

имеется в единственном экземпляре, а ножного переключателя  

к нему нет ни в одном из магазинов этой сети на всей территории 

нашей страны. Думается, причина в том, что российские музы-

канты попросту не знают о существовании Fender G–DEC 3. 

Теперь рассмотрим порядок выполнения операций в различ-

ных режимах Fender G–DEC 3. Всего их 7: Play, Tuner, Amp, FX, 

Band, Phrase и Utility. 

Режим Play (воспроизведение) 

После включения питания автоматически устанавливается ре-

жим Play (готовность к началу воспроизведения звуковой дорож-

ки). Именно в этом режиме вы будете применять G–DEC 3 ос-

новную часть времени. И с него нужно начинать освоение 

прибора. В режиме Play вам доступны 100 звуковых дорожек, для 

каждой из которых назначен "фабричный" набор эффектов.  

Признаком режима Play служит значок  (стилизованное изобра-

жение медиатора), который находится в правом верхнем углу дисплея. 

На дисплее также отображаются (перечисляем сверху вниз): 

 номер и название звуковой дорожки; 

 структура цепочки эффектов; 
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 имя воспроизводимого файла; 

 назначение многофункциональных кнопок (AMP — переход  

в режим выбора модели комбо-усилителя; FX — переход в 

режим выбора эффектов и редактирования их параметров; 

BAND — переход в режим выбора класса звуковой дорожки 

(MIDI, WAV, MP3); PHRASE — переход в режим выбора оп-

ций сэмплирования). 

Звуковые дорожки переключаются с помощью энкодера. Для 

того чтобы выбранная звуковая дорожка зазвучала, нажмите 

кнопку START-STOP. Повторное нажатие кнопки остановит 

воспроизведение. 

Подключите гитару ко входу INPUT, отрегулируйте относи-

тельную громкость звучания гитары и звуковой дорожки (регуля-

торами GUITAR TONE и BAND LEVEL). Включите воспроиз-

ведение и осваивайте гитару, либо стараясь повторить гитарную 

партию, имеющуюся на звуковой дорожке, либо придумывая 

свою собственную дополнительную партию.  

Имеющейся в памяти устройства сотни звуковых дорожек  

с предустановленными эффектами на первое время хватит. А за-

тем можно перейти к углубленному освоению G–DEC 3. 

Режим Tuner (тюнер) 

Наряду с режимом воспроизведения звуковой дорожки до-

вольно часто приходится работать в режиме настройки гитары  

с помощью тюнера (гитара, разумеется, должна быть подключена 

к G–DEC 3). Чтобы включить тюнер, нужно нажать и удерживать 

кнопку TAP / HOLD FOR TUNER (позиция E). На дисплее вы 

увидите шкалу, отградуированную в центах (сотых долях полу-

тона). Середина шкалы соответствует точной настройке струны.  

ПРИМЕЧАНИЕ  

Стандартный строй шестиструнной гитары (начиная с наиболее 
тонкой струны): ми (E), си (B), соль (G), ре (D), ля (A), ми (E).  

Теперь можно поочередно извлекать звук из открытых струн. 

Тюнер измерит частоту колебаний, распознает звучащую ноту. 

Ее обозначение отобразится на дисплее. Также на шкале появится 
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отметка, указывающая величину расстройки струны относительно 

ближайшей ноты и знак расстройки (бемоль — струна настроена 

ниже или диез — струна настроена выше). Остается подкрутить 

колок, добиваясь, чтобы отметка переместилась в середину шка-

лы тюнера.  

Для обратного перехода в режим воспроизведения достаточно 

кратковременного нажатия кнопки TAP / HOLD FOR TUNER. 

Два рассмотренных режима наиболее просты и прозрачны, ос-

тальные — сложнее.  

Режим Amp 

Цифровой процессор, встроенный в G-DEC 3, позволяет моде-

лировать звучание различных гитарных усилителей фирмы Fend-

er (в общей сложности 22 наименования). Режим Amp использу-

ется для выбора модели усилителя и настройки его параметров.  

Для перехода из режима Play в режим Amp нужно нажать про-

граммируемую кнопку AMP. Признаком режима Amp на дисплее 

служит значок . Выбор усилителя и регулирование его пара-

метров производится путем вращения энкодера. Что именно при 

этом переключается или перестраивается? Ответ на этот вопрос 

содержится в строке дисплея, расположенной над двумя средни-

ми программируемыми кнопками. Например, если в этой строке 

вы видите Amp Type, то энкодер будет переключать тип усили-

теля. Функция энкодера выбирается ("пролистывается") правой  

и левой программируемыми кнопками. То есть в нижней строке 

дисплея содержится информация о функциях энкодера: текущей 

(посередине строки), предыдущей (слева) и следующей (справа). 

Например, следующей функцией энкодера после выбора типа 

усилителя является регулирование его входного коэффициента 

усиления (Gain). Затем последовательно можно выбрать: 

 регулирование уровня громкости на выходе (Volume); 

 раздельное регулирование тембра для нижних (Bass), средних 

(Middle) и верхних (Treble) частот; 

 регулирование порога компрессии (Compressor); 

 переключение фиксированных настроек тембра (Timbre); 
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 регулирование порога срабатывания гейта (Noise Gate, при-

меняется в качестве средства борьбы с шумом в паузах); 

 импортирование в текущий пресет настроек из другого пресе-

та (Import).  

Как только вы измените что-либо в параметрах модели усили-

теля, цвет кнопки SAVE станет красным. Это означает, что изме-

нения записаны во временную память. На данном этапе их не 

поздно отменить. Для этого нажатием кнопки EXIT / HOLD FOR 

UTIL нужно вернуться в режим Play и повернуть энкодер. Кнопка 

SAVE снова станет белой. Предположим, что новые настройки вас 

устраивают. При красном цвете кнопки EXIT / HOLD FOR UTIL 

их можно сохранить как изменения текущего пресета, но можно  

и создать новый пресет. Для сохранения пресета требуется дважды 

нажать кнопку SAVE. Первое нажатие инициализирует процедуру 

сохранения (ее все еще можно отменить), второе завершает ее. По-

сле первого нажатия этой кнопки на дисплее появится надпись 

Save over и название текущего (редактируемого вами) пресета.  

Если сейчас еще раз нажать кнопку SAVE, то изменения будут за-

писаны в текущий пресет (его прежние параметры окажутся заме-

ненными на новые). С фабричными пресетами так лучше не посту-

пать, их все же создавали специалисты. Пусть эти пресеты еще 

послужат вам. Поэтому до того, как повторно нажать кнопку 

SAVE, нужно дать вашему пресету новое имя. С помощью правой 

и левой программируемых кнопок перемещайте курсор ввода  

в строке имени пресета. Вращением энкодера выбирайте вводимую 

латинскую букву. Вторая слева программируемая кнопка служит 

переключателем регистра ввода (строчные, заглавные буквы, циф-

ры). Третья слева программируемая кнопка предназначена для 

ввода пробела. После того как будет введено новое имя пресета, 

можно нажать кнопку SAVE. 

ПРИМЕЧАНИЕ  

Разработчики позаботились о сохранности фабричных пресетов. 
По умолчанию память заблокирована: после нажатия кнопки 

SAVE на дисплее появится изображение замка и надпись Memory 

Locked. Когда вы освоите G–DEC 3 и вероятность утраты полез-
ного пресета станет незначительной, разблокируйте память. О том, 
как это делается, мы расскажем, рассматривая режим Utility. 
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Режим FX 

Цифровой процессор, встроенный в G–DEC 3, обеспечивает 

реализацию множества эффектов. Эффекты условно поделены на 

4 группы:  

 Stompbox — 4 эффекта, характерных для простых ножных 

переключателей и педалей (овердрайв, варианты "вау-вау", 

варианты фуза); 

 Modulation — 13 эффектов, связанных с модуляцией (хорус, 

флэнжер, фейзер, варианты тремоло и вибрато); 

 Delay — 9 разновидностей дилэя; 

 Reverb — 10 разновидностей реверберации. 

Режим FX используется для редактирования параметров эффек-

тов. Чтобы перейти из режима Play в режим FX, нужно нажать 

программируемую кнопку FX. Признаком режима FX на дисплее 

служит значок . 

Технология работы с эффектами аналогична той, которую мы 

рассмотрели применительно к редактированию моделей усилите-

лей (фактически и то, и другое — эффекты). После нажатия 

кнопки FX входим в меню эффектов. По умолчанию будет вы-

брана группа Stompbox. Формально будет установлен эффект  

No Stompbox (нет эффекта группы Stompbox). На этом уровне 

меню с помощью правой и левой программируемых кнопок вы-

бираем нужную группу эффектов (на дисплее в середине нижней 

строки последовательно будут появляться надписи: Stompbox, 

Modulation, Delay, Reverb). Затем энкодером выбираем эффект, 

входящий в данную группу. Опять задействуем правую или ле-

вую программируемые кнопки для выбора параметра эффекта и, 

наконец, энкодером регулируем значение текущего параметра.  

Если передумали сохранять результаты редактирования, то 

нажимаем кнопку EXIT / HOLD FOR UTIL. Если решаем со-

хранить пресет — нажимаем кнопку SAVE, вводим имя пресета 

и еще раз нажимаем кнопку SAVE. 

ПРИМЕЧАНИЕ  

Кнопку SAVE можно задействовать и в том случае, когда она не 
окрашена в красный цвет (не внесены изменения в параметры 
пресета). Это может пригодиться, например, если вы просто хоти-
те присвоить пресету новое имя. 
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Режим Band 

Режим Band позволяет редактировать параметры режима вос-

произведения звуковых дорожек. Чтобы перейти из режима Play 

в режим Band, нужно нажать многофункциональную кнопку Band. 

Признаком режима Band служит значок  на дисплее. Сразу же 

после перехода в этот режим мы оказываемся в меню выбора ти-

па звуковой дорожки (надпись на дисплее Band Type посередине 

нижней строки). Вращением энкодера выбираем один из двух 

типов: MIDI или MP3/WAV. Нажимаем правую программируе-

мую кнопку, посередине нижней строки появляется надпись File.  

ПРИМЕЧАНИЕ  

Впредь для определенности будем считать, что для перемещения 
по различным меню используется правая программируемая кноп-
ка, хотя и левая годится для этого (только перемещение происхо-
дит в обратном порядке). 

Вращением энкодера выбираем нужный файл с записью зву-

ковой дорожки. Нажатием правой программируемой кнопки по-

очередно выбираем операцию, применяемую к данному файлу 

при его воспроизведении: 

 Repeat — циклическое повторение; с помощью энкодера вы-

бираем опцию: On (включить повторение) или Off (выклю-

чить повторение); 

 Speed — изменение скорости воспроизведения (темпа); с по-

мощью энкодера устанавливаем новую скорость в пределах от 

50 до 150 % исходной (тональность при этом сохраняется, 

MIDI-файлы воспроизводятся без искажений, а качество звука 

аудиофайлов, естественно, ухудшается); 100% означает ори-

гинальную скорость воспроизведения; 

 Pitch — изменение высоты тона; с помощью энкодера уста-

навливаем новую тональность в пределах 5 полутонов по от-

ношению к исходной (темп не меняется); 0 означает сохране-

ние оригинальной тональности при воспроизведении; 

 Mix — микширование исходного стереофонического файла;  

с помощью энкодера выбираем один из вариантов:  

 Stereo — оставить стереофайл без изменения; 
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 Left Right Mix — преобразовать в монофонический формат 

путем смешивания сигналов правого и левого стереоканалов 

в заданной пропорции (значение параметра Balance выбира-

ется энкодером);  

 Center Channel — преобразовать в монофонический фор-

мат путем суммирования сигналов правого и левого сте-

реоканалов (сформировать так называемый центральный 

канал); 

 Import — импортировать настройки режима воспроизведения 

из другой звуковой дорожки (выбирается энкодером). 

Безусловно, опции режима Band полезны. Например, можно 

замедленно воспроизводить звуковую дорожку в начале обуче-

ния, можно также подобрать наиболее подходящую тональность.  

Режим Phrase  

Режим Phrase позволяет редактировать опции записи в память 

устройства (сэмплирования) партии, исполняемой на подключен-

ной электрогитаре. Чтобы перейти из режима Play в режим Phrase, 

нужно нажать многофункциональную кнопку Phrase. Признаком 

режима Phrase служит значок  на дисплее. 

Сразу же после перехода в режим Phrase на дисплее появляет-

ся предложение Press COMMIT to keep dub track — нажать 

программируемую кнопку COMMIT, чтобы сделать копию зву-

ковой дорожки, на которую вы собираетесь "накладывать" запись 

гитарной партии в своем исполнении. Есть смысл последовать 

этому совету. Тогда исходная звуковая дорожка сохранится  

в своем первозданном виде, а работать вы будете с ее копией. 

Выбрав с помощью правой многофункциональной кнопки 

пункт UNDO, вы можете отменить ранее выполненное копирова-

ние звуковой дорожки и тем самым сэкономить память. 

Далее правой многофункциональной кнопкой можно пооче-

редно выбирать еще ряд опций сэмплирования: 

 Save Phrase — сохранить записанную фразу в памяти G–DEC 3; 

энкодером выбирается место сохранения — жесткий диск (HD), 

имеющийся в G–DEC 3, или сменная карта памяти (SD); после 

нажатия программируемой кнопки SAVE PHRASE фраза будет 
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сохранена в файле; имя файла в формате GDEC0000.WAV фор-

мируется автоматически (следующему файлу будет присвоен 

очередной номер); 

 Load Phrase — загрузить ранее записанную фразу либо с же-

сткого диска (HD), либо со сменной карты памяти (SD) — вы-

бирается энкодером; 

 Phrase Level — отрегулировать (энкодером) уровень громко-

сти воспроизведения фразы; 

 Dub Feedback — опция полезна для многократного наложе-

ния сыгранных фраз на одну и ту же звуковую дорожку, при 

этом формируются так называемые слои; энкодером можно 

выбрать относительную громкость звучания ранее записанно-

го слоя; предельные значения параметра: 10.0 — все слои бу-

дут звучать с одинаковой громкостью, 1.0 — громкость каж-

дого ранее записанного слоя будет значительно меньше 

громкости "соседнего" слоя, записанного позже; 

 Phrase Mode — опция применяется только к MIDI-файлам; 

если выбрать (с помощь энкодера) вариант SYNCHRONOUS, 

то начало сыгранной фразы будет привязано к началу бли-

жайшего такта; вариант FREEFORM означает отсутствие 

привязки фразы к такту;  

 Phrase Source — выбрать (с помощь энкодера) источник 

звука при записи фразы: GUITAR — только гитара; BAND — 

только звуковая дорожка; ALL — и гитара и звуковая до-

рожка; 

 Phrase Speed — при воспроизведении фразы изменить ско-

рость воспроизведения (темп); с помощью энкодера устанав-

ливается новая скорость в пределах от 50 до 150% по отноше-

нию к исходной; 

 Phrase Pitch — при воспроизведении фразы изменить высоту 

тона; с помощью энкодера устанавливается новая тональность  

в пределах 5 полутонов по отношению к исходной (темп не 

меняется); 

 Phrase Playback — воспроизводить фразу однократно (ONCE) 

или циклически (REPEAT); режим выбирается с помощью 

энкодера; 
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 Phrase Quality — выбрать качество записи фразы: HI RES — 

повышенное разрешение, при котором можно записать фразу 

длительностью не больше 35 секунд; LOW RES — нормаль-

ное разрешение, при котором можно записать фразу длитель-

ностью до 2 минут 20 секунд; 

 Phrase Delete — удалить файл с записанной фразой; файл вы-

бирается с помощью энкодера, затем следует нажать про-

граммируемую кнопку DELETE. 

ПРИМЕЧАНИЕ  

Рассмотренный режим Phrase — это лишь режим выбора парамет-
ров записи фразы (сэмпла). Собственно режим записи фразы вклю-

чается специальными кнопками:  — запись сэмпла и  — 

запись сэмпла с наложением на звуковую дорожку. 

Кнопка  включает режим воспроизведения записанного сэмпла. 

Режим Utility 

В сервисном режиме Utility выполняется настройка ряда 

функций процессора и памяти G–DEC 3. Чтобы перейти из ре-

жима Play в режим Utility, нужно нажать и удерживать не меньше 

2 секунд кнопку EXIT/HOLD FOR UTIL. Признаком режима 

Phrase служит значок  на дисплее. 

После повторного (кратковременного) нажатия этой кнопки 

устройство возвратится в режим Play. 

Рассмотрим опции, доступные в режиме Utility: 

 QA1 / QA2 / QA3 — программирование кнопок QA1, QA2, 

QA3 быстрого доступа к звуковым дорожкам; с помощью эн-

кодера назначается звуковая дорожка, которая будет выби-

раться нажатием соответствующей программируемой кнопки 

(т. е. заранее можно выбрать три звуковых дорожки-фаворита, 

которые для воспроизведения будут выбираться не последова-

тельным перебором 100 дорожек, а нажатием двух кнопок — 

QUICK ACCESS и QA1 / QA2 / QA3. 

 Mem Lock — блокирование (On) и разблокирование (Off) па-

мяти (переключается энкодером); если память заблокирована, 

то изменения в пресетах не удастся сохранить;  
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 Import — импортирование пресета из файла, записанного на 

сменную карту памяти (файл выбирается энкодером); 

 Export One — экспортирование текущего пресета в файл (на 

сменную карту памяти); 

 Export All — экспортирование всех пресетов в файлы;  

 Restore All Presets — восстановление всех исходных пре- 

сетов; 

 USB DRIVE — активизация USB-интерфейса (нажатием про-

граммируемой кнопки Enter); если G–DEC 3 и компьютер фи-

зически соединены USB-кабелем, то в результате активизации 

компьютер "увидит" жесткий диск и сменную карту памяти, 

имеющиеся в G–DEC 3, и средствами Windows их содержимое 

можно будет отредактировать (удалить записанные там фай-

лы, переименовать их или записать новые файлы); 

 Memory — отображение на дисплее объема свободной памяти 

на жестком диске G–DEC 3 и сменной карте. 

Вы уже, наверное, убедились, что G–DEC 3 не просто комбо-

усилитель со встроенным плеером, а настоящий компьютер, хотя 

и в необычном корпусе. 

На инсталляционном диске и на сайте http://www.fender.com/ 

имеется свободно распространяемая программа Fender FUSE.  

С ее помощью можно выполнять все рассмотренные операции. 

Фактически она дублирует элементы управления, имеющиеся на 

передней панели G–DEC 3. Достоинство программы — красоч-

ный интерфейс, удобная система меню, более наглядное отобра-

жение информации по сравнению с дисплеем G–DEC 3. Напри-

мер, выбрав определенную модель усилителя, вы увидите на 

экране его изображение. Каждый из четырех модулей эффектов 

также отображается на экране со всеми присущими ему элемен-

тами управления. Вращая виртуальные регуляторы, вы сможете 

редактировать параметры эффекта. 

Итак, мы рассмотрели работу с несколькими виртуальными 

помощниками гитариста. А теперь поговорим о программах, спо-

собных выручить не очень хорошего вокалиста — о вокодерах  

и вокальных гармонизаторах. 
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2.4. Вокодеры 

Вокодер (voice coder — кодировщик голоса) — устройство 

синтеза речи на основе произвольного сигнала с богатым спек-

тром.  

Вокодеры различных типов были разработаны в целях эконо-

мии частотных ресурсов радиолинии системы связи при передаче 

речевых сообщений. Экономия достигается за счет того, что вме-

сто собственно речевого сигнала передают только значения его 

определенных параметров, которые на приемной стороне управ-

ляют синтезатором речи. Основу синтезатора речи составляют 

три элемента: генератор тонального сигнала для формирования 

гласных звуков, генератор шума для формирования согласных  

и система формантных фильтров для воссоздания индивидуаль-

ных особенностей голоса. Конструирование вокодеров, способ-

ных не только разборчиво воспроизводить речь, но и сохранять 

узнаваемость голоса говорящего человека, оказалось нелегкой 

задачей. После всех преобразований голос человека становится 

похожим на голос робота. Однако для систем голосовой связи это 

вполне терпимо. Если же не ставить перед собой задачу прибли-

жения звучания голоса, обработанного вокодером, к звучанию 

оригинала, а рассматривать вокодер как специфический эффект, 

то можно получить интересные результаты.  

Подавая на блок речевого синтеза сигнал, например электро-

гитары, и произнося слова в микрофон блока анализа, можно по-

лучить эффект "говорящей гитары". При подаче сигнала с про-

стейшего музыкального синтезатора получается "голос робота". 

А если подать сигнал, близкий по спектру к колебаниям голосо-

вых связок, но отличающийся по частоте, то изменится регистр 

голоса — мужской на женский или детский (и наоборот). 

Вокодер как эффект, применяемый в музыке, позволяет пере-

нести свойства одного (модулирующего) сигнала (modulator) на 

другой сигнал, который обычно называют носителем (carrier). 

Часто в качестве сигнала-модулятора используется голос челове-

ка, а в качестве носителя — сигнал, формируемый музыкальным 

синтезатором. Так и достигается эффект "говорящего" или "по-

ющего" музыкального инструмента. 
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В практике компьютерного музыканта обычно используются 

вокодеры виртуальные, реализованные в виде VST-плагинов. Ра-

зумеется, применяются подобные плагины не сами по себе, а со-

вместно с программой-хостом. В качестве таковой может быть 

использована любая виртуальная студия, поддерживающая тех-

нологию VST, например, Cakewalk SONAR. 

А что в итоге дает вокодер компьютерному музыканту, спро-

сите вы?  

Во-первых, с помощью виртуального вокодера можно исказить 

до неузнаваемости голос певца, придав ему свойства "поющего 

робота", а заодно и скрыв все недостатки обрабатываемого голоса. 

Искажения окажутся столь сильными, что замаскируют не только 

ошибки интонирования, дрожь, перепады громкости и тому по-

добные изъяны, но даже явные дефекты речи. 

Во-вторых, можно превратить в песню последовательность 

слов, не пропетых, а просто произнесенных, прочитанных без 

всякого выражения. 

Но это все экзотика. А самое интересное — это как раз  

"в-третьих": спетую единственным человеком вокальную партию 

можно дополнить несколькими синтезированными партиями. Го-

лоса, исполняющие их, не будут похожи на исходный голос, но 

дадут ощущение многоголосного пения. Вместо последователь-

ности нот будет звучать последовательность аккордов. Подобный 

эффект называется гармонизацией. То, что вокодеры делают на 

практике, можно назвать псевдогармонизацией. Потому что они 

синтезируют дополнительные голоса на основе алгоритма воко-

дера, внося сильнейшие искажения, а не преобразуют высоту то-

на исходного голоса с максимальной достоверностью звучания, 

как это следовало бы делать настоящему гармонизатору. 

Программных вокодеров много. С некоторыми, наиболее ин-

тересными, мы познакомили читателей в ранее опубликованных 

книгах и статьях. В статье "Закодированный голос" [96], имею-

щейся на сайте http://petelin.ru/, рассмотрены вокодеры: Vocoder 

из комплекта плагинов Cubase SX, Fruity Vocoder из комплекта 

плагинов FL Studio, Waves Morphoder из пакета Waves Diamond 

Bundle 5. Раздел 7.6 книги "Профессиональные плагины для 

SONAR и Cubase" [14] посвящен описанию работы с весьма 

 "навороченным" вокодером Native Instruments Vokator.  
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Рис. 2.26. Окно плагина D.C. Vocoder 

А сейчас хотим рассказать вам о вокодере, который привлек 

наше внимание хорошим звучанием именно в режиме гармони- 

зации. VST-плагин D.C. Vocoder (рис. 2.26) представляет собой  

высококачественный 50-полосный вокодер, обеспечивающий 

прозрачное звучание синтезированных голосов. Отличительная 

особенность плагина — относительно простое управление. 

Знакомиться с имеющимися элементами управления начнем  

с наиболее понятных. Трудно не заметить 50-полосный графиче-

ский эквалайзер и находящийся над ним анализатор спектра 

(MODULATOR SPECTRUM ANALYZER). Если анализатор 

спектра в большей степени служит украшением, то с помощью 

эквалайзера можно менять в широких пределах тембр синтезиро-

ванных голосов. 

В верхней части панели расположены измерители и регулято-

ры уровня компонент сигнала: 

 MODULATOR — модулирующего сигнала (голоса вока- 

листа); 
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 CARRIER — сигнала-носителя (звука встроенного или внеш-

него синтезатора); 

 OUTPUT — сигнала на выходе вокодера. 

Нажатием кнопки FREEZE включается непрерывное воспроиз-

ведение последнего сформированного звука. В поле, расположен-

ном ниже кнопки, можно выбрать клавишу компьютерной клавиа-

туры (например, <Alt>), которая будет включать этот режим. 

Аналогично настраивается управление кнопкой FLAT. Пока 

она нажата — отключается графический эквалайзер (хотя на ото-

бражаемом положении его регуляторов это не сказывается). 

Регулятор FORMANT изменяет положение формантной об-

ласти. Этим достигается эффект "смены возраста и пола" вокали-

ста. Например, поет взрослая женщина: если сместить регулятор 

к положению M, то будет сымитирован тембр голоса, характер-

ный для мужчины, а если к положению F, то получится голос 

первоклассницы. Правда, звучит все это очень недостоверно (как 

и в любых других вокодерах) и годится лишь в качестве уж очень 

специального эффекта. 

Кнопками группы OCTAVE SHIFT выбирается интервал 

сдвига высоты тона синтезируемого звука с шагом в октаву  

(в пределах двух октав). Регулятором TUNE можно точно под-

строить высоту тона в пределах от 50 центов по отношению  

к номинальной (нулевая расстройка восстанавливается двойным 

щелчком левой кнопки мыши на регуляторе). 

В раскрывающемся списке CARRIER WAVEFORM можно 

выбрать одну из 4 форм колебаний, формируемых встроенным 

синтезатором (от этого зависит тембр звука). Внутренний синте-

затор будет задействован, если в группе CARRIER SOURCE 

нажата кнопка INT.  

ПРИМЕЧАНИЕ  

Наличие кнопки EXT свидетельствует о возможности использова-

ния сигнала внешнего синтезатора в качестве носителя. На прак-
тике при тестировании плагина с программой Cakewalk SONAR 
этого сделать не удалось. При подключении плагина к проекту ни-
какими ухищрениями не удалось добиться появления связанного с 
ним входного аудиопорта.  
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Кроме основного голоса можно сформировать еще до 6 синте-

зированных голосов. Выбор источника управляющего воздейст-

вия для гармонизатора производится с помощью кнопок группы 

CARRIER PLAYBACK.  

Если нажата кнопка DRONE, то управление будет произво-

диться с виртуальной клавиатуры, которая отображается в сере-

дине нижней области панели плагина. Какие клавиши выделите 

(пометите жирной точкой) с помощью мыши, такой аккорд и за-

звучит. Для работы в реальном времени этот вариант не годится. 

Придется на аудиотреке выделять короткий фрагмент, набирать 

на виртуальной клавиатуре плагина нужный аккорд и применять 

эффект (например, в Cakewalk SONAR командой Process > Apply 

Effect > Audio Effects главного меню). И так для каждой спетой 

ноты. Трудоемко, да и достойный результат с первой попытки 

вряд ли получится. 

Значительно удобнее управлять гармонизацией с MIDI-трека, 

на котором заранее записаны необходимые ноты. Для этого на 

панели плагина в группе CARRIER PLAYBACK нужно нажать 

кнопку MIDI. 

D.C. Vocoder (как и другие аналогичные вокодеры и гармониза-

торы) по умолчанию устанавливается в системе как VST-плагин. 

Для того чтобы плагином можно было управлять по MIDI, необхо-

димо сконфигурировать его как VST-инструмент. Вот как это  

делается в виртуальной студии SONAR. Командой Utilites >  

Cakewalk Plug-in Manager главного меню следует открыть диало-

говое окно Cakewalk Plug-in Manager. В поле Plug-in Categories 

надо выбрать нужную категорию плагинов — в данном случае 

VST Audiuo Effects (VST). В поле Registered Plug-ins отобразится 

список VST-плагинов, распознанных программой при сканировании. 

Теперь в этом списке выберем нужный плагин (в данном случае его 

имя — DCVocoder) и нажмем кнопку Plug-in Properties. Откроется 

диалоговое окно VST Plug-in Properties. В нем установим флажок 

Configure as synth и нажмем кнопку OK. Отныне программа будет 

считать VST-плагин DCVocoder VST-инструментом, т. е. синтеза-

тором, который способен воспринимать MIDI-сообщения. Среди 

плагинов категории VST Audiuo Effects (VST) вы больше не уви-
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дите плагина с именем DCVocoder — теперь он фигурирует в спи-

ске плагинов категории VST Instruments (VSTi). Рассматривае-

мый вокодер можно использовать в проекте SONAR как VST-

плагин, управляемый по MIDI.  

Подробно подключение виртуальных синтезаторов к про- 

екту программы SONAR версии 8.5 мы описали в книге [30].  

В SONAR X1 — самой свежей версии программы на момент под-

готовки рукописи данной книги — есть небольшие отличия. Они 

связаны с тем, что виртуальная рэковая стойка в новой версии пере-

стала быть отдельным диалоговым окном и размещается на вкладке 

панели Browser. Пожалуй, есть смысл привести здесь краткую по-

шаговую инструкцию, описывающую подключение виртуального 

инструмента к проекту SONAR X1, а плагина — к треку проекта. 

Если панель Browser скрыта, то отобразите ее, выбрав в глав-

ном меню команду Views > Browser. На панели имеются 3 вклад-

ки: Media, Plugins и Synth. 

На вкладке Media отображаются диски, папки, файлы. Это 

традиционный браузер.  

На вкладке Plugins по категориям отображаются плагины  

(а также папки, в которых находятся группы плагинов). Всего 

имеется 4 категории, отображение которых переключается кноп-

ками: 

 Audio FX — аудиоплагины; 

 MIDI FX — MIDI-плагины; 

 Instruments — виртуальные инструменты; 

 ReWire — программы, взаимодействующие с SONAR по про-

токолу ReWire (например, популярная виртуальная студия  

FL Studio [30]). 

Плагин подключается к треку путем перетаскивания из вклад-

ки Plugins на поле FX трека. 

Вкладка Synth является виртуальной рэковой стойкой, по-

средством которой к проекту подключаются виртуальные синте-

заторы. Для подключения синтезатора к проекту на данной 

вкладке следует нажать кнопку  и выбрать нужный синтезатор 

в открывшемся меню (его содержимое совпадает с содержимым 

категории Instruments вкладки Plugins). Далее синтезатор можно 
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задействовать для воспроизведения конкретного MIDI-трека, вы-

брав строку с именем синтезатора в качестве выходного MIDI-

порта этого трека. 

ПРИМЕЧАНИЕ  

Плагин, ранее сконфигурированный нами как синтезатор (в дан-
ном примере D.C. Vocoder), находится в категории Instruments. 
Несмотря на это, подключать его нужно не как VST-синтезатор,  
а как плагин, т. е. не вообще к проекту SONAR, а к конкретному 
аудиотреку в проекте (путем перетаскивания на поле FX трека). 

Итак, чтобы задействовать D.C. Vocoder, перетащим его из 

вкладки Plugins на поле FX того аудиотрека, на котором записа-

на обрабатываемая нами вокальная партия. После этого у каждо-

го из MIDI-треков в раскрывающемся списке Output To появится 

выходной порт, обозначенный именем плагина (в данном приме-

ре — DCVocoder). Остается выбрать именно этот выходной порт 

для того MIDI-трека, на котором заранее записаны ноты нужных 

аккордов). 

Разработчик плагина D.C. Vocoder — японская фирма Akai 

Professional. На момент подготовки рукописи книги D.C. Vocoder 

на сайте http://www.akaipro.com отнесен к числу устаревших, но 

все еще поддерживаемых продуктов. Так что найти программу 

сейчас будет не так уж просто. Но поискать ее на просторах Ин-

тернета стоит: по сравнению с другими вокодерами (а при подго-

товке этого материала мы протестировали немало плагинов по-

добного назначения) плагин D.C. Vocoder отличается простотой 

управления и хорошим качеством синтезированного звука. Увы, 

но результат работы большинства других вокодеров, протестиро-

ванных нами в режиме гармонизации, напоминает кошачий кон-

церт, хотя как одноголосный эффект (например, имитация "голо-

са робота") они работают вполне приемлемо. 

2.5. Гармонизаторы  

В принципе, пользуясь компьютером для записи голоса, вы 

можете "в лоб" решить проблему имитации звучания хора. Для 

этого достаточно будет напеть и записать несколько дублей во-

кальной партии. Унисон таким путем вы, вероятно, получите. 
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Хотя это и не факт. Звучание будет приличным, если вы в со-

стоянии несколько раз одинаково спеть необходимые фрагменты 

песни. Не каждому это дано. И даже если все выйдет, как заду-

мано, то результатом станет простой унисон, а не многоголосье. 

Чтобы получить эффект, хотя бы отдаленно напоминающий зву-

чание хора Турецкого, нужно обладать мастерством вокалиста.  

В частности, нужно уметь петь не только первым, но и вторым,  

и третьим голосами. Тогда микс голосов образует аккорды, соот-

ветствующие текущей гармонии. 

Если у вас имеются необходимые вокальные данные — флаг 

вам в руки. Записывайте себя и при исполнении основной пар-

тии, и в качестве бэк-вокалиста. Но если певец вы посредствен-

ный, то лучше не рискуйте. Помните, что судьба вашей песни 

зависит не только от степени "хитовости" мелодии и глубины 

смыслового содержания текста, но и от того, насколько прив- 

лекательно исполнение. Это справедливо даже в том случае, 

когда речь идет не о завершенной фонограмме, а о демоверсии 

песни. Встречают все-таки по одежке. Словом, если вы (как  

и авторы книги) не в состоянии создать партитуру для хора  

и с высоким качеством лично спеть все вокальные партии, то 

лучше и не пытайтесь это сделать, а положитесь на компьютер 

и соответствующие компьютерные программы. Их сейчас пре-

достаточно.  

Задача синтеза хорового звучания сложна и, вместе с тем, уз-

ка. В масштабах проблемы компьютерной обработки звука — это 

всего лишь одно из многих направлений. Поэтому редко встре-

чаются программы, целиком посвященные ее решению. Обычно 

функции обработки вокала возлагаются на специализирован- 

ные плагины, которые следует подключать к одному из хостов 

(виртуальных студий класса Cakewalk SONAR). В наши дни по-

добных программных продуктов насчитываются сотни. Но каче-

ственное звучание в сочетании с удобством применения обеспе-

чивают немногие из них. Сейчас мы расскажем о двух плагинах-

вокальных гармонизаторах, которые на наш взгляд отличаются  

в лучшую сторону. 
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2.5.1. Steinberg VoiceMachine Generator  

Steinberg VoiceMachine Generator (рис. 2.27) — гармонизатор, 

позволяющий создать целую вокальную партитуру (многоголос-

ный хор) из одного-единственного голоса. 

На первый взгляд, окно плагина Steinberg VoiceMachine 

Generator выглядит сложновато. Если же вглядеться, то становится 

ясно, что в нем можно выделить четыре одинаковых модуля.  

В верхней части каждого модуля располагаются регуляторы 

параметров вибрато: Rate — частота вибрато, Depth — его глу-

бина, Delay — задержка начала вибрато относительно начала 

очередного звука, спетого вокалистом. Кнопками SINE, SAW, 

TRI выбирают форму колебания на выходе низкочастотного ге-

нератора, управляющего вибрацией.  

 

Рис. 2.27. Окно плагина Steinberg VoiceMachine Generator 
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В раскрывающемся списке Tmp Sync выбирают длительность 

(от целой ноты до тридцатьвторой триоли), с которой будет син-

хронизировано вибрато. Если выбрать no sync, то вибрато не бу-

дет синхронизировано с темпом композиции. Кнопка Modulation 

Link позволяет связать друг с другом одноименные регуляторы 

всех модулей. 

В нижней части каждого модуля находятся три регулятора.  

 Gain — регулятор, управляющий громкостью звучания данно-

го голоса в миксе обработанных голосов.  

 Formant — регулятор сдвига формантной области в синтези-

руемом голосе. Положительные значения соответствуют более 

высоким голосам (вплоть до эффекта "смены пола" певца  

с мужского на женский). Отрицательные значения параметра 

позволяют "превратить" женский голос в мужской, тенор  

в баритон, а баритон в бас. 

 Fine — регулятор точной подстройки высоты тона в преде- 

лах 50 центов с шагом в 1 цент. 

Регулятор Balance управляет позицией обработанного голоса 

на стереопанораме. 

В верхнем положении регулятора Mix на выход плагина по-

ступает только обработанный сигнал, в нижнем — только исход-

ный. В промежуточных положениях регулятора эти сигналы 

микшируются в определенной пропорции. 

Регулятором Humanizer в формируемые голоса вносятся  

небольшие частотные и временны́е различия, имитирующие не-

идеальность звучания настоящего хора. 

Если нажать кнопку Setup, то откроется вкладка, на которой 

для управления рядом элементов (они выделяются черным цве-

том) можно задать определенные MIDI-сообщения.  

Четыре модуля позволяют одновременно сформировать четы-

ре голоса. А пятый голос (вернее, он-то как раз и есть первый) — 

исходный, тот, что записан на обрабатываемом треке. Хор не хор, 

но уж, во всяком случае, квинтет в вашем распоряжении может 

оказаться. 

Над клавиатурой и под модулями находятся четыре раскры-

вающихся списка, в каждом из которых можно выбрать источник 
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MIDI-сообщений, управляющих формированием голосов. Если 

выбрать вариант Int. Keyb, то управление данным формировате-

лем голоса будет осуществляться с внутренней виртуальной кла-

виатуры. Вариант All Chan означает, что высота тона в данном 

формирователе голоса будет управляться MIDI-сообщениями  

типа Note (сообщение о нажатии клавиши), поступающими по 

любому из 16 MIDI-каналов. Это удобно в том случае, когда по-

следовательность аккордов записана на одном MIDI-треке или 

исполняется в реальном времени на подключенной к программе-

хосту MIDI-клавиатуре.  

Но для каждого модуля формирования голоса можно выбрать 

конкретный MIDI-канал. Это удобно в том случае, когда ноты 

последовательности аккордов записаны на разных MIDI-треках 

проекта. Также только этот вариант пригоден в том случае, когда 

в проекте кроме MIDI-треков, управляющих данным экземпля-

ром плагина VoiceMachine Generator, имеются и несколько MIDI-

треков, на которых записаны либо партии музыкальных инстру-

ментов, либо последовательности аккордов, управляющие дру-

гими экземплярами плагина VoiceMachine Generator. Кстати го-

воря, если ваш компьютер справится, то вы можете размножить 

исходную вокальную партию на несколько аудиотреков и к каж-

дому подключить по экземпляру VoiceMachine Generator. Такой 

способ позволит вам наращивать количество виртуальных хори-

стов (4 + 4 + 4 + …). 

Мы несколько вечеров испытывали плагин VoiceMachine Ge-

nerator и пришли к выводу, что с его помощью можно получить 

достойно звучащий хор. Правда, поставив перед собой задачу во 

всей песне заменить вокальное соло на вокальное многоголосье, 

придется серьезно потрудиться.  

Основная проблема заключается в "грязи", которая неизбежно 

возникает в тех местах, где смена ноты, спетой вокалистом, не 

совпадает по времени со сменой аккорда. Эти места требуют 

прецизионного редактирования. Также при варианте управления 

All Chan программа иногда начинает иначе (причем непредска-

зуемо) трактовать тот или иной аккорд: например, синтезирован-
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ный голос № 3 может формироваться то как тоника, то как тер-

ция, то как квинта аккорда.  

ПРИМЕЧАНИЕ  

Разработчики некоторых других вокальных гармонизаторв преду-
преждают о возможности возникновения подобных ошибок и сове-
туют организовывать управление голосами по принципу "одна но-
та — один MIDI-канал — один синтезированный голос". Думается, 
этот совет применим и к VoiceMachine Generator. 

Конечно, не следует увлекаться значительными измене-

ниями формант. Попытка виртуальной "смены пола" вокали-

ста дает звучание, не вызывающее ничего, кроме смеха. В ка-

честве спецэффекта это, возможно, и подойдет. Но если вы 

жаждете правдоподобности в звучании сформированной та-

ким противоестественным путем вокальной группы, то будете 

разочарованы. 

Наиболее же разумным применением плагина VoiceMachine 

Generator, на наш взгляд, является формирование коротких пар-

тий бэк-вокала. Из всех рассмотренных в данном разделе гармо-

низаторов VoiceMachine Generator позволил получить наиболее 

чисто звучащие голоса. Проблема заключается лишь в малодос-

тупности плагина. Ведь разработан он достаточно давно. И если 

некоторое время назад плагин был представлен на сайте 

http://www.steinberg.net/, то при подготовке материала книги мы 

не нашли на этом сайте информации о том, где и почем можно 

купить его лицензионную копию. А вот с приобретением сле-

дующего гармонизатора проблем сейчас нет. 

2.5.2. VirSyn KLON  

VirSyn KLON (рис. 2.28) позиционируется разработчиком (не-

мецкая компания VirSyn Software Synthesizer, http://www.virsyn.de/) 

как процессор обработки вокала, сочетающий в себе несколько 

функций. Стоимость плагина составляет 99 евро.  

На основе единственного голоса VirSyn KLON способен: 

 генерировать голоса хора, моделируя неидеальное звучание, 

характерное для реальных исполнителей;  
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Рис. 2.28. Окно плагина VirSyn KLON  

 гармонизировать вокальную партию, добавляя в нее еще  

до 4 голосов; 

 корректировать высоту тона в соответствии с заданным ладом 

и тоникой; 

 управлять формантами вплоть до преобразования женского 

вокала в мужской и наоборот. 

Формируемыми голосами можно управлять по MIDI (если  

в раскрывающемся списке, расположенном над изображением 

клавиатуры, выбрать вариант MIDI note). Аккорды можно либо 

брать в реальном времени на MIDI-клавиатуре, либо воспроиз- 

водить с MIDI-трека программы-хоста, к которой подключен  

плагин. 

В верхней области каждого модуля канала расположено коор-

динатное поле. Перемещая мышью вверх/вниз кружочек, симво-

лизирующий формируемый голос, можно задать фиксированное 

смещение высоты тона в полутонах, влево/вправо — положение 

голоса на стереопанораме. 
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Для каждого голоса в отдельности можно отрегулировать еще 

3 параметра:  

 Pitch — фиксированное смещение высоты тона в центах; 

 Formant — смещение формантной области;  

 Level — уровень громкости. 

Остальные элементы управления мы не будем рассматривать, 

т. к. они имеют отношение не к гармонизации, а к коррекции высоты 

тона. А с этой задачей плагин справляется хуже, чем специализиро-

ванные программы. С ними вы можете познакомиться по материа-

лам статей [65, 82, 92], имеющихся на сайте http://petelin.ru/. 

О программах, предназначенных для редактирования аудио-

материала, можно писать бесконечно. Думается, сказано уже 

достаточно для того, чтобы стало ясно главное: они способны 

выполнять практически любое преобразование звука, которое 

только можно себе вообразить.  

 



 

 

Работа со звуковым  
редактором Adobe Audition  
на элементарном уровне 

Adobe Audition (http://www.adobe.com/) — программа, при-

надлежащая к числу наиболее мощных звуковых редакторов. На 

момент написания книги актуальна третья версия программы.  

Если попытаться кратко охарактеризовать возможности Adobe 

Audition, то можно утверждать, что в умелых руках программа 

при работе со звуком способна на все. И это не будет преувели-

чением.  

В Adobe Audition есть два принципиально различных режима 

работы: редактирование отдельных аудиофайлов и совместное 

мультитрековое редактирование совокупности аудиофайлов. Для 

каждого режима предусмотрены свое главное меню и свое глав-

ное окно: Edit View (рис. 3.1) и Multitrack View (рис. 3.2) — два 

различных по назначению звуковых редактора, объединенных  

в функциональный комплекс. Операции редактирования, выпол-

няемые в режиме Edit View (вырезание, вставка, обработка эф-

фектами и т. п.), по своей сути являются разрушающими, и когда 

вы сохраняете аудиофайл, изменения вносятся непосредственно  

в него. Редактирование, выполненное в режиме Multitrack View 
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(перенос, склейка блоков, изменение громкости, панорамы, па-

раметров эффектов реального времени и т. п.), является неразру-

шающим. 

В Adobe Audition вы можете использовать как встроенные  

в программу эффекты, так и VST- либо DX-плагины.  

В Adobe Audition предусмотрены два варианта использования 

эффектов: применение эффекта в реальном времени и пересчет 

звуковых данных. Первый вариант удобнее, поскольку, регули-

руя параметры эффекта, вы тут же слышите результат. Однако 

для этого требуется высокопроизводительный компьютер. При-

менение эффекта путем пересчета позволяет обрабатывать звуко-

вые данные с помощью относительно "слабого" компьютера, но 

процесс обработки может продолжаться десятки минут. 

Основной способ применения эффектов в режиме Edit View — 

пересчет звуковых данных. Полноценный режим реального вре-

мени здесь не обеспечен. Однако замена ему все же имеется.  

В окне эффекта доступна кнопка Preview (предварительное про-

слушивание, проба в реальном времени), поэтому вы сможете 

подобрать параметры эффекта.  

В режиме Multitrack View поддержка эффектов реального 

времени предусмотрена. Цепочка эффектов монтируется с помо-

щью виртуальной рэковой стойки в окне Effects Rack (рис. 3.3). 

Вы уже знаете, что Adobe Audition — мультитрековая среда, 

позволяющая поместить любое число аудиофайлов (блоков) на 

различные треки как для параллельного воспроизведения, так  

и для последующего объединения всех треков в один. Процесс 

микширования включает объединение всех блоков, размещенных 

на треках, в два (или больше) каналов вывода. Для этого имеется 

специальное окно Mixer (рис. 3.4). 

В режиме Multitrack View реализованы современные техно-

логии редактирования с использованием огибающих автоматиза-

ции — графиков изменения состояния регуляторов. Эффекты ре-

ального времени можно применять не только к отдельным 

трекам, но и к группам треков, объединенных в шины. С помо-

щью микшера можно маршрутизировать сигнал между отдель-

ными эффектами, подключенными к шине.  
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Рис. 3.2. В режиме Multitrack View монтируют и сводят аудиокомпозицию 

 

Рис. 3.3. В окне Effects Rack смонтированы два эффекта  
и отображается панель многополосного компрессора 
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Рис. 3.4. В мультитрековом режиме предусмотрен удобный микшер 

Программа сама распознает VST- и DX-эффекты, установлен-

ные в системе, и оценивает свою совместимость с ними. 

Если производительность процессора и жесткого диска мала, 

то большое количество подключенных эффектов будет тормозить 

работу. На этот случай предусмотрена операция "заморажива-

ния" аудиотрека. После нажатия на микшере кнопки Freeze 

Track программа пересчитает аудиоданные на треке с учетом 

состояния всех регуляторов микшера, значений параметров под-
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ключенных эффектов и вида огибающих автоматизации. Экономия 

ресурсов компьютера достигается благодаря тому, что аудиодан-

ные с "замороженного" трека нужно всего лишь воспроизводить,  

а вот аудиоданные с обычного трека в процессе воспроизведения 

нужно еще и успевать обрабатывать в соответствии с многочис-

ленными и сложными вычислительными алгоритмами, на кото-

рых базируются эффекты. Повозились с одним треком, подобра-

ли приблизительно параметры его обработки — "замораживайте" 

его на некоторое время и работайте с другим треком. При необ-

ходимости внесения изменений можно "разморозить" трек с по-

мощью той же кнопки.  

Кроме аудиофайлов различных форматов (например, WAV) 

Adobe Audition позволяет использовать сессионные (Session) 

файлы (с расширением SES). Мы бы назвали WAV-файлы стан-

дартными блоками, партиями, из которых строится любая аудио-

композиция, например, песня. Тогда можно считать, что сесси-

онный файл — это и есть собственно песня (партитура), хотя  

в SES-файле фактически нет никаких звуковых данных. По раз-

меру SES-файл очень мал. Он содержит только подробные указа-

ния программе Adobe Audition в виде следующих данных: 

 имена используемых аудиофайлов и пути к ним; 

 имена треков; 

 моменты времени включения и выключения воспроизведения 

определенного аудиофайла;  

 уровень аудиосигнала и панорама, устанавливаемые перед на-

чалом воспроизведении каждого аудиофайла, и законы изме-

нения этих параметров в процессе воспроизведения; 

 подключенные эффекты реального времени и законы измене-

ния их параметров. 

К имевшимся в ранних версиях программы средствам анализа 

свойств обрабатываемого звука, таким как анализаторы текущего 

и мгновенного спектра (сонограмма) (см. разд. 1.3.2), позднее 

добавился виртуальный стереогониометр (см. разд. 1.3.3), позво-

ляющий по виду фигур Лиссажу оценить качество стереополя  

(в частности — моносовместимость создаваемой композиции). 
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Рис. 3.5. Отображение сигналограммы в режиме Top/Tail Views 

Для просмотра и редактирования сигналограмм в Edit View 

удобен режим Top/Tail Views (рис. 3.5): в одном и том же окне  

в левой секции детально отображается начальный фрагмент аудио-

файла, в правой секции — его финальный фрагмент, а в секции, 

расположенной посередине, обзорно — весь аудиофайл. Дли-

тельность отображаемых "крайних" фрагментов можно выбирать 

произвольным образом. Режим включается и выключается ко-

мандой View > Top/Tail Views главного меню. При воспроизве-

дении аудиофайла вы первым делом услышите его начало, а по-

том указатель текущей позиции перескочит в правую секцию,  

и вы услышите концовку. 

А как удобно обрабатывать начало и окончание аудиофайла, 

создавая Fade In (плавное увеличение громкости) и Fade Out 

(плавное уменьшение громкости! Выберите команду View >  

On-clip UI и в окне Edit View (в его верхних углах) появятся два 

хендла (элементы управления интерактивными графиками).  

Захватите, например, левый хендл мышью, — и тут же станет 

видимым график, определяющий характер нарастания громкости 

звука в начале аудиофайла. Перемещая хендл мышью, можно 
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придать графику любую форму (рис. 3.6). При этом вы будете 

видеть и то, как изменится сигналограмма, если к ней применить 

Fade In. Стоит отпустить кнопку мыши — и программа выполнит 

расчеты, претворяя в жизнь задуманное вами преобразование. 

В режиме Edit View предусмотрены несколько вариантов ото-

бражения и редактирования аудиоданных Прежде всего это 

Waveform Display (редактирование сигналограммы) и Spectral 

Frequency Display (редактирование мгновенного спектра — со-

нограммы). Отображать сонограмму могут многие звуковые ре-

дакторы, а вот возможность ее редактирования предоставляет 

лишь Adobe Audition. Однако на этом чудеса еще не заканчивают-

ся. В Adobe Audition имеются совершенно уникальные инстру-

менты редактирования звуковых данных в Edit View. В режиме 

Spectral Pan Display можно наблюдать и редактировать распре-

деление спектральных компонент сигнала по панораме, а в ре-

жиме Spectral Phase Display аналогичные операции можно вы-

полнять с графиками фазового спектра. Поскольку аналогов этим 

инструментам нет, создание методик их использования при обра-

ботке звука — задача будущего. 

 

Рис. 3.6. Предельно упрощено выполнение операций Fade In и Fade Out 
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Еще одна особенность Adobe Audition 3 — встроенный MIDI-

секвенсор. В предыдущих версиях Adobe Audition в режиме 

Multitrack View была предусмотрена возможность импортиро-

вать в программу один готовый MIDI-файл (при этом автомати-

чески создавался единственный MIDI-трек). Воспроизводить 

MIDI-сообщения можно было только аппаратным синтезато-

ром, подключенным к выходному порту этого MIDI-трека. Ре-

дактировать MIDI-композицию было нельзя. Сейчас поддержка 

MIDI получила некоторое развитие. В многоканальный проект 

теперь можно вставлять неограниченное число MIDI-треков. 

Для каждого из них можно открыть окно несложного секвенсора, 

в котором MIDI-сообщения отображаются в виде "отпечатков 

клавиш" (Piano Roll). Сигнал с каждого MIDI-трека можно подать 

на виртуальный синтезатор (VSTi). Таким образом, звуковой ре-

дактор Adobe Audition становится все более похожим на вирту-

альные студии Cakewalk SONAR [26, 30] и Steinberg Cubase [28]. 

Но в сравнении с MIDI-редакторами, входящими в состав вирту-

альных студий, MIDI-секвенсор Adobe Audition пока что выгля-

дит примитивно. Да и работает он (в отличие от шлифуемой на 

протяжении многих лет аудиосоставляющей программы Adobe 

Audition) крайне неустойчиво.  

Надеемся, что заинтересовали вас возможностями Adobe 

Audition, и предлагаем познакомиться с основами применения 

этой замечательной программы. 

3.1. Подготовка Adobe Audition  

к работе 

В принципе, вы можете начать работу с Adobe Audition, не 

выполняя никаких специальных настроек. Аудиофайл, загружен-

ный в Adobe Audition, будет звучать, запись будет осуществляться. 

Однако по мере освоения работы с программой и в случае воз-

никновения каких-либо проблем вам придется заглянуть в меню 

Options и в окно Preferences.  

В меню Options собраны команды (у некоторых из них есть 

подменю), определяющие не самые важные параметры режимов 
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функционирования Adobe Audition. Поэтому просто перечислим 

их с минимальными пояснениями: 

 Loop Play Mode — включение режима циклического воспро-

изведения; 

 Timed Record Mode — включение записи по таймеру; 

 Metering — подменю, позволяющее настроить свойства изме-

рителя уровня аудиосигнала; 

 MIDI Trigger Enable — включение режима управления про-

граммой по MIDI-интерфейсу; 

 Syncronize Cursor Across Windows — включение режима со-

хранения местоположения курсора или выделенного участка 

сигналограммы при переходе от одного открытого файла  

к другому (это полезно при монтаже фонограмм, например: 

режим включен, вы работаете с файлом 1.WAV и выделили 

фрагмент в интервале от 0:01:00 до 0:02:00; если затем пере-

ключить главное окно на просмотр файла 2.WAV, то в этой 

сигналограмме тоже будет выделен фрагмент от 0:01:00  

до 0:02:00); 

 Windows Recording Mixer — вызов диалогового окна стан-

дартного микшера Windows (команда недоступна, если в сис-

теме установлен виртуальный микшер, специально предназна-

ченный для управления вашей звуковой картой); 

 Start Default Windows CD Player — запуск CD-плеера, пре-

дусмотренного в Windows по умолчанию; 

 Preroll and Postroll Options — настройка функции предвари-

тельного прослушивания аудиофайла при работе с эффектами, 

не поддерживающими режим реального времени. 

С помощью опций диалогового окна Preferences можно вне-

сти тонкие изменения во взаимодействие программы с оборудо-

ванием, настроить некоторые параметры обработки аудио- 

данных, подстроить интерфейс программы под собственные 

потребности. О назначении этих опций вы узнаете, прочитав 

следующий раздел. 
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3.1.1. Выбор основных установок 

программы с помощью окна Preferences 

Команда Edit > Preferences главного меню открывает диалого-

вое окно Preferences, содержащее 8 вкладок: General, System, 

Colors, Display, Data, Multitrack, SMPTE и External Controllers. 

Поочередно открывая вкладки, задают основные установки про-

граммы.  

Вкладки Colors, SMPTE/MTC и External Controllers мы 

лишь вкратце прокомментируем. 

С помощью опций вкладки Colors можно задавать цвета эле-

ментов интерфейса программы. Цветовое оформление не оказы-

вает непосредственного влияния на качество работы программы. 

Назначение опций вкладки Colors интуитивно понятно: выделяе-

те в списке название того или иного элемента интерфейса, и его 

цвет отображается в небольшом поле. Если появляется желание 

изменить окраску, сделайте это, открыв кнопкой Tint стандарт-

ное окно Windows, предназначенное для настройки цвета. 

Вкладка SMPTE/MTC содержит опции, определяющие пара-

метры синхронизации по интерфейсу SMPTE. Для большинства 

компьютерных музыкантов эта вкладка не представляет интере-

са. Ведь в домашних студиях очень редко возникает необходи-

мость сведéния аудиоматериала, записанного на нескольких раз-

личных устройствах. 

Для управления параметрами программы можно использовать 

внешние аппаратные устройства. При этом появляется возмож-

ность нажимать реальные кнопки и крутить реальные ручки, вме-

сто того чтобы щелкать кнопками мыши на виртуальных элемен-

тах пользовательского интерфейса. По сути, такое устройство 

является специализированным MIDI-контроллером. С компьюте-

ром оно соединяется посредством MIDI-интерфейса. Для взаимо-

действия с ним необходимо установить соответствующий драйвер. 

А уже в самой программе Adobe Audition можно сопоставить эле-

менты регулировки и коммутации, имеющиеся на внешнем уст-

ройстве управления, конкретным параметрам программы. Для этого 

предназначены опции вкладки External Controllers. В домашней 
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студии начинающего компьютерного музыканта такое устройство 

вряд ли имеется. Это, скорее, актуально для профессионалов. По-

этому настройка Adobe Audition для работы с устройствами 

управления рассмотрена в книге [29], адресованной подготов-

ленным читателям. 

А вот о настройке параметров на вкладках General, System, 

Display, Data и Multitrack поговорить нужно подробнее.  

Общие установки (вкладка General) 

Вкладка General (рис. 3.7) диалогового окна Preferences со-

держит опции, определяющие общие установки программы. 

В левой верхней части вкладки располагаются 3 флажка: 

 Force Spacebar to always trigger play — после нажатия кла-

виши <пробел> включать режим воспроизведения независимо 

от того, какое из открытых окон имеет фокус; 

 

Рис. 3.7. Вкладка General диалогового окна Preferences 
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 Auto play on external launch — автоматически включать ре-

жим воспроизведения при запуске программы из командной 

строки с именем аудиофайла в качестве параметра; 

 Auto-scroll during playback and recording — при воспроизве-

дении указатель текущей позиции оставлять на месте (сигна-

лограмма будет смещаться относительно него). 

В группе Upon a manual scroll/zoom/selection change задается 

логика организации прокрутки экрана в тех случаях, когда в про-

цессе воспроизведения или записи вы изменяете границы выде-

ленного фрагмента или масштаб отображения сигналограммы: 

 Abort auto-scrolling until next play/record — прокрутка будет 

остановлена, для ее возобновления нужно вновь включить ре-

жим записи или воспроизведения; 

 Resume auto-scrolling only after play cursor enters view — 

возобновить прокрутку после того, как указатель текущей по-

зиции войдет в отображаемый на экране участок сигнало-

граммы; 

 Resume auto-scrolling immediately — возобновить прокрутку 

немедленно. 

Поле ввода frames/sec в группе Custom Time Code Display 

служит для выбора пользовательского формата кодирования 

времени (Часы:Минуты:Секунды:Кадры), в котором можно из-

менять только количество кадров в секунду. 

В группе Mouse Wheel имеется единственное поле ввода Zoom 

Factor: … %, предназначенное для выбора коэффициента чувст-

вительности колеса мыши. 

В группе Edit View Right-Clicks находятся переключатели, 

определяющие функцию щелчка правой кнопкой мыши на поле 

отображения сигналограммы. Если выбрана опция Popup Menu 

(use Shift+Click to extend), то щелчок правой кнопкой мыши от-

кроет контекстное меню, а щелчок левой кнопкой мыши при на-

жатой клавише <Shift> позволит изменить границы выделенного 

участка сигналограммы. Если выбрана опция Extend Selection 

(hold Ctrl for popup menu), то перемещение указателя мыши при 

нажатой правой кнопке мыши приведет к изменению границы 

выделенного участка сигналограммы. Для вызова контекстного 
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меню в этом случае нужно сначала нажать клавишу <Ctrl>, а по-

том щелкнуть правой кнопкой мыши. 

Переключатели группы Edit View Selections позволяют изме-
нять область сигналограммы, считающуюся выделенной по умол-

чанию. Если выбрана опция View, то выделенным по умолчанию 
будет считаться фрагмент сигналограммы, отображаемый на рабо-

чем поле главного окна. Если выбрать опцию Entire file, то выде-
ленной по умолчанию будет считаться вся текущая сигналограмма 
(включая и те ее участки, которые в данный момент могут быть не 
видны из-за того, что выбран крупный масштаб отображения).  
Установка, выполненная в данной группе, играет существенную 
роль в процессе обработки сигналограммы эффектами. Дело в том, 
что если вы предварительно не выделите специально какой-либо 
фрагмент сигналограммы, то эффект будет применен к той облас-
ти, которая считается выделенной по умолчанию. 

Если флажок Select audio after paste установлен, то фрагмент 
звуковых данных, только что вставленный в текущую сигнало-
грамму, будет выделен (подсвечен, по умолчанию белым цве-
том). В противном случае вставленный фрагмент окажется невы-
деленным и его трудно будет отличить от звуковых данных, уже 
имеющихся в этой сигналограмме. 

Системные установки программы  
(вкладка System) 

Опции вкладки System (рис. 3.8) диалогового окна Prefe-

rences позволяют изменить системные установки программы.  
Самая первая и самая важная рекомендация: если вы до конца 

не разобрались в назначении опций этой вкладки, постарайтесь 
ничего не менять! Обращайтесь к ней лишь в случае крайней не-
обходимости и только после ознакомления с назначением опций 

вкладки System, приведенным ниже. 

Поле ввода Cache Size … MB  в группе Wave Cache опреде-
ляет размер кэш-памяти. Программа позволяет свободно опери-
ровать аудиофайлами, длительность звучания которых достигает 
десятков минут, а объем — сотен мегабайт. При необходимости 
Adobe Audition использует свободное пространство жесткого 
диска. Скорость обмена с винчестером значительно меньше, чем 
с оперативной памятью, а при обработке звука программе прихо-
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дится многократно обращаться к отдельным отсчетам аудиофай-
ла. Если бы каждый раз происходили обращения только к жест-
кому диску, то, например, создание эффекта реверберации для 
аудиофайла большого объема заняло бы несколько часов (а мо-
жет, и суток). Выход из подобной ситуации в том, что фрагмент 
данных, обрабатываемый в текущий момент, заносится в опера-
тивную память, и там над ним выполняются все необходимые опе-
рации. Затем уже обработанный фрагмент вновь записывается на 
диск, а в оперативную память считывается очередной блок данных. 
Так продолжается до тех пор, пока не будут обработаны все данные. 
Чем больше объем информации, временно помещаемой в опера-
тивную память, тем за меньшее время завершится процесс обра-
ботки, однако зависимость между этими величинами не является 
линейной. Описанная технология, как известно, называется кэши-
рованием, а область памяти, в которую загружается блок обраба-
тываемых данных, — кэш-памятью. В зависимости от объема 
оперативной памяти вашего компьютера рекомендуется занимать 
под кэш-память от 8 до 32 мегабайт.  

 

Рис. 3.8. Вкладка System диалогового окна Preferences 
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В полях Primary Temp и Secondary Temp группы Temporary 

Folders следует указать основную и дополнительную папки для 

хранения временных файлов. В целях повышения производи-

тельности программы эти папки рекомендуется размещать на 

разных физических дисках. Выбор диска и папки осуществляется 

с помощью кнопок, помеченных тремя точками. 

Группа Enable Undo содержит опции управления функцией 

возврата к предыдущим этапам редактирования данных:  

 Enable Undo — флажок включения/отключения режима от-

мены операций с количеством уровней, заданным в поле ввода 

Levels (minimum);  

 Purge Undo — кнопка удаления служебной информации, необ-

ходимой для выполнения операции отмены с количеством 

уровней выше заданного.  

Если за сессию работы с программой вы произвели, скажем, 

10 операций и нажали кнопку Purge Undo (при максимальном 

количестве уровней отмены, например, 5), то отменить после это-

го можно будет не все 10, а только последние 5 операций. Ино-

гда, если на диске мало свободного места, действительно есть 

смысл ограничить возможности возврата к далеким предыдущим 

версиям редактирования аудиофайла. 

Раскрывающийся список Default file filter when opening 

WAV files позволяет задать разновидность файлов с расширени-

ем WAV, которая будет выбираться при загрузке. В большинстве 

случаев таким типом файлов должен быть Windows PCM.  

Если установлен флажок Default format for Open dialogs, то 

станет доступным раскрывающийся список, где можно выбрать тип 

аудиофайлов, на который по умолчанию будет настроен фильтр 

окна загрузки файлов. Если установлен флажок Default format 

for Save As dialogs, то аналогичное назначение можно выполнить 

и для окна сохранения файлов. 

В поле Replace invalid filename characters with this character 

(blank to remove) нужно ввести символ, которым при импортиро-

вании треков с CD Digital Audio в имени трека будут замещаться 

недопустимые символы. Если поле оставить чистым, то недопус-

тимые символы будут удаляться.  
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Осталось рассмотреть назначение трех флажков, расположен-

ных в левой нижней части вкладки System. 

Если установлен флажок Auto-Save for Recovery, то про-

грамма чаще обычного будет выполнять автосохранение резуль-

татов вашей работы в файле. Если сбои системы и отключение 

питания у вас происходят редко, то флажок можно не устанав- 

ливать. 

Если установлен флажок Delete clipboard files on exit, то при 

выходе из программы данные из буфера обмена будут удалены.  

В противном случае они остаются в буфере обмена и могут быть 

использованы в других приложениях. 

Adobe Audition позволяет избегать непосредственной работы  

с загруженными аудиофайлами. Если в режиме редактирования 

сигналограммы (Edit View) воспользоваться командой File > 

Flush Virtual File, то вся информация из текущего файла неза-

метно для пользователя скопируется в одну из папок, предназна-

ченных для хранения временных файлов, а сам исходный файл  

с точки зрения операционной системы будет закрыт. Благодаря 

этому другие приложения смогут работать с данным файлом. 

Средствами Windows вы можете переименовать загруженный 

ранее в Adobe Audition файл или даже удалить его, но при рабо-

те с этим файлом в Adobe Audition все будет выглядеть так, 

словно с ним ничего не произошло. Завершив его обработку, вы 

можете воспользоваться командой сохранения, и ваш уже отре-

дактированный файл окажется на своем прежнем месте. Такой 

способ работы с файлами называется flushing. На случай воз-

никновения каких-либо проблем при сохранении редактируемо-

го файла поверх его исходной версии (с тем же именем) преду-

смотрен флажок Force complete flush before saving, который по 

умолчанию снят. Если его установить, то непосредственно пе-

ред сохранением аудиофайла незаметно для пользователя будет 

автоматически выполняться команда Flush Virtual File (если 

ранее она не была выполнена вручную). То есть сначала аудио-

данные будут скопированы в папку для временных файлов, ис-

ходный файл будет закрыт, и только потом будет выполнена 

команда сохранения. Естественно, это замедлит выполнение 

команды сохранения.  
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Параметры отображения (вкладка Display) 

С помощью опций вкладки Display (рис. 3.9) диалогового ок-

на Preferences можно изменять параметры отображения.  

Программа позволяет отображать аудиофайл в спектральном 

(сонограмма) и временнóм (сигналограмма) представлении. 

Параметры спектрального отображения определяются опция-

ми группы Spectral Display. 

Раскрывающийся список Windowing Function содержит пе-

речень алгоритмов преобразования, используемых для отображе-

ния спектра сигнала. Алгоритмы отличаются друг от друга видом 

функции, с помощью которой в процессе вычисления спектра 

учитывается предыстория анализируемого сигнала. Если у вас не 

выработалась привычка применять какой-либо определенный 

алгоритм спектрального анализа, то не имеет большого значения, 

какую именно строку вы выберете в этом списке. Разница между 

ними на практике слабо ощутима. 

 

Рис. 3.9. Вкладка Display диалогового окна Preferences 
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Раскрывающийся список Resolution … Bands позволяет вы-

брать разрешение при представлении сигнала в виде спектра. Чем 

больше полос, на которые будет разбит диапазон анализируемых 

частот, тем точнее анализ, но и вычисления потребуют больше 

времени. Так как спектральный анализ проводится на основе алго-

ритмов быстрого преобразования Фурье (БПФ), значение парамет-

ра Resolution … Bands численно равно размеру выборки. 

В поле ввода Window Width … % можно задать ширину 

спектрального окна, выраженную в процентах по отношению  

к размеру выборки. Рекомендуется оставлять эту величину рав-

ной 100 %. 

В поле Decibel Range ... dB задается диапазон логарифмиче-

ской шкалы (в децибелах) при отображении спектра. 

Группа Top/Tail Views содержит опции управления режимом 

Top/Tail Views (см. рис. 3.5): в одном и том же окне в левой сек-

ции детально отображается начальный фрагмент аудиофайла,  

в правой секции — его финальный фрагмент, а в секции, распо-

ложенной посередине, обзорно — весь аудиофайл. Режим вклю-

чается и выключается командой View > Top/Tail Views главного 

меню. Длительность отображаемых по умолчанию "крайних" 

фрагментов можно выбирать произвольным образом в поле Ini-

tial Viewing Range: … seconds. Если установлен флажок Link 

Top/Tail zoom levels, то при изменении масштаба отображения 

сигналограммы в левой секции будет автоматически изменен 

масштаб в правой секции (и наоборот). 

В группе Waveform Display сосредоточены элементы управ-

ления, позволяющие выбрать стиль и параметры отображения 

сигналограммы. Прежде всего, это 4 флажка: 

 Show Marker and Range Lines — включение отображения 

линий, обозначающих границы фраз; 

 Show Grid Lines — включение отображения линий коорди-

натной сетки; 

 Show Center Lines — включение отображения центральной 

горизонтальной линии координатной сетки (линии нулевого 

значения сигнала, или уровня – ); 

 Show Boundary Lines — включение отображения ограничи-

тельных линий координатной сетки. 
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Значение, заданное в поле Display Lines at … dB (в децибелах), 

определит положение ограничительных горизонтальных линий, 

служащих своеобразным ориентиром для визуальной оценки уров-

ня сигнала. 0 дБ соответствует максимальной возможной величине 

амплитуды сигнала. При превышении этого уровня происходит 

ограничение сигнала, сопровождающееся заметными на слух ис-

кажениями. Установив значение Display Lines at … dB равным, 

например, –1 дБ и следя, чтобы изображение сигналограммы не 

пересекало ограничительные линии, вы можете с большой вероят-

ностью избежать возникновения искажений. 

Рассмотрим группу Peak Files. 

В поле Peaks Cache … /Clip следует задать количество отсче-

тов в блоке данных при записи/считывании информации из слу-

жебных файлов (PEAK-файлов), предназначенных для ускорения 

операций загрузки WAV-файлов и отображения сигналограмм. 

При работе с WAV-файлами большого размера (десятки и сотни 

мегабайт) рекомендуется увеличить это значение до 1024. 

Если установлен флажок Save Peak Cache Files, то Adobe 

Audition будет сохранять как WAV-файлы, так и файлы с расши-

рением PK. Эти файлы содержат информацию, позволяющую зна-

чительно ускорить прорисовку сигналограммы на экране при  

повторной загрузке соответствующего WAV-файла. Когда со вре-

менем объем памяти, занимаемой PEAK-файлами, станет непри-

емлемо большим, можно удалить наиболее "древние" из этих фай-

лов. Главное — случайно не удалить нужный WAV-файл! 

Нажатие кнопки Rebuild Wave Display Now приводит к об-

новлению (перерисовке) сигналограммы.  

При установленном флажке Show on-clip gain control when 

there is no selection range в режиме Edit View, если даже не вы-

делен участок сигналограммы, будет отображаться регулятор 

усиления. 

Параметры обработки звуковых данных 

(вкладка Data) 

С помощью опций вкладки Data (рис. 3.10) диалогового окна 

Preferences можно управлять параметрами обработки звуковых 

данных. 
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Рис. 3.10. Вкладка Data диалогового окна Preferences 

Если установлен флажок Auto-convert all data to 32-bit upon 

opening, то при открытии файла все аудиоданные будут автома-

тически преобразованы в 32-битный формат. 

Установленный флажок Interpret 32-bit PCM .wav files as 

16.8 float включает режим совместимости 32-битных файлов 

формата WAV PCM с форматом представления данных в старых 

версиях Cool Edit Pro. 

Для внутреннего представления звука, как и многие другие 

современные звуковые редакторы, Adobe Audition использует 

больше 16 двоичных разрядов. За счет такого расширения дина-

мического диапазона представления цифрового сигнала сущест-

венно уменьшается погрешность, накапливающаяся при выпол-

нении операций над звуковыми данными. Однако после всех 

преобразований, необходимых для создания того или иного эф-

фекта, эти данные конвертируются в обычный 16-битный фор-

мат. При этом динамический диапазон сигнала вновь сужается  
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до стандартных 96 дБ. Конечно, часть полезной информации те-

ряется после выполнения преобразований звука. Чтобы такая по-

теря не стала заметной на слух, ее можно компенсировать добав-

лением псевдослучайного шума с очень маленькой амплитудой. 

При этом динамический диапазон сигнала как бы остается на 

уровне 105 дБ, что соответствует 24-битному представлению 

сигнала. С позиций математики такого быть не может, но благо-

даря особенностям человеческого слухового восприятия при  

добавлении псевдослучайного шума возникает ощущение, что  

качество звука оказывается выше, чем при 16-разрядном пред-

ставлении. Такой подход используется и в Adobe Audition. Вклю-

чение/выключение эффекта кажущегося расширения динамиче-

ского диапазона посредством дитеринга осуществляется при 

помощи флажка Dither Transform Results (increases dynamic 

range). 

Флажок Use Symmetric Dithering включает особый алгоритм 

дитеринга, при котором добавляемые отсчеты цифрового шума 

принимают как положительные, так и отрицательные значения  

и в среднем симметрично распределены в окрестностях нулевого 

значения. Такой алгоритм позволяет избежать появления посто-

янной составляющей в обработанном сигнале, а значит, и щелч-

ков на границах обработанного фрагмента. Желательно, чтобы 

флажок Use Symmetric Dithering был всегда установлен. 

Флажок Smooth Delete and Cut boundaries over … ms следует 

установить, чтобы сгладить фрагменты сигналограмм в местах 

сращивания при выполнении операций Cut и Delete и устранить 

слышимые щелчки. В соответствующем поле следует указать дли-

тельность (в миллисекундах) интервала, в течение которого пре-

дыдущий фрагмент плавно перейдет в следующий. 

Установленный флажок Smooth all edit boundaries by cross-

fading … ms означает, что будет производиться сглаживание на 

границе редактируемых фрагментов — операция, аналогичная 

кроссфейду (crossfade, уменьшение амплитуды сигнала предше-

ствующего фрагмента с одновременным увеличением амплитуды 

сигнала текущего фрагмента). Время, за которое осуществляются 

плавный набор и сброс громкости, задается в соответствующем 

поле (в миллисекундах). 
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В группе Auto-convert settings for Paste можно задавать па-

раметры автоматического конвертирования при выполнении опе-

рации вставки. Автоматическое конвертирование работает в том 

случае, когда формат вставляемого блока звуковых данных отли-

чается от формата редактируемого аудиофайла.  

В полях Downsampling quality level и Upsampling quality 

level некими безразмерными числами от 30 до 1000 задается точ-

ность выполнения операций понижения и повышения частоты 

сэмплирования.  

Флажок Pre-filter включает специальную фильтрацию оциф-

рованных звуковых данных перед понижением частоты дискре-

тизации. Флажок Post-filter включает фильтрацию после повы-

шения частоты дискретизации. 

В поле Dither amount for saving 32-bit data to 16-bit files … 

bits нужно указать число, определяющее величину псевдослу-

чайного сигнала, добавляемого для сохранения 32-разрядных 

данных в 16-разрядных файлах (от 0 до 1). Значение 1 включает 

режим добавления псевдослучайного сигнала, 0 — отключает 

его. Для частичного подмешивания псевдослучайного сигнала 

введите значение 0.5. 

Флажок Allow for partially processed data after cancelling ef-

fect определяет порядок завершения процесса обработки аудио-

файла эффектом в том случае, когда вы прервали этот процесс, 

нажав кнопку Cancel в окне прогресс-индикатора. Если флажок 

снят, то результаты обработки аудиофайла будут аннулированы. 

Если флажок установлен, то та часть звуковых отсчетов, которую 

программа успела обработать, останется в сигналограмме и в со-

ответствующем аудиофайле именно в обработанном виде. 

Параметры мультитрекового редактирования  

(вкладка Multitrack) 

Adobe Audition является мультитрековым редактором. После 

того как произведено индивидуальное редактирование каждого 

из аудиофайлов, вы можете разместить их на отдельных треках и 

заняться монтажом проекта. О работе в мультитрековом режиме 

(Multitrack View) мы расскажем в разд. 3.6, 3.7. А сейчас рас-
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смотрим опции вкладки Multitrack (рис. 3.11) диалогового окна 

Preferences, определяющие некоторые параметры этого режима. 

В группе Defaults следует выбрать ряд параметров, которые 

будут установлены по умолчанию: 

 Recording Bit Depth — разрядность представления звуковых 

отсчетов при записи аудиофайла (16- или 32-битное); 

 Stereo Panning Mode — один из двух способов панорамиро-

вания: 

 Left/Right Cut (logarithmic) — логарифмическое панора-

мирование, при котором панорамирование влево получа- 

ется за счет снижения уровня сигнала в правом канале  

и наоборот; 

 -3dB Center — панорамирование с сохранением мощности, 

когда, например, при панорамировании в любую крайнюю 

точку панорамы громкость будет такой же, как и у сигна-

лов двух каналов при панорамировании в центр. 

 

Рис. 3.11. Вкладка Multitrack диалогового окна Preferences 
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В группе Audio Mix Down переключателями Bounce and 

Mixdown Bit Depth вы можете выбрать разрядность, с которой 

осуществляется микширование (объединение нескольких треков 

в один): 16-разрядное (16-bit) или 32-разрядное (32-bit). Целесо-

образно для всех промежуточных операций выбирать разряд-

ность, наибольшую из возможных, а к 16 битам переходить толь-

ко перед записью окончательно подготовленной фонограммы на 

носитель. 

Если выбрана разрядность 16 бит, то становятся доступными 

опции, связанные с дитерингом (добавлением псевдослучайного 

сигнала для уменьшения нежелательных эффектов процесса 

квантования). При установленном флажке Enable Dither дите-

ринг разрешен. Это не случайно: применять дитеринг есть смысл 

при переходе от высокой разрядности к более низкой (например, 

от 32-битного формата к 16-битному).  

Нажатие кнопки Dither Settings открывает одноименное диа-

логовое окно, предназначенное для выбора параметров дитеринга 

инойзшейпинга, сопровождающих понижение разрядности пред-

ставления звуковых данных. В этом окне совсем немного элемен-

тов, поэтому обойдемся без рисунка. В поле Dither Depth: … 

Bits можно выбрать уровень случайного шума в битах (опти-

мальный уровень шума варьируется в пределах от 0,2 до 0,5).  

В раскрывающемся списке Probability Distribution Function 

(функция распределения вероятности) задается модель шума. Ка-

кая из них подходит лучше применительно к конкретному звуко-

вому материалу — решать вам. 

Еще один метод борьбы с шумом квантования, нойзшейпинг, 

заключается в применении специальных алгоритмов округления 

значений отсчетов при понижении разрядности. После примене-

ния данного метода большая часть энергии шума квантования 

сосредотачивается в области высоких частот, к которым челове-

ческий слуховой аппарат наименее восприимчив. Обычно нойз-

шейпинг применяется совместно с дитерингом. В нижней части 

окна Dither Settings располагается раскрывающийся список 

Noise Shaping. В нем можно выбрать тип нойзшейпинга, соот-

ветствующий одному из вариантов распределения спектра шума 
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в полосе звуковых частот. Тем самым можно замаскировать шум 

квантования и шум, вносимый при применении дитеринга.  

Выбрав параметры дитеринга и нойзшейпинга, нажатием 

кнопки OK применим наш выбор и закроем диалоговое окно 

Dither Settings, возвратившись на вкладку Multitrack (см. рис. 3.11) 

диалогового окна Preferences. 

Группа Automation Optimizations содержит элементы, влияю-

щие на параметры автоматического микширования. 

Запись автоматизации может происходить в процессе воспроиз-

ведения проекта путем перемещения того или иного регулятора  

с помощью мыши. В режиме Touch, если регулятор "отпустить", 

он возвратится в исходное положение. В режиме Latch регулятор 

останется в том положении, в которое был перемещен вами. В поле 

Automatch Time … seconds следует указать время, в течение ко-

торого в режиме Touch автоматизируемые параметры будут воз-

вращаться к первоначальным значениям.  

При установленном флажке Linear Edit Point Thinning на 

графиках (огибающих) автоматизации параметров будут уда-

ляться лишние узлы, расположенные на участках, где значение 

параметра не изменяется. 

При установленном флажке Minimum Time Interval Thinning 

в поле Minimum Time … ms можно задать минимальный проме-

жуток времени между узлами огибающей автоматизации (в мил-

лисекундах). 

Рассмотрим назначение пяти флажков, расположенных в ниж-

ней части вкладки Multitrack. 

Если флажок Auto zero-cross edits установлен, то перед вы-

полнением операций редактирования (вырезание, удаление, 

вставка) границы выделенного участка будут автоматически пе-

ремещены к ближайшим точкам, в которых сигналограмма пере-

секает нулевую линию. Это позволит избежать щелчков в местах 

состыковки отредактированных фрагментов. 

Если флажок Smooth auto-scrolling during playback снят, то  

в мультитрековом редакторе используется страничная организа-

ция прокрутки изображения, экономящая ресурсы компьютера. 
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Если флажок установлен, то будет применен метод плавной про-

крутки, такой же как в редакторе сигналограмм. 

Флажок Use BWF Time Reference as insert start time следует 

установить, если вы намерены вставлять в мультитрековый про-

ект файлы в формате BWF (Broadcast Wave File), содержащие 

информацию о позиции начала аудиофайла относительно начала 

проекта.  

В Adobe Audition можно подключать к трекам эффекты реаль-

ного времени. После того как нужные эффекты подключены, 

трек можно заблокировать (заморозить). При этом фактически 

произойдет перерасчет аудиоданных трека с учетом применен-

ных к нему эффектов: где-то в папке для временных файлов поя-

вятся новые файлы и при воспроизведении трека будут считы-

ваться именно они. Если флажок Save frozen track audio files 

with sessions установлен, то временные файлы, содержащие ау-

диоданные замороженных треков, будут сохранены после закры-

тия сессии (обычно все временные файлы после закрытия сессии 

удаляются). Когда вы вновь вернетесь к сессии, необходимости  

в расчете этих файлов не будет и загрузка выполнится быстрее. 

Если флажок Play audio while scrubbing with the Start Time 

Indicator установлен, то перемещение правого или левого лока-

тора, которые в мультитрековом режиме указывают на границы 

выделенного участка проекта, будет сопровождаться воспроизве-

дением звука. Это поможет вам сориентироваться в проекте. При 

снятом флажке данное действие будет беззвучным. 

В поле Crossfade Time (For Overlapped Clips): … ms задает-

ся время перекрестного затухания, т. е. время, в течение которого 

выполняется кроссфейд, когда осуществляется запись нового 

фрагмента в существующий материал. Состыковка двух фраг-

ментов осуществляется не путем резкого выключения одного  

и включения другого (в этом случае очень трудно избежать 

щелчка), а по-другому. В конце предыдущего фрагмента уровень  

аудиосигнала плавно, но быстро уменьшается от номинального  

к нулевому, а в начале следующего — наоборот, увеличивается 

от нулевого до номинального. Стык получается незаметным на 

слух. В этом и состоит суть кроссфейда. 



Глава 3  196 

3.1.2. Выбор устройств записи  

и воспроизведения с помощью  

окна Audio Hardware Setup 

Продолжим готовить программу к работе. На очереди выбор 

устройств ввода (записи) и вывода (воспроизведения) данных, 

которыми оперирует Adobe Audition. Необходимые опции сосре-

доточены в диалоговом окне Audio Hardware Setup, которое  

открывается командой Edit > Audio Hardware Setup главного 

меню и содержит три вкладки: Edit View, Multitrack View  

и Surround Encoder. Вкладку Surround Encoder мы не станем 

описывать: созданием музыкальных surround-проектов пока что 

даже профессионалы занимаются редко, тем более это не по пле-

чу начинающим. А вот понимание смысла настроек, имеющихся 

на двух других вкладках, полезно для всех. 

Устройства ввода/вывода в режиме Edit View  

(вкладка Edit View) 

В верхней части вкладки Edit View (рис. 3.12) диалогового окна 

Audio Hardware Setup расположен раскрывающийся список Audio 

Driver доступных драйверов устройств ввода/вывода аудиоданных.  

 

Рис. 3.12. Вкладка Edit View диалогового окна Audio Hardware Setup 
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Наилучшие результаты с точки зрения производительности  

и надежности работы программы будут получены в том случае, 

когда вы выберете в данном списке драйвер, "родной" для вашей 

звуковой карты (или внешнего звукового модуля). Сегодня прак-

тически все профессиональные звуковые редакторы и виртуаль-

ные студии поддерживают ASIO. Соответственно поддержка 

ASIO имеется у мультимедийных звуковых карт, не говоря уже 

о полупрофессиональных и профессиональных звуковых интер-

фейсах.  

ПРИМЕЧАНИЕ  

ASIO (Audio Stream In/Out — ввод/вывод аудиопотока) — API, 
продвигаемый фирмой Steinberg; позволяет драйверам звуковых 
карт непосредственно обмениваться звуковыми данными со зву-
ковым программным обеспечением. Применение звуковых карт, 
драйверы которых поддерживают ASIO, позволяет добиваться 
минимальных задержек при использовании плагинов, микширова-
нии звуковых потоков и т. п. (имеется в виду задержка между по-
ступлением какой-либо команды и моментом ее фактического во-
площения в звуке). 

Если драйверы вашей звуковой карты поддерживают ASIO,  

то в Adobe Audition следует использовать именно эти драйве- 

ры (в нашем случае драйвер называется M-Audio FW ASIO).  

Если поддержки ASIO нет, но имеется поддержка DirectX, то 

следует использовать ASIO Full Duplex DirectX Driver или 

ASIO Multimedia Driver.  

Все остальные параметры, доступные на рассматриваемой 

вкладке, относятся именно к тому устройству, которое выбрано  

в списке Audio Driver.  

В группе Driver Properties отображаются сведения о пара-

метрах выбранного драйвера: 

 Sample Rate — частота дискретизации (сэмплирования); 

 Clock Source — источник синхронизирующего сигнала; 

 Buffer Size — размер буфера для промежуточного хранения 

аудиоданных. 

На рассматриваемой вкладке эти параметры приведены для 

сведения, а изменить их можно на панели управления звуковой 
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картой, которая открывается нажатием кнопки Control Panel 

(вид этой панели зависит от звуковой карты). 

Фактически, параметр Buffer Size — это задержка при вво-

де/выводе звуковых данных, напрямую связанная с размером бу-

фера, через который происходит обмен звуковыми данными. Чем 

меньше задержка, тем лучше. Однако при малых значениях за-

держки могут возникнуть проблемы, которые будут ощутимы на 

слух в виде хруста и выпадений звука. Причины этих проблем 

могут быть различными. Самая банальная — нехватка быстро-

действия системы: звуковая карта готова выводить звуковой по-

ток через маленький буфер, обеспечивающий маленькую задерж-

ку, однако другие элементы системы (процессор, жесткий диск, 

память, программы) не в состоянии обеспечить непрерывный вы-

вод звукового потока при таком размере буфера. Бывает и так, 

что описанные проблемы возникают на самом современном ком-

пьютере. В этом случае проблема, скорее всего, заключается  

в драйверах самой звуковой карты. Нужно скачать с сайта произ-

водителя самые свежие драйверы, в которых, возможно, недос-

татки уже выявлены и устранены. 

В любом случае значение параметра Buffer Size подбирается 

опытным путем. Установите наименьшее значение этого пара-

метра. Воспроизводите проект, содержащий несколько аудиотре-

ков и использующий VST-плагины. Если слышен хруст, треск  

и т. п., то немного увеличьте значение параметра Buffer Size и 

повторите опыт. Действуйте так до тех пор, пока проблемы с вы-

водом звука не будут устранены. 

Если установлен флажок Release ASIO Driver in Background, 

то при свертывании главного окна Adobe Audition программа будет 

освобождать аудиодрайвер, поэтому его может использовать ка-

кое-либо другое приложение Windows. 

Выбор драйвера равноценен выбору устройства ввода/вывода 

аудиоданных. Некоторые устройства могут иметь несколько ка-

налов ввода/вывода. Каналы, используемые программой по 

умолчанию, следует выбрать в раскрывающихся списках Default 

Input и Default Output группы Edit View Ports. 
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Устройства ввода/вывода в режиме  

Multitrack View (вкладка Multitrack View) 

Верхняя и нижняя части вкладки Multitrack View (рис. 3.13) 

диалогового окна Audio Hardware Setup ничем не отличаются от 

того, с чем вы познакомились, рассматривая вкладку Edit View.  

В верхней части вкладки находится раскрывающийся список 

Audio Driver, в котором перечислены доступные драйверы устройств 

ввода/вывода аудиоданных, а в нижней — раскрывающиеся списки 

Default Input и Default Output, в которых выбирают каналы вво-

да/вывода, используемые программой по умолчанию. 

 

Рис. 3.13. Вкладка Multitrack View диалогового окна Audio Hardware Setup 
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ПРИМЕЧАНИЕ  

Устройства и каналы ввода/вывода для режимов Edit View и 
Multitrack View можно выбирать независимо. 

В средней части вкладки находится группа Input and Output 

Ports, в полях которой отображаются списки либо входных, либо 

выходных портов. Для выбора группы отображаемых портов 

предназначен раскрывающийся список. 

В поле Stereo перечислены стереофонические порты, в кото-

рых каналы объединены попарно. В поле Mono перечислены мо-

нофонические порты, позволяющие получить доступ к каждому 

одиночному каналу. 

Завершив подготовку программы, можно перейти к работе  

с ней. Конечно, начинать нужно с наиболее простых и часто вы-

полняемых действий. 

3.2. Работа с файлами  
и сигналограммами,  
воспроизведение звука 

В программе Adobe Audition предусмотрены два принципи-

ально различных режима работы: 

 редактирование отдельных монофонических или стереофони-

ческих аудиофайлов;  

 мультитрековое редактирование, при котором из отдельных 

аудиофайлов, как из кубиков, можно составить композицию. 

У каждого режима есть свое главное меню и главное окно 

(Edit View и Multitrack View соответственно). По сути, это два раз-

ных по назначению звуковых редактора, объединенных в функцио-

нальный комплекс. Основной режим работы для Adobe Audition — 

мультитрековый. Технологию работы с Adobe Audition как  

с мультитрековым редактором, поддерживающим многоканаль-

ную запись, в целом можно сформулировать так: 

1. Выполнение одноканальной записи (методом наложения) или 

многоканальной записи в мультитрековом режиме. 

2. Редактирование записанных аудиофайлов, а также аудиофай-

лов, полученных извне (например, из библиотеки сэмплов,  
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с треков CD Digital Audio или с саундтрека цифрового видео) 

в режиме Edit View. 

3. Возврат в мультитрековый режим, монтаж и сведéние компо-

зиции на основе отредактированных аудиофайлов с примене-

нием эффектов реального времени и средств автоматизации. 

При таком подходе работа над композицией начинается и за-

канчивается в мультитрековом режиме (Multitrack View), а режим 

Edit View является связующим звеном в технологической цепочке. 

Приступим к освоению элементарных средств программы, 

доступных пользователю в процессе редактирования отдельных 

монофонических или стереофонических аудиофайлов в главном 

окне Edit View. 

3.2.1. Знакомство с главным окном  
режима Edit View 

После первого запуска программа находится в мультитреко-

вом режиме. Чтобы переключиться в режим редактирования  

аудиофайла, нажмите клавишу <F12> или воспользуйтесь коман-

дой View > Edit View главного меню. Если теперь закрыть про-

грамму Adobe Audition и запустить ее вновь, программа окажется 

в том режиме, в котором она была закрыта.  

Главное окно Adobe Audition в режиме Edit View показано  

на рис. 3.14. 

В верхней части главного окна расположена панель инстру-

ментов, внешний вид и состав которой можно формировать по 

своему усмотрению: размещать на ней или исключать из нее те 

или иные инструменты (кнопки, соответствующие командам 

главного меню). 

ПРИМЕЧАНИЕ  

Выбор инструментов, отображаемых в главном окне, производит-
ся с помощью подменю Shortcut Bar меню View. 

Чтобы узнать о назначении какого-либо инструмента, нужно 

подвести к нему указатель мыши и задержать примерно на 1 с; 

рядом с инструментом появится всплывающая подсказка с переч-

нем его функций. Мы не будем останавливаться на назначении 
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инструментов, т. к. их набор не является постоянным, а сами они 

полностью дублируют команды главного меню, которые мы рас-

сматриваем по мере необходимости. 

Обращаем ваше внимание только на три кнопки в левой части 

панели инструментов. Эти кнопки — еще один способ перехода: 

 — в режим редактирования отдельных аудиофайлов (Edit 

View);  

 — в мультитрековый режим (Multitrack View); 

 — в режим редактирования списка треков перед записью 

их на компакт-диск (CD View).  

На рис. 3.14 видно не заполненное никакой информацией ра-

бочее поле. Оно свободно лишь потому, что вы еще не загрузили 

в память программы аудиофайл. Если считать аудиофайл с диска 

или записать звук с любого из доступных входов звуковой карты, 

то в этом поле отобразится сигналограмма. К рассказу о работе  

с этим полем мы вернемся сразу после того, как в нашем распо-

ряжении окажется аудиофайл. 

ПРИМЕЧАНИЕ  

Если придерживаться точных формулировок, то следует говорить 
так: "В режиме Edit View мы редактируем отсчеты оцифрованного 
аудиосигнала, загруженного в Adobe Audition из файла, предвари-
тельно сохраненного на диске". Невероятно длинно и "нечитабель-
но". Поэтому мы будем писать короче: "редактируем аудиосигнал", 
"редактируем аудиофайл" — и даже: "редактируем сигналограмму", 
"записываем, воспроизводим сигналограмму", "открываем, загружа-
ем, сохраняем, удаляем сигналограмму". Строго говоря, сигнало-
грамма — всего лишь отображение аудиосигнала. Однако именно 
она является тем элементом графического интерфейса, который 
олицетворяет аудиосигнал. Поэтому формально можно считать, что 
работа в программе ведется именно с "портретом" сигнала, а не  
с самим аудиосигналом. Надеемся, что это примечание поможет 
вам правильно понимать то, что говорится далее, и вы не станете 
упрекать нас в нарушении терминологии. 

В главном окне есть еще несколько элементов и инструментов, 

но рассказывать о них сейчас не имеет смысла. Сначала нужно за-

полнить главное окно сигналограммой. Для этого есть несколько 

возможностей. Сигналограмму можно открыть или загрузить из 

файла, или вставить из буфера обмена, или, наконец, записать. 
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3.2.2. Работа с файлами 

Команды, обеспечивающие работу с файлами, содержатся  

в меню File. Перечислим их: 

 New — создать новый файл; 

 Open — открыть существующий файл; 

 Open As — открыть файл, переопределив его атрибуты; 

 Open Append — открыть файл в дополнение к уже открытому 

(добавляемая сигналограмма размещается следом за уже на-

ходящейся в окне редактора);  

 Extract Audio from Video — извлечь саундтрек из видеофай-

ла и загрузить его в Adobe Audition; 

 Extract Audio from CD — извлечь трек с диска CD-Digital 

Audio и загрузить его в Adobe Audition;  

 Browse и Reveal in Brige — команды доступны, если вы приобре-

ли и установили приложение Adobe Brige CS4, предназначенное 

для работы с медиафайлами (http://www.adobe.com/products/ 

creativesuite/bridge/); описание которого выходит за рамки 

данной книги; 

 Close — закрыть текущий редактируемый файл; 

 Close All — закрыть все файлы и текущую мультитрековую 

сессию; 

 Close Unused Media — закрыть все открытые аудиофайлы, не 

используемые в текущей мультитрековой сессии;  

 Save — сохранить файл с прежним именем; 

 Save As — сохранить файл с новым именем, заданным поль-

зователем; 

 Save Copy As — сохранить копию файла; 

 Save Selection — сохранить в файле только выделенный 

фрагмент сигналограммы;  

 Save All — последовательно сохранить все открытые в на-

стоящее время аудиофайлы; 

 Save All Audio As — последовательно сохранить все откры-

тые в настоящее время аудиофайлы с именами, заданными 

пользователем; 
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 Revert to Saved — вернуться к последнему сохраненному 

файлу; 

 Import Bitmap — импортировать в программу данные из графи-

ческого файла в целях синтеза музыки на основе изображения; 

 File Info, XMP Info — открыть окна с информацией о файле; 

 Batch Processing — конвертировать форматы файлов в пакет-

ном режиме; 

 Scripts — редактировать список операций обработки аудио-

файлов (сценария); 

 Flush Virtual File — освободить открытый файл для исполь-

зования другим приложением; 

 Manage Temporary Folder Reserve Space — открыть окно  

с информацией об объеме свободной памяти на жестком дис-

ке, предназначенное для очистки и резервирования дискового 

пространства; 

 Exit — завершить работу с программой Adobe Audition. 

Применение некоторых из этих команд нужно рассмотреть 

подробнее. 

Открытие файлов 

Команда File > Open позволяет открыть аудиофайл. При этом 

на экране появляется диалоговое окно Open (рис. 3.15). Кроме 

элементов управления, традиционных для окон открытия файлов 

в любых Windows-приложениях, это окно содержит особые до-

полнительные элементы управления. 

В раскрывающемся списке Recent Folders перечислены те 

папки (каталоги), к которым вы обращались ранее, открывая 

файлы. Для того чтобы быстро перейти от одной папки к другой, 

достаточно выбрать в этом списке нужную строку. 

При установленном флажке Show File Information в поле, рас-

положенном под ним, будет отображаться информация о форма- 

те выделенного аудиофайла, продолжительности его звучания  

и объеме занимаемой им памяти. 

Если установлен флажок Auto Play, то при выделении аудио-

файла в списке он начнет воспроизводиться. Выделенный файл 

также можно прослушать, нажав кнопку Play. 
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Рис. 3.15. Диалоговое окно Open  

Adobe Audition поддерживает многие форматы звуковых фай-

лов и даже позволяет загружать файлы неизвестных форматов  

с произвольными расширениями, как бы полагая, что для пред-

ставления звука в них используется импульсно-кодовая модуля-

ция (PCM). Перед загрузкой файла, заголовок которого неизвес-

тен Adobe Audition, программа предложит вам самостоятельно 

определить частоту сэмплирования, количество каналов (мо-

но/стерео) и разрешение представления звуковых данных. Если 

после загрузки файла он будет звучать "не так, как надо" (слиш-

ком замедленно, с шумом, либо слышен только сплошной шум), 

а вы точно уверены, что этот файл содержит именно звуковые 

отсчеты, следует пробовать загружать этот файл еще и еще, пе-

ребирая каждый раз параметры его формата. 

Adobe Audition умеет работать с различными форматами ау-

диофайлов (всего около десятка), в том числе с теми, которые 

используются на других платформах (например, на компьютерах 

Amiga, Mac). Звуковые данные можно хранить даже в обыкно-

венном текстовом файле с расширением TXT.  

Вернемся к окну Open (см. рис. 3.15).  
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При установленном флажке Don't ask for further details про-

грамма Adobe Audition не станет запрашивать у вас сведения  

о представлении звуковых данных в формате неизвестного ей 

типа, а будет считать, что файл имеет такой же формат, как  

и предыдущий загруженный.  

В раскрывающемся списке Тип файлов (в нерусифицирован-

ных версиях ОС — Files of type) выбирается тип аудиофайла (по 

умолчанию WAV).  

ПРИМЕЧАНИЕ  

Программа Adobe Audition может загрузить один за другим сразу 

несколько аудиофайлов. Для этого в окне Open надо выделить все 

нужные файлы (при нажатой клавише <Ctrl>) и нажать кнопку Open. 
Выделенные файлы поочередно будут загружены в программу. Ка-
ждый из них займет отдельную страницу главного окна программы.  

В раскрывающемся списке Preview Playback Device можно 

выбрать устройство для предварительного прослушивания выде-

ленного аудиофайла.  

Следующая команда меню File — Open As (открыть как) ана-

логична предыдущей, за исключением того, что в процессе за-

грузки звуковые данные, хранящиеся в выбранном файле, можно 

конвертировать в другой формат (задать новую частоту сэмпли-

рования, разрядность и 

количество каналов). По-

сле того как в окне Open 

As вы выберете один или 

несколько файлов и на-

жмете кнопку Открыть 

(Open), откроется диало-

говое окно Open File(s) As 

(рис. 3.16), позволяющее 

задать новый формат за-

гружаемого файла (или 

файлов). 

В списке Sample Rate 

выберите частоту дискре-

тизации (сэмплирования). 

 

Рис. 3.16. Диалоговое окно Open File(s) As 
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В группе Channels выберите режим: моно (Mono) или стерео 

(Stereo). 

В группе Resolution выберите разрешение представления сиг-

нала: 8-битное (8-bit), 16-битное (16-bit) или 32-битное с плаваю-

щей запятой (32-bit (float)). 

ПРИМЕЧАНИЕ  

Новый формат выбирается вовсе не в раскрывающемся списке 
Тип файлов (Files of type) окна Open As, как иногда думают 
пользователи. Этот список — всего лишь логический фильтр, ус-
коряющий поиск нужного файла известного вам типа. 

Преобразование формата аудиоданных начнется после того, 

как вы нажмете кнопку OK в окне Open File(s) As. Процесс мо-

жет занять довольно много времени, т. к. включает несколько 

операций. О начале и ходе очередной операции вас оповестит 

окно прогресс-индикатора. Когда необходимые преобразования 

будут завершены, загруженная и преобразованная в процессе за-

грузки сигналограмма появится на рабочем поле главного окна. 

Вероятно, вам известно о существовании форматов аудиофай-

лов, в которых применяются различные методы сжатия объема, 

занимаемого аудиоинформацией (например, форматы MP3, Real 

Audio, Microsoft ADPCM и др.). В подавляющем большинстве ме-

тодов сжатия звуковой информации используется сжатие с поте-

рями: качество фонограммы ухудшается, но зато она занимает 

меньший объем. 

ПРИМЕЧАНИЕ  

Ни при каких обстоятельствах не используйте сжатие для хране-
ния промежуточных аудиофайлов проекта! 

Пример того, как нельзя поступать: выполнили запись с микрофо-
на, сохранили файл в MP3. Через какое-то время открыли файл, 
чтобы удалить из него шумы и выполнить динамическую обработ-
ку. Вновь сохранили файл в формате MP3. Затем использовали 
этот файл в мультитрековом проекте, а результат сведения опять 
сохранили в MP3. Качество звука в описанном отрицательном 
примере неуклонно будет деградировать при каждом сохранении 
файла. Чтобы избежать этого, используйте формат Windows PCM. 

Теперь поговорим о способе представления звуковых отсчетов 

в аудиофайлах. Понятно, что если запись выполняется с микро-
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фона (в 99,99 % случаев — монофонического), имеет смысл ис-

пользовать монофонический формат. Другое дело, если в процес-

се обработки изначально монофоническая запись получит сте-

реофонические свойства (всевозможные эффекты, в которых 

применяется задержка). В этом случае ваша фонограмма должна 

иметь стереофонический формат еще до начала обработки. Если 

вы не собираетесь применять эффекты, придающие фонограмме 

стереофонические свойства, в режиме редактирования аудиофай-

ла, а хотите использовать эффекты реального времени при сведе-

нии мультитрекового проекта, то изменять монофонический 

формат аудиофайла на стереофонический не нужно. Поток зву-

ковых данных с выходов эффектов будет поступать на стереофо-

нический аудиопорт или шину. Поэтому звучание стереофониче-

ских эффектов не будет зависеть от формата, в котором 

представлены исходные монофонические данные. 

Важный вопрос — разрешающая способность, или разреше-

ние. Трудно представить, где сейчас могут применяться 8-битные 

аудиофайлы. Мы рассмотрим только 16-битный и 32-битный с 

плавающей точкой форматы представления звуковых данных при 

редактировании в Adobe Audition. 16-битный формат следует ис-

пользовать в том случае, когда запись изначально имеет низкое 

качество. Понятно, что если запись выполнена с помощью муль-

тимедийного микрофона, подключенного к микрофонному входу 

звуковой карты, то о сохранении каких-то тонких нюансов, полу-

ченных в ходе обработки изначально низкокачественного звука, 

речь не идет. Другое дело, если вы обладаете высококачествен-

ным звукозаписывающим оборудованием и подготовленным для 

звукозаписи помещением. Используйте 32-битный формат — это 

поможет избежать накопления погрешностей при многократном 

применении всевозможных эффектов. 

Монтаж на одном треке последовательности 
аудиофайлов 

Команда File > Open Append главного меню, как и команда 

File > Open, предназначена для открытия файлов. Однако при за-

грузке одного или нескольких файлов с диска командой Open 

Append сигналограммы окажутся размещенными на одном треке 
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(в случае монофонического формата аудиоданных) или на одной 

паре треков (при стереофоническом формате) последовательно друг 

за другом. Точнее, сигналограммы открытых этой командой аудио-

файлов окажутся последовательно состыкованными и расположен-

ными в одном и том же экземпляре главного окна программы  

(режим Edit View). Иными словами, эта команда служит для объе-

динения нескольких исходных аудиофайлов в один результирующий 

файл. При загрузке, например, двух аудиофайлов позиция, в которой 

начинается вторая сигналограмма, отмечена вертикальной пунктир-

ной линией красного цвета и надписью с именем файла. 

Сохранение и закрытие файлов 

Команда Save меню File сохраняет на диске редактируемый 

файл с тем же именем, с которым он был загружен с диска. Если 

файл был создан командой New, то вместо команды Save выпол-

нится следующая команда меню File — Save As. 

Команда Save As сохраняет файл с именем, которое определя-

ет пользователь. После выбора этой команды открывается диало-

говое окно Save As (рис. 3.17), которое содержит стандартные 

элементы управления, но имеет две особенности.  

 

Рис. 3.17. Диалоговое окно Save As 
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Первая особенность — наличие кнопки Options. Ее нажатие 

открывает окно, вид которого зависит от формата аудиофайла. 

Для некоторых форматов кнопка Options недоступна. Опции до-

полнительного окна тоже бывают разными, например, предна-

значенными для выбора способа сжатия звуковой информации. 

Вторая особенность — наличие флажка Save extra non-audio 

information (сохранять дополнительную незвуковую информа-

цию). Если он установлен, то в аудиофайле кроме спецификации 

формата и самих звуковых данных будет записана такая инфор-

мация, как, например, название композиции, сведения об автор-

ских правах и многое другое. 

Следующая команда Save Copy As меню File аналогична  

команде Save As, за исключением того, что файл сохраняется  

в другой папке. 

Команда File > Save Selection главного меню сохраняет в файле 

только аудиоданные, соответствующие выделенному фрагменту 

сигналограммы. 

Команда Save All, также предназначенная для сохранения 

файлов, в режиме Edit View доступна только в том случае, если 

ранее вы применяли команду загрузки файлов с объединением 

сигналограмм Open Append. Она позволяет сохранить все объе-

диненные звуковые данные в одном файле. Собираясь применить 

эту команду, сосредоточьтесь. Программа не запрашивает имя 

файла, содержащего объединенные звуковые данные. Файл с ни-

ми будет сохранен под именем файла, загруженного первым 

(к которому вы присоединили все остальные). Может случиться 

неприятность: исходный файл будет затерт. Конечно, утраченное 

можно постараться восстановить. Но чтобы это сделать, придется 

основательно потрудиться, вырезая все присоединенное. 

Команда Revert to Saved (вернуться к сохраненному) полезна 

в том случае, если вы решили сразу отказаться от всех изменений, 

внесенных после последнего сохранения звуковых данных на дис-

ке или последнего выполнения команд загрузки. Проще говоря, 

команда Revert to Saved загружает файл, имя которого в данный 

момент отображается в заголовке главного окна. При выполне-

нии этой операции программа запросит у вас подтверждение со-

хранения текущей сигналограммы в файле. 
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Команда Close закрывает редактируемый файл. Вернее, она 

освобождает память программы от редактируемой сигналограм-

мы. Программа возвращается в исходное состояние. Команда 

Close All закрывает все файлы. Команда Close Unused Media за-

крывает любые открытые аудиофайлы, не используемые в теку-

щей сессии (не вставленные в многоканальный проект). 

3.2.3. Работа с сигналограммой  

и воспроизведение аудиофайла 

Итак, с помощью команды File > Open главного меню вы за-

гружаете файл со звуковыми данными. После этого вид главного 

окна программы изменится. На рабочем поле появится графиче-

ское изображение аудиосигнала — сигналограмма. Возможный 

вид стереофонической сигналограммы показан на рис. 3.18. 

Управление отображением сигналограммы,  

выделение фрагмента 

Перед тем как пристальнее вглядеться в сигналограмму, дого-

воримся о двух терминах: маркер и указатель текущей позиции. 

Оба эти объекта выглядят на экране как обычные отрезки верти-

кальных прямых, только маркер — пунктирная линия, а указа-

тель текущей позиции — сплошная. 

Маркер указывает то место (т. е. время) на сигналограмме,  

с которого начнется запись или воспроизведение. Маркер виден 

только в статическом состоянии программы — в режиме Stopped. 

Указатель текущей позиции, напротив, существует и виден 

только в динамических режимах: при воспроизведении и записи. 

Он указывает на сигналограмме то место, запись или воспроизве-

дение которого происходит в текущий момент времени. 

На рис. 3.18 временнáя позиция характеризуется номером от-

счета (поэтому в числах на горизонтальной оси много нулей).  

А маркер находится в самом начале сигналограммы. 

Часто бывает так, что изображение всей сигналограммы не 

умещается на рабочем поле главного окна: видна только ее часть. 

Чтобы помочь вам сориентироваться в том, какая именно часть 

сигналограммы видна, над ней расположена диаграмма, светлый 
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прямоугольник которой обозначает отображаемую область (по 

назначению диаграмма подобна полосе прокрутки). Перемещая 

этот прямоугольник с помощью мыши, можно "перематывать" 

сигналограмму. Если вся диаграмма светлая, значит, сигнало-

грамма отображается в окне целиком. Размер прямоугольника 

относится к размеру всей диаграммы как длительность отобра-

жаемого фрагмента к длительности всей сигналограммы. 

Щелкните на диаграмме правой кнопкой мыши. Появится 

контекстное меню, с помощью которого можно управлять мас-

штабом отображения сигналограммы. Если в нем выбрать ко-

манду Zoom In, то масштаб отображения сигналограммы увели-

чится, если команду Zoom Out — уменьшится. Выбор команды 

Zoom Full приведет к тому, что в окне отобразится вся сигнало-

грамма. С помощью двух оставшихся команд контекстного меню 

можно изменять расположение самой диаграммы: над рабо- 

чим полем главного окна (Above Display) или под ним (Below 

Display). 

 

Рис. 3.18. Стереофоническая сигналограмма 
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Если фрагмент сигналограммы выделен, то на диаграмме его 

протяженность и расположение относительно границ всей сигна-

лограммы отображаются в виде серого прямоугольника. Это 

очень удобно: после любых перемещений вдоль сигналограммы 

всегда можно возвратиться к выделенному фрагменту, совместив 

на диаграмме зеленый прямоугольник с серым. 

ПРИМЕЧАНИЕ  

Диаграмма сама по себе является инструментом. Ее длина от 

начала до конца соответствует длине всей сигналограммы. 

Светлая (по умолчанию ярко-зеленая) подвижная область — 

ползунок — соответствует отображаемому в данный момент 

участку сигналограммы. Если в окне отображается вся сигнало-

грамма, то ползунок занимает всю длину линейки и переме-

щаться ему некуда. Как только вы уменьшите масштаб отобра-

жения сигналограммы по горизонтали (Zoom Out Horizontally), 

уменьшится и длина ползунка. Захватив мышью ползунок, мож-

но прокручивать сигналограмму. А если захватить границу пол-

зунка и передвинуть ее, то изменится граница отображаемой 

части сигналограммы и, соответственно, масштаб отображения 

сигналограммы по горизонтали. 

Есть и еще один способ прокрутки сигналограммы: захватите 

мышью горизонтальную координатную шкалу — шкалу времени, 

расположенную под сигналограммой (указатель мыши примет 

форму руки), и переместите ее в нужном направлении, "перема-

тывая" сигналограмму влево или вправо. Кстати, у шкалы време-

ни есть еще одна, не менее полезная функция — эффективный 

способ уменьшения горизонтального масштаба отображения сиг-

налограммы. Если, удерживая нажатой 

правую кнопку мыши, выделить фрагмент 

шкалы, то после того как кнопка мыши 

будет отпущена, выделенный фрагмент 

"растянется" на весь экран. 

Масштабом отображения сигнало-

граммы по вертикали и горизонтали мож-

но управлять и с помощью инструментов 

панели Zoom (рис. 3.19).  

 

Рис. 3.19. Панель Zoom  
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Масштаб отображения сигналограммы по горизонтали задает-

ся при помощи кнопок:  

  Zoom In Horizontally — увеличить масштаб;  

  Zoom Out Horizontally — уменьшить масштаб; 

  Zoom Out Full Both Axis — отобразить всю сигналограмму; 

  Zoom to Selection — увеличить масштаб так, чтобы выделен-

ный фрагмент сигналограммы занял все рабочее поле окна; 

  Zoom In to Left Edge of Selection — увеличить масштаб  

и отобразить в окне левую границу выделенного фрагмента 

сигналограммы; 

  Zoom In to Right Edge of Selection — увеличить масштаб  

и отобразить в окне правую границу выделенного фрагмента 

сигналограммы. 

Для изменения масштаба отображения сигналограммы по вер-

тикали предназначены кнопки  Zoom In Vertically и  

Zoom Out Vertically. 

В последующей работе вы не сможете обойтись без инстру-

ментария для выделения фрагментов сигналограммы. 

Начнем с простого. Допустим, вам понадобилось прослушать 

фрагмент не с начала, а с какого-то определенного момента. Под-

ведите указатель мыши к этой позиции и сделайте одиночный 

щелчок. Если аудиофайл стереофонический, старайтесь, чтобы 

по вертикали указатель мыши находился около линии, разде-

ляющей сигналограммы левого и правого каналов (не обязательно 

точно на ней). На месте щелчка появится маркер — вертикальная 

пунктирная линия, "прикрепленная" за верхний и нижний концы 

к главному окну маленькими желтыми треугольниками. В при-

мере, показанном на рис. 3.20, эта вертикальная линия находится 

в позиции 350 000-го отсчета. Это хорошо видно на панели ото-

бражения текущей позиции Time.  

Теперь, если вы нажмете кнопку  Play (или клавишу <про-

бел>), то воспроизведение начнется с той позиции, в которой на-

ходится маркер. 
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Рис. 3.20. Маркер установлен в позицию 350 000-го отсчета 

Попробуйте установить маркер точно в заданную позицию. 

Скорее всего, вам это удастся далеко не с первой попытки. Осо-

бенно трудно "попасть в цель", работая с протяженной сигнало-

граммой. Погрешность визуальной установки маркера почти все-

гда будет составлять величину порядка нескольких отсчетов или 

даже нескольких десятков отсчетов.  

Иногда точность установки по-

зиции маркера принципиально важна. 

В таких случаях следует воспользо-

ваться одним из шести полей ввода 

панели Selection/View (рис. 3.21), по 

умолчанию расположенной в ниж-

ней части окна, правее панели Time. 

 

Рис. 3.21. Панель  

Selection/View  
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Эти поля ввода организованы в таблицу, содержащую две строки 

и три столбца. 

В верхней строке (Selection) отображаются (и могут быть отре-

дактированы) временны́е параметры выделенного фрагмента сиг-

налограммы, а в нижней (View) — временные параметры фрагмен-

та сигналограммы, отображаемого в окне. 

Левый столбец (Begin) соответствует начальному моменту 

фрагмента сигналограммы, средний (End) — конечному. В пра-

вом столбце (Length) отображается протяженность фрагмента. 

Для того чтобы точно задать позицию маркера, щелкните ле-

вой кнопкой мыши в поле ввода, находящемся на пересечении 

строки Selection и столбца Begin, сделав это поле ввода доступ-

ным для редактирования. Введите нужное число и нажмите кла-

вишу <Enter>. Хотя мы воспользовались инструментом для вы-

деления фрагмента сигналограммы, нам удалось применить его 

для точного позиционирования маркера. 

Чтобы определить границы выделенного фрагмента с высокой 

точностью, нужно задать их в полях ввода, находящихся на пере-

сечении строки Selection и двух столбцов: 

 Begin (левая граница выделенного фрагмента сигналограммы); 

 End (правая граница выделенного фрагмента сигналограммы). 

Для определения границ выделенного или отображаемого 

фрагмента можно задать его начало и конец. Этот способ мы толь-

ко что рассмотрели. Но можно действовать и по-другому: задать 

левую границу фрагмента и его протяженность. Для этого предна-

значены поля ввода в столбце Length. Следует знать, что в любом 

случае только две из трех величин, характеризующих временны́е 

параметры фрагмента сигналограммы, являются независимыми. 

Если вы задали координату правой границы фрагмента, то число  

в столбце Length программа определит автоматически. И наоборот. 

Способ задания границ фрагмента вводом числовых значений 

точнее графического, но не всегда удобен и может замедлять ва-

шу работу с сигналограммой. Пользоваться графическим спосо-

бом проще и быстрее.  

Как мы уже отметили, для установки маркера нужно сделать 

на рабочем поле главного окна одиночный щелчок. Если же сде-
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лать двойной щелчок, то выделится тот фрагмент сигналограм-

мы, который отображается в окне программы. Если вы хотите 

выделить часть этого фрагмента (еще более короткий участок 

сигналограммы), то воспользуйтесь следующей рекомендацией.  

Подведите указатель мыши к началу (или концу) фрагмента  

и нажмите ее левую кнопку. Не отпуская кнопку, подведите ука-

затель мыши к концу (или началу) фрагмента. Отпустите кнопку. 

Примерный результат этих действий приведен на рис. 3.22. 

 

Рис. 3.22. Выделенный фрагмент стереофонической сигналограммы 

Если потребуется изменить границы выделенной области сиг-

налограммы, совсем необязательно повторять эти действия. Вни-

мание: как только вы щелкнете левой кнопкой мыши на сигнало-

грамме, выделение звукового фрагмента пропадет. Чтобы этого не 

произошло, для уточнения границ ранее выделенного фрагмента 
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воспользуйтесь левой кнопкой мыши в сочетании с клавишей 

<Shift>. Можно поступить и по-другому. Захватите мышью ма-

ленький желтый треугольник, расположенный под сигналограм-

мой на линии границы выделения (подобный треугольник есть  

и над сигналограммой), и перемещайте его влево-вправо, изменяя 

тем самым положение одной из границ выделенного фрагмента. 

Вторую границу перемещают аналогичным образом. 

Итак, вы выделили фрагмент сигналограммы. Программа ор-

ганизована так, что все операции выполняются исключительно  

с выделенным фрагментом. Иногда, например при применении 

эффектов, программа автоматически выделяет всю сигналограм-

му, если вы ранее не выделили ее фрагмент.  

Adobe Audition позволяет работать отдельно с каждым из сте-

реоканалов. Для этого нужно выделять фрагменты определенным 

образом. Делается это просто. Подведите указатель мыши не к ли-

нии, разделяющей сигналограммы, а к верхней или нижней сигна-

лограмме (для работы с левым или правым каналом соответствен-

но). Как только вы поместите указатель мыши на нужной высоте, 

он изменит свой вид: кроме обычной стрелочки появится буква L 

(Left — левый) или R (Right — правый). После этого вы можете 

работать со звуковой информацией отдельных каналов.  

Команда Edit > Select Entire Wave (<Ctrl>+<A>) выделяет 

всю сигналограмму. Сигналограммы, загруженные в программу, 

но находящиеся на неактивных страницах, не выделяются. Если 

выделенную сигналограмму вставить в мультитрековый проект, 

то в нем она тоже будет выделенной.  

При воспроизведении по изображению сигналограммы пробе-

гает сплошная вертикальная линия. Это и есть указатель текущей 

позиции — он показывает на сигналограмме место, воспроизво-

димое в данный момент. Когда отображаемый в окне фрагмент 

значительно меньше всей сигналограммы и включен особый режим 

воспроизведения (см. рис. 3.7: вкладка General диалогового окна 

Preferences, опция Auto-scroll during playback and recording), вос-

производимый участок сигналограммы отображается довольно 

интересно — вертикальная линия находится посередине окна,  

а перемещается само изображение сигналограммы. 
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В главном окне программы можно редактировать сигнало-

грамму на уровне отдельных звуковых отсчетов (т. е. на микро-

уровне). Иногда это может быть очень полезно, например, если 

нужно удалить короткую импульсную помеху (щелчок). А можно 

вручную нарисовать звуковую волну и использовать ее в буду-

щем для создания собственного музыкального инструмента, об-

ладающего уникальным тембром. 

Познакомимся с этим режимом редактирования на практике. 

Чтобы редактировать сигналограмму на микроуровне, нужно 

установить соответствующий масштаб. Нажимая кнопку  

Zoom In Horizontally, добейтесь того, чтобы отдельные отсче-

ты были не только видны, но их можно было захватить мышью 

(указатель мыши примет форму руки, у которой согнуты все 

пальцы, кроме указательного). В этом режиме звуковые отсчеты 

отображаются в виде квадратиков, соединенных тонкими ли-

ниями (рис. 3.23). 

 

Рис. 3.23. Режим редактирования отдельных звуковых отсчетов 
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Эти линии помогают ориентироваться в том, какой вид будет 

иметь сигнал, прошедший через цифроаналоговый преобразова-

тель (ЦАП) звуковой карты (включая ФНЧ). Вы, наверное, уже 

догадались, что эти квадратики можно перетаскивать мышью по 

вертикали. Именно так и осуществляется редактирование формы 

сигнала на микроуровне. Можно вернуться к обычному масштабу 

(редактирование на уровне огибающей амплитуды, а не на уров-

не отдельных отсчетов), неоднократно нажимая кнопку  Zoom 

Out Horizontally или один раз нажав кнопку  Zoom Out Full 

Both Axis.  

Рабочее поле главного окна, в котором отображается сигнало-

грамма, представляет собой координатную плоскость. 

По горизонтальной оси откладываются единицы времени.  

Выбор единиц измерения времени предоставлен пользователю. 

Для этого предназначено подменю View > Display Time Format. 

Из доступных форматов представления времени обратим ваше 

внимание на следующие: 

 Decimal (mm:ss.ddd) — в привычной форме (Минуты:Секунды. 

Миллисекунды); 

 Samples — при помощи номеров цифровых отсчетов звука (от 

начала сигналограммы); 

 Bars and Beats — в музыкальных тактах и долях тактов. 

При выборе в этом подменю новой строки меняются: 

 числовая разметка горизонтальной оси рабочего поля главного 

окна; 

 формат отображения времени на панели Time, в полях ввода, 

в информационных полях главного окна и диалоговых окон. 

Если выбран монофонический формат аудиофайла, то в рабо-

чем поле будет отображаться только один трек. При стереофони-

ческом формате будут отображаться два трека, расположенные 

один под другим: трек, соответствующий левому каналу, — вверху, 

правому — внизу.  

Числовая разметка вертикальной оси (каждого из треков в от-

дельности) соответствует диапазону значений отсчетов сигнала 

(Sample Values). Для 16-битного сигнала этот диапазон ограни-

чен значениями –32 768 и 32 767.  
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Для удобства пользователей предусмотрено еще три варианта 

разметки вертикальной оси системы координат (переключаются 

командами подменю View > Vertical Scale Format главного меню 

или командами контекстного меню вертикальной шкалы, которое 

открывается щелчком на ней правой кнопки мыши): 

 в процентах (Percentage) от максимального допустимого зна-

чения отсчета сигнала, соответствующего 100 %; 

 нормализованная (Normalized Values) — в виде правильных 

десятичных дробей (единице соответствует максимальное до-

пустимое значение отсчета сигнала); 

 в децибелах (Decibels). 

Сейчас речь идет о главном окне программы в режиме ото-

бражения сигналограммы. В окне может отображаться не сама 

сигналограмма, а ее мгновенный спектр. В этом случае по верти-

кальной оси откладываются значения частоты, а не значения от-

счетов сигнала. 

В самом низу главного окна расположена строка статуса, в поля 

которой выводится информация об уже записанном звуке. Слева 

отображается текущий режим программы (Stopped — останов), 

Playing — воспроизведение, Recording — запись), в поле Data 

Under Cursor — координаты указателя мыши.  

ПРИМЕЧАНИЕ  

Поле Data Under Cursor наиболее полезно для оценки уровня 
сигнала в характерных точках. Для этого достаточно нацелить на 
такую точку указатель мыши. 

Следующее поле (Sample Format) содержит напоминание о том, 

какой формат был выбран при создании аудиофайла (например, 

44100 16-bit Stereo — 44,1 кГц, 16 бит, стерео). 

Далее слева направо расположены поля, в которых отобража-

ются: 

 объем памяти, занятой аудиофайлом (поле File Size); 

 общая продолжительность фонограммы (поле File Size [time]); 

 объем свободной памяти на тех логических дисках, где созда-

ны временные папки для хранения копий аудиофайла, форми-

руемых программой во время текущей сессии (поля Free 

Space и Free Space[time]). 
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В поле Keyboard Modifiers отображается состояние клавиа-

туры, а в поле MTS/SMPTE — сведения о синхронизации. 

Правое поле (Display Mode) содержит напоминание о том, ка-

кой режим отображения выбран. 

В процессе записи/воспроизведения содержимое полей изме-

няется, информируя вас о состоянии дел. 

Если отвлекают цифры, мелькающие в полях строки статуса, 

вы можете выключить отображение всех или некоторых из этих 

полей. Щелкните правой кнопкой мыши на строке статуса и в 

открывшемся контекстном меню снимите флажки тех полей, ко-

торые вы не хотите видеть. 

Итак, теперь вы знаете, как управлять отображением сигнало-

граммы в главном окне программы. 

Воспроизведение аудиофайла  
и "перемотка" сигналограммы 

По умолчанию в левой нижней части главного окна располо-

жена панель с кнопками, напоминающими магнитофонные. Это 

панель управления, называемая транспортной панелью (рис. 3.24). 

Ее, как и некоторые другие панели главного окна, можно отсты-

ковать от других панелей и границ главного окна. Панель Trans-

port станет самостоятельной (плавающей), ее можно переместить 

в любое место главного окна. Можно и вновь пристыковать ее  

к другим панелям.  

 

Рис. 3.24. Панель Transport  

Кнопки панели Transport управляют записью и воспроизве-

дением сигналограммы. Рассмотрим их назначение подробнее.  

 Stop — кнопка остановки записи или воспроизведения. 

После нажатия этой кнопки указатель текущей позиции возвра-
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тится к маркеру. Следующий сеанс записи или воспроизведения 

начнется с позиции маркера. 

  — кнопка включения режима воспроизведения, название 

которой может меняться. Щелчком правой кнопки мыши на ней 

вы откроете контекстное меню, в котором представлены 10 вари-

антов реагирования программы на нажатие этой кнопки.  

 Play View — воспроизводится только фрагмент сигналограм-

мы, отображенный на экране. Когда указатель текущей пози-

ции достигнет правой границы видимой области сигнало-

граммы, воспроизведение прекратится, а указатель текущей 

позиции возвратится к левой границе области сигналограммы. 

 Play from Cursor to End of View — воспроизведение начина-

ется от маркера и завершается, когда указатель текущей пози-

ции достигнет правой границы видимой области сигнало-

граммы. Если имеется выделенный фрагмент сигналограммы, 

то воспроизведен будет только он. По окончании воспроизве-

дения указатель текущей позиции возвратится к маркеру или  

к началу выделенного фрагмента. 

 Play from Cursor to End of File — воспроизведение начина-

ется от маркера и завершается в конце сигналограммы. 

 Play Entire File — воспроизводится вся сигналограмма. 

 Play Spectral Selection — если установлен режим отображения 

Spectral Frequency Display, то воспроизводится только частот-

но-временная область, выделенная инструментом Marquee, 

Lasso или Effects Paintbrush. 

 Play Top and Tail Only — если установлен режим отображе-

ния Top/Tail Views, то воспроизводятся только начальный  

и финальный фрагменты аудиофайла. 

 Play Preroll and Postroll (Skip Selection) — воспроизводятся: 

фрагмент, предшествующий выделенному (Preroll), и фрагмент, 

следующий за выделенным фрагментом сигналограммы (Postroll). 

Длительность фрагментов Preroll и Postroll устанавливается  

в диалоговом окне Preroll and Postroll Options, которое от-

крывается одноименной командой рассматриваемого контек-

стного меню. 

 Play Preroll and Selection — воспроизводятся предшествую-

щий выделенному (Preroll) и выделенный фрагменты. 
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 Play Postroll — воспроизводится только фрагмент, следую-

щий за выделенным фрагментом сигналограммы (Postroll). 

 Play Preroll, Postroll and Selection — воспроизводятся фраг-

менты: Preroll, выделенный и Postroll. 

 Pause — кнопка временной остановки записи или воспроиз-

ведения. После остановки указатель текущей позиции останется на 

том месте, где его застало нажатие этой кнопки. Повторное нажа-

тие кнопки приведет к продолжению воспроизведения (записи). 

 — еще одна кнопка включения режима воспроизведения. 

Щелчок правой кнопкой мыши открывает контекстное меню, 

идентичное контекстному меню кнопки . Эти кнопки есть 

смысл настроить по-разному. 

 Play Looped — кнопка включения режима циклического 

воспроизведения (воспроизведение начинается с позиции марке-

ра). Характер циклического воспроизведения определяется ко-

мандой, выбранной в контекстном меню этой кнопки: 

 Loop View (or Selection) — зацикливается фрагмент сигнало-

граммы, отображенный на экране, а при наличии выделения — 

выделенный;  

 Loop Entire (or Selection) — зацикливается вся сигналограм-

ма (либо ее выделенный фрагмент); 

 Loop Top and Tail Only (or Selection) — если установлен ре-

жим Top/Tail Views, то зацикливаются начальный и финаль-

ный фрагменты аудиофайла (либо выделенный фрагмент). 

В любом из этих случаев выделенный фрагмент обладает при-

оритетом. 

 Go to Beginning or Previous Cue — кнопка перемещения 

маркера к началу сигналограммы или к предыдущей позиции ав-

томатической разметки границ фраз и тактов. 

 Rewind — кнопка "обратной перемотки". Если программа 

находится в состоянии Stopped, то нажатие этой кнопки приведет 

к перемещению маркера в направлении начала сигналограммы. 

Причем однократное нажатие кнопки вызовет перемещение мар-

кера на один шаг. Если кнопку нажать и удерживать, маркер бу-

дет перемещаться до тех пор, пока не дойдет до начала сигнало-

граммы или пока не будет отпущена кнопка Rewind. 
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Щелчком правой кнопки мыши на кнопке Rewind открывает-

ся меню, в котором можно выбрать скорость перемотки. Верхние 

две строки этого меню соответствуют переменной скорости пе-

ремотки: чем дольше вы удерживаете нажатой кнопку Rewind, 

тем быстрее происходит перемотка. При выборе любой из ос-

тавшихся строк установится фиксированная скорость перемотки. 

Если нажать кнопку Rewind во время воспроизведения сигна-

лограммы, в обратном направлении будет перемещаться не мар-

кер, а указатель текущей позиции. На слух полученный результат 

будет напоминать работу реального лентопротяжного устройства 

магнитофона в режиме обратной перемотки. Когда вы отпустите 

кнопку, воспроизведение продолжится с того места, к которому 

успел переместиться указатель текущей позиции. 

 Fast Forward — кнопка ускоренной перемотки вперед. За 

исключением направления перемотки эта кнопка ничем не отли-

чается от кнопки Rewind. 

 Go to End or Next Cue — кнопка перемещения маркера  

к концу сигналограммы или к следующей позиции автоматиче-

ской разметки границ фраз и тактов. 

 Record — кнопка включения режима записи. 

Загрузите с диска любой имеющийся у вас аудиофайл (напри-

мер, один из файлов с расширением WAV из числа имеющихся  

в папке EXAMPLES на диске, сопровождающем книгу) и проверь-

те на нем действие кнопок в различных ситуациях и режимах.  

От включения режима записи (кнопка Record) пока воздержитесь. 

3.3. Создание нового файла.  
Запись звука с микрофона 

Включить режим записи в Adobe Audition не составляет труда: 

достаточно нажать кнопку  (Record), расположенную на 

транспортной панели. Но перед тем как сделать это, необходимо: 

1. Подключить к звуковой карте микрофон. 

2. Убедиться, что выбрано нужное устройство ввода звуковых 

данных (см. разд. 3.1.2). 

3. Установить такой уровень записываемого сигнала, чтобы ис-

кажения стали маловероятными. 
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4. Выбрать один из двух возможных режимов записи. 

5. Выбрать формат файла, в котором будут храниться записан-

ные звуковые данные. 

Первые три пункта этого алгоритма мы уже подробно рас-

смотрели. Поговорим о пунктах 4 и 5. Начнем с предпоследнего.  

Щелкните правой кнопкой мыши на кнопке  (Record). От-

кроется меню, предназначенное для выбора режима записи.  

В нем три команды: Instant Record, Timed Record и Disable 

Record Button. Последняя команда блокирует кнопку , чтобы, 

нажав ее случайно, вы не "затерли" аудиофайл, представляющий 

для вас ценность. Если вы выберете вариант Instant Record, то 

запись будет начинаться в момент нажатия кнопки . Выбор 

варианта Timed Record позволяет запрограммировать время на-

чала и продолжительность сеанса записи. Этот режим записи мы 

рассматривать не будем. 

Выберите вариант Instant Record. Наконец-то можно смело 

нажимать кнопку . Вы ожидали, что прямо сейчас начнется 

запись? Потерпите немного. Осталось определиться с форматом, 

в котором будет вестись запись. Для этого и открылось диалого-

вое окно New Waveform (рис. 3.25). Это же окно появляется  

и при выборе команды File > New главного меню. 

 

Рис. 3.25. Диалоговое окно New Waveform: выбор формата аудиофайла 



Глава 3  228 

Диалоговое окно New Waveform предназначено для задания 

формата, в котором будет храниться оцифрованный звук. Можно 

считать, что до тех пор, пока в этом диалоговом окне не выбраны 

необходимые параметры и оно не закрыто нажатием кнопки OK, 

аудиофайл не существует. И только после закрытия окна New 

Waveform следует говорить о том, что он создан. Правда, пока 

сеанс записи не начат, созданный аудиофайл не содержит ни од-

ного отсчета, а в главном окне нет сигналограммы. 

В списке Sample Rate выберите частоту дискретизации (сэм-

плирования). 

В группе Channels выберите режим: моно (Mono) или стерео 

(Stereo). 

В группе Resolution выберите разрешение представления сиг-

нала: 8-битное (8-bit), 16-битное (16-bit) или 32-битное с пла-

вающей точкой (32-bit (float)). 

Сразу после того, как вы нажмете кнопку OK или клавишу 

<Enter>, окно New Waveform закроется и начнется запись. 

Можно поступить иначе: заранее создать новый аудиофайл 

командой File > New главного меню. При этом открывается то же 

окно New Waveform, вы выбираете в нем формат аудиофайла и 

нажимаете кнопку OK, но запись после этого не начинается. 

Программа находится в полной готовности и ждет нажатия кноп-

ки  на транспортной панели. 

Пусть запись, так или иначе, началась. Указатель текущей по-

зиции "побежал" вправо, а на рабочем поле стала прорисовывать-

ся сигналограмма. 

Не забывайте поглядывать на измеритель уровня записывае-

мого сигнала (см. разд. 1.3.1), чтобы не допустить его "зашкали-

вания" — срабатывания индикатора клиппирования.  

ПРИМЕЧАНИЕ  

Помните, что в самой программе Adobe Audition нет возможности 
регулировать уровень входного сигнала. Это нужно делать в ап-
паратном микшере, если таковой имеется и задействован в сеан-
се записи, либо в виртуальном микшере звуковой карты. 

Время записи можно контролировать, глядя на панель Time. 

Эту панель также можно отделить от других панелей, перемес-
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тить в любое место рабочего поля либо на экран второго монито-

ра и установить устраивающий вас размер. Если, например, на 

панели видны цифры 0:02.254, то это означает, что с момента 

начала записи прошло 0 минут, 2 секунды и 254 миллисекунды.  

В данном случае время отображается в десятичном формате. 

Щелчком правой кнопки мыши на панели открывается контекст-

ное меню, в котором можно выбрать другой формат отображения 

времени. 

Если вы решили временно прервать запись, нажмите кнопку 

 (Pause). 

Считать, что в вашем распоряжении уже есть сигналограмма 

(волновая форма), можно будет только после нажатия кнопки  

(Stop). Ну вот, запись выполнена. На всякий случай сразу же со-

храните полученный результат в файле.  

3.4. Редактирование  

записанного аудиофайла 

Запись завершена, а основная работа еще только начинается. 

Ее объем и содержание зависят от характера конечного продукта, 

который вы решили создать. Возможностей Adobe Audition дос-

таточно для того, чтобы выполнить реставрацию старой записи  

с магнитной ленты или винилового диска, записать "с нуля" му-

зыкальную композицию или песню, создать звуковой рекламный 

ролик. Кроме того, с помощью Adobe Audition можно обработать 

саундтрек для цифрового видео. 

В гл. 1 мы рассказали об основных приемах анализа (измере-

ние уровня, спектральный анализ, анализ качества стереополя)  

и обработки звуковых данных (фильтрация, динамическая обра-

ботка, обработка эффектами). Все это можно и нужно применять 

и к звуковым данным, записанным с микрофона. Но сначала 

нужно навести порядок в исходном материале. Вероятно, во вре-

мя сеанса записи вам пришлось сделать не один дубль. А если 

запись велась непрерывно, то в ней неизбежны фрагменты, явно 

непригодные для дальнейшей обработки. Исполнитель сбивался, 

кашлял, "сердился" в неприличных выражениях, что-то с грохо-
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том опрокидывалось, звонили мобильники… Словом, получилась 

фонограмма, нуждающаяся в монтаже. Кроме того, запись могла 

выполняться на такой аппаратуре или в таких условиях, что  

в итоге оказалась шумной. С этим тоже нужно что-то делать. Да-

вайте познакомимся с теми возможностями, какие предоставляет 

Adobe Audition в плане монтажа (редактирования) фонограмм. 

Монтаж фонограммы из отдельных фрагментов на единствен-

ном треке обязательно предполагает помещение данных в буфер 

обмена и их последующую вставку на трек. В свою очередь, любая 

операция редактирования (копирование, удаление, вставка данных) 

начинается с выделения нужного фрагмента сигналограммы. По-

этому сначала мы рассмотрим действия, которые есть смысл вы-

полнить, готовясь к выделению фрагментов и их монтажу. 

3.4.1. Выбор рабочего буфера обмена 

В программе предусмотрено 5 внутренних буферов обмена  

и один внешний (системный). Для определения рабочего (теку-

щего) буфера обмена в главном меню предназначено подменю 

Edit > Set Current Clipboard. Именно в буфер обмена, выбран-

ный в этом подменю, будут помещаться данные при выполнении 

тех операций редактирования, для которых он требуется. 

Через внешний (системный) буфер обмена можно обмени-

ваться данными с другими Windows-приложениями. 

Чем хороша работа не с системным, а с собственным буфером 

обмена программы? Если вы выключите компьютер, а на сле-

дующий день решите продолжить работу с Adobe Audiotion, то 

обнаружите, что информация, помещенная во внутренний буфер 

обмена, сохранилась. Никуда она не пропадет и через неделю,  

и через год. Секрет прост — внутренний буфер обмена организо-

ван в виде файла. 

А в каких случаях может оказаться полезным наличие несколь-

ких буферов обмена? Допустим, вы формируете фонограмму из 

нескольких аудиофайлов, причем некоторые из них используются 

многократно. Содержимое каждого аудиофайла можно скопиро-

вать в отдельный буфер обмена, чтобы затем вставлять в нужные 

места; главное — не перепутать, где что хранится, и вовремя ме-

нять текущий буфер обмена.  
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3.4.2. Выбор способа привязки границ  

выделенного фрагмента сигналограммы  

к координатной сетке 

Подменю Edit > Snapping главного меню облегчает процесс 

ручной привязки границ выделенного фрагмента сигналограммы  

к характерным точкам: либо к линиям шкалы времени (координат-

ной сетке), либо к границам фраз/долей. 

Выберите команду Snap to Ruler (Fine) и попробуйте выде-

лить фрагмент сигналограммы. Нажмите левую кнопку мыши и, 

не отпуская ее, медленно перемещайте указатель мыши, напри-

мер, вправо. Зона выделения будет расширяться, но характер 

движения ее правой границы не всегда соответствует движению 

мыши. Как только вы приблизите правую границу зоны выделе-

ния к очередной линии координатной сетки, оставшийся неболь-

шой интервал граница преодолеет скачком. А при дальнейшем 

движении мыши она не сразу "отлепится" от линии координат-

ной сетки. Этот алгоритм имитирует слабое "притяжение" грани-

цы зоны выделения к линии координатной сетки. 

Если же выбрана команда Snap to Ruler (Coarse), описанный 

процесс станет еще заметнее: граница зоны выделения будет 

сильно "притягиваться" линиями координатной сетки. 

При выборе команды Snap to Markers граница зоны выделе-

ния "притягивается" не к линиям координатной сетки, а к лини-

ям, которыми после применения команды Edit > Auto-Mark 

главного меню отмечены границы фраз и долей. 

Если выбрана команда Snap to Zero Crossing, то граница зо-

ны выделения будет тяготеть к тем точкам, в которых сигнало-

грамма пересекает нулевую линию (сигнал принимает нулевое 

значение). 

При монтаже саундтрека видеофильма очень удобен вариант 

Snap to Frames. В этом случае легко выделить фрагмент, грани-

цы которого совпадают с границами кадров. 

Если не выбрана ни одна из перечисленных команд, переме-

щение границы выделенного участка строго соответствует дви-

жению указателя мыши в горизонтальном направлении. 
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Как вы уже знаете, начинать обработку звуковых данных, за-

писанных с помощью микрофона, следует с удаления наименее 

удачных дублей и посторонних звуков в паузах между словами. 

Из оставшихся после выбраковки дублей нужно взять и затем 

смонтировать в нужной последовательности лучшие фрагменты. 

3.4.3. Перемещение границ  
выделенного фрагмента сигналограммы  
к нулевым точкам 

Подменю Edit > Zero Crossings содержит команды, позво-

ляющие передвигать начало и конец выделенного фрагмента 

сигналограммы в те позиции, где звуковая волна пересекает ли-

нию, соответствующую нулевой отметке (или уровню –  при 

логарифмическом масштабе вертикальной шкалы). Эта функция, 

а также функция Crossfade (кроссфейд) служат для достижения 

одной и той же цели — предотвращения щелчков в начале и в 

конце вставляемого фрагмента. Алгоритм поиска нуля работает  

с учетом того, что у вас могут быть два стереоканала, сигнало-

граммы в которых отличаются. Кратко рассмотрим смысл ко-

манд подменю. 

Применение команды Adjust Selection Inward означает, что 

границы выделенного фрагмента будут автоматически перемеще-

ны к ближайшим нулевым точкам, расположенным внутри выде-

ленного интервала. На рис. 3.26 приведен пример неудачно выде-

ленного фрагмента сигналограммы. Видно, что границы фрагмента 

оказались в тех точках, где отсчеты имеют ненулевые значения. 

Если такой фрагмент вырезать и смонтировать с какой-либо дру-

гой сигналограммой, то на их стыке будет слышен щелчок.  

На рис. 3.27 представлена та же сигналограмма после примене-

ния команды Adjust Selection Inward. Сравните рисунки и убеди-

тесь, что границы выделенного участка переместились к ближай-

шим нулевым точкам, приблизившись друг к другу. 

Применение команды Adjust Selection Outward приведет к то-

му, что границы выделенного фрагмента будут автоматически 

перемещены к нулевым точкам, расположенным вне выделенно-

го интервала. 
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Рис. 3.26. Пример неудачно выделенного фрагмента сигналограммы 

 

Рис. 3.27. Пример перемещения границ выделения  
внутрь выделенного фрагмента сигналограммы 

Команда Adjust Left Side to Left сдвинет левую границу вы-

деленного фрагмента к ближайшей слева нулевой точке. 

Команда Adjust Left Side to Right сдвинет левую границу вы-

деленного фрагмента к ближайшей справа нулевой точке. 

Команда Adjust Right Side to Left сдвинет правую границу 

выделенного фрагмента к ближайшей слева нулевой точке. 
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Команда Adjust Right Side to Right сдвинет правую границу 

выделенного фрагмента к ближайшей справа нулевой точке. 

Проделав несколько опытов по перемещению границ выде-

ленного фрагмента, вы заметите, что они не всегда перемещают-

ся именно к ближайшим нулевым точкам: создается впечатление, 

будто иногда Adobe Audition "проскакивает" их. И все же про-

грамма не ошибается. Просто если вы выделили фрагмент сте-

реофонической сигналограммы, то Adobe Audition отыскивает 

такие точки, где нулю равны одновременно сигналы и правого,  

и левого каналов. 

Поупражняйтесь, выделяя фрагменты сигналограммы и пере-

мещая границы выделения в различных направлениях. 

3.4.4. Копирование, вырезание,  
удаление, вставка материала 

Команды, позволяющие копировать, вырезать, удалять и встав-

лять материал, содержатся в меню Edit. 

Чтобы скопировать или вырезать фрагмент сигналограммы, 

его нужно сначала выделить. О том, как это сделать графическим 

или численным способом, мы подробно рассказали в предыду-

щих разделах. 

При выполнении команд Copy (<Ctrl>+<C>) и Cut (<Ctrl>+<X>) 

данные будут помещены в текущий буфер обмена. 

Команды Paste (<Ctrl>+<V>) и Paste to New обеспечивают 

вставку в сигналограмму данных из текущего буфера обмена. 

Если вы примените команду Paste, то данные будут вставлены 

в сигналограмму, находящуюся на активной странице окна. На-

чало вставляемого фрагмента совпадет либо с положением мар-

кера, либо с началом выделенного фрагмента сигналограммы. 

Команда Paste to New, по существу, представляет собой целую 

последовательность операций: сначала автоматически создается 

новая страница, а потом из буфера обмена на нее вставляется 

фрагмент. Затем фрагмент превращается в новую сигналограмму, 

которую можно сохранить в файле с новым именем. 

Командой Copy to New вы также организуете последователь-

ность операций. В результате выделенный фрагмент текущей сигна-

лограммы будет вставлен в автоматически созданный новый файл. 
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Команда Delete Selection (<Del>) предназначена для удаления 

выделенного фрагмента сигналограммы. 

Команда Trim (<Ctrl>+<T>), наоборот, удаляет из текущей 

сигналограммы все звуковые данные, кроме выделенного фраг-

мента. Оставшийся после удаления фрагмент будет по-прежнему 

выделен. 

Опробуйте действие перечисленных команд. 

3.4.5. Микширование вставляемой 

сигналограммы с существующей 

Команда Edit > Mix Paste заслуживает большего внимания. 

Она предназначена для наложения звуковых данных из буфера 

обмена на редактируемую сигналограмму. Команда Mix Paste 

открывает одноименное диалоговое окно (рис. 3.28). 

 

Рис. 3.28. Диалоговое окно Mix Paste 

В группе Volume расположены элементы управления уровнем 

вставляемого материала для левого (L) и правого (R) каналов. Уро-

вень задается в процентах (по умолчанию 100 %) при помощи 

слайдеров или численно. Если установить флажок Lock Left/Right, 

то уровень обоих стереоканалов можно будет изменять одновре-

менно. При установленном флажке Invert происходит инверсия 
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звуковой волны перед вставкой. Слово "инверсия" в данном слу-

чае означает умножение каждого из отсчетов на –1. Результат 

будет таким: положительные полуволны колебаний превратятся  

в отрицательные, а отрицательные, наоборот, в положительные. 

В левой нижней части окна вы можете выбрать один из спосо-

бов вставки. 

 Insert — вставка, при которой редактируемая сигналограмма 

будет "раздвинута", чтобы разместить содержимое буфера. 

 Overlap (Mix) — вставка с микшированием. Материал из бу-

фера "перемешается" с редактируемой сигналограммой. 

 Replace — вставка с заменой. Материал из буфера заместит 

звуковые данные, находившиеся в этой области сигналограм-

мы до вставки. 

 Modulate — вставка с модуляцией по амплитуде. Каждый от-

счет звукового сигнала из буфера обмена умножается на соот-

ветствующий отсчет редактируемой сигналограммы. 

Флажок Crossfade предназначен для установки режима сглажи-

вания, который часто бывает очень полезен. Когда вы выделяете 

блок звуковых данных, значения отсчетов сигнала на краях этого 

блока не обязательно будут равны нулю, что в дальнейшем может 

вызывать неприятные щелчки при воспроизведении материала, 

вставленного из буфера обмена. От этих щелчков нужно как-то 

избавляться, что и делается при помощи режима сглаживания. При 

сглаживании программа не просто вставляет звуковой блок в сигна-

лограмму, а делает это "разумно": она управляет его уровнем, т. е.  

в начале блока уровень плавно возрастает от 0 до 100 %, а за некото-

рое время до окончания блока начинает плавно убывать до 0 %. 

Время изменения уровня, задаваемое в поле, расположенном справа 

от флажка, очень невелико (порядка десятка миллисекунд), поэтому 

слушатель ничего не заметит. 

Следующая группа переключателей позволяет выбрать источ-

ник вставляемого блока. 

 From Clipboard N — внутренний буфер обмена. N — номер 

текущего буфера обмена. Программа заботится, чтобы вы не 

перепутали, какой именно материал вставляете. 

 From Windows Clipboard — системный буфер обмена. 

 From File — файл. 
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Если вы решили вставить данные из файла (и выбрали соот-

ветствующий переключатель), далее нужно выбрать нужный 

файл, нажав кнопку Select File (откроется окно загрузки файлов). 

Если этого не сделать, то вставка будет осуществляться из теку-

щего буфера обмена, несмотря на то что выбран переключатель 

From File. 

Опция Loop Paste … times позволяет вставлять сигналограм-

му, находящуюся в буфере обмена, несколько раз подряд (коли-

чество повторений задается в поле, расположенном справа от 

флажка). 

Задав все параметры, нажмите кнопку OK или клавишу <Enter>. 

Вы, наверное, убедились, что команда Mix Paste и соответст-

вующее диалоговое окно — мощный универсальный инструмент 

монтажа фонограмм. Если бы программа Adobe Audition не была 

мультитрековым редактором, то это средство было бы просто 

незаменимым.  

3.4.6. Отмена  

и повторение операций 

Команды отмены и повторения операций находятся в меню 

Edit. Первая из них — команда Undo, отменяющая последнее 

совершенное действие. Если повторить выбор этой команды, то 

отменится еще один шаг редактирования и т. д. до тех пор, пока 

возможность отмены не будет исчерпана. Если отмену произве-

сти невозможно, то вместо названия Undo вы увидите бледную 

надпись Can't Undo. 

Команда Edit > Redo повторяет отмененную ранее операцию. 

Команда Edit > Enable Undo позволяет включать (если она 

помечена в меню) и выключать режим отмены. 

Для возможности применения команды Edit > Undo результа-

ты каждого шага при работе с программой автоматически запи-

сываются в специальные временные файлы, которые могут иметь 

большой объем. Если на вашем диске немного свободного места, 

то можно отключить режим отмены, тогда временные файлы 

создаваться не будут. В этом случае придется как следует обду-
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мывать каждое свое действие, поскольку отменить неудачное 

решение вы не сможете. Мы уже рассказали, как ограничить 

максимальное число отмен (см. разд. 3.1.1). 

По выборе команды Edit > Repeat Last Command (или при 

нажатии клавиши <F2>) повторяется последняя выполненная  

команда. 

ПРИМЕЧАНИЕ  

Здесь нужно быть очень внимательным! Повторяться будет та ко-

манда, которую программа Adobe Audition выполнила последней, 

независимо от того, с какой сигналограммой вы работали, — с те-

кущей или с другой. Причем если команда открывает диалоговое 

окно с изменяемыми опциями и параметрами, то при повторе оно 

содержит те же установки, что и при предыдущем выполнении  

команды. 

Заметим, что не все команды могут повторяться. Команда  

Repeat Last Command доступна в меню Edit, если последняя 

команда может быть повторена.  

Итак, инструменты подготовлены, с операциями, позволяю-

щими монтировать фонограмму, перемещая, заменяя и удаляя ее 

отдельные фрагменты, вы познакомились. Пора переходить к де-

лу — приводить в порядок структуру записанного аудиофайла. 

Перекраивая структуру сигналограммы, не забывайте, что 

этим редактирование не заканчивается. Впереди еще шумоподав-

ление, фильтрация и преобразование динамического диапазона. 

Возможно, после выполнения этих этапов придется вновь вер-

нуться к монтажу фонограммы, правда, уже к более тонкому  

и тщательному. Поэтому не пытайтесь сразу же "вылечить" сиг-

налограмму от всех замеченных "болезней". В частности, обяза-

тельно сохраните в файле несколько наиболее протяженных 

фрагментов, в которых нет полезного сигнала (речи, вокала или 

звука музыкального инструмента), а имеется только шум, харак-

терный для помещения, где производилась запись, или фон от 

электромагнитных помех, наведенных в сигнальных цепях аппа-

ратуры. Участок, содержащий только шум, понадобится в про-

цессе шумоподавления. 
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3.4.7. Обработка стыков фрагментов,  
пауз и амплитуды аудиосигнала  

Допустим, что из исходного аудиофайла, записанного с мик-

рофона, вы удалили ненужные фрагменты и сохранили остав-

шийся материал в новом файле. В нем теперь нет явно непригод-

ных участков. Но и то, что осталось, все же требует обработки. 

На ее очередном этапе можно сделать следующее: 

 позаботиться о том, чтобы стыки фрагментов были незаметны 

на слух; 

 отредактировать длительности пауз и между словами, и между 

фразами; 

 заполнить абсолютной тишиной протяженные паузы, содер-

жащие шум; 

 приблизительно выровнять громкость звучания отдельных 

фрагментов (особенно взятых от различных дублей). 

Эти операции не обязательно должны выполняться в указанном 

порядке. Некоторые можно пропустить, если в результате анализа 

сигналограммы вы увидели, что в них нет необходимости. 

Уровень сигнала на выделенном участке сигналограммы (в ча-

стности, на стыке фрагментов) можно преобразовать с помощью 

диалогового окна Amplify/Fade, открываемого командой Effects > 

Amplitude and Compression > Amplify/Fade (process).  

Кроме того, в режиме Edit View имеются удобные средства 

графического редактирования сигналограммы непосредственно  

в главном окне.  

Устранение постоянной составляющей  
в аудиосигнале 

Потенциальная причина возникновения щелчков — постоян-

ная составляющая напряжения в записанном сигнале. В ее нали-

чии или отсутствии вам поможет убедиться окно Amplitude  

Statistics, открываемое командой Window > Amplitude Statistics. 

На его вкладке General среди прочей статистической информа-

ции о параметрах аудиофайла вы найдете DC Offset — среднее 

значение отсчетов (уровень постоянной составляющей в выде-

ленном фрагменте аудиофайла для каждого из двух каналов). 
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Как-то мы пытались записывать речь диктора, подавая сигнал 

с микрофона непосредственно на вход встроенной звуковой карты 

ноутбука. И получили ужасный результат: DC Offset = –0,395 %. 

Если подобная неприятность произошла и с вашим аудиофайлом, 

то откройте диалоговое окно Amplify/Fade (команда Effects > 

Amplitude and Compression > Amplify/Fade (process)) на вклад-

ке Constant Amplification. Допустим, что преобразовывать ам-

плитуду сигнала пока не нужно, поэтому в полях, расположен-

ных справа от слайдеров L и R группы Amplification, задайте 

значение 0 дБ (или 100 %). 

В группе DC Bias установите флажок DC Bias Adjust, выберите 

переключатель Absolute и убедитесь, что в полях L и R, располо-

женных справа от флажка DC Bias Adjust, присутствует значение 

0, заданное по умолчанию. Нажмите кнопку OK. После непродол-

жительных расчетов вся сигналограмма как единое целое немного 

сместится в главном окне программы по вертикали. Если теперь с 

помощью команды Analyze > Statistics вновь измерить статисти-

ческие параметры аудиофайла, то окажется, что DC Offset = 0 %. 

Смещение ликвидировано, постоянная составляющая устранена. 

Графическое редактирование уровня 

сигналограммы в режиме Edit View 

В Adobe Audition предусмотрены удобные средства графиче-

ского редактирования сигналограммы, имеющие прямое отноше-

ние к преобразованию уровня аудиосигнала. В начале сигнало-

граммы уровень можно постепенно увеличить (Fade In), в конце — 

уменьшить (Fade Out), а на выделенном интервале — и увели-

чить, и уменьшить. 

В режиме Edit View в правом и левом верхних углах панели 

Main (рис. 3.29, а) на фоне сигналограммы, присмотревшись, 

можно заметить по одному небольшому квадратику. Если навес-

ти на них поочередно указатель мыши, то появится подсказка: 

Fade In либо Fade Out. 

ПРИМЕЧАНИЕ  

Эти квадратики могу быть не видны, если отображается не вся 
сигналограмма, а только ее фрагмент, в который не входят на-
чальная и конечная точки. 
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 а      б      в 

Рис. 3.29. Пример выполнения операции Fade In графическим способом 

Захватим мышью, например, левый квадратик. К нему из левого 

нижнего угла координатного поля тут же протянется хорошо за-

метная желтая линия. Это график изменения уровня сигнала. Пе-

ремещая указатель мыши влево-вправо, зададим длительность 

интервала, на котором будет выполняться операция Fade In. Пе-

ремещая указатель мыши вверх-вниз, придадим графику нужную 

форму (рис. 3.29, б). Отпустим кнопку мыши. После непродол-

жительных расчетов программа отработает наше задание. Полу-

чится сигналограмма, в начале которой уровень сигнала нарастает 

постепенно (рис. 3.29, в). 

Аналогично выполняется операция Fade Out в конце аудио-

файла, если захватить мышью правый квадратик. 

ПРИМЕЧАНИЕ  

Это операции разрушающего редактирования. После их выполне-
ния в аудиофайл вносятся изменения. Их можно отменить, вос-

пользовавшись командой Edit > Undo. 
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Рис. 3.30. Пример применения регулятора Gain Control  
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Теперь выделим тот участок сигналограммы, на котором нуж-

но увеличить или уменьшить уровень сигнала. Позаботимся, что-

бы границы выделения проходили через точки, в которых сигнал 

принимает нулевое значение (см. разд. 3.4.3). На фоне выделен-

ной сигналограммы мы увидим полупрозрачное изображение 

круглой ручки — регулятор усиления/ослабления сигнала Gain 

Control.  

ПРИМЕЧАНИЕ  

К сожалению, показать данный регулятор на рисунке не удается. 
Этот элемент графического интерфейса "не улавливается" при 
выполнении в Windows операции Print Screen. Если на вкладке 
Display диалогового окна Preferences (см. разд. 3.1.1) установлен 

флажок Show on-clip gain control when there is no selection 

range, то в режиме Edit View, если даже не выделен участок сиг-
налограммы, будет отображаться регулятор усиления. 

Захватив и "вращая" мышью этот регулятор, можно изменить 

уровень исходного аудиосигнала (рис. 3.30, а) в одинаковой сте-

пени или для всего аудиофайла, или для всего выделенного уча-

стка (рис. 3.30, б). 

ПРИМЕЧАНИЕ  

Это также операция разрушающего редактирования. Ее можно 
отменить, воспользовавшись командой Edit > Undo. 

Формирование абсолютной тишины  
на заданном участке сигналограммы 

Если в фонограмме есть продолжительные паузы, то в них 

становятся более заметными шумы, записанные вместе с полез-

ным сигналом. 

В Adobe Audition есть несколько способов борьбы с шумами  

в паузах. Один из них — замена звука, имеющегося в паузах, на 

абсолютную тишину. На практике это означает, что значения 

всех звуковых отсчетов в заданном фрагменте приравниваются  

к нулю. 

Абсолютная тишина на выделенном участке сигналограммы 

создается после применения команды Effects > Mute главного 

меню.  
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Рис. 3.31. Пример сигнала исходного (а)  

и обработанного командой Effects > Mute (б) 

Чтобы уяснить сущность этой функции, сравните рис. 3.31, а 

(исходный сигнал) и рис. 3.31, б (тот же сигнал после обработки 

командой Effects > Mute).  

Команда Effects > Mute может пригодиться в том случае, ко-

гда части полезного сигнала (слова, фразы) отделены друг от 

друга протяженными паузами, в которых ничего нет кроме шума. 

Она незаменима, если все фрагменты полезного звукового сиг- 

нала должны оставаться на своих местах, а удаление пауз недо-

пустимо. 

Если допускается смещение фрагментов полезного сигнала во 

времени, то можно просто вырезать паузы из фонограммы или 
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применить средство автоматизации этого процесса, имеющееся  

в Adobe Audition (команда Edit > Delete Silence). 

В ряде ситуаций, наоборот, нужно "раздвинуть" отдельные 

фрагменты на определенный интервал, добавив между ними паузы 

заданной длительности. Конечно, есть смысл сделать так, чтобы 

вновь введенные паузы не содержали шумов. В таких случаях це-

лесообразно воспользоваться командой Generate > Silence главно-

го меню, открывающей окно Generate Silence, в котором есть поле 

для ввода длительности паузы. После нажатия кнопки OK сигна-

лограмма будет разделена в точке расположения маркера, а справа 

от нее появится участок заданной длительности, содержащий аб-

солютную тишину. Левая часть исходной сигналограммы останет-

ся на месте, а начало ее правой части переместится в конец сфор-

мированной паузы. 

Если паузы коротки и их много, то становится хлопотно выде-

лять вручную каждую из них с целью последующей замены шума 

абсолютной тишиной. Разумнее применить шумоподавление. 

Нужно, однако, понимать, что путем применения алгоритмов шумо-

подавления нельзя достичь абсолютной тишины, а можно только 

более или менее эффективно снизить уровень шума. 

Вместе с тем, некоторые специалисты считают, что шум  

в паузах хотя и должен быть ослаблен, но полностью удалять его 

(например, заменяя абсолютной тишиной) не следует. Скачки от 

идеально тихих фрагментов к фрагментам, где наряду с речью 

либо музыкой содержится шум, иногда бывают заметными и раз-

дражают слушателя. 

Не заменяйте фрагменты аудиофайла абсолютной тишиной, 

если вы планируете применить к аудиофайлу средство шумопо-

давления, имеющееся в Adobe Audition. Оно состоит в том, что 

программа вычисляет значения спектральных составляющих 

предъявленного ей шума и затем вычитает их из соответствую-

щих спектральных составляющих смеси "сигнал + шум". Если  

в аудиофайле имеется участок абсолютной тишины, то после 

шумоподавления он будет заменен инвертированным шумом.  

Из сказанного следует, что если вы решите вставить в сигнало-

грамму фрагменты абсолютной тишины, то делать это целесооб-

разно после шумоподавления, а не до него. 
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Инвертирование аудиосигнала 

В каких случаях может пригодиться эта операция? Инверти-

ровать сигнал требуется тогда, когда при записи стереофониче-

ского аудиофайла нарушено фазирование сигналов из-за ошибок 

коммутации или неверной распайки кабелей и разъемов. Сигналы 

правого и левого стереоканалов оказываются записанными в про-

тивофазе. Это в корне меняет стереообраз и приводит к мононесо-

вместимости фонограммы. Проще говоря, если такую фонограмму, 

например, воспроизвести в концертном зале с монофоническим 

акустическим оборудованием или передавать посредством ра-

диостанции стереофонического вещания, а принимать на моно-

фонический приемник, то в худшем случае кроме редких хрипов 

и скрежета ничего услышать не удастся.  

 

 а  

 б 

Рис. 3.32. Исходный (а) и инвертированный (б) сигналы 
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Противофазные (для основных спектральных составляющих) 

сигналы двух стереоканалов при сложении в моносигнал почти 

компенсируют друг друга. Чтобы избежать этого, нужно тща-

тельно контролировать идентичность преобразования фазы в сте-

реоканалах микшера, устройствах коммутации и обработки. Если 

ошибки избежать не удалось, придется инвертировать один из 

сигналов стереопары. 

Предварительно выделите тот фрагмент сигналограммы, в ко-

тором звуковые волны требуется инвертировать. Затем выберите 

команду Effects > Invert. Программа немедленно приступит к опе-

рации инвертирования аудиосигнала. Каждый звуковой отсчет, 

приходящийся на выделенный участок, будет умножен на –1. 

Сравните две картинки: исходный сигнал (рис. 3.32, а) и ре-

зультат инвертирования сигнала (рис. 3.32, б). 

Видно, что положительные полуволны звуковых колебаний 

стали отрицательными и наоборот. В этом и состоит инвертиро-

вание. 

3.5. Уменьшение уровня шума  

с помощью функции Noise Reduction 

Одна из самых замечательных функций Adobe Audition выпол-

няется с помощью диалогового окна Noise Reduction (рис. 3.33), 

открываемого командой Effects > Restoration > Noise Reduction 

(process).  

Когда вы научитесь пользоваться этим простым и в то же вре-

мя мощнейшим инструментом, возможно, у вас появится вера  

в то, что какой бы зашумленной ни была запись, Adobe Audition 

сумеет подавить шум без ущерба для полезного сигнала. Конечно 

же, это не совсем так. Искажения при шумоподавлении есть, но  

в разумных пределах, т. е. человек их не замечает. Принцип дейст-

вия функции Noise Reduction основан на довольно сложной ма-

тематике, заимствованной из теории оптимальной обработки 

сигналов на фоне помех. Вот только программа занимается не 

обнаружением сигнала или измерением его параметров, а оцени-

вает свойства шума и синтезирует фильтр, согласованный с по-
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лученной моделью шума. Затем таким фильтром обрабатывается 

аудиофайл. 

ПРИМЕЧАНИЕ  

Согласованный фильтр имеет АЧХ, совпадающую со спектром то-
го процесса, с которым он согласован.  

На рис. 3.33 диалоговое окно Noise Reduction представлено  

в том виде, в каком оно бывает, если открыть его впервые в те-

кущем сеансе. На том месте, где позднее появятся координатные 

поля, пока что отображается пошаговая инструкция. Как раз  

о том, как привести в действие шумоподавитель, мы сейчас и 

расскажем. 

 

Рис. 3.33. Диалоговое окно Noise Reduction 
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Рис. 3.34. Выделен фрагмент сигналограммы,  
содержащий только шум 

 

Рис. 3.35. Сигналограмма с подавленным шумом  
(кроме начального фрагмента)  
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Для шумоподавления нужно иметь хотя бы немного информа-

ции о шуме. А чем больше его статистических свойств известно, 

тем эффективнее подавление. Функция Noise Reduction чем-то 

напоминает собаку-ищейку, которой для поиска нужен образец 

запаха. Программе Adobe Audition тоже требуется образец, но не 

запаха, а шума. Откуда взять эту информацию? В начале аудио-

файла всегда нужно оставлять участок, содержащий только шум. 

Его-то и нужно дать "обнюхать" шумоподавителю.  

Прежде чем приступать к шумоподавлению, закройте диало-

говое окно Noise Reduction. Теперь в главном окне программы 

выделите фрагмент сигналограммы (рис. 3.34) без полезной ин-

формации, но содержащий характерный для этого аудиофайла 

шум (шипение микрофона, фоновые звуки и т. п.). Желательно, 

чтобы этот фрагмент был подлиннее, и программа получила по-

больше информации о шуме.  

Теперь откройте окно Noise Reduction. 

Нажмите кнопку Capture Profile. Будет собрана информация 

о шуме, которая отобразится в верхнем координатном поле 

(рис. 3.36). Программа совершенно справедливо сочтет, что 

предъявленный ей фрагмент содержит только шум. Вы можете 

вести ее в заблуждение, выделив участок, где наряду с шумом 

есть и полезный сигнал. 

В принципе, здесь представлена амплитудно-частотная харак-

теристика (АЧХ) фильтра подавления, однозначно связанная  

со спектром проанализированного фрагмента сигналограммы.  

Но это не совсем обычная АЧХ. Можно сказать, что это "АЧХ 

наоборот": чем выше находится какая-либо ее точка на коорди-

натном поле, тем сильнее ослабляется соответствующая этой 

точке спектральная составляющая. 

ПРИМЕЧАНИЕ  

В гл. 1, рассматривая АЧХ фильтров, мы говорили о коэффици-
енте передачи и его зависимости от частоты. Иногда вместо ко-
эффициента передачи для описания свойств фильтров исполь-
зуют обратную ему величину: коэффициент ослабления. График 

в верхнем координатном поле окна Noise Reduction как раз  

и представляет собой зависимость коэффициента ослабления 
от частоты.  
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Рис. 3.36. Диалоговое окно Noise Reduction  
после сбора информации о шуме 

По горизонтальной оси верхнего координатного поля отложена 

частота, а по вертикальной — величина коэффициента ослабления 

(хотя сами оси и не размечены). При реализации обработки порог шу-

моподавления будет непосредственно зависеть от вида АЧХ. Правда, 

на координатном поле вы можете разглядеть целых три графика: 

 верхний (на экране — красный): АЧХ фильтра, соответст-

вующая максимальному порогу шумоподавления; 

 нижний (на экране — зеленый): АЧХ фильтра, соответствую-

щая минимальному порогу шумоподавления (эти графики про-

грамма формирует автоматически после сбора информации  

о шуме, изменить их вы не можете); 

 средний (на экране — желтый): АЧХ фильтра, соответствую-

щая реально установленному вами уровню шумоподавления. 
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Величина последнего параметра регулируется ползунком 

Noise Reduction Level или вводится в расположенном рядом с ним 

поле (в процентах). Поиграйте этим ползунком, и вы увидите, как 

при его левом положении желтый график сливается с зеленым,  

а при правом — с красным. В промежуточном положении пол-

зунка желтый график имеет собственную форму.  

При малом значении параметра Noise Reduction Level  

в спектр полезного сигнала практически не вносятся никакие из-

менения, а шум может подавляться на десятки децибел. Однако 

такая шумовая обстановка складывается не всегда, может потре-

боваться и глубокое шумоподавление. При этом спектр сигнала, 

скорее всего, исказится, возникнут режущие слух эффекты. 

Как правило, при значении параметра Noise Reduction Level, 

равном 60 %, внешний записанный шум оказывается понижен-

ным до уровня, хотя и не сравнимого с уровнем собственных 

шумов звуковой карты и шума квантования, но такого, что при 

средней громкости воспроизведения шум в паузах не слышен. 

Если выбрать порог подавления более высоким, то дальнейшего 

улучшения субъективного ощущения тишины в паузах, возмож-

но, и не будет, зато в полезном сигнале появятся искажения в ви-

де металлического призвука.  

Итак, желтый график — это зависимость реального порога шу-

моподавления от частоты. Вы можете не только влиять на его об-

щий уровень (с помощью ползунка Noise Reduction Level), но  

и корректировать этот уровень в отдельных частотных областях  

с помощью нижнего координатного поля. Для коррекции зависимо-

сти уровня подавления от частоты можно воспользоваться имею-

щимся там графиком. Узлы на нем создают щелчками мыши. Пе-

ретаскивая их по координатному полю, графику придают любую 

желаемую форму. Все манипуляции с этим графиком будут неза-

медлительно изменять форму желтого графика в верхнем коорди-

натном поле. Таким образом, в вашем распоряжении есть средство 

корректировки той характеристики, которую программа сформи-

ровала автоматически. Это может пригодиться в сложных случаях, 

когда не удается осуществить глубокое автоматическое подавле-

ние шума во всей полосе частот при сохранении высокого качества 

полезного сигнала и приходится искать приемлемые компромиссы.  
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Характеристики шума можно сохранить в файле, воспользо-

вавшись кнопкой Save. Теперь, если в будущем вы захотите очи-
стить от шума аудиофайл, записанный в той же шумовой обста-

новке, что и нынешний, достаточно нажать кнопку Load Profile  
и загрузить соответствующий файл с характеристиками шума. 
Однако мы не рекомендуем этим увлекаться, поскольку шумовые 
характеристики помещения, где проводятся сеансы записи, мож-
но считать стационарными только в случае хорошей звукоизоля-
ции — для домашних студий это не характерно, настоящую зву-
коизоляцию здесь не создать. Во время одного сеанса записи под 
окном долго прогревалась машина, во время другого — дальний 
сосед сверху сверлил стены, либо у ближайшего соседа из крана 
лилась вода. Это и есть нестационарные составляющие внешних 
шумов. Прелесть Noise Reduction в том, что это средство способ-
но устранять не только истинно шумовые помехи, но и регуляр-
ные фоновые мешающие сигналы, стационарные в период вре-
мени обработки сигналограммы или ее фрагмента. То есть если 
двигатель автомобиля тихо тарахтел на всем протяжении сеанса 
записи, то впоследствии этот звук можно удалить практически 
полностью. Но если вы попытаетесь воспользоваться данным об-
разцом шума для обработки аудиофайла, записанного в сеансе, ко-
гда работала электродрель, это не только не избавит аудиофайл от 
ее звука, но и исказит фонограмму, потому что программа будет 
удалять из нее несуществующий звук автомобильного мотора. 

Для создаваемых файлов с данными о шуме можно задать  

в поле Snapshots in profile количество выборок. 
Все описанное выше было лишь подготовкой к сеансу шумо-

подавления. Как же надо действовать, чтобы и в самом деле из-
бавиться от шума? 

Если теперь кнопкой Select Entire File выделить всю сигнало-
грамму, включая участки, содержащие только шум, и участки, где 
имеется смесь полезного сигнала с шумом, и применить функцию 

Noise Reduction, нажав кнопку OK, то будет выполнено опти-
мальное подавление шума. 

Вы можете убедиться, что интенсивность шума уменьшилась. 
В левой части рис. 3.35 сравните участки с неподавленным и по-
давленным шумом. Если такое уменьшение оказалось недоста-
точным, отмените операцию шумоподавления, вновь откройте 
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окно Noise Reduction и воспользуйтесь регулятором Noise 

Reduction Level или соответствующим полем ввода. 

С принципиально важными элементами окна Noise Reduction мы 
разобрались. Осталось рассмотреть еще несколько полезных опций. 

Если установлен флажок Log Scale, то по оси частот выбира-
ется логарифмическая шкала. Вы уже знаете, что это позволяет 
разглядывать во всех подробностях низкочастотную часть спек-
тра. При снятом флажке — шкала линейная, больше пригодная 
для анализа высокочастотной области спектра. 

Установленный флажок Live Update включает режим моди-
фикации АЧХ в реальном времени. Это означает всего лишь то, 
что АЧХ будет изменяться непрерывно по мере перемещения уз-
лов графика уровня подавления. В противном случае график, 
расположенный в верхнем координатном поле, изменится лишь 
после того, как вы, переместив узел графика в нижнем коорди-
натном поле, отпустите кнопку мыши. 

Нажатием кнопки Reset графику в нижнем координатном поле 
возвращается его исходный вид: он превращается в горизонталь-
ную прямую линию. 

Правее кнопки Reset расположено поле, в котором отобража-
ются координаты указателя мыши (частота в герцах и уровень  
в процентах), когда он находится в пределах нижнего координат-
ного поля.  

Группа Noise Reduction Settings содержит настройки самой 

процедуры шумоподавления. Список FFT Size … points содер-
жит варианты объема выборок для выполнения операции БПФ, 
используемой при шумоподавлении. Чем больше значение, вы-
бранное в списке, тем лучше будет выполнена обработка звука  
и тем больше времени она займет. 

ПРИМЕЧАНИЕ  

Учитывая важность операции шумоподавления, рекомендуем не 
экономить на ней время и выбирать максимальное значение па-
раметра FFT Size. 

Если выбран переключатель Remove Noise, то будет удален 

шум, если выбран переключатель Keep Only Noise, то именно шум 

и останется, а удалится полезный сигнал. Для чего может понадо-

биться последний режим? Подбирая параметры шумоподавителя, 
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обычно вы контролируете степень ослабления шума на слух, нажав 

кнопку Preview (ее название изменится на Stop). Можно практиче-

ски полностью избавиться от шума, но при этом будет в значи-

тельной степени затронут и сам полезный сигнал. Прослушивая 

обработанную фонограмму, легко убедиться в отсутствии шума,  

а оценить, не поврежден ли сигнал, значительно труднее. Вот здесь 

на помощь и приходит переключатель Keep Only Noise. Включите 

его, выделите сигналограмму или ее фрагмент (главное — в выде-

ленном фрагменте должен быть не только шум, но и полезный 

сигнал) и послушайте результат. Если ничего, кроме шума не ус-

лышите, значит, вы правильно подобрали значения параметров 

шумоподавителя. Отмените предварительное прослушивание, на-

жав кнопку Stop, выберите переключатель Remove Noise и, не  

изменяя значения остальных параметров, выполните окончатель-

ное шумоподавление. Если не удалось найти наилучшее сочетание 

параметров, то после применения шумоподавления с выбранным 

переключателем Keep Only Noise вы обязательно услышите, как 

сквозь шум пробиваются некие "членораздельные" звуки. Это  

означает, что при выбранных параметрах к шуму оказались при-

числены и некоторые элементы полезного сигнала. Отмените опе-

рацию, выберите другие значения параметров (например, пере-

двиньте влево ползунок Noise Reduction Level) и сделайте еще 

одну пробу. Добившись исчезновения следов полезного сигнала из 

выборки, вы можете прекратить эксперименты и приступить к на-

стоящему шумоподавлению. 

В поле Precision Factor вводится коэффициент, влияющий на 

точность расчета. Чем больше коэффициент, тем точность выше. 

Однако при увеличении значения этого параметра свыше 10 за-

метного улучшения качества звука не происходит, а времени за-

трачивается гораздо больше. 

Вместо того чтобы понизить шум мгновенно, программа спо-

собна постепенно переходить от зашумленного состояния сигна-

лограммы к незашумленному. В поле Transition Width вводят 

значение параметра, влияющего на протяженность такого пере-

хода. Это позволяет избежать изменений уровня шума, заметных 

на слух. Кстати, полное отсутствие шума в паузах иногда вос-

принимается слушателями негативно, ибо это неестественно.  
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С параметром Smoothing Amount связана степень сглажива-

ния (осреднения) АЧХ. Для помех с большой дисперсией (по-

добных белому шуму) можно оставить в этом поле число 1 (зна-

чение по умолчанию). Для помех с регулярной структурой 

(подобных фону сетевого напряжения с частотой 50 Гц) следует 

попытаться увеличить значение Smoothing Amount. Это может 

способствовать более полному подавлению регулярной помехи 

ценой некоторого повышения уровня шума. Более детальные ре-

комендации по предпочтительному значению этого параметра 

дать трудно. Стоит поэкспериментировать, подбирая его, если 

результаты шумоподавления вас не вполне устраивают. 

В поле Spectral Decay Rate вводится значение (в процентах) 

параметра, определяющего степень обработки спектральных со-

ставляющих сигнала, величина которых находится на уровне 

шума. Рекомендуемые значения параметра: 40—75 %. 

Есть и еще ряд элементов (не столь важных). Переключатели 

Left и Right группы View задают канал (левый или правый), ко-

торому соответствует график в верхнем координатном поле. 

График в нижнем координатном поле общий для двух каналов. 

Если нажать кнопку Select Entire File, то будет выделена вся 

сигналограмма в активном окне, что очень удобно: не нужно за-

крывать окно Noise Reduction, вручную выделять сигналограмму 

и вновь открывать его. 

Установив флажок Bypass, вы временно отключите шумопо-

давитель.  

Итак, вы подавили шум в аудиофайле. На этом мы завершаем 

рассказ о работе с Adobe Audition в режиме Edit View (редакти-

рование отдельных аудиофайлов) и переходим к описанию рабо-

ты в мультитрековом режиме Multitrack View. 

3.6. Вставка аудиоданных  

в мультитрековый проект 

Во многих звуковых редакторах компоновка аудиокомпози-

ции из отдельных файлов осуществляется на единственной паре 

стереотреков — в Adobe Audition этому соответствует режим ре-

дактирования отдельных аудиофайлов Edit View. В этих целях 
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здесь можно использовать только такие стандартные опера- 

ции, как вырезание, вставка, копирование и микширование. Та-

кой монтаж фонограммы, по сути дела, немногим отличается от 

традиционной склейки фрагментов магнитной ленты. Конечно, 

электронный монтаж значительно удобнее, чем работа с резаком, 

кисточкой, клеем и прессом. Однако последовательная процедура 

сборки фрагментов в единое целое требует немалых затрат вре-

мени на подгонку их соединения и достижение баланса в миксах. 

Adobe Audition предоставляет в распоряжение пользователя каче-

ственно новый инструмент монтажа — мультитрековую среду, ко-

торую с полным правом можно считать "редактором в редакторе".  

Итак, основная работа — монтаж из отдельных аудиофайлов 

завершенной аудиокомпозиции — выполняется именно в муль-

титрековом редакторе.  

В окне мультитрекового редактора действительно имеется 

много треков, расположенных один под другим. Там также есть 

свой маркер. Если вы, работая в режиме Edit View, в меню Edit 

выберете команду Insert into Multitrack Session, то сигнало-

грамма, находящаяся на активной странице, будет вставлена на 

трек мультитрекового редактора. Причем начало вставленной 

сигналограммы совпадет с положением маркера. 

При обращении к команде Edit > Insert into Multitrack Session 

в первый раз сигналограмма будет вставлена на первый свободный 

трек. Вторая вставка произойдет на следующий трек и т. д.  

3.7. Работа в главном окне  

в режиме Multitrack View 

Для того чтобы перейти в мультитрековую среду (режим 

Multitrack View, рис. 3.37) из режима Edit View, нужно либо  

в меню View выбрать команду Multitrack View, либо нажать 

кнопку  в главном окне, либо воспользоваться клавишей 

<F12>. На рис. 3.37 мы видим много знакомых элементов: транс-

портную панель, инструменты управления масштабом, панель 

Time, поля ввода границ отображаемого и выделенного фрагмен-

тов сигналограммы, измеритель уровня сигнала, строку статуса.  
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В верхней части окна, как обычно, располагается главное меню. 

Однако на этом сходство с окном редактора, к которому мы при-

выкли, работая в режиме Edit View, заканчивается. Отличия же 

заключаются в том, что в мультитрековой среде в главном окне 

имеется не стереопара треков, а много таких пар.  

3.7.1. Общие принципы работы  

в мультитрековой среде Adobe Audition 

Сигналограммы в мультитрековой среде представлены в виде 

блоков — разноцветных прямоугольников. В каждом из них про-

сматриваются: сигналограмма, имя аудиофайла, в котором эта 

сигналограмма хранится, и графики изменения различных пара-

метров. Блоки представляют собой некие кирпичики, из которых 

в мультитрековой среде можно собрать композицию. 

Блоки можно перемещать во времени и по трекам, а также 

разрезать на части и микшировать (сводить в один стерео- или 

монотрек). Однако в мультитрековой среде невозможно редакти-

ровать саму сигналограмму. Чтобы сделать это, нужно щелкнуть 

на интересующем вас блоке — произойдет переключение в ре-

жим Edit View редактирования выбранной сигналограммы. По-

сле того как из сигналограммы будет вырезано все лишнее, 

проведены шумоподавление, динамическая обработка, фильт-

рация, обработка эффектами, нормализация и т. д., достаточно 

переключиться обратно в мультитрековый режим. 

Надо отметить, что границы блока могут не совпадать с гра-

ницами сигналограммы: в блоке может отображаться и воспроиз-

водиться заданный фрагмент сигналограммы. Кроме того, в раз-

ных блоках может использоваться одна и та же сигналограмма. 

Причем возможны различные варианты: в одном блоке представ-

лен один фрагмент сигналограммы, в другом блоке — другой 

фрагмент этой же сигналограммы, в третьем блоке — эта же сиг-

налограмма представлена полностью и т. д. Естественно, при мо-

дификации общей для нескольких блоков сигналограммы изме-

нения коснутся всех этих блоков. 

Скоро вы узнаете, что можно управлять громкостью звучания 

и панорамой сигналограммы на каждом отдельном треке и при-
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менять к трекам эффекты реального времени. Однако изменение 

громкости, панорамы, применение эффектов достигаются здесь 

путем пересчета значений отсчетов оцифрованного звука непо-

средственно во время воспроизведения, а в сами сигналограммы 

никакие изменения не вносятся.  

На треках можно размещать уже имеющиеся сигналограммы, 

но можно и записывать их, работая непосредственно в мультитре-

ковой среде. Кроме того, только в мультитрековой среде можно 

реализовать многоканальную запись, когда одновременно на раз-

ные треки записываются сигналы от нескольких источников зву-

ка (если позволяет звуковая карта).  

В мультитрековый проект можно включить MIDI-файлы и ви-

деофайлы в формате AVI. Последние невозможно редактировать 

в Adobe Audition. Зато вы сможете согласовать свой проект с ви-

деорядом. 

Актуальна возможность работы с видео [15]. Мультитрековые 

видеоредакторы (например, Adobe Premier) хотя и позволяют ре-

дактировать звук, но по этим возможностям значительно отстают 

от Adobe Audition.  

Итак, простейший алгоритм работы с Adobe Audition как  

с мультитрековым редактором можно представить следующим 

образом. 

1. Создаете новую сессию (команда File > New Session) или от-

крываете существующую (File > Open Session). 

2. На нужные треки от требуемой временной отметки выполняете 

запись или вставляете уже готовые сигналограммы-блоки. 

3. Вновь записанные сигналограммы обрабатываете, переключа-

ясь в режим редактирования сигналограммы (щелчком на со-

ответствующем блоке). 

4. Возвратившись в мультитрековый редактор, при необходимо-

сти разрезаете, как угодно перемещаете, удаляете, объединяе-

те разные блоки. 

5. Производите микширование: регулируете громкость и пано-

раму треков, применяете к ним эффекты реального времени, 

рисуете огибающие автоматизации, с помощью которых управ-

ляете во времени интересующими вас параметрами.  
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6. Командой File > Export > Audio Mix Down или командами 

подменю Edit > Mixdown to New File выполняете сведéние 

(сохраняете полученную композицию в одном аудиофайле). 

Что такое сессия? По существу сессия — это файл с расшире-

нием SES, мультитрековый проект вашей композиции, в котором 

хранятся следующие данные: 

 пути к аудиофайлам, размещенным на треках (входящим в дан-

ную сессию); 

 принадлежность аудиофайлов к конкретным трекам; 

 значение времени начала воспроизведения для каждого аудио-

файла; 

 атрибуты треков и шин, параметры подключенных к трекам  

и шинам эффектов; 

 автоматизация. 

Файл сессии занимает совсем немного места, потому что в нем 

не хранятся непосредственно отсчеты оцифрованного звука. Он 

содержит указания о том, где найти эти отсчеты, когда и как их 

воспроизводить, а это не требует много памяти. Можно сказать 

(если на минутку забыть о файлах и дисках), что с точки зрения 

пользователя сессия — это совокупность образов сигналограмм, 

размещенных на треках мультитрекового редактора. 

В то же время аудиофайлы и их сигналограммы существуют 

как бы независимо от сессии: вы можете редактировать их,  

сохранять, закрывать, удалять. Кроме того, вы можете создать 

несколько разных сессий, в которых используются одни и те же 

аудиофайлы. 

Если аудиофайл используется в открытой в данный момент 

сессии, и вы попытаетесь его закрыть (командой File > Close  

в режиме Edit View), то появится предупреждение о том, что соот-

ветствующий блок исчезнет из мультитрекового проекта. Если же 

средствами операционной системы вы удалите или переместите 

какой-либо аудиофайл, а потом попытаетесь открыть сессию,  

в которой он используется, то появится стандартное диалоговое 

окно, в котором программа предложит вам указать путь к данно-

му файлу (или любому другому файлу на замену отсутствующе-

му). В случае нажатия кнопки Cancel соответствующий блок так 

и не появится в мультитрековом проекте. 
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ПРИМЕЧАНИЕ  

Обращаем ваше внимание на следующее ограничение: все аудио-
файлы, используемые в сессии, должны иметь одинаковую часто-
ту сэмплирования (дискретизации)! 

При создании новой сессии команда File > New Session от-

крывает диалоговое окно, в котором следует выбрать частоту дис-

кретизации для всего проекта. Если возникнет такая ситуация, что 

добавляемый в проект аудиофайл будет иметь частоту сэмплиро-

вания, отличную от общей для всего проекта, то программа пред-

ложит создать копию этого файла, конвертирует аудиофайл  

с учетом новой частоты сэмплирования и добавит в мультитреко-

вую сессию эту конвертированную копию исходного файла.  

Перед конвертированием у вас будет возможность изменить 

формат файла (стерео/моно) и разрядность представления звуко-

вого сигнала. 

3.7.2. Атрибуты треков. Подключение 
эффектов к трекам и шинам. Запись звука 

Напомним, что в Adobe Audition можно импортировать MIDI- 

и AVI-файлы. Содержащаяся в них информация будет размещена 

на MIDI- и видеотреке соответственно. Фактически есть три типа 

треков: аудио, MIDI и видео. Кроме того, в проекте всегда имеется 

один мастер-трек (Master). Также можно вставить любое количе-

ство треков шин (Bus), предназначенных для обработки группы 

аудиотреков общей цепочкой эффектов. 

Набор атрибутов видеотрека сведен к минимуму и включает  

в себя лишь название трека. В проект можно вставить единствен-

ный видеотрек.  

Работу с MIDI-треками мы не будем рассматривать по двум при-

чинам. Во-первых, потому что в Adobe Audition она не просто не-

удобна, а мучительна. А во-вторых, вопросы MIDI-редактирования 

выходят за рамки тематики книги. Им посвящена отдельная наша 

книга "Музыкальный компьютер для начинающих" [30]. 

Атрибуты аудиотрека мы рассмотрим подробно. 

В начале каждого аудиотрека есть поле атрибутов, содержа-

щее различные элементы управления. Их набор зависит от гео-
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метрических размеров полей атрибутов, которые, в свою очередь, 

определяются масштабом отображения треков по вертикали и по-

ложением правой границы полей атрибутов треков. Кроме того,  

в верхней части главного окна над полями атрибутов треков 

имеются четыре кнопки, с помощью которых можно переклю-

чать отображение атрибутов: 

 Inputs/Outputs — будут отображаться раскрывающиеся 

списки для выбора входного и выходного портов (рис. 3.38, а); 

 Effects — будут отображаться слоты (рис. 3.38, б) для 

подключения эффектов реального времени (VST-плагинов); 

 

 а  

 б 

 в  

 г 

Рис. 3.38. Атрибуты аудиотрека 
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 Sends — будут отображаться элементы, связанные с выво-

дом сигнала трека на заданную шину (рис. 3.38, в);  
 EQ — будут отображаться параметры настройки треково-

го эквалайзера (рис. 3.38, г); у каждого аудиотрека имеется пара-

метрический трехполосный эквалайзер. 

В верхней части поля атрибутов аудиотрека находится строка  

с названием трека. По умолчанию треки называются Track 1, 

Track 2 и т. д. Чтобы изменить название трека, достаточно щелкнуть 

на соответствующем поле и ввести новое название с клавиатуры. 

Кроме названия в поле атрибутов аудиотрека независимо от выбран-

ного режима отображения всегда видны еще несколько элементов. 

Кнопки R, S, и M включают/выключают режимы записи, соло 

и мьютирования соответственно: 

 R — если включен режим записи, то после того как на транс-

портной панели будет нажата кнопка  (Record), начнется 

запись сигнала на данный трек с заданного входа; 

 S — если включен режим соло, то звучать будет только данный 

трек (либо будут звучать все треки, у которых нажата кнопка S); 

 M — если включен режим мьютирования, то данный трек бу-

дет заглушен, в общем миксе вы его не услышите. 

Регулятор  Volume управляет громкостью, а  

Stereo Pan — панорамой трека.  

Раскрывающийся список, расположенный в нижней части поля 

атрибутов аудиотрека, предназначен для выбора варианта исполь-

зования автоматизации трека. Слева от него находится переключа-

тель Show/Hide Automation Lanes (маленький треугольник). 

Щелчком на нем включается/выключается отображение субтреков 

автоматизации (см. разд. 3.7.5).  

На этом перечень элементов, общих для разных вариантов по-

ля атрибутов аудиотрека, исчерпан. Теперь поговорим об элемен-

тах специфических. 

Поле атрибутов аудиотрека  

в режиме Inputs/Outputs  

В режиме Inputs/Outputs (см. рис. 3.38, а) в поле атрибутов 

аудиотрека отображаются раскрывающиеся списки для выбора 

входного (  Input) и выходного (  Output) портов.  



Работа со звуковым редактором Adobe Audition… 265 

Входной аудиопорт — порт, с которого будет осуществляться 

запись. Раскрывающийся список  Input содержит подменю 

для выбора монофонических, стереофонических портов, прило-

жений Rewire и команду Audio Hardware Setup, которая откры-

вает одноименное окно на вкладке Multitrack View (вы с ней уже 

знакомы, см. рис. 3.13). 

В раскрывающемся списке  Output выбирают выходной 

порт, через который будет воспроизводиться аудиоинформация 

данного трека. Здесь тоже есть команда Audio Hardware Setup, 

открывающая одноименное окно на вкладке Multitrack View. 

Подменю Mono и Stereo содержат списки монофонических и 

стереофонических физических выходных портов, которыми рас-

полагает ваша звуковая карта (см. рис. 3.13).  

Кроме физических портов в раскрывающемся списке есть как 

минимум один виртуальный порт, соответствующий мастер-шине 

(Master). По умолчанию именно на эту шину направлены сигна-

лы с аудиотреков. А уже с нее смикшированный сигнал поступа-

ет на физический аудиовыход. У мастер-шины атрибутов немно-

го: редактируемое имя; регуляторы уровня и панорамы, кнопки 

заглушения и солирования.  

Еще в раскрывающемся списке  Output есть команда Add 

Bus. Всякий раз, когда вы ее выбираете, создается очередная 

шина. Шинам автоматически присваиваются имена A, B, C, … 

В рассматриваемом раскрывающемся списке появляется строка 

Bus A и т. д. А в главном окне появляется трек шины с таким 

же именем. 

Шины служат для группирования треков. Вы можете создать 

шину и задать ее в качестве выходного порта для нескольких 

треков. Подключая эффекты реального времени к этой шине, вы 

будете обрабатывать ими сигналы группы треков. В свою оче-

редь в поле атрибутов шины тоже есть раскрывающийся список 

 Output. Поэтому сигнал с каждой из шин может быть на-

правлен и на любой физический порт, и на любую другую шину.  

Имя шины можно отредактировать в поле атрибутов шины,  

а программа автоматически изменит его в раскрывающемся спи-

ске  Output всех аудиотреков и шин. 
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Поле атрибутов аудиотрека  

в режиме Effects 

Если нажать кнопку  Effects, то в поле атрибутов трека бу-

дут отображаться слоты для подключения эффектов реального 

времени (VST-плагинов). На рис. 3.38, б показан единственный 

слот, но, если увеличить вертикальный размер трека, будут вид-

ны и другие слоты. Нажав треугольную кнопку на правом конце 

слота, вы откроете меню, в котором, в свою очередь, имеются 

подменю. В них по функциональному признаку сгруппированы 

команды подключения VST-эффектов к треку.  

ПРИМЕЧАНИЕ  

В режиме Multitrack View доступны не все эффекты, имеющиеся 
в Adobe Audition, а только VST-эффекты. Полный перечень эф-

фектов содержится в меню Effects (в режиме Edit View). 

В левом конце слота расположена кнопка временного выклю-

чения эффекта. Аналогичная по виду кнопка  FX Power, но 

только отключающая сразу всю цепочку эффектов, связанных  

с данным треком, находится в верхней части поля атрибутов тре-

ка. Рядом расположена кнопка  FX Pre-Fader/Post-Fader, со-

стояние которой определяет точку подключения цепочки эффек-

тов: до или после фейдера (регулятора уровня громкости трека).  

В той же строке справа расположена кнопка  Freeze Track. 

Если ее нажать, то после непродолжительных вычислений трек 

окажется "замороженным": звуковые данные на нем будут пере-

считаны программой таким образом, будто все подключенные  

к треку эффекты применены с теми параметрами, которые были 

выбраны на их панелях. Замораживание позволяет высвободить 

ресурсы компьютера. Ведь при воспроизведении замороженного 

трека отпадает необходимость вычисления в реальном времени 

значений отсчетов аудиосигнала, изменяющихся в соответствии  

с алгоритмами, заложенными в эффектах. Повторным нажатием 

кнопки  трек размораживается, после чего вновь появляется 

возможность редактирования параметров подключенных к нему 

эффектов. 
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ПРИМЕЧАНИЕ  

Слоты для подключения эффектов имеются не только у аудиотре-
ков, но и у шин. Исключение составляет мастер-шина.  

Может иметь важное значение порядок, в котором эффекты под-
ключены к треку или шине. 

В раскрывающемся списке слота кроме нескольких подменю 

эффектов имеется команда Effects Rack, открывающая диалого-

вое окно виртуальной рэковой стойки Effects Rack (рис. 3.39).  

ПРИМЕЧАНИЕ  

За исключением названия и кнопки  Effects Rack Safe During 

Write, включающей защиту эффектов от случайного изменения 
параметров в режиме записи, это диалоговое окно идентично окну 

Mastering Rack, которое в режиме Edit View открывается коман-

дой Effects > Mastering Rack главного меню. 

 

Рис. 3.39. Диалоговое окно виртуальной рэковой стойки Effects Rack 
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В общей сложности к треку можно подключить до 16 VST-

плагинов (по количеству слотов, имеющихся в левой верхней 

части окна). Для подключения плагина нужно щелчком на стрел-

ке справа от слота открыть меню, выбрать в нем сначала катего-

рию плагина (например, Filter and EQ), а потом и сам плагин 

(например, Graphic Equalizer). Панель плагина займет рабочее 

поле окна Mastering Rack. К следующему слоту можно подклю-

чить другой плагин и т. д. Для смены отображаемой панели под-

ключенного плагина нужно щелкнуть на соответствующем слоте.  

В раскрывающемся списке Rack Preset имеются пресеты це-

почек плагинов, приспособленные для решения некоторых типо-

вых задач. Воспользовавшись кнопкой , в качестве пресета 

можно сохранить собственный набор подключенных плагинов.  

А с помощью кнопки  удаляют пресет, выделенный в раскры-

вающемся списке Rack Preset. 

Аналогичные кнопки, расположенные справа от раскрываю-

щегося списка Effect Preset, позволяют сохранять и удалять пре-

сеты настроек подключенных VST-плагинов. Кнопкой Remove 

All все подключенные плагины будут отключены и удалены из 

рэка. Для временного отключения (Bypass) конкретного плагина 

служит кнопка , расположенная в левой части слота. Такая же 

кнопка, находящаяся в левом нижнем углу панели, предназначе-

на для временного отключения всей цепочки плагинов. Рядом  

с ней расположена кнопка  / , предназначенная для 

включения/выключения режима прослушивания. 

Ниже слотов в группе Input находятся регулятор уровня 

входного сигнала , соответствующее ему поле ввода и изме-

ритель уровня. В группе Output содержатся аналогичные эле-

менты, относящиеся к выходному сигналу. Регулятором Mix 

можно изменить пропорцию, в которой на выходе рэковой стой-

ки смешиваются исходный (Dry) и обработанный (Wet) цепоч-

кой плагинов сигналы. Если установлен флажок Preroll/Postroll 

Preview, то предварительное прослушивание будет осуществ-

ляться не в пределах выделенного участка, а начнется раньше  

и закончится позже. Длительность интервалов "пред-" и "после-

прослушивания" по умолчанию составляет 1 секунду. Вы можете 
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изменить эту величину с помощью диалогового окна Preroll  

and Postroll Options, которое открывается командой Options > 

Preroll and Postroll Options главного меню. 

Слотами окна Effects Rack дублируются слоты поля атрибу-

тов трека. Основное преимущество окна Effects Rack: в нем есть 

традиционный набор элементов, позволяющий сохранять в пре-

сетах конфигурации цепочек подключенных эффектов и выбран-

ные для них параметры. Кроме того, если к трекам и шинам под-

ключено больше одного эффекта, то в этом окне появляются  

несколько вкладок, на каждой из которых отображается панель 

соответствующего эффекта. 

Есть еще один способ подключения эффектов к треку — с по-

мощью органайзера (см. разд. 3.8): выбираете нужный эффект  

в древовидном списке Effects и перетаскиваете на нужный трек. 

Поле атрибутов аудиотрека в режиме Sends 

В режиме Sends в поле атрибутов (см. рис. 3.38, в) отобража-

ются элементы, связанные с выводом сигнала трека на заданную 

шину. 

Кроме знакомых по другим режимам элементов здесь име-

ются регуляторы уровня  Send 1 Level и панорамы  

Send 1 Pan сигнала, посылаемого на шину. Собственно шина-

адресат выбирается (или создается) командой из раскрывающе-

гося списка. 

Большинство программ разработаны по образцу реальных 

микшеров: в них есть посылы на шины AUX, объединение не-

скольких треков в группу. В Adobe Audition имеется окно-

микшер (см. рис. 3.4), в котором есть линейки треков и шин. 

Однако после внимательного изучения программы вы поймете, 

что у микшера Adobe Audition мало общего с настоящим мик-

шером. Его шины не похожи ни на шины AUX, ни на основ- 

ные шины, которые вы могли видеть, например, в программе  

Cakewalk SONAR [26, 30]. Это, скорее, нечто среднее. Вы можете 

задать для нескольких треков в качестве выходного аудиопорта 

одну и ту же шину, к которой подключены один или несколько 

эффектов.  
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Поле атрибутов аудиотрека в режиме EQ 

Своеобразным эффектом реального времени можно считать 

трехполосный параметрический эквалайзер, в обязательном по-

рядке подключенный к каждому из треков. Такой эквалай- 

зер принято называть трековым. В режиме EQ в поле атрибутов 

(см. рис. 3.38, г) отображаются параметры настройки и кнопка 

вызова панели эквалайзера.  

Регуляторы параметров организованы в виде матрицы. Строки 1, 

2 и 3 соответствуют конкретным фильтрам, а столбцы — их па-

раметрам:  

 dB — коэффициент передачи фильтра в полосе пропускания;  

 Hz — центральная или граничная частота фильтра.  

Кнопка EQ открывает одноименное окно параметрического 

трекового эквалайзера (рис. 3.40). 

Три светлых точки соответствуют центральным (либо гранич-

ным) частотам фильтров. Их можно перемещать мышью или  

с помощью слайдеров либо посредством полей ввода.  

 

Рис. 3.40. Окно параметрического трекового эквалайзера  
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В полях ввода Q1, Q3 и Q3 по умолчанию можно изменять 

добротность фильтра № 2. Добротность двух других фильтров по 

умолчанию недоступна для изменений.  

Кнопки  Band/Low Shelf и  Band/High Shelf переклю-

чают тип фильтров (фильтры верхних и нижних частот превра-

щаются в полосовые фильтры). При этом для них становится 

доступна регулировка добротности.  

Нажатием кнопки Reset выполняется сброс настроек эквалай-

зера, после чего его АЧХ становится линейной. 

Не закрывая окно EQ, щелкните на кнопке EQ какого-либо 

другого трека. Вы увидите, что в верхней части окна появятся две 

вкладки с названиями треков и АЧХ эквалайзера станет не такой, 

как у трека, для которого было открыто это окно. Дело в том, что 

по умолчанию в окне EQ отображается вкладка с настройками 

эквалайзера текущего трека.  

А теперь попробуйте выбирать разные треки в качестве теку-

щего. Тогда в окне EQ будет уже не две, а несколько вкладок, 

каждая из которых соответствует эквалайзеру определенного 

трека.  

ПРИМЕЧАНИЕ  

Как вы уже, вероятно, заметили, в Adobe Audition используется 
понятие текущего трека. Текущий трек выбирается щелчком на 
треке. Текущий трек отличается от остальных цветом — он немно-
го светлее. 

Те настройки эквалайзера, которые вы сделали, хранятся в од-

ном из двух регистров. Регистры можно переключать с помощью 

кнопки EQ / A (или EQ / B). В одном регистре — одни настройки 

эквалайзера, в другом — другие. Настройки можно переключать 

непосредственно во время воспроизведения звука, выбирая луч-

ший вариант (название кнопки будет меняться с EQ / A на EQ / B 

и обратно). 

3.7.3. Запись аудиоданных на трек  

Теперь у вас достаточно информации, чтобы попытаться что-

нибудь записать на трек. Подготовьте один или несколько треков 

к записи: определите входные аудиопорты, нажмите кнопку R, 
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установите маркер в позицию, с которой нужно начать запись. 

Запустите запись нажатием кнопки  (Record) на транспортной 

панели. Если все сделано правильно, начнется запись. Остано-

вить ее можно нажатием кнопки  (Stop) на транспортной па-

нели или клавиши <пробел> на клавиатуре компьютера. 

ПРИМЕЧАНИЕ  

Напомним, что с маркером (вертикальной линией из желтых то-
чек), указывающим позицию, начиная с которой будет осуществ-
ляться запись/воспроизведение/вставка сигналограммы, вы уже 
имели дело при работе в режиме редактирования сигналограммы. 

Запись может не начаться в том случае, если устройство, вы-

бранное в качестве источника сигнала, не поддерживает частоту 

сэмплирования, используемую для всей сессии.  

3.7.4. Работа с блоками  

Итак, мы рассмотрели такой способ добавления аудиофайлов 

в проект, как их непосредственная запись. Однако ничто не ме-

шает вам добавить в свою композицию аудиофайлы, записан- 

ные ранее или хранящиеся в библиотеке сэмплов. Для этого есть 

несколько путей: 

 вставьте (командой Edit > Insert into Multitrack Session)  

в мультитрековый редактор открытую на текущей странице  

в режиме Edit View сигналограмму, которая до этого не вхо-

дила в сессию; 

 вставьте (командой Insert > Имя аудиофайла — здесь и далее 

речь идет о командах мультитрекового редактора) в мульти- 

трековый редактор любой аудиофайл, загруженный в данный 

момент в Adobe Audition; 

 вставьте в мультитрековый редактор любой аудиофайл, т. е. 

загрузите этот файл в Adobe Audition и разместите в нужном 

месте нужного трека (команда Insert > Audio); 

 командой Insert > Video вставьте в мультитрековый редактор 

видеофайл, при этом сам видеоряд разместится на одном треке 

(видеотреке), а звуковая дорожка из этого файла разместится 

на втором треке (обыкновенном аудиотреке); 
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 командой File > Import импортируйте аудиофайл в Adobe Au-

dition, после чего можете с помощью команды Insert > Имя 

аудиофайла разместить его на одном из треков; 

 загрузите аудиофайл (аудиофайлы) в составе сессии (File > 

Open Session), работая в режиме Multitrack View; 

 загрузите аудиофайл в Adobe Audition, используя органайзер, 

и перетащите ее из органайзера на нужный трек (см. разд. 3.8). 

Как задать позицию, начиная с которой должна размещаться 

сигналограмма? Мы уже говорили о существовании текущего 

трека, который назначается щелчком мыши на самом треке или 

на его поле атрибутов. Текущий трек выделяется цветом — он бо-

лее яркий (светлый). Как и в редакторе сигналограммы, в мульти- 

трековом редакторе имеется маркер, обозначающий позицию,  

начиная с которой будет осуществляться запись или воспроизве-

дение. Положение этого маркера и определяет то место, куда на 

текущий трек будет помещена сигналограмма. 

После того как сигналограмма попадет в мультитрековую сре-

ду, правильнее будет называть ее блоком.  

Переместить блок с места на место очень просто. Его нужно 

захватить, нажав правую кнопку мыши, и перетащить на задан-

ную позицию заданного трека.  

Иногда требуется выполнять операции одновременно с несколь-

кими блоками, которые нужно предварительно выделить. Несколько 

блоков выделяют щелчками левой кнопки мыши при нажатой  

клавише <Ctrl>. Есть и альтернативный способ выделения не-

скольких блоков — при нажатой клавише <Ctrl> "растянуть" ука-

зателем мыши (левой кнопкой) прямоугольную рамку, охваты-

вающую нужные блоки. 

Для одновременного перемещения нескольких блоков нужно 

правой кнопкой мыши захватить любой блок из предварительно 

выделенных блоков и вместе с остальными выделенными блока-

ми перетащить в новую позицию. 

ПРИМЕЧАНИЕ  

Выделять можно не только "соседствующие" блоки. Для выделе-
ния нескольких произвольно расположенных блоков нужно нажать 
клавишу <Ctrl> и, не отпуская ее, щелкнуть на каждом из них. 
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В ряде случаев вам потребуется выделить не отдельные блоки, 

а целый фрагмент мультитрекового проекта, охватывающий  

несколько блоков или их фрагментов. Для чего это нужно? На-

пример, чтобы произвести пересчет (mixdown) этого мультитре-

кового фрагмента в один аудиофайл. 

Установите указатель мыши на любую из горизонтальных ли-

ний, разделяющих треки, в ту точку, с которой должен начинать-

ся выделенный фрагмент. Нажмите левую кнопку мыши и, не 

отпуская ее, переместите указатель мыши в конечную точку вы-

деляемого фрагмента. Отпустив кнопку мыши, вы увидите серую 

вертикальную полосу. Только что вы выделили фрагмент проек-

та, включающий в себя фрагменты всех имеющихся треков. Уч-

тите, что в этом случае сами блоки не считаются выделенными,  

а выделен именно фрагмент композиции. 

В пределах выделенного фрагмента проекта вы можете вы-

брать один или несколько блоков. В результате могут оказаться 

выделенными даже отдельные части блоков, если границы выде-

ленного фрагмента проекта пересекают эти блоки. Чтобы сделать 

это, нажмите клавишу <Ctrl> и щелкните левой кнопкой мыши 

на том блоке, фрагмент которого следует выделить, в зоне, где 

блок пересекается серой вертикальной полосой. Весь блок ока-

жется подсвеченным, а его нужный фрагмент — выделенным. 

Если нужно выделить фрагменты нескольких блоков, пере-

крывающихся во времени, то порядок действий должен быть 

аналогичным. Единственное отличие — на заключительном эта-

пе нужно, не отпуская клавишу <Ctrl>, "перещелкать" выделяе-

мые фрагменты всех нужных блоков. 

Что делать, если вам понадобилось создать копию блока? 

Прежде всего, его можно скопировать в буфер обмена командой 

Edit > Copy, а затем вставить в нужное место командой Edit > 

Paste.  

Скопировать блок можно еще двумя способами: 

 повторно добавить в проект тот же самый аудиофайл; 

 удерживая нажатыми клавишу <Ctrl> и правую кнопку мыши, 

перетащить копируемый блок на то место, где должна распо-

лагаться копия (сам блок останется на прежнем месте, а на 

указанном месте появится его копия). 
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Первый способ нельзя назвать копированием в чистом виде. 

Повторное добавление сигналограммы приведет к появлению 

нового блока, у которого все атрибуты будут находиться в со-

стоянии, принятом по умолчанию. Вторым способом копируются 

именно блоки: и аудиофайлы, и их атрибуты. 

Для разбиения блоков выполните следующие действия: 

1. Щелкните на месте разбиения левой кнопкой мыши: блок 

окажется выделенным, маркер будет установлен на место бу-

дущего разбиения. 

2. Нажмите кнопку  Split clip at cursor на панели инструмен-

тов или воспользуйтесь командой Clip > Split главного меню 

или командой Split контекстного меню блока (открывается 

щелчком правой кнопки мыши). 

Для удаления блоков выделите один или несколько блоков, 

фрагмент одного блока или фрагменты нескольких блоков и на-

жмите клавишу <Delete> либо выберите команду Edit > Delete 

главного меню. 

Если вы хотите не просто удалить блок из сессии, но и выгру-

зить его из Adobe Audition, выделите его и нажмите комбинацию 

клавиш <Shift>+<Backspace>. 

В ряде случаев полезно объединить несколько блоков в груп-

пу. После объединения блоки будут перемещаться, копироваться 

и удаляться все разом, причем не нужно будет выделять каждый 

из блоков по отдельности, т. е. сгруппированные блоки ведут се-

бя как единый блок. Для группирования блоков выполните сле-

дующие действия: 

1. Выделите нужные блоки. 

2. Нажмите кнопку  Group/Ungroup clips на панели инстру-

ментов либо выберите команду Clip > Group Clips главного 

меню или команду Group Clips контекстного меню. 

Вы можете зафиксировать один или несколько блоков: в ре-

зультате блоки будет невозможно перемещать. Технология фик-

сации блоков несложна: 

1. Выделите нужные блоки. 

2. Нажмите кнопку  Lock Clip in time на панели инструмен-

тов либо выберите команду Clip > Lock in Time главного ме-

ню или команду Lock in Time контекстного меню. 
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В левом нижнем углу зафиксированного блока появится изо-

бражение замка. Отмена фиксации блоков осуществляется точно 

так же, как фиксация, — повторным нажатием кнопки  или 

повторным применением указанных команд. 

3.7.5. Автоматизация 

Термином "автоматизация" в звукозаписи традиционно назы-

вается возможность записывать изменения положений различных 

регуляторов на микшере посредством MIDI-сообщений. Все дей-

ствия звукорежиссера сохраняются в секвенсоре, могут быть от-

редактированы и воспроизведены. Во время воспроизведения ре-

гуляторы на микшере перемещаются как бы сами собой. В Adobe 

Audition автоматизация присутствует в двух вариантах. 

 Программа позволяет записывать изменения, производимые 

вами в настройках треков, эффектов и т. д. в процессе вос-

произведения проекта. Программа реагирует на эти измене-

ния, и они сохраняются в виде графиков изменения каких-

либо параметров во времени. Проект воспроизводится, а вы, 

например, "крутите" регулятор уровня сигнала. При повтор-

ном воспроизведении проекта этот регулятор будет изменять 

свое состояние уже без вашей помощи, потому что програм-

ма запомнила ваши действия.  

 Вы можете создавать и графически редактировать огибающие 

автоматизации, которые будут управлять различными пара-

метрами во время воспроизведения проекта.  

Фактически огибающие автоматизации и являются графиками 

изменения каких-либо параметров во времени: например, чем вы-

ше проходит огибающая громкости, тем громче будет звук в этом 

месте блока. И, наоборот, с помощью огибающей можно, напри-

мер, приглушить фоновую музыку в том месте, где говорит диктор 

(подразумевается, что речь диктора хранится в блоке, размещен-

ном параллельно блоку с фоновой музыкой на другом треке). 

Огибающую панорамы следует трактовать так: чем выше прохо-

дит линия, тем левее будет уходить кажущийся источник звука; чем 

линия проходит ниже, тем правее позиционируется источник звука. 

Центр панорамы соответствует середине блока по вертикали. 
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Огибающие автоматизации параметров эффектов можно трак-

товать так: чем выше проходит линия, тем больше значение ав-

томатизируемого параметра; чем линия ниже, тем значение па-

раметра меньше. 

Применение автоматизации в мультитрековом редакторе про-

граммы Adobe Audition организовано очень удобно.  

В нижней части поля атрибутов аудиотрека, трека шины и 

мастер-трека имеется раскрывающийся список, в котором можно 

выбрать режим использования автоматизации трека. Предусмот-

рены следующие режимы: 

 Off — автоматизация трека отключена, даже если на субтре-

ках автоматизации сформированы огибающие, то во время 

воспроизведения и микширования программа их игнорирует; 

 Read — данные автоматизации программой считываются  

в процессе воспроизведения проекта и учитываются при мик-

шировании; 

 Latch — программа запоминает ваши манипуляции с элемен-

тами регулировки трека и подключенных к нему плагинов, со-

вершаемые вами в процессе воспроизведения проекта;  

 Touch — аналогичен режиму Latch, но по завершении записи 

автоматизации устанавливается то значение автоматизируемо-

го параметра, которое было до начала записи; 

 Write — аналогичен режиму Latch, но по завершении записи 

автоматизации режим автоматически изменяется на Touch. 

Слева от раскрывающегося списка, в котором задается режим 

автоматизации, расположен переключатель Show/Hide Automa-

tion Lanes (маленькая треугольная стрелка). Щелчком на нем 

включается/выключается отображение субтреков автоматизации. 

Стрелка меняет направление с горизонтального на вертикальное, 

и под основным треком (например, под аудиотреком) появляется 

первый субтрек (рис. 3.41). По умолчанию это субтрек Volume, 

связанный с регулятором уровня сигнала. 

Пока что график изменения значения автоматизируемого па-

раметра выглядит как горизонтальная линия. При воспроизведе-

нии этот параметр (в данном случае громкость) изменяться не 

будет. Придать графику нужную форму можно двумя способами.  
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Рис. 3.41. Отображен субтрек Volume 

 

Рис. 3.42. Сформирована огибающая автоматизируемого параметра 

Первый способ вам, наверняка, хорошо знаком: щелчком на 

графике нужно создать узел, перетащить его мышью в нужное 

положение, затем создать и перетащить следующий узел и т. д. 

Делать это можно в любое время, независимо от того, включен 

режим воспроизведения/записи проекта или нет. Второй способ 
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реализуется только в режиме воспроизведения/записи проекта: 

захватите мышью нужный регулятор (в данном примере Volume 

в поле атрибутов трека) и изменяйте его состояние (в данном 

примере вращайте). В любом случае вы получите равноценный 

результат: изменится форма огибающей автоматизируемого па-

раметра (рис. 3.42). 

Теперь при воспроизведении проекта регулятор Volume в по-

ле атрибутов трека будет вращаться, отрабатывая изменения, за-

даваемые огибающей. 

Кнопка  Safe During Write включает режим запрета редак-

тирования огибающей. Узлы графика исчезают, и сколько ни пы-

тайтесь создать новый узел — ничего не выйдет. А в режиме 

воспроизведения/записи проекта программа не запоминает изме-

нения состояния регулятора. 

Кнопка  Clear Edit Points удаляет все узлы огибающей. 

В раскрывающемся списке для данного субтрека можно вы-

брать другой автоматизируемый параметр, например, Pan — па-

нораму трека. Огибающая автоматизации, сформированная вами 

для параметра Volume, никуда не денется — она просто не будет 

отображаться. 

Полный набор параметров, доступных для автоматизации, за-

висит от того, подключены ли к треку эффекты, какие именно  

и сколько их. В любом случае, даже если эффекты не подключе-

ны, можно автоматизировать регуляторы громкости, панорамы  

и кнопку заглушения трека, а также элементы регулировки и 

коммутации, имеющиеся у трекового эквалайзера.  

Кнопка  Show Additional Automation Lane включает ото-

бражение еще одного субтрека. На нем можно редактировать 

огибающую автоматизации какого-либо другого параметра (на-

пример, Pan — панораму трека). Как только будет включено 

отображение хотя бы двух субтреков, на каждом из них станет 

доступной кнопка  Close Automation Lane, которой можно 

скрыть данный субтрек. Скрыть сразу все субтреки автоматиза-

ции можно кнопкой  Hide All Automation Lanes на панели 

инструментов главного окна или командой View > Hide All Au-

tomation Lanes главного меню. 
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То, о чем мы только что рассказали, называется автоматиза-

цией трека.  

ПРИМЕЧАНИЕ  

Данные автоматизации трека могут существовать, даже если на 
треке нет блока, содержащего аудиофайл. Ведь огибающие ав-
томатизации в этом случае представляют собой графики изме-
нения состояния регуляторов, так или иначе связанных с треком 
в целом.  

Наряду с автоматизацией трека в Adobe Audition доступна ав-

томатизация блока. Правда, ее возможности ограниченны. Авто-

матизируются только два параметра — громкость и панорама. 

Причем огибающие автоматизации формируются не на субтре-

ках, а на самом аудиотреке в пределах каждого блока. В исход-

ном состоянии на фоне сигналограммы они видны плохо, а то  

и вовсе не видны. Чтобы отобразить их, нужно воспользоваться 

кнопками панели инструментов или одноименными командами 

главного меню: 

 (команда View > Show Clip Volume Envelopes) — отобра-

зить/скрыть огибающие автоматизации громкости; 

 (команда View > Show Clip Pan Envelopes) — отобра-

зить/скрыть огибающие автоматизации панорамы. 

Включить режим редактирования автоматизации блока можно 

с помощью кнопки  или команды View > Enable Clip Envelope 

Editing. По краям горизонтальных линий появятся узлы.  

Для редактирования доступна только огибающая выделенного 

блока. Если вы щелкнете на каком-либо блоке (и, соответствен-

но, выделите его), то станут видны узлы огибающей (точки пере-

гиба). Вы можете создать новый узел. Подведите указатель мыши 

к огибающей (он должен принять вид ) и щелкните левой 

кнопкой мыши — появится новый узел. Если навести указатель 

мыши на узел, в контекстной подсказке отобразится значение 

автоматизируемого параметра в данной точке (рис. 3.43). 

ПРИМЕЧАНИЕ  

Можно создать сколько угодно узлов и, перемещая их с помощью 
мыши, придать огибающей желаемую форму. 
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Рис. 3.43. Огибающая громкости  
и значение автоматизируемого параметра 

Зачастую бывает полезной аппроксимация огибающих сплай-

нами, при которой огибающая выглядит не как ломаная линия,  

а как плавная кривая, проходящая около узлов. Включается данная 

опция так: щелкните правой кнопкой мыши на блоке (предвари-

тельно можно выбрать сразу несколько блоков), откроется контек-

стное меню блока. Выберите в нем команду Clip Envelopes, а за-

тем один из двух видов огибающей: 

 Volume — огибающая громкости; 

 Pan — огибающая панорамы. 

После этого выберите для огибающей нужного вида команду 

Use Splines. 

Вид огибающей без аппроксимации и со сплайн-аппроксима-

цией показан на рис. 3.44. 

ПРИМЕЧАНИЕ  

Если опция аппроксимации отключена, то при построении оги-
бающей по узлам фактически используется метод интерполяции 
первого порядка, т. е. узлы соединяются отрезками прямых линий. 

В том же подменю, что и команда Use Splines, находится коман-

да Clear Selected Points, которая пригодится вам в случае, когда 

нужно удалить несколько узлов. Прежде чем воспользоваться дан-

ной командой, следует выделить фрагмент мультитрекового проек-

та, включающий те узлы огибающей, которые нужно удалить.  
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Рис. 3.44. Огибающие: обычная (а),  
с использованием сплайн-аппроксимации (б) 

Есть и более простой способ удаления узла огибающей: захва-

тите узел мышью и перетащите его за пределы блока. 

Автоматизация блока не влияет на регуляторы уровня сигнала 

и панорамы трека. Если один и тот же параметр (например, пано-

рама) автоматизирован и на уровне блока, и на уровне трека, то 

результирующий эффект складывается из данных автоматизации 

трека и данных автоматизации блока. Чтобы не запутаться, есть 

смысл для автоматизации уровня сигнала и панорамы применять 

какой-либо один из двух вариантов: либо автоматизацию блока, 

либо автоматизацию трека. Для остальных параметров есть един-

ственный вариант: автоматизация трека. 

3.7.6. Циклическая запись дублей 

В Adobe Audition предусмотрен режим, в котором можно сде-

лать несколько дублей записи на одну и ту же область трека, со-

хранив все дубли. Для перехода в этот режим нужно соответст-

вующим образом настроить кнопку записи  (Record) на 

транспортной панели. По умолчанию для нее назначена функция 

непрерывной линейной записи (Continuous Linear Record). Это 

самый обычный режим: после нажатия кнопки  длительность 

записываемого блока будет непрерывно увеличиваться, запись 
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будет продолжаться до тех пор, пока вы не нажмете кнопку  

(Stop).  

Щелкните на кнопке  правой кнопкой мыши. Откроется 

контекстное меню с тремя командами. Первая (Continuous Linear 

Record) вам уже знакома. Вторая и третья команды соответству-

ют двум разновидностям циклического режима записи: 

 Loop While Recording (View or Sel) — выполнять цикличе-

скую запись в пределах длительности отображаемого или вы-

деленного фрагмента проекта; 

 Loop While Recording (Entire or Sel) — выполнять цикличе-

скую запись в пределах длительности существующего проекта 

или его выделенного фрагмента. 

Выбор одной их этих команд не означает, что запись тут же 

начнется, просто вы предварительно настраиваете ее режим. При 

выборе любого из циклических режимов вид кнопки Record из-

менится на . Теперь нужно подготовить трек (треки) к записи, 

нажав кнопку R. Затем следует выделить интервал времени (об-

ласть трека), в пределах которого будет выполняться цикличе-

ская запись. Пусть, например, вы работаете с мультитрековым 

проектом песни, на части треков которого записан аккомпане-

мент, а на один или несколько свободных пока треков вам нужно 

записать вокальную партию. Причем вокалисту не удается спеть 

всю партию с одного раза, а требуется исполнить ее по частям, 

записав несколько дублей. Выделите сначала интервал проекта, 

например, соответствующий первому куплету. Теперь можно 

включить режим записи кнопкой . Аккомпанемент будет вос-

производиться с начала первого куплета до его конца. Вокалист 

споет первый куплет, но вы не останавливайте запись, ведь пока 

готов только первый дубль. Цикл повторится заново: инструмен-

ты сыграют, вокалист споет. Второй дубль готов. Когда поймете, 

что накопилось несколько подходящих дублей, а дальнейшая за-

пись не дает приращения качества исполнения, нажмите на 

транспортной панели кнопку  Stop. На треке синхронно с ак-

компанементом окажутся записанными несколько блоков фраг-

мента вокальной партии. Это очень удобно: в ходе дальнейшего 

редактирования не потребуется перемещать блоки вдоль шкалы 
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времени, а значит, исключены ошибки, приводящие к рассинхро-

низации аккомпанемента и вокала. Программа автоматически 

присвоит каждому из блоков уникальное имя, состоящее из слова 

Track, номера трека и номера дубля, например: Track 2_011 — 

трек № 2, дубль № 11.  

По умолчанию на треке отображается блок, записанный по-

следним (с максимальным номером дубля). Его вы и услышите, 

включив воспроизведение проекта.  

Для того чтобы посмотреть на сигналограмму другого дубля  

и прослушать его, нужно открыть контекстное меню блока и пе-

рейти в подменю Bring to Front. В нем будут перечислены все 

выполненные вами дубли. Выберите нужный. Теперь он будет 

отображен на треке "поверх" остальных и его можно прослушать.  

Команда Play Hidden Clips контекстного меню блока разре-

шает воспроизводить скрытые блоки. При воспроизведении вы 

услышите все дубли, а не только "верхний". Обычная команда 

Delete контекстного меню или Edit > Delete главного меню уда-

лит тот блок, который отображается на треке. А команда Remove 

Hidden Clips, наоборот, удалит все скрытые блоки. 

3.8. Использование органайзера 

По умолчанию в левой части рабочего пространства програм-

мы находится панель органайзера, предназначенная для создания 

комфортной обстановки при работе с файлами и эффектами. Па-

нель напоминает записную книжку, в которую всегда можно за-

глянуть, чтобы освежить в памяти некоторые детали редактиро-

вания сигналограмм. Но самое главное — посредством этой 

панели, не обращаясь к главному меню, можно выполнить очень 

много операций. 

В предыдущих версиях программы панель так и называлась: 

Organizer. В текущей версии у нее нет имени, но она содержит 

три именованные вкладки: 

 Files — опции работы с файлами; 

 Effects — открытие окна эффекта; 

 Favorites — вызов операций-фаворитов (эту вкладку мы не 

будем рассматривать). 
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3.8.1. Вкладка Files — работа с файлами 

Вкладка Files панели органайзера представлена на рис. 3.45.  

Основную часть вкладки Files занимает прокручиваемый спи-
сок открытых файлов. В верхней части вкладки расположены 
кнопки, нажимая которые можно выполнить несколько наиболее 
"популярных" операций с файлами: 

 Import File — импортировать файл; 

 Close Files — закрыть файлы, выделенные в списке на 

вкладке Files; 

 Insert Into Multitrack — вставить выделенные файлы  

в мультитрековый редактор. В процессе вставки программа может 
запросить у вас разрешение на преобразование формата файлов; 

 Edit File — сделать текущей (отображаемой и доступной 

для редактирования) страницу с файлом, выделенным в списке. 
Кнопка недоступна, если в списке выделен файл, отображенный 
на текущей странице. Переключаться между страницами можно 
также двойным щелчком на имени нужного файла в списке; 

 Insert Into CD List — вставить выделенные файлы в спи-

сок треков для записи на CD; 

 Show Options — включить дополнительные опции вклад-

ки. Вид вкладки Files после включения дополнительных опций 
представлен на рис. 3.46. 

 В нижней части вкладки находится фильтр типов файлов, 
отображаемых в списке. Предполагается, что вы можете работать 
с аудиофайлами, файлами лупов, видеофайлами и MIDI-файлами. 
В списке будут отображены имена файлов только тех типов, ко-
торые вы выберете кнопками . 

Кнопка  отменяет выделение файла в списке на вкладке Files. 

При нажатой кнопке  Full Paths кроме имен файлов с расшире-

ниями в списке будут также отображаться полные пути к ним. 

В раскрывающемся списке Sort By выбирают признак, по ко-
торому файлы будут упорядочены (отсортированы) в списке. 

Кнопка  Loop Play подготавливает режим циклического 

воспроизведения. Кнопка  Play включает воспроизведение 

файла, выделенного в списке. Если нажата кнопка  Auto Play, 

то при выделении очередного файла в списке он будет автомати-
чески воспроизведен. 
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Рис. 3.45. Вкладка Files  
панели органайзера 

 

Рис. 3.46. Вкладка Files панели 
органайзера: включены  
дополнительные опции 

Регулятор  Preview Volume позволяет управлять гром-

костью предварительного прослушивания. 

Если установлен флажок Follow session tempo, то при про-

слушивании аудиофайлов они будут воспроизводиться в темпе, 

установленном для проекта. В противном случае — в собствен-

ном оригинальном темпе. 

3.8.2. Вкладка Effects — вызов  

окна эффекта 

На вкладке Effects (рис. 3.47, а) панели органайзера представ-

лен список эффектов, доступных в программе Adobe Audition. 

Для вызова окна эффекта нужно щелкнуть на его имени в спи-

ске. Система организации списка зависит от состояния кнопок 
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Group By Category и Group Real-Time Effects. Если ни одна 

кнопка не нажата, то все доступные эффекты перечисляются  

в списке в алфавитном порядке. При нажатой кнопке Group By 

Category эффекты оказываются сгруппированными по признаку 

функционального предназначения. Если нажать кнопку Group 

Real-Time Effects, то группы эффектов будут представлены  

в виде дерева, имеющего три ветви (рис. 3.47, б). Перейдя на ниж-

ний уровень иерархии, вы получите перечень эффектов. Те эф-

фекты, имена которых выделены более ярким цветом, могут быть 

применены в реальном времени. 

В Adobe Audition все эффекты разбиты на три категории: 

 Real-Time Effects — эффекты реального времени (их можно 

применять как в режиме редактирования сигналограммы, так 

и в мультитрековом режиме); 

 а       б 

Рис. 3.47. Вкладка Effects панели органайзера 
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 Process Effects — эффекты, которые можно применять только 

в режиме редактирования сигналограммы; 

 Multitrack Effects — мультитрековые эффекты, которые 

можно применять только в мультитрековом режиме. 

Именно по этим категориям могут быть сгруппированы эффек-

ты в древовидном списке панели органайзера. В действительности 

все эффекты Adobe Audition являются плагинами, а в органайзере 

отображается список этих плагинов. В принципе, мультитрековые 

эффекты можно подключить к треку методом перетаскивания из 

органайзера на трек. Но так делать не стоит, потому что эффекты 

этой категории можно применять только к выделенным блокам, 

находящимся внутри выделенной области мультитрекового проек-

та. Из органайзера их можно вызывать двойным щелчком на на-

звании нужного эффекта. Применять мультитрековые эффекты 

желательно только посредством команд меню Effects (в режиме 

Multitrack View). 

Мультитрековые эффекты применимы к одному или двум  

(в зависимости от эффекта) выбранным блокам. Но перед этим 

еще должна быть выделена область мультитрекового проекта, 

включающая в себя эти блоки. 

3.9. Микширование  

и сведение в стерео 

Наличие окна-микшера в программах для работы с музыкой  

и звуком стало уже традицией. Имеется микшер и в Adobe Audition. 

Вызвать панель Mixer (рис. 3.48) можно командой Window > Mixer 

или комбинацией клавиш <Alt>+<2>.  

В правой части микшера расположена мастер-секция с фейдером 

общей громкости и прочими ее атрибутами. Вид остальной части 

панели зависит от количества аудиотреков и треков шин в проекте.  

Каждая из линеек микшера соответствует одному из треков.  

В левой части панели имеется вертикальный ряд кнопок, опре- 

деляющих отображаемый на микшере набор атрибутов треков. 

Мы нажали все эти кнопки, поэтому на рис. 3.48 показан наибо-

лее полный вид микшера.  
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Каждая из линеек шин (на рис. 3.48 это Bus A, Bus B, Bus C) 

соответствует треку шины.  

Поля и кнопки атрибутов треков на микшере соответствуют 

элементам полей атрибутов треков в главном окне. Пожалуй, 

единственное отличие заключается в наличии фейдера громкости 

(в главном окне для управления громкостью трека используются 

вращающийся регулятор и числовое поле ввода). Кроме того, на 

панели Mixer одновременно отображаются все атрибуты трека,  

а состав атрибутов в главном окне зависит от выбранного режима 

отображения (см. разд. 3.7.2).  

Панель микшера является плавающей. Ее можно перетащить  

и встроить на любое место в главном окне. Размеры панели мик-

шера тоже можно изменять. 

С помощью микшера для каждого трека, имеющегося в проек-

те, нужно установить необходимые параметры (громкость, пано-

рама и их изменение во времени; значения параметров эффектов  

и обработок). После этого проект следует свести — преобразо-

вать его в единственный аудиотрек, пригодный для воспроизве-

дения не только средствами программы Adobe Audition, но и лю-

бым программным аудиоплеером. 

Имеется 3 варианта выполнения сведения.  

1. Командой File > Export > Audio Mix Down главного меню 

открыть диалоговое окно для экспортирования проекта в ау-

диофайл. Как и в любом окне, предназначенном для сохра-

ненрия файла, здесь можно выбрать диск, содать папку, при-

своить сохраняемому файлу имя, выбрать тип файла (советуем 

вам выбирать тип Windows PCM (*.wav; *.bwf)). Кроме того, 

можно конкретизировать, что именно следует сохранять:  

Master — весь проект (все, что поступает на мастер-шину); 

Track — отдельные треки проекта; Output — аудиосигнал, на-

правляемый на определенный выход звуковой карты. Также для 

сохраняемого аудиофайла можно выбрать монофонический или 

стереофонический формат и разрядность (32 или 16 бит). 

2. Командой главного меню Edit > Mix Down to New File от-

крыть подменю команд для создания микса. Возможные вари-

анты: микширование всех незаглушенных блоков в стерео-

микс (Master output in session (Stereo)); микширование всех 
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выбранных и незаглушенных блоков в стереомикс (Master 

output for selected range (Stereo)); микширование всех незаглу-

шенных блоков в мономикс (Master output in session (Mono)); 

микширование всех выбранных и незаглушенных блоков в 

мономикс (Master output for selected range (Mono)). После 

сведения микс окажется во временном файле, который следует 

сохранить под нужным вам именем. Какая бы из перечислен-

ных команд ни была выбрана, если выделен фрагмент проекта, 

то микшироваться будут только те блоки (или фрагменты этих 

блоков), которые оказались в зоне выделения. В любом случае 

микшируются аудиоданные, поступающие на мастер-трек. 

3. Командой Edit > Bounce to New Track главного меню от-

крыть подменю команд, связанных с внутренним пересведе-

нием — объединением нескольких блоков в один: 

 All Audio Clips in Session (Stereo) — пересвести все блоки 

в стереотрек; 

 Audio Clips in Selected Range (Stereo) — пересвести в сте-

реотрек блоки, попадающие в выделенную область проекта; 

 Selected Audio Clips (Stereo) — пересвести в стереотрек 

только выделенные блоки; 

 All Audio Clips in Session (Mono), Audio Clips in Selected 

Range (Mono) и Selected Audio Clips (Mono) — команды, 

аналогичные предыдущим, но результат пересведения со-

храняется в монофоническом формате. 

3.10. Запись альбома  

на компакт-диск 

Наряду с уже знакомыми вам режимами редактирования ау-

диофайла Edit View и мультитрекового редактирования проекта 

Multitrack View в Adobe Audition имеется третий режим CD View, 

в котором выполняются редактирование содержания аудиодиска, 

настройка параметров записи и запись (прожиг) компакт-диска. 

С помощью команды View > CD View главного меню или 

кнопки  перейдите в режим CD View. Теперь вы сможете 



Глава 3  292 

"прожигать" диски CD-R и CD-RW, не выходя из Adobe Audition. 

Из всего множества известных на сегодняшний день форматов 

дисков здесь поддерживается только CD Digital Audio. Но ведь 

эта программа и предназначена только для работы со звуковыми 

данными. 

ПРИМЕЧАНИЕ  

С помощью команд View > Free space based on 74 min CD  

и View > Free space based on 80 min CD главного меню можно 

выбрать одну из стандартных длительностей звучания диска (74 

или 80 минут), что соответствует 650- и 700-мегабайтным дискам. 

 

Рис. 3.49. Главное окно программы (Main) в режиме CD View 

Главное окно программы (Main) в режиме CD View представ-

лено на рис. 3.49. Когда вы перейдете в режим CD View, окно 

Main, скорее всего, будет пустым. А мы заранее создали в рас-

сматриваемом окне список треков, перетащив имена загружен-

ных в программу аудиофайлов из списка вкладки Files панели 

органайзера. 

ПРИМЕЧАНИЕ  

Перед записью компакт-диска в Adobe Audition следует загрузить 

именно сведенные аудиофайлы в формате 44,1 кГц/16 бит/стерео, 

а не проекты мультитрековой сессии. 
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Список в окне Main организован в виде таблицы. Одна строка 

соответствует одному треку будущего диска, а столбцы содержат 

сведения о каждом из них (атрибуты трека). 

 Track — номер трека. 

 Title — имя трека. 

 Source — имя файла-источника. 

 Selection — сведения о части аудиофайла, которая будет использо-

вана при создании трека. Значение Entire File означает, что будет 

использован весь файл. Эксперименты показали, что других вари-

антов получить не удается. Например, если даже в главном окне 

Adobe Audition в режиме Edit View заранее выделить какой-либо 

фрагмент сигналограммы, то для записи трека все равно будет ис-

пользоваться вся сигналограмма, а не ее выделенный фрагмент. 

 Pause — пауза между треками на компакт-диске. 

 Start — время начала трека на компакт-диске. 

 End — время окончания трека на компакт-диске. 

 Length — общая продолжительность трека с учетом возмож-

ной паузы между соседними треками. 

Группа CD Size содержит информацию о том, какой объем на 

диске займут файлы, включенные в проект. 

Кнопка Move Up перемещает трек в списке на одну строку 

вверх, кнопка Move Down — на одну строку вниз. С помощью 

кнопки Remove выбранный трек удаляется из списка. Кнопка 

Remove All удаляет все треки. 

Кнопка Track Properties открывает одноименное диалоговое 

окно (рис. 3.50), предназначенное для редактирования атрибутов 

трека. Это окно можно также открыть двойным щелчком на стро-

ке с именем трека. 

Четыре поля в верхней части окна в пояснениях не нуждаются. 

Если в окне Track Properties выбран переключатель Use de-

fault track properties, то трек будут сопровождать атрибуты, уста-

новленные по умолчанию. При выборе переключателя Use custom 

track properties пользователю становятся доступными для редак-

тирования некоторые из свойств (атрибутов) трека. 

 Pause — использовать перед треком паузу (длительность пау-

зы в формате Секунда:Кадр задается с помощью кнопок ).  
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Рис. 3.50. Диалоговое окно Track Properties  

 

Рис. 3.51. Диалоговое окно Write CD  
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Пауза перед треком (форма волны — горизонтальная прямая) 

генерируется программой автоматически непосредственно во 

время записи диска. 

 Copy protecion — включить защиту от копирования (помогает 

далеко не всегда). 

 Pre-emphasis — включить предварительную коррекцию. 

Если нажать кнопку Set as default, то параметры трека, назна-

ченные пользователем, будут рассматриваться программой как ус-

тановленные по умолчанию. 

Установленный флажок ISRC означает, что будет использо-

ван международный стандартный код записи. Собственно код 

вводится в поле, расположенном справа от надписи ISRC. 

ПРИМЕЧАНИЕ  

ISRC (International Standard Recording Code) — международный 
стандартный код записи, уникальная 12-разрядная комбинация 
цифр и символов в формате ASCII, однозначно идентифицирую-
щая трек. Существуют специальные уполномоченные организа-
ции, которые выдают эти коды. Однако Adobe Audition не прове-
ряет корректность введенного кода. 

Если установлен флажок Same for all tracks, то выбранные 

значения параметров распространяются на все треки диска.  

Прослушать отдельный трек диска, выбрав его в списке окна 

Main, нельзя. Но можно сделать это, воспользовавшись кнопкой 

на вкладке Files панели органайзера. 

Предположим, что список записываемых треков вы сформи-

ровали. Тогда в окне Main можно нажать кнопку Write CD. От-

кроется одноименное диалоговое окно (рис. 3.51). 

В группе Write Options окна Write CD находятся раскры-

вающиеся списки, посредством которых вы можете выбрать: 

 Device — устройство записи; 

 Write Mode — режим записи: 

 Test — тестирование выбранного устройства; 

 Write — запись без предварительного тестирования; 

 Test & Write — запись будет выполнена после тестирования; 

 Copies — количество копий. 
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При установленном флажке Eject CD when complete по завер-

шении прожига диска автоматически откроется карман дисковода. 

Прогресс-индикаторы группы Write Status отображают ход 

записи очередного трека и всего диска. 

В группе Text Options находятся поля для ввода текстовой 

информации. Если установлен флажок Write CD-Text, то эти по-

ля доступны и введенная в них информация будет записана на 

диск в качестве служебной: 

 Title — название альбома, записанного на диске; 

 Artist — имя исполнителя; 

 UPC/EAN — штрихкод. 

ПРИМЕЧАНИЕ  

UPC (Universal Product Code) — система идентификации товаров на 
основе штрихкода, принятая в США и Канаде. EAN (European  
Article Numbering) — аналогичная европейская система. 

Кнопка CD Device Properties открывает диалоговое окно, в кото-

ром можно выбрать устройство записи, а также скорость его работы 

при записи (Write Speed) и размер буфера данных (Buffer Size). 

В режиме CD View в меню File есть команды, предназначен-

ные для работы с проектом диска: 

 New CD List — создание нового проекта диска; 

 Open CD List — загрузка существующего проекта диска; 

 Save CD List — сохранение проекта диска под прежним именем; 

 Save CD List As — сохранение проекта диска под новым именем. 

ПРИМЕЧАНИЕ  

Под проектом диска понимается файл, в котором хранится спи-
сок предназначенных для записи на диск треков со всеми их атри-
бутами и путями к файлам-источникам. 

Если все готово, вставляйте диск в устройство записи, возвращай-

тесь в диалоговое окно Write CD и нажимайте кнопку Write CD.  

Мы рассмотрели далеко не все, а только самые необходимые ре-

жимы работы, окна, меню и команды, из числа имеющихся в звуко-

вом редакторе Adobe Audition. Но и рассмотреного начинающему 

любителю домашней звукозаписи хватит для того, чтобы превра-

титься в подготовленного пользователя музыкального компьютера. 



 

 

Запись вокальной партии  
шаг за шагом 

Звуковой редактор Adobe Audition, с которым вы познакоми-

лись в предыдущей главе, позволяет "с нуля" по отдельным пар-

тиям записать, отредактировать и свести музыкальную компози-

цию, исполненную на традиционных акустических музыкальных 

инструментах. Правда, в таком случае вам потребуются не только 

сами инструменты, но и исполнители, владеющие ими. Вряд ли 

начинающий компьютерный музыкант в состоянии создать по-

добный коллектив. Да что там начинающий — далеко не у вся-

кой "звезды" имеется свой оркестр. Не секрет, что и в коммерче-

ских студиях большая часть продукции создается с помощью 

виртуальных оркестров. То есть основой любой композиции яв-

ляется проект, в котором партии записаны в виде последователь-

ности MIDI-сообщений, управляющих MIDI-синтезаторами. Для 

"оживления" композиция может быть дополнена одной-двумя 

партиями реальных инструментов (гитары, скрипки, саксофона  

и т. д.). И, конечно же, если речь идет о песне, то не обойтись без 

вокальной партии (хотя и существуют виртуальные инструменты, 

способные "спеть" записанный текст, но, к счастью, русского язы-

ка они пока "не знают"). При такой постановке вопроса основ- 

ную работу удобнее выполнять в виртуальной студии, а звуковой 
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редактор привлекать для решения тех задач, с которыми он 

справляется лучше, например, для устранения шума в записи, 

выполненной посредством микрофона. 

В книге "Музыкальный компьютер для начинающих" [30] мы 

подробно описали процесс создания музыкальной композиции 

исключительно в исполнении виртуальных музыкальных инст-

рументов. Каждая партия такой композиции должна быть запи-

сана и отредактирована в MIDI-секвенсоре. А MIDI-секвенсор 

входит в состав виртуальной студии. В качестве такой студии мы 

выбрали Cakewalk SONAR — довольно сложный и многофунк-

циональный программный продукт. Но если ограничиться ис-

пользованием его элементарных средств, то работа по созданию 

музыкальной композиции окажется по плечу не только профес-

сионалу, но и начинающему компьютерному музыканту. Мы по-

думали, что читателям легче будет освоить виртуальную студию, 

если процесс работы над композицией проиллюстрировать сери-

ей файлов, в которых отображается развитие проекта. В качестве 

примера мы взяли песенку "Монолог куклы", сочиненную Юри-

ем Петелиным для внучки. Шаг за шагом мы рассказывали и по-

казывали, как исходно пустой шаблон проекта постепенно запол-

нялся музыкальной информацией: маркерами обозначались части 

композиции; подбирались голоса инструментов; вводились сна-

чала символы аккордов, а затем и собственно аккорды; записы-

вались партии мелодии, баса и ударных; усложнялась аранжи-

ровка; выполнялось предварительное сведение MIDI-средствами. 

Итогом процесса, описанного в книге "Музыкальный компьютер 

для начинающих", стал фрагмент (куплет и припев) музыкальной 

композиции, который мы сохранили в файлах трех различных 

форматов: 

 в аудиофайле (WAV) — для того чтобы можно было исполь-

зовать композицию в качестве "минусовки" при доработке 

песни средствами звукового редактора; 

 в стандартном MIDI-файле (MID) — для того чтобы можно было 

перенести результаты работы в другую виртуальную студию; 

 в файлах проекта Cakewalk SONAR (CWP и CWB) — для того 

чтобы продолжить работать с композицией в "родной" для нее 

программе. 
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И промежуточные, и итоговые файлы мы записали на диск, 

сопровождающий книгу "Музыкальный компьютер для начи-

нающих".  

Но, пожалуй, хватит вспоминать о том, что описано в нашей 

предыдущей книге. Пора поговорить о той книге, которую вы 

читаете сейчас. В трех первых главах состоялось ваше знакомст-

во с основами компьютерных аудиотехнологий, с возможностями 

программ, предназначенных для работы с оцифрованным звуком 

и с элементарными средствами Adobe Audition. Тем самым соз-

дана необходимая база для того, чтобы приступить к решению 

одной из наиболее часто встречающихся в практике компьютер-

ного музыканта задач — к дополнению музыкальной композиции 

записью вокальной партии. Вот об этом и пойдет речь в данной 

главе. А дорабатывать мы будем все ту же детскую песенку.  

То есть исходным материалом будет файл того проекта, который 

мы создали в процессе работы над предыдущей книгой. 

Есть несколько возможных вариантов организации работы. 

Самый неудачный — загрузить в Adobe Audition аудиофайл, со-

держащий сведенную музыкальную композицию (аккомпане-

мент), и дописывать к ней вокальную партию в этой программе. 

В таком случае будут предельно ограничены наши возможности 

достижения хорошего баланса в звучании голоса и отдельных ин-

струментов. По сути, мы заведомо отказываемся от полноценного 

сведéния в надежде устранить недостатки на этапе мастеринга. Это 

неразумно. Или, например, можно каждую партию имеющегося 

проекта в SONAR по отдельности преобразовать в аудиофайл, по-

лученные аудиофайлы загрузить в мультитрековый редактор 

программы Adobe Audition, а уже в этой программе дополнять 

"минусовку" вокальной партией. Однако этот вариант очень не-

удобен (хотя звук с микрофона мы запишем и обработаем без 

проблем). Мы не сможем внести изменения в структуру инстру-

ментальных партий. Например, не сможем транспонировать их, 

приспосабливая к диапазону голоса вокалиста, удалить ранее 

примененные эффекты, исправить исполнительские огрехи. Про-

блематичной будет также запись новых инструментальных пар-

тий. Придется вновь обращаться к проекту SONAR, транспони-

ровать и дописывать MIDI-партии, вновь преобразовывать их  
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в аудиофайлы, которые вновь вставлять в мультитрековый редак-

тор программы Adobe Audition… В общем, придется работать по 

принципу "У попа была собака". 

Разумнее всего выбрать такой вариант: записывать вокальную 

партию в той же программе, где создана MIDI-минусовка (ведь 

Cakewalk SONAR позволяет работать не только с MIDI-, но и с аудио-

данными).  

ПРИМЕЧАНИЕ  

Предварительно при необходимости можно транспонировать тре-
ки мелодических инструментов, подстраиваясь под вокалиста.  

В этой же программе целесообразно смонтировать вокальную 

партию из нескольких дублей. После чего нужно экспортировать 

ее в аудиофайл и только его загрузить для обработки в Adobe 

Audition. Цель обработки — уменьшение уровня шума средства-

ми Adobe Audition. Эта операция могла быть лишней, если бы 

запись вокала выполнялась в студийных условиях. Но при до-

машней звукозаписи уровень шума неизбежно будет слишком 

велик, и без шумоподавления не обойтись. Затем вокальную пар-

тию, обработанную шумоподавителем, следует сохранить в ау-

диофайле (работая в Adobe Audition). После чего останется им-

портировать этот аудиофайл в проект SONAR, а исходный трек с 

"шумным" вокалом — удалить. Теперь можно дорабатывать тре-

ки проекта как угодно.  

Если при создании аккомпанемента мы использовали Cakewalk 

SONAR в качестве MIDI-редактора, то теперь нам предстоит при-

менить программу как виртуальную студию и аудиоредактор.  

Общий алгоритм работы над песней:  

1. Создать проект и назначить MIDI-инструменты, исполняющие 

партии композиции. 

2. Записать мелодию, текст и гармонию песни. 

3. Аранжировать музыкальную композицию средствами MIDI-

редактирования. 

4. Записать вокальную партию, отредактировать ее, выполнить 

шумоподавление. 

5. Применить к записанной вокальной партии фильтрацию, ком-

прессию, обработать ее желаемыми эффектами. 
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6. Уточнить состав MIDI-инструментов, исполняющих партии 

композиции. 

7. Добиться частотного и громкостного балансов, а также опти-

мального распределения голосов по стереопанораме.  

8. Свести записанную песню в стереофайл. 

Первые три операции мы сейчас не рассматриваем. О них 

подробно говорилось в нашей предыдущей книге [30]. Мы про-

сто предлагаем пример готовой MIDI-композиции. Сущность 

большинства остальных операций по отдельности описана в пре-

дыдущих главах. А в этой главе мы рассмотрим их в комплексе  

и в той последовательности, в которой их целесообразно выпол-

нять (применительно к программам SONAR и Adobe Audition). 

В книге [30] мы подробно рассказали о подготовке SONAR  

к работе и о порядке выполнения операций в основных окнах 

программы. Но акцент был сделан на редактировании MIDI-

данных. Работа с этой программой как с аудиоредактором имеет 

определенную специфику. На нее мы обратим ваше внимание  

в данной главе.  

И еще об одном обстоятельстве необходимо сказать перед 

тем, как приступить к ознакомлению с аудиосоставляющей  

программы SONAR. Виртуальная студия Cakewalk SONAR 

(http://www.cakewalk.com/) непрерывно развивается. На момент 

написания книги "Музыкальный компьютер для начинающих" 

была актуальной версия 8.5 программы. 2011 год програм- 

ма встретила в обновленном виде: изменился ее графический  

интерфейс, появилось несколько новых изощренных средств  

редактирования и введена новая система обозначения версий. 

Актуальная на момент написания этих строк версия программы 

называется SONAR X1. Наиболее полный вариант программы — 

SONAR X1 Producer. Кроме него есть два более дешевых вариан-

та: SONAR X1 Studio и SONAR X1 Essential. Как мы уже сказали, 

графический интерфейс программы претерпел существенные из-

менения. В основном это выразилось в том, что система отобра-

жения различных окон стала еще более гибкой и, нужно при-

знать, более удобной. Например, правая нижняя часть главного 

окна теперь отведена под так называемый мультидок — область, 
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в которой ряд основных окон программы могут быть отображены 

в виде вкладок. В предыдущих версиях программы эти окна час-

тенько оказывались разбросанными по произвольным областям 

экрана основного и дополнительного мониторов, так что взгляд 

их не сразу и находил. Впрочем, если вам больше по душе при-

вычный "рабочий беспорядок", то любое окно можно "отстыко-

вать" от мультидока, выбрав соответствующую команду в кон-

текстном меню обрамления окна. 

Непонятно, зачем разработчикам понадобилось раздражать 

давнишних пользователей программы, вводя многочисленные 

изменения вида и мест локализации ряда элементов графического 

интерфейса. Например, исчезло главное меню Options, а все на-

стройки программы перекочевали из нескольких окон, откры-

вавшихся командами этого меню, на вкладки окна Preferences, 

которое открывается командой главного меню Edit > Preferences. 

В предыдущих версиях программы имелся набор из полутора де-

сятков избирательно отображаемых панелей инструментов. Те-

перь их функции частично выполняют команды главного меню  

и контекстных меню окон, частично — транспортная панель, пе-

реименованная в панель управления (Control Bar). 

Есть и изменения, одобрительно встреченные поклонниками 

программы. Одно такое изменение коснулось секции треков и ин-

спектора. В предыдущих версиях программы элементы панели ин-

спектора полностью совпадали с атрибутами выделенного трека,  

а набор атрибутов, отображаемых в секции треков, определялся 

тем, какая вкладка этой секции выбрана. Теперь в секции треков 

отображается переключаемый набор основных атрибутов, а на па-

нели инспектора — их полный набор. Работать стало удобнее.  

В новой версии упразднено отдельное окно виртуальной рэко-

вой стойки. Теперь это средство, предназначенное для подклю-

чения к проекту виртуальных инструментов, выполнено в виде 

вкладки Synth браузера Browser (открывается командой Views > 

Browser главного меню). А сам обновленный браузер стал очень 

удобным. Кроме упомянутой вкладки Synth и вкладки Folders, 

обеспечивающей доступ к любому файлу на любом диске, в нем 

имеется вкладка Plugins, на которой отображаются все установ-
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ленные в системе MIDI-, VST- и DX-плагины. При этом подклю-

чить плагин к треку проекта можно простым перетаскиванием 

его из браузера на поле FX инспектора. 

Эти и другие изменения, появившиеся в новой версии про-

граммы, не затрагивают тех средств, которые мы называем  

элементарными, т. е. базовых средств, давно "прописавшихся"  

в Cakewalk SONAR. С самой первой версии программы и по на-

стоящее время в ней есть: 

 окно Track, где композиция представлена в виде треков (с со-

ответствующими атрибутами) и клипов; 

 окна Piano Roll и Event List, позволяющие редактировать му-

зыкальную композицию, записанную в виде отпечатков кла-

виш и MIDI-сообщений; 

 команды, обеспечивающие работу с файлами, и команды вы-

полнения традиционных операций редактирования (наподобие 

копирования, вырезки, вставки); 

 средства для подключения виртуальных инструментов, эф-

фектов, обработок; 

 регуляторы громкости, панорамы для выбора исходных зна-

чений этих параметров и графики-огибающие для их измене-

ния во времени. 

Так что материал, рассмотренный в этой книге и в книге  

"Музыкальный компьютер для начинающих", вы сможете при-

менять на практике независимо от того, какая версия программы 

имеется в вашем распоряжении: SONAR 6 — SONAR 8.5 или 

SONAR X1. На данный момент пользоваться одной из предыду-

щих версий, а не SONAR X1 даже предпочтительнее: многие по-

сетители тематических сайтов отмечают, что SONAR X1 — вер-

сия "сырая". Фактически разработчики невольно с этим 

согласились, выпустив обновление SONAR X1A, в котором уст-

ранена большая порция "багов", уже через несколько дней после 

выхода SONAR X1. 

ПРИМЕЧАНИЕ  

Проекты, созданные в предыдущих версиях программы, без каких-
либо потерь загружаются в SONAR X1. А вот обратная совмести-
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мость отсутствует. Если вы работали в SONAR X1 и сохранили 
проект в файле, то ни в одной из предыдущих версий программы 
открыть его не удастся. Мы не знаем, какой версией  программы 
пользуетесь вы. Поэтому решили примеры задублировать. Файлы 
проектов, совместимые только с SONAR X1, находятся в папке 
EXAMPLES\SONAR X1, а файлы проектов, совместимые с любой 
версией программы —  в папке EXAMPLES\SONAR. 

В процессе любой работы всегда возникают трудности и про-

блемы, о которых и не подозреваешь, пока сам не столкнешься  

с ними на практике. Как говорится, "гладко было на бумаге…". 

Мы здесь описываем, как шло редактирование реального проек-

та, поэтому многие из таких проблем дали о себе знать, а мы по-

старались найти и объяснение им, и способ их решения. 

Итак, предположим, песня сочинена, записана мелодия, вы-

полнена аранжировка, теперь нужно напеть вокальную партию, 

отредактировать записанный звук и свести проект в стереотрек. 

Иными словами, нужно подготовить демозапись средствами до-

машней студии. А что это за средства? Компьютер со звуковой 

картой, MIDI-клавиатура, микрофон с предварительным усили- 

телем, мониторные наушники и, конечно, виртуальная студия 

SONAR. 

ПРИМЕЧАНИЕ  

Все, что получается по ходу работы над песней, мы сохраняем  

в файлах (см. диск, сопровождающий книгу). Ссылки на файлы 

приведены в тексте главы. Приложение 2 содержит перечень фай-

лов с примерами, а также краткое описание назначения каждого 

файла и логической связи между имеющимися файлами. Для того 

чтобы не создавать путаницу, файлы-примеры к данной книге мы 

нумеруем иначе, чем к предыдущей: мы добавили в имя символы 

подчеркивания и цифру 2, например: SONG_2_01.CWP (а в книге 

"Музыкальный компьютер для начинающих", например — SONG 

01.CWP). "Точкой состыковки" материала двух книг является файл  

в формате проекта SONAR (расширение CWP), в котором записана 

MIDI-аранжировка песни (аудиотреки отсутствуют). На диске к книге 

"Музыкальный компьютер для начинающих" — это файл SONG 

12.CWP. А на диске к книге "Домашняя звукозапись для начинаю-

щих" — это файл: SONG_2_01.CWP. Содержимое данных файлов 

идентично. Теперь исходным является файл SONG_2_01.CWP. Его 

мы и будем дорабатывать.  



Запись вокальной партии шаг за шагом 305 

4.1. Записываем и редактируем  

текст песни в окнах Staff и Lyrics 

программы SONAR 

Песенка, которую мы взялись записывать в качестве примера, на-

зывается "Монолог куклы" (автор Юрий Петелин). У нее само со-

бой есть слова. Вот они. 

 
А в игрушечном нашем мире 

Даже лужицы, словно море, 

Свет от лампы заката шире, 

А грустинка — такое горе! 

Наша радость с людской в сравненьи 

Каплей кажется в океане, 

Шелест трав, будто птичье пенье, 

"Дважды два" — просто бездна знаний. 

Припев:  

Мы — листочки в грозу,  

Вы — игрушки тоже, 

Как слеза на слезу, 

Вы на нас похожи. 

  

А бывает, что Барби злится, 

О заморских краях мечтая. 

Мол: "Вокруг не такие лица. 

И Кукляндия здесь плохая". 

Я, конечно, в науку верю, 

Но вчера на исходе ночи 

Мы оплакивали потерю: 

Умер маленький Тамагочи. 

Припев 

Жить в коробке темно и душно, 

И заплатки к ненастью ноют, 

И играем с любым послушно, 

Кто картонную дверь откроет. 

Но взгляните на наши лица: 

Грусти в них не найти ни крошки. 

Рождены, чтобы веселиться 

Неваляшки, петрушки, матрешки. 

Припев 
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Скорее всего, исполнять песню будет не автор, а другой чело-

век, которого нужно научить ее петь. В нашем случае поет внуч-

ка автора. Чтобы упростить обучение, хорошо бы не только дать 

вокалисту несколько раз послушать мелодию, но и было бы иде-

альным предоставить ему возможность вглядеться в ноты и текст, 

совмещенный с ними (поделенный на слоги). Это вполне реально. 

Командой Views > Staff View главного меню откройте окно Staff 

(рис. 4.1) и нажмите в нем кнопку . Это необходимо для 

ввода текста песни. Установите указатель мыши на белой полоске 

под изображением ноты, начиная с которой пойдет текст песни. 

Перемещая указатель в небольших пределах, добейтесь, чтобы он 

принял вид карандаша. Нажмите левую кнопку мыши — появит-

ся прямоугольная рамка с курсором, в которой можно ввести 

текст песни. Текст записывают по слогам. Пробел воспринимает-

ся программой как команда перехода к следующей ноте, а де-

фис — к следующему слогу (расположенному под следующей 

нотой). После ввода последнего слога нажмите клавишу <Enter>. 

Чтобы удалить ошибочно введенный слог, щелкните на нем и 

нажмите клавишу <Delete>. Немного попрактиковавшись, вы 

научитесь безошибочно выполнять все необходимые операции, и 

у вас получится примерно то, что показано на рис. 4.1. 

ПРИМЕЧАНИЕ  

Небольшая проблема возникает только с предлогами-
согласными. Если такой предлог нужно петь на одной ноте с пер-
вым слогом следующего слова, то и писать его тоже приходится 
слитно со словом. Иначе возникнет смещение слогов относитель-
но соответствующих нот. 

 

Рис. 4.1. Пример записи текста песни в окне Staff 
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Рис. 4.2. Окно Lyrics, предназначенное  
для редактирования текста песни 

Редактировать текст песни можно и в специальном окне — 

Lyrics (рис. 4.2). Чтобы открыть это окно, выполните команду 

Views > Lyrics. 

Любой текст, набранный в окне Lyrics, появится и в окне Staff 

(и наоборот). Если набрать текст, отделяя слова пробелами,  

а слоги — дефисами, то в окне Staff слоги автоматически ока-

жутся под соответствующими нотами. 

В окне Lyrics раскрывающийся список Font предназначен для 

выбора одного из двух заранее установленных шрифтов. Впро-

чем, каждый из них можно при желании настроить. Для этого 

достаточно выбрать в этом списке команду Fonts и в стандартном 

диалоговом окне указать нужный шрифт. 

Раскрывающийся список Tracks позволяет выбрать в одно-

именном диалоговом окне треки, отображаемые в окне Lyrics. 

Итак, мы воспользовались заготовкой проекта, сохраненной  

в файле SONG_2_01.CWP, и ввели под нотоносец с мелодией 

текст одного куплета и одного припева, а результат сохранили  

в файле SONG_2_02.CWP. Теперь у нас есть аккомпанемент  

и слова песни. 

4.2. Боремся с шумом  

домашними средствами 

Запись в домашних условиях речи или пения представляет 

серьезную, но в принципе разрешимую задачу. Вполне реально 

создать в домашней студии демофонограммы с приемлемым ка-

чеством звучания вокальной партии.  

У нас была возможность сравнить качество записи звука до- 

ма и в студиях, звукоизоляция которых обошлась владельцам  
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от 100 000 до 150 000 долларов. Безусловно, преимущества тихо-

го помещения неоспоримы, но вместе с тем, то улучшение каче-

ства звука, которое мы наблюдали, таких денег не стоит.  

Дорогое студийное оборудование также не гарантирует пре-

красный звук в фонограмме. Например, в некоторых студиях из-

за неразумной планировки помещение, где установлен микрофон, 

и аппаратная могут далеко отстоять друг от друга. В результате 

даже в симметричном микрофонном кабеле при большой его 

длине появляются такие наводки, уровень которых сравним с уров-

нем шума в обычной комнате безо всякой звукоизоляции.  

А еще не всегда эксплуатацией дорогого студийного оборудо-

вания занимаются люди, хорошо в нем разбирающиеся. Однажды 

нам довелось наблюдать прямо-таки анекдотическую ситуацию: 

сотрудник студии, считающий себя специалистом, проводил  

запись с помощью высококачественного и очень дорогого кон-

денсаторного микрофона, нацелив максимум его диаграммы на-

правленности не на певца, а на потолок, покрытый звукопогло-

щающим материалом. Дело в том, что он попросту не знал, где  

у микрофона "перед".  

Так что не "комплексуйте" по поводу того, что у вас нет денег 

на оборудование суперстудии, а лучше используйте по максиму-

му те возможности, которые в плане записи звука предоставляет 

компьютер. 

У авторов книги накопился солидный опыт записи звука в об-

становке, не очень-то для этого подходящей. Как бы там ни было, 

но именно в обычной квартире нам удалось записать дикторский 

текст пятидесяти выпусков радиопередачи "Музыкальный ком-

пьютер" и семи выпусков одноименной телепередачи, а также 

вокальные партии около трех десятков песен.  

В необорудованной жилой комнате нет никакой звукоизоля-

ции. Но шаги обитателей квартир на других этажах, шум от элек-

тродрели, работающей в пределах здания, и автомобилей, проез-

жающих под окном, — все это не так страшно. Подобные помехи 

можно просто переждать. Самая большая неприятность — это… 

постоянное гудение вентиляторов компьютера. Оно досаждало 

нам с первого сеанса записи. Что только мы ни делали, чтобы его 

ослабить! На время записи переставляли системный блок на пол, 
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подкладывая толстый поролоновый коврик, сверху накрывали 

его огромной картонной коробкой из-под телевизора, на которую 

набрасывали ватные одеяла. Бедняга компьютер — как ему, на-

верное, было жарко… Комнату временно делили на две части 

веревкой, прикрепленной к противоположным стенам, на кото-

рой с помощью прищепок развешивали всевозможные покрывала 

и пледы. "Упакованный" компьютер и микрофон размещали по 

разные стороны от импровизированной перегородки. Причем 

максимум кардиоидной диаграммы направленности микрофона 

ориентировали в сторону, противоположную от компьютера. За-

одно старались минимизировать реверберацию, заглушить комна-

ту, развешивая вдоль стен и вблизи поверхностей мебели остав-

шиеся одеяла и покрывала. Этой же цели попутно служили 

толстые ковры на одной из стен и на полу. В общем, постороннему 

человеку без смеха в такую "студию" заглянуть невозможно.  

Микрофон поначалу у нас был плохой. Особенно "доставала" 

его бурная реакция на взрывные звуки. Для борьбы с "п" перед 

микрофоном устанавливался самодельный поп-фильтр: материал 

от старых капроновых колготок в два слоя, натянутый на дере-

вянные пяльцы для вышивания (нынешний фирменный поп-

фильтр отличается от той самоделки только узлом крепления  

к микрофонной стойке). 

В результате всех ухищрений уровень шума компьютера на 

входе программы, с помощью которой записывался звук, удава-

лось довести приблизительно до –(45—50) дБ. Столь шумную 

фонограмму нельзя монтировать в радиопередачу или песню. Но 

такой уровень шума уже позволяет эффективно и без заметных 

искажений полезного сигнала подавить его специальными про-

граммными средствами. С некоторыми из них вы можете позна-

комиться в книгах [14, 25, 29] и статьях [50, 67, 83]. Для шумопо-

давления мы, как правило, используем модуль Noise Reduction, 

встроенный в звуковой редактор Adobe Audition (см. разд. 3.5).  

С его помощью шум речевой или вокальной фонограммы удается 

ослабить до –90 дБ, что можно считать весьма неплохим резуль-

татом. Кроме шумоподавления мы вручную вырезаем в Adobe 

Audition все огрехи типа "плямканья" губами, "клацанья" зубами, 

а иногда даже шумные "вдохи".  
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Для того чтобы хронометраж фонограммы не изменился, нужно 

не просто удалять "бракованные" места, а заменять их абсолют-

ной тишиной. В Adobe Audition для этого имеется специальная 

команда Effects > Mute, которую нужно применять к выделен-

ному фрагменту фонограммы. 

Практика — критерий истины: качество наших фонограмм 

вполне устраивало инженеров и редакторов радиостанций. Зна-

чит, и вы сможете работать в аналогичных условиях. 

Со временем вместо настольного компьютера мы обзавелись 

достаточно мощным ноутбуком. Если его не загружать непо-

сильными вычислениями и не заставлять вентилятор напрягаться, 

то и без всяких "заглушек" уровень шума составляет всѐ те же  

–50 дБ. Но одна проблема тянет за собой другую. Встроенная  

в ноутбук звуковая карта явно не годится для выполнения высоко-

качественной записи с микрофона. Она шумит и смещает постоян-

ную составляющую сигнала с нулевого уровня. Имеющийся в на-

шем распоряжении внешний ламповый микрофонный усилитель  

к ноутбуку не подключить, т. к. в нашем ноутбуке отсутствует ли-

нейный вход, а микрофонный вход, естественно, будет перегружен 

сигналом линейного уровня с выхода предусилителя. Следова-

тельно, нельзя воспользоваться конденсаторным микрофоном. 

Хорошо, что такой узел противоречий разрубается легко.  

Мы приобрели внешний модуль сопряжения M-Audio FireWire 410  

и подключили его к ноутбуку "по цифре" посредством порта 

IEEE 1394. В модуле имеются два универсальных аналоговых 

входа. На микрофонные входы можно подать фантомное пита-

ние, а значит, есть все необходимое для подключения конденса-

торного микрофона. Но нам нравится окраска, которую придает 

звучанию голоса ламповый предусилитель. Поэтому полностью 

звуковой тракт выглядит так: конденсаторный микрофон под-

ключен ко входу лампового микрофонного предварительного 

усилителя, выход которого подключен к линейному входу M-

Audio FireWire 410. К одному из аналоговых выходов M-Audio 

FireWire 410 подключены мониторные наушники.  

Во время записи вокала дополнительно используется много-

канальный усилитель, к которому подключаются три пары науш-

ников — для вокалиста, звукорежиссера и продюсера. При 
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сведéнии кроме наушников применяются активные мониторные 

акустические системы. 

MIDI-клавиатура у нас подключена к ноутбуку посредством 

интерфейса USB.  

Конечно, стоимость такой домашней студии не так уж мала, 

но она не идет ни в какое сравнение со стоимостью оборудования 

любой из коммерческих студий. 

Студия подобной конфигурации обеспечивает очень прилич-

ное качество записи звука. Внешний вид входящих в нее устройств 

и схему их соединений мы привели в книге [30] на рис. 1.19, 1.20. 

Если компьютерная обработка звука станет вашей профессией 

или серьезным увлечением, то со временем вы обзаведетесь ана-

логичным оборудованием. Возможно, при той же стоимости оно 

обеспечит даже более высокое качество записи звука. Ведь тех-

ника в этой области развивается стремительно.  

Но это будет потом, а сейчас начинать учиться можно и на бо-

лее дешевой аппаратуре: микрофон, компьютер со звуковой кар-

той и стереофонические наушники. Правда, вы должны ясно по-

нимать, что искажения в записанном звуке необратимы. Если уж 

микрофон и звуковая карта никуда не годятся, то никакие самые 

современные плагины чуда не сотворят. В этом принципиальное 

отличие звукозаписи от записи MIDI-композиции. Техническое 

качество последней не зависит от качества аппаратуры (если,  

конечно, не принимать в расчет случаи, когда аппаратура явно 

неисправна и поэтому не способна воспринимать и воспроизво-

дить MIDI-сообщения).  

Предположим, что вы так или иначе приспособили имеющее-

ся в вашем распоряжении помещение для компьютерной записи 

звука. Пора браться за вокальную партию. 

4.3. Готовимся к записи  

вокальной партии 

Подготовку к записи вокальной партии начнем с того, что за-

грузим в SONAR файл SONG_2_02.CWP с проектом, в котором 

имеются партии аккомпанемента и записан текст песни. 
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4.3.1. Знакомимся с главным окном 

SONAR и создаем аудиотрек  

Создадим аудиотрек (команда Insert > Audio Track главного 

меню). К существовавшим ранее в проекте SONG_2_02.CWP 

MIDI-трекам и треку виртуального синтезатора Cakewalk TTS-1 

добавился аудиотрек под номером 9, он пока пуст (рис. 4.3).  

ПРИМЕЧАНИЕ  

Проект, в который вставлен аудиотрек, мы сохранили в файле 
SONG_2_03.CWP. 

Надеемся, что вы читали книгу "Музыкальный компьютер для 

начинающих" [30], а значит, в принципе знакомы с главным ок-

ном программы SONAR 8.5. Но в данной книге мы впервые при-

вели вид главного окна программы, к тому же это окно програм-

мы SONAR X1, а кроме того, в нем имеется новый для вас 

элемент — аудиотрек. Поэтому давайте сориентируемся в том, 

что мы видим на рисунке. 

В верхней части окна находится главное меню. Вертикальная 

панель, расположенная слева, — инспектор трека. В нем ото-

бражаются элементы, соответствующие атрибутам того трека, 

который в данный момент выбран (на рис. 4.3 это добавленный 

аудиотрек). 

Вдоль нижней стороны окна на рисунке размещена панель 

управления (Control Bar). На ней может располагаться очень 

много элементов (выбираются в контекстном меню панели, кото-

рое открывается щелчком на ней правой кнопкой мыши). Мы ос-

тавили на панели управления минимальный набор самых необхо-

димых элементов. В итоге она стала походить на транспортную 

панель, имевшуюся в предыдущих версиях программы. 

ПРИМЕЧАНИЕ  

Текущая конфигурация (раскладка) главного окна (открытые окна, 
их размеры и расположение, отображаемые элементы, треки и их 
настройки) сохраняется при сохранении файла проекта. Поэтому, 
загрузив файл SONG_2_03.CWP, вы увидите на экране то же, что 
и на рис. 4.3.  
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Над панелью управления находится мультидок (MULTIDOCK) — 

область, в которой можно располагать в качестве вкладок сразу 

несколько окон (например, знакомые вам окна Staff и Lyrics). 

Сейчас мультидок пуст. 

Основное место в главном окне занимает панель треков и шин 

(Track View). В ее правой части в виде цветных прямоугольников 

(клипов) отображаются MIDI- и аудиоданные, записанные на тре-

ках. В левой части панели находится секция треков, которая со-

держит атрибуты треков (по отдельности для каждого из имею-

щихся треков). 

В нижней части панели располагается секция шин. Слева — 

секция атрибутов шин. В ней можно контролировать и изменять 

атрибуты шин. В секции автоматизации шин (справа) отобра-

жаются и доступны для редактирования в виде огибающих дан-

ные автоматизации шин.  

По умолчанию созданы 2 шины:  

 шина Master, на которую можно вывести сигналы с одного 

или нескольких аудиотреков и синтезаторных треков; 

 шина Metronome, предназначенная для управления сигналами 

встроенного метронома. 

Командой Insert > Stereo Bus главного меню можно создать 

неограниченное количество дополнительных шин, которым авто-

матически будут присваиваться номера начиная с 3. Шины удобно 

использовать в том случае, когда 

нужно одновременно управлять 

параметрами нескольких треков 

(например, обрабатывать группу 

треков одним и тем же эффектом, 

синхронно изменять для группы 

треков уровень громкости). 

Теперь познакомимся с теми 

атрибутами аудиотрека (рис. 4.4), 

которые могут нам понадобить-

ся в ходе подготовки к записи,  

а также в процессе записи и вос-

произведения вокальной партии.  

 

Рис. 4.4. Атрибуты аудиотрека 
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ПРИМЕЧАНИЕ  

Выбор отображаемых атрибутов трека производится в раскры-
вающемся списке, расположенном в верхней части секции треков. 
На рис. 4.3. выбран вариант All — отображать все элементы. 

Кроме него возможны варианты: Custom — показывать пользо- 

вательский набор атрибутов; Mix — показывать только те атрибу-
ты, которые нужны для сведéния (громкость, панорама и т. п.); 
FX — показывать только атрибуты, связанные с применением 

эффектов реального времени; I/O — показывать порты вво-

да/вывода треков и шин. Команда Track Control Manager этого 
раскрывающегося списка открывает диалоговое окно, в котором 
можно выбрать атрибуты, отображаемые в режиме Custom. 

В левом углу указан номер трека в проекте. Щелчком на поле 

номера трек (и все относящиеся к нему клипы) выделяют. По-

вторным щелчком снимают выделение.  — логотип аудиотре-

ка. Правее расположено поле имени трека. По умолчанию в нем 

указываются слово "Track" и номер трека. Включив двойным 

щелчком режим редактирования содержимого поля, вы можете 

присвоить треку наиболее подходящее имя, например, Вокал. 

В заголовке трека располагаются кнопки статуса. 

 (Manual Mute) — если она нажата, то трек заглушен. 

 (Solo) — если она нажата (кнопка зеленого цвета), то трек 

находится в режиме соло: слышен будет только он, остальные 

треки будут заглушены. В режим соло можно перевести не один 

трек, а целую группу треков. 

 (Record) — кнопка разрешения записи для данного трека. 

Если эта кнопка нажата (выделена красным цветом), то при 

включении режима записи нажатием кнопки Record на панели 

инструментов Control Bar начнется запись аудиосообщений на 

соответствующий трек.  

Кнопка  (Input Echo) управляет режимом трансляции аудио-

сообщений сквозь SONAR. Режим трансляции сообщений всегда 

включен для текущего трека.  

Кнопка  открывает меню, в котором можно вы-

брать информацию, отображаемую в секции клипов (графики-

огибающие, предназначенные для автоматизации различных па-

раметров трека или клипа). Название кнопки меняется в соответ-

ствии с выбранным вариантом. 
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Кнопкой  включается режим записи данных автоматизации. 

В этом режиме программа запомнит ваши манипуляции с эле-

ментами управления во время воспроизведения проекта. Кнопка 

 разрешает чтение записанных данных автоматизации. 

Если нажата кнопка , то трек перейдет в архивированное 

состояние. Он будет заглушен, причем перевести такой трек  

в незаглушенное состояние во время проигрывания вы не сможе-

те, поскольку информация, относящаяся к архивированному тре-

ку, даже не загружается в память в целях экономии системных 

ресурсов. 

Кнопкой  инициируется "замораживание" трека. Данные на 

треке пересчитываются. При этом к ним применяются алгоритмы 

подключенных эффектов. Замороженный трек в ходе воспроиз-

ведения расходует меньше ресурсов компьютера, т. к. все ресур-

соемкие вычисления произведены заранее. Размораживается трек 

повторным нажатием кнопки . 

Регулятор  управляет уровнем громкости воспроиз-

ведения трека. Регулятором  изменяют панораму для 

монофонических аудиотреков и стереобаланс для стереофониче-

ских. Регулятор стереобаланса работает так: при перемещении ре-

гулятора Pan в крайнее положение уровень сигнала в соответст-

вующем этому положению стереоканале останется без изменений, 

а в другом стереоканале сигнал будет полностью заглушен. То есть 

при любом отклонении регулятора Pan от центра общая громкость 

трека будет уменьшаться. Когда регулятор Pan работает именно 

как регулятор панорамы, общая громкость остается без изменений 

вне зависимости от положения этого регулятора. Достигается это 

за счет того, что при уменьшении уровня сигнала в одном стерео-

канале уровень сигнала в другом стереоканале увеличивается.  

После выполнения записи на аудиотрек имеет смысл отрегу-

лировать параметр . С помощью этого регулятора вы 

должны добиться того, чтобы во время воспроизведения трека 

при значении параметра , равном 0 дБ, показания изме-

рителя уровня сигнала на пиках не заходили в красную область. 

При работе с микшером такая операция называется калибровкой 

фейдера, в качестве которого в данном случае выступает регуля-

тор .  
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Диапазон измерителя уровня сигнала можно задать в контекст-

ном меню, открываемом щелчком правой кнопки мыши на изме-

рителе. Если во время воспроизведения загорится красный сигнал, 

расположенный на месте, указанном стрелкой, — , 

значит, произошло клиппирование. Следует уменьшить уровень 

сигнала регулятором . Если трек не откалиброван,  

то положение регулятора  тоже следует принимать во 

внимание. Если клиппирование будет происходить при записи, то 

учитывать придется еще и настройки микшера звуковой карты,  

а также внешних устройств (микшера, микрофонного предусили-

теля и т. п.), подключенных к ней.  

FX — поле для подключения эффектов реального времени 

(DX- и VST-плагинов). Подключение аудиоэффектов реального 

времени происходит так: щелкаете правой кнопкой мыши на по-

ле FX, выбираете в контекстном меню строку (подменю) Audio 

Effects, затем нужную группу DX- или VST-плагинов и, в конце 

концов, выбираете сам эффект. 

Последние два элемента атрибутов трека — раскрывающиеся 

списки Input и Output — предназначены для выбора портов вво-

да и вывода аудиосообщений с данного аудиотрека.  

ПРИМЕЧАНИЕ  

Для SONAR в целом порты ввода и вывода должны быть уже вы-
браны по умолчанию при инсталляции программы. Но удостове-
риться в этом будет не лишним. Командой Edit > Preferences глав-

ного меню откройте окно Preferences на вкладке Audio Devices. 

Убедитесь, что в секциях Input Devices и Output Devices флажки 
установлены для портов того устройства, которое вы намерены 
использовать при записи и воспроизведении звука (речь идет  
о вашей звуковой карте).  

Драйверу звуковой карты соответствуют несколько логиче-

ских портов ввода/вывода. Одному и тому же физическому порту 

ввода звуковой карты могут соответствовать следующие логиче-

ские порты, доступные в SONAR (подразумевается, что проект 

стереофонический): 

 источник звука левого канала; 

 источник звука правого канала; 

 стереофонический источник звука. 
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Для выбора порта ввода, связанного с данным треком, предна-

значен раскрывающийся список Input . 

В раскрывающемся списке Output  выбирают порт 

вывода. В качестве порта вывода можно выбрать не только физи-

ческий порт звуковой карты, но и одну из шин SONAR.  

Шины SONAR делятся на две категории — стереофонические 

(Stereo Bus) и многоканальные (Surround Bus). Шины не имеют 

фиксированных имен. Их имена могут зависеть от шаблона, ис-

пользуемого при создании проекта. Разумеется, шины можно до-

бавлять, переименовывать и удалять. Если для нескольких треков 

в качестве порта вывода выбрать одну и ту же шину, то суммар-

ный сигнал данных треков можно обрабатывать одним набором 

плагинов, подключенных к шине. Для каждой из шин, в свою 

очередь, определяется свой порт вывода, которым может быть как 

выходной порт звуковой карты, так и другая шина. В любом слу-

чае сигналы с треков и шин, в конечном счете, попадут на один 

или несколько физических выходных портов звуковой карты. 

4.3.2. Готовимся к записи, репетируем, 

подбираем тональность и громкость 

аккомпанемента  

Подключим микрофон и наушники. Отрегулируем уровень 

сигнала (см. разд. 1.3.1), поступающего с микрофона.  

Запись вокальной партии будет происходить на фоне звуча-

ния аранжировки, воспроизводящейся в нашем случае вирту-

альным синтезатором с семи MIDI-треков. Исполнитель должен 

петь, слушая аккомпанемент в наушниках. Здесь есть неболь-

шая проблема. Даже если наушники закрытые, все равно звук 

(преимущественно высокие частоты) из них "просачивается" 

наружу и попадает в близко расположенный микрофон. Правда, 

уровень этого побочного сигнала невысок. С полуоткрытыми  

и открытыми наушниками дело обстоит серьезней: аккомпане-

мент явно воспринимается микрофоном и при записи окажется 

на треке с вокалом (средний уровень побочного сигнала может 

составлять –40 дБ).  
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Неприятны здесь несколько обстоятельств.  

Во-первых, само по себе наличие какого-то другого сигнала на 

треке с вокалом крайне нежелательно. Это осложнит дальнейшее 

редактирование голоса, начиная от шумоподавления и заканчи-

вая обработкой эффектами. В итоге, звучание голоса в фоно-

грамме в какой-то степени утратит прозрачность.  

Во-вторых, звук, проникший таким путем в микрофон, очень 

сильно искажен. А избавиться от него будет трудновато.  

Эффективные программные средства борьбы с помехами разра-

ботаны только для шума с равномерным, стационарным во вре-

мени спектром, фона переменного тока и щелчков. Здесь же 

помеха представляет собой музыкальный сигнал, не имеющий 

существенных отличий, по которым его можно было бы иден-

тифицировать и выделить на фоне полезного (тоже музыкаль-

ного) сигнала. Искажения записанного побочного сигнала  

будут восприниматься на слух как искажения в звучании ак-

компанемента. Взаимодействие в микшере данного побочного 

сигнала с сигналами, воспроизводимыми непосредственно MIDI-

инструментами, исполняющими партии аккомпанемента, может, 

например, привести к частичной потере высоких частот (если 

происходит противофазное сложение). Может также возник-

нуть и неглубокое амплитудное или фазовое вибрато. 

В-третьих, не забывайте, что у нас пока что готова только осно-

ва аранжировки, которая нужна лишь для того, чтобы записать 

вокал. В дальнейшем могут появиться другие MIDI-партии, изме-

нятся голоса инструментов. А в побочном сигнале, записанном  

заодно с голосом певца, по-прежнему будет слышен исходный 

вариант аранжировки. Следствие — ухудшение все той же про-

зрачности звучания итоговой фонограммы. 

Вывод: громкость звучания аккомпанемента в наушниках 

должна быть минимальной, но, конечно, такой, чтобы вокалист 

не испытывал дискомфорта. Для обеспечения этого условия нуж-

но отрегулировать в сторону уменьшения уровень громкости 

всех партий аккомпанемента. В данном случае управлять громко-

стью каждого трека по отдельности неудобно, да и ни к чему. 

SONAR позволяет делать это одновременно, причем тремя раз-

личными способами. 
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Первый способ. Командой Views > Console View главного  

меню откроем окно Console. Это виртуальный микшер, встроен-

ный в SONAR. Щелчком правой кнопки мыши на регуляторе Vol 

модуля MIDI-трека № 1 откроем контекстное меню, в нем выбе-

рем команду Group, а затем группу, например, обозначенную 

латинской буквой "A" и красным цветом. Аналогичные действия 

совершим поочередно для регуляторов Vol модулей MIDI-треков 

№№ 2—7. Все семь регуляторов громкости окажутся сгруппиро-

ванными: перемещение любого из них теперь будет приводить  

к перемещению остальных. Громкость воспроизведения партий, 

записанных на этих треках, можно изменять одновременно. 

Второй способ. Командой Insert > Stereo Bus главного меню 

создадим дополнительную шину. По умолчанию она будет назы-

ваться Bus 3. В раскрывающемся списке Output каждого из син-

тезаторных треков выберем порт вывода Bus 3. Теперь громкость 

звучания всех виртуальных синтезаторов можно изменять един-

ственным регулятором — размещенным на этой шине регулято-

ром Output Volume. 

Третий способ годится, если все партии аккомпанемента  

в проекте озвучиваются единственным виртуальным синтезато-

ром. В нашем случае так и есть: в заготовке аранжировки задейство-

ван лишь Cakewalk TTS-1 — простой в управлении синтезатор, тра-

диционно входящий в комплект поставки программы. От состояния 

регулятора Volume, размещенного на треке Cakewalk TTS-1, будет 

зависеть громкость звучания аккомпанемента. Но чтобы не воз-

вращаться к этому вопросу, если когда-нибудь к проекту будут 

подключены и другие виртуальные синтезаторы, мы применим 

второй способ: создадим дополнительную шину. 

Можно приступить к пению. Включим режим воспроизведе-

ния проекта и начнем репетицию.  

Возможно, тональность, в которой записан аккомпанемент, не 

подходит для конкретного исполнителя вокальной партии. В та-

ком случае нужно экспериментально подобрать ту тональность,  

в которой певец будет чувствовать себя наиболее уверенно. Транс-

понирование аккомпанемента из тональности в тональность вы-

полняется очень просто. С помощью команды Process > Transpose 

главного меню откройте одноименное диалоговое окно и в поле 
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Amount укажите количество полутонов, на которое следует про-

извести транспонирование (вверх — без знака, вниз — со знаком 

"минус").  

Здесь есть один нюанс. Перед транспонированием нужно выде-

лить все MIDI-треки проекта, кроме трека, на котором записана 

партия ударных инструментов (в проекте SONG_2_03.CWP это 

трек № 4 Ударные и перкуссия). Дело в том, что транспониро-

вание в MIDI-редакторе сводится к изменению номеров всех 

MIDI-нот на одно и то же число. В наборе ударных инструмен-

тов каждый из них соответствует определенной MIDI-ноте.  

Поэтому транспонирование ритмической партии приведет к смене 

играющих ударных инструментов. Наверное, из-за незнания 

этого обстоятельства во многих композициях, которые присы-

лают нам начинающие компьютерные музыканты, партии удар-

ных звучат странно. В них бывают задействованы плохо соче-

тающиеся друг с другом инструменты. И вообще, в тех долях, 

где душа ожидает удара Kick Drum (басовый барабан, на кото-

ром играют посредством ножной педали с колотушкой), вдруг 

ни с того ни с сего звучит Metron Bell (колокольчик, предназна-

ченный для озвучивания сигналов метронома). А все объясня-

ется тем, что в наборе General MIDI Drums номера нот, соответ-

ствующих этим инструментам, отличаются на единицу, и, 

видимо, автор композиции где-то по ходу дела транспонировал 

ее всю (вместе с партией ударных) на один полутон вниз. 

ПРИМЕЧАНИЕ  

В результате транспонирования партий, исполняемых мелодиче-
скими инструментами (мелодии, гармонии и баса), соответственно 
изменятся все ноты. В частности, изменятся ноты аккордов в партии 

на треках № 2 Гармония и № 7 Гармония 2 (например, при транс-
понировании на два полутона вверх аккорд ля минор превратится  
в аккорд си минор). Но вот обозначения аккордов, записанные над 
нотным станом на этом треке, останутся прежними (например, Am), 
а значит, перестанут соответствовать реально имеющимся  
аккордам. На звучании MIDI-партий это ровным счетом никак не 
скажется. Но не забудьте о таком несоответствии, если захотите  
в процессе обработки вокала воспользоваться имеющимися обо-
значениями аккордов как справочным материалом. Знание гармо-
нии может потребоваться, например, при обработке голоса вокоде-
ром [14, 20], а также при формировании многоголосного бэк-вокала 
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путем преобразования высоты тона фрагментов единственной  
записанной вокальной партии. Если вы по натуре педантичны, то 
отредактируйте обозначения аккордов. Или забудьте о них, если 
подобные мелочи вас не волнуют, а в дальнейшем ориентируйтесь 

лишь на реальные MIDI-ноты треков Гармония и Гармония 2. 

В нашем случае для юной вокалистки наиболее удобной то-

нальностью оказалась тональность си минор. В нее мы и транс-

понировали аккомпанемент. Во время репетиции мы также при-

шли к выводу, что нужно изменить темп композиции с 150  

до 160 BMP (долей в минуту). В прежнем темпе песня звучала вяло.  

ПРИМЕЧАНИЕ  

В SONAR есть средство для преобразования хронометража  
(а значит и темпа) записанного аудиофайла. Команды Process > 

Length и Process > Fit tp Time главного меню открывают диало-

говые окна, в которых имеется опция Stretch Audio. Она позволя-
ет "растягивать" или "сжимать" выделенные аудиосообщения  
в заданной пропорции. Например, можно записать вокальную пар-
тию в темпе 150 BMP, а затем, "сжав" во времени весь проект, 
включая вокальную партию, увеличить темп. Однако такие преоб-
разования не даются даром. Качество звука неизбежно ухудшит-
ся. Поэтому лучше записывать песню сразу в предпочтительном 
темпе. 

Итак, тональность и темп подобраны.  

Заготовку проекта, предназначенного для записи вокальной 

партии, мы сохранили в файле SONG_2_04.CWB. В файлах этого 

типа аудиоданные хранятся вместе с остальными данными, 

имеющимися в проекте. Если при попытке открыть файл этого 

типа программа предложит указать другое имя для проекта, то вы 

можете либо тут же выполнить требование, либо отказаться от 

этого и в открытом окне Unpack Bundle снять флажок Store 

Project Audio in its own Folder.  

Пора перейти от репетиций к записи. 

Можно попытаться спеть песню всю сразу от начала до конца. 

Но если отсутствие вокального опыта не позволяет сделать за-

пись за один проход, то разделим процесс на этапы. Попробуем 

сделать несколько дублей припева и каждого из куплетов. Если  

и это окажется непосильной задачей — записываем песню по  

отдельным фразам. Правда, тогда более трудоемким окажется  
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последующий монтаж, да и не исключено, что от фразы к фразе 

будет заметно меняться интонация или тембр голоса. В нашем 

случае юная вокалистка справилась с задачей "покуплетной"  

записи песни. Собирать партию из отдельных слов не пришлось.  

Удобно вести запись в циклическом режиме. Чтобы подгото-

виться к записи первой части первого куплета нашей песни, зацик-

лим такты с девятого по девятнадцатый. Для этого мышью выде-

лим их на шкале времени, расположенной в верхней части секции 

клипов, а на панели управления (Control Bar) нажмем кнопку  

(Set Loop Points To Selection). Выделенный фрагмент окажется 

зацикленным. Для перемещения указателя текущей позиции в на-

чало цикла воспользуемся кнопкой  (RTZ [W]) на панели 

управления (повторным нажатием этой кнопки указатель текущей 

позиции можно переместить в начало проекта). При таких грани-

цах цикла воспроизведение аккомпанемента будет начинаться за 

два такта до начала первого куплета: прозвучат аккорды, позво-

ляющие певцу сориентироваться в тональности и в темпе. 

ПРИМЕЧАНИЕ  

Было бы удобно, если бы начальный момент записи (левая гра-
ница будущего аудиоклипа) был привязан к началу такта. Чтобы 
обеспечить себе точную установку указателя текущей позиции на 
шкале времени в начало любого такта, (а также выделение интер-
валов, кратных целому числу тактов), нужно включить режим при-
вязки к тактовой сетке. Для этого, прежде всего, следует щелчком 
правой кнопки мыши на панели управления открыть ее контекст-
ное меню и установить флажок в строке Snap Module. На панели 
управления отобразится модуль привязки к сетке (рис. 4.5).  

На нем нужно включить кнопку  (Snap), а в контекстном меню 

соседней кнопки выбрать строку Measure.  

Нажмем кнопку  (Record) в поле атрибутов трека № 9, раз-

решив запись на него аудиоданных.  

Щелчком правой кнопки мыши на кнопке  (Record [R]), 

расположенной на панели управления, откроем диалоговое окно 

Preferences на вкладке Record. Обратим внимание на опции двух 

групп: Recording Mode и Loop Recording. 

Если в группе Loop Recording выбрана опция Store Takes in  

a Single Track, то при циклической записи каждый следующий 

дубль будет сохраняться на отдельном аудиотреке (программа 
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будет создавать треки автоматически). Выбор опции Store Takes 

in Separate Tracks, означает, что запись очередного дубля будет 

производиться не на новый трек, а на новый слой (подтрек) одно-

го и того же трека. Для дальнейшего редактирования это не 

принципиально. И в том и в другом случае каждый дубль по от-

дельности можно прослушивать, выделять, разрезать, копиро-

вать, перемещать, удалять.  

Если в группе Recording Mode выбрана опция Sound on Sound 

(Blend), то при записи материал, имеющийся на треке, стираться 
не будет, новые аудиоданные будут записаны поверх суще- 

ствующих (накладываться на них). Выбор опции Overwrite  

(Replace) означает, что при записи новых данных прежние дан-
ные будут удалены.  

ПРИМЕЧАНИЕ  

Опции группы Recording Mode значимы в том случае, когда нужно 
дописать звуковые данные на тот трек, где они уже имеются.  
В случае циклической записи эти опции не играют никакой роли:  
в пределах одного сеанса запись каждого дубля будет выполнять-
ся на автоматически создаваемые чистые аудиотреки (или слои 
одного аудиотрека). Главное, завершив один сеанс (записав нуж-
ное количество дублей и остановив запись), не начните запись 
следующего сеанса с того же места на тот же трек. Вот тогда уж 
точно либо фонограммы, полученные в первом сеансе, будут за-
терты, либо на них будут наложены фонограммы второго и после-
дующих сеансов. Короче говоря, правила "техники безопасности" 
таковы: не останавливайте запись до тех пор, пока не поймете, 
что есть дубли, из которых найдется, что выбрать; если останови-
ли запись (закончили сеанс), то запись в следующем сеансе вы-
полняйте на новый аудиотрек.  

Выбрав опции, закройте диалоговое окно Preferences нажатием 

кнопки OK. Вот теперь, пожалуй, наконец-то все готово к записи. 

4.4. Записываем дубли фрагментов 
вокальной партии 

Кнопкой  (Record [R]), расположенной на панели управле-

ния, включим режим записи. Зазвучал аккомпанемент. Вокалистка 

начинает петь текст: "А в игрушечном нашем мире…" Раз за разом 

повторяет первую часть первого куплета. В зависимости от вы-
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бранного режима она записывается либо на новые треки (а в на-

шем примере именно так и происходит), либо на новые слои (под-

треки) одного трека. Когда будут устойчиво появляться дубли 

удовлетворительного качества, остановим запись и сохраним ре-

зультаты первого сеанса в файле SONG_2_05.CWB. Несколько 

дублей первого фрагмента песни при записи на разные треки (на-

чиная с трека № 9) выглядят так, как представлено на рис. 4.5.  

ПРИМЕЧАНИЕ  

В целях уменьшения объема памяти, занимаемой полученным 
файлом, часть наименее удачных треков мы удалили. Поэтому  
в именах клипах нарушен порядок нумерации.  

Воспроизводя в цикле записанный фрагмент и поочередно 

включая режим солирования для каждого из треков, можно ото-

брать лучший вариант. Но заниматься этим есть смысл после то-

го, как будут записаны дубли всех частей песни. 

 

Рис. 4.5. Записаны дубли первой части первого куплета песни 
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После этого перейдем к следующему фрагменту. В принципе, 

можно продолжать вести запись на тот же трек № 9. Только при 

выборе режима следует назначить интервал записи такой, чтобы 

"не зацепить" имеющийся фрагмент. Однако в действительности 

это не очень удобно. Поэтому создадим новый трек № 12 и будем 

записывать дубли, начиная с него.  

Теперь зациклим такой фрагмент, который в своем начале за-

хватывал бы концовку ранее записанной фразы, т. е. начинался 

бы, например, с семнадцатого такта. Это нужно для того, чтобы 

исполнитель мог согласовать интонацию записываемой фразы  

с интонацией фразы, записанной ранее. Ну, а окончание цикла 

должно быть в такой позиции, чтобы в цикл укладывалась вторая 

часть первого куплета, т. е. должно приходиться на конец тридцать 

шестого такта (рис. 4.6). Многократно запишем вторую часть пер-

вого куплета (результат сохранен в файле SONG_2_06.CWB). 

 

Рис. 4.6. Записаны дубли второй части первого куплета песни 



Запись вокальной партии шаг за шагом 327 

 

Рис. 4.7. Записаны дубли припева песни 

Теперь выделим фрагмент с 34 по 44 такты. Создадим трек 

№ 17 и, начиная с него, запишем дубли припева (рис. 4.7, файл 

SONG_2_07.CWB). 

Продолжаем действовать аналогичным образом до тех пор, 

пока не окажутся записанными все части песни. Желательно не 

растягивать этот процесс надолго и уж, во всяком случае, не от-

кладывать запись части песни на завтра, иначе в каждом фраг-

менте тембр голоса будет другим и появятся заметные различия  

в интонации. Ну а в нашем примере, записав первый куплет и при-

пев, мы считаем данный этап работы завершенным. 
После выполнения пофрагментной записи всей вокальной 

партии прослушиваем дубли фрагментов и отбраковываем явно 
плохие. Для этого поочередно зацикливаем и многократно вос-
производим каждый из фрагментов (в нашем примере, первую, 
вторую части куплета и припев). 
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Для зацикливания фрагмента его нужно выделить и на панели 

управления нажать кнопку . Чтобы исключить одновременное 

звучание дублей, включаем для одного из них режим солирова-

ния (нажимаем кнопку ).  

ПРИМЕЧАНИЕ  

Сначала есть смысл прослушивать только вокал без аккомпане-
мента — так будут заметнее даже мелкие огрехи исполнения. За-
тем нужно прослушать вокал на фоне аккомпанемента, чтобы 
убедиться в их синхронности. Чтобы аккомпанемент был слышен 
в условиях, когда хотя бы на одном треке с дублем вокальной 

партии нажата кнопка , следует нажать такую же кнопку на син-

тезаторном треке № 8 Cakewalk TTS-1 1 Output 1.  

 

Оставляем по несколько дублей каждого фрагмента (сохранив 

на всякий случай этот промежуточный результат в файле; в на-

шем примере это файл SONG_2_07.CWB).  

Из оставшихся дублей для каждого фрагмента выбираем наи-

лучшие (рис. 4.8, файл SONG_2_08.CWB). Забракованный трек 

выделяем щелчком на его номере и удаляем командой меню окна 

треков Tracks > Delete Track(s) (меню Tracks находится над 

секцией треков, чуть выше и правее дисплея, отображающего 

текущее время при воспроизведении проекта). 

Затем монтируем фонограмму вокальной партии. Для этого 

последовательно выделяем треки, на которых записаны два со-

седних фрагмента, и в местах стыка командой Split контекстного 

меню секции клипов разрезаем клипы на две части, чтобы отсечь 

ненужное. В нашем случае границы фрагментов приходятся на 

начала двадцатого и тридцать шестого тактов. Лишними являют-

ся перекрывающиеся части клипов, которые мы искусственно 

создали при записи, чтобы каждый следующий фрагмент петь  

"с разгона". Конечно, можно и не избавляться от них, а просто 

накладывать исходный клип одного трека на исходный клип дру-

гого трека с перекрытием. Но тогда на перекрывающихся интер-

валах вокальной партии возрастет (в первом приближении —  

удвоится) уровень шума. 
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Рис. 4.8. Выбраны лучшие дубли фрагментов партии 

 

Рис. 4.9. Удалены перекрывающиеся фрагменты клипов 
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ПРИМЕЧАНИЕ  

В нашем примере есть забавное недоразумение. Лучшим дублем 
второй части куплета с точки зрения качества вокала оказался тот 
дубль, в котором за полтакта до начала пения звучит подсказка 
участника записи: "Наша радость…". В файле SONG_2_08.CWB 
это слышно. Чтобы не загрязнять фонограмму, мы такое место 
вырезали. Пришлось точку разбиения клипа Record 6, Take 5 
сместить на 3/4 такта вправо. Этого не удалось бы сделать без 

изменения шага привязки к сетке. В контекстном меню кнопки  

(Snap) вместо Whole можно выбрать меньший шаг, например, 1/4. 

А можно и вовсе кнопкой  отключить режим привязки. 

После этой операции клипы на разных треках во времени 

окажутся расположенными друг за другом (рис. 4.9, файл 

SONG_2_09.CWB): начало последующего будет приходиться на 

конец предыдущего. 

Теперь остается только аккуратно перенести клипы на один трек и 

объединить в один клип. А можно, не утруждаясь, просто выделить 

все клипы ("перещелкать" их при нажатой клавише <Ctrl>) и восполь-

зоваться командой меню окна треков Track(s) > Bounce to Track(s). 

Откроется диалоговое окно Bounce to Track(s). В нем нужно выпол-

нить установки, показанные на рис. 4.10, и нажать кнопку OK. 

При этом без какой-либо ручной работы сформируется трек 

№ 12, на котором клипы с трех разных треков будут смикширо-

ваны в один клип. Его следует сохранить, а треки №№ 9, 10 и 11 

с исходными клипами можно удалить. В проекте (рис. 4.11, файл 

SONG_2_10.CWB) останутся MIDI-треки, синтезаторный трек  

и аудиотрек (бывший трек № 12). 

ПРИМЕЧАНИЕ  

На этом этапе мы также удалили MIDI-трек с мелодией, считая, 
что он свою роль сыграл — помог вокалистке во время записи. 
Поэтому аудиотрек стал не девятым, а восьмым треком проекта. 
В конце работы над песней мы обнаружим, что вступление оста-
лось без мелодии, и вернем трек Мелодия в проект. 

Мы собираемся в дальнейшем перенести фонограмму с запи-

сью вокала в звуковой редактор Adobe Audition, чтобы с его по-

мощью избавиться от шума. После этого обработанную вокаль-

ную партию предстоит вновь поместить в проект SONAR. Все 

это мы сделаем и поясним чуть позднее.  
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Рис. 4.10. Диалоговое окно Bounce to Track(s)  
с необходимыми установками 

 

Рис. 4.11. Три клипа смикшированы в один,  
ненужные (исходные) клипы удалены 
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А вот позаботиться о том, чтобы упростить себе задачу опре-

деления места вставки аудиосообщения в проект SONAR, можно 

уже сейчас. Посмотрите на рис. 4.11. Начало аудиоклипа совпа-

дает с началом такта № 9. Перед вставкой (импортированием) 

обработанного аудиофайла нужно будет поместить указатель те-

кущей позиции в эту точку. Можно запомнить это место и точно 

"прицелиться". А можно постараться не сдвигать указатель те-

кущей позиции, оставив его там же, где он расположен в файле 

SONG_2_10.CWB. 

Итак, у нас есть проект SONG_2_10.CWB, который кроме 

MIDI-аккомпанемента содержит аудиотрек со смонтированной 

заготовкой вокальной партии. Этот аудиотрек — даже не полу-

фабрикат, а всего лишь сырье, из которого предстоит выработать 

ту вокальную партию, техническое качество звука которой по-

зволит поместить ее в проект песни.  

ПРИМЕЧАНИЕ  

Уровень вокала и в целом эстетическую ценность песни-примера 
мы не обсуждаем. Не желая осложнять работу над книгой реше-
нием вопросов авторского права, мы отказались от использования 
в качестве примера песни, написанной другими авторами. По этой 
же причине мы не стали привлекать постороннего исполнителя 
вокальной партии. Песню, разложенную на "кирпичики", как могла, 
спела Аня Петелина.  

Оцифрованный звук, соответствующий исходной вокальной 

партии, нужно обработать, выполнив целый ряд операций. 

1. Снизить уровень шума фонограммы.  

2. Скорректировать спектр сигнала — тембр звучания. 

3. Выполнить динамическую обработку сигнала (сжать динами-

ческий диапазон сигнала с целью повышения среднего уровня 

громкости). 

4. Обработать эффектами (например, реверберацией). 

В принципе, Cakewalk SONAR обеспечивает выполнение все-

го этого плана, за исключением п. 1. Правда, в Cakewalk SONAR 

предусмотрена функция Remove Silence (доступ к ней обеспечива-

ет команда Process > Apply Effects > Remove Silence главного ме-

ню), позволяющая избавиться от шума в паузах. Но на шум, сме-

шанный с голосом певца, она никак не повлияет. Суть операции, 
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выполняемой функцией Remove Silence, состоит в приравнива-

нии к нулю значений тех звуковых отсчетов, величина которых 

меньше заданного порога. Если, зная, что уровень шума в исход-

ной фонограмме не превышает, например, –50 дБ, задать порог, 

равный –50 дБ, то шум в паузах, конечно, будет вырезан, но вме-

сте с ним исчезнут и небольшие кусочки начал и окончаний слов. 

Это нам не подходит. 

4.5. Снижаем уровень шума 

Итак, средства борьбы с шумом непосредственно в SONAR 

отсутствуют. Тем не менее, есть несколько вариантов разрешения 

возникшей проблемы. Реализовать шумоподавление можно двумя 

путями. Во-первых, можно подключить к SONAR один из специ-

ально предназначенных для шумоподавления VST-плагинов [14, 

29] и воспользоваться им. Во-вторых, можно обработать аудио-

файл в универсальном звуковом редакторе, например, в Adobe 

Audition. Достоинство этого способа в том, что заодно с шумопо-

давлением можно отредактировать оцифрованный звук, устранив 

различные мелкие огрехи, допущенные на этапе его записи  

с микрофона.  

Чтобы реализовать второй способ, нужно проделать одну под-

готовительную операцию: экспортировать аудиотрек из проекта 

SONG_2_10.CWB в WAV-файл. Трек, содержащий вокальную 

партию, нужно выделить, включить для него кнопку  и вос-

пользоваться командой File > Export > Audio главного меню 

SONAR. В открывшемся окне Export Audio следует:  

1. Установить флажок Track Mute/Solo.  

2. В раскрывающемся списке Source Category выбрать вариант 

Entire Mix. 

3. В раскрывающемся списке Dithering выбрать вариант None. 

4. Остальные параметры оставить назначенными по умолчанию. 

5. Нажать кнопку Export. 

В итоге у нас получился WAV-файл VOCAL_02_01.WAV, со-

держащий запись смонтированной вокальной партии. Далее его 

нужно загрузить в звуковой редактор Adobe Audition с помощью 

стандартной команды File > Open.  
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Можно поступить еще проще. Предположим, что в SONAR 

загружен нужный проект (SONG_2_10.CWB). Откройте Adobe 

Audition. Захватите мышью в окне SONAR клип, предназначен-

ный для обработки (в нашем примере — это клип, расположен-

ный на треке № 8), и перетащите его в окно Adobe Audition. 

ПРИМЕЧАНИЕ  

Несмотря на всю привлекательность метода Drag and Drop (пере-
таскивание), в данном случае мы не советуем пользоваться им. 
Для реализации перетаскивания должны быть запущены обе про-
граммы  — и SONAR, и Adobe Audition. При определенном стече-
нии обстоятельств они будут конфликтовать из-за драйверов. Де-
ло кончится, скорее всего, тем, что перетащенный в Adobe 
Audition аудиофайл придется сохранить, а обе программы за-
крыть. Затем предстоит запустить программу Adobe Audition, за-
менить в ней драйвер, автоматически выбранный во время кон-
фликта, на родной драйвер вашей звуковой карты и только потом 
загрузить аудиофайл. 

Теперь можно выделить в начале сигналограммы фрагмент, 

содержащий только шум (рис. 4.12). 

 

Рис. 4.12. Вокальная партия загружена в Adobe Audition,  
выделен участок сигналограммы с шумом 
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Рис. 4.13. В вокальной партии подавлен шум 

Вы уже знаете, что функция шумоподавления в програм- 

ме Adobe Audition выполняется с помощью диалогового окна  

Noise Reduction (см. рис. 3.33), открываемого командой Effects >  

Restoration > Noise Reduction (process) главного меню программы. 

Подробности работы с шумоподавителем рассмотрены в разд. 3.5. 

Напомним главное. Фрагмент аудиосигнала без полезной инфор-

мации, но содержащий характерный для фонограммы шум, уже 

выделен. Откройте диалоговое окно Noise Reduction. Нажмите 

кнопку Capture Profile. Подождите немного, пока программа соби-

рает информацию о шуме. Нажав кнопку Select Entire File, выдели-

те всю сигналограмму. Нажмите кнопку OK. Через несколько се-

кунд шум будет подавлен. И это станет заметно не только на слух, 

но и визуально (рис. 4.13). 

Если результаты шумоподавления вас не вполне устраивают, 

стоит поэкспериментировать, подбирая параметры шумоподави-

теля (см. разд. 3.5). Наша фонограмма-пример исходно была за-

писана в приемлемо тихой обстановке, поэтому с небольшим 

шумом программа справилась успешно.  
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Переходим к ручной работе в Adobe Audition:  

1. Прослушивая запись, отыскиваем участки, содержащие неже-

лательные звуки (громкий вдох, случайный щелчок ногтем от 

прикосновения к наушникам, шелест бумажного листа с тек-

стом песни и т. п.). 

2. Выделяем очередной такой участок и кнопкой  (Adjust  

selection to zero crossings) перемещаем границы выделения  

в точки, где сигнал принимает нулевое значение. 

3. Командой Effects > Mute главного меню в выделенном фраг-

менте заменяем звук на абсолютную тишину (приравниваем 

значения сигнала к нулю).  

После этого вручную немного понижаем уровень громко- 

сти фраз, спетых громко (например, см. интервал времени с 17  

по 23 секунду на рис. 4.13), и повышаем — спетых тихо (с 23  

по 29 и с 41 по 53 секунду). Для этого выделяем нужный фраг-

мент, командой Effects > Amplitude and Compression > Amplify 

открываем окно VST Plugin - Amplify, его регуляторами уста-

навливаем требуемый коэффициент усиления (примерно –2 дБ 

для уменьшения громкости и 2 дБ для ее увеличения) и нажима-

ем кнопку OK. 

ПРИМЕЧАНИЕ  

Строго говоря, ручное выравнивание громкости фрагментов сиг-
налограммы не относится к числу необходимых операций. 
В принципе, эту задачу позволяет решить обработка компрессо-
ром, которую мы планируем провести. Но мы всегда поступаем 
именно таким образом, считая, что это позволит в дальнейшем 
уменьшить степень сжатия динамического диапазона компрес-
сором.  

Итак, мы подавили шум, имевшийся в записи вокальной пар-

тии, заодно устранив незначительные дефекты исходной фоно-

граммы, а результат сохранили в файле VOCAL_02_02.WAV.  

После этого мы импортировали аудиофайл VOCAL_02_02.WAV 

в проект песни SONG_2_10.CWB (взамен уже имевшегося там ау-

диотрека с вокалом). Можно действовать, например, так: 

1. Открыть в SONAR проект SONG_2_10.CWB (положение ука-

зателя текущей позиции не менять, он находится в той точке 
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шкалы времени, начиная с которой предстоит вставлять ау-

диосообщение). 

2. Командой Insert > Audio Track главного меню создать новый 

аудиотрек (в нашем примере это будет трек № 9), выделить его. 

3. Командой File > Import > Audio главного меню открыть окно 

Import Audio, с его помощью найти и выделить файл 

VOCAL_02_02.WAV, нажать кнопку Открыть (на аудиотреке 

№ 9 появится клип). 

4. Выделить трек № 8 (там находится клип с необработанной 

шумоподавителем вокальной партией) и командой Tracks > 

Delete Track(s) меню окна Track удалить этот трек. 

В результате проект-пример вновь будет содержать единст-

венный аудиотрек (№ 8), но на нем теперь будет располагаться 

клип с вокальной партией, очищенной в Adobe Audition от шума. 

Обновленный проект сохранен в файле SONG_2_11.CWB.  

4.6. Выполняем фильтрацию, 

компрессию, обработку эффектами 

Настало время завершить обработку аудиосигнала, соответст-

вующего вокальной партии. Необходимо, как минимум, выполнить 

оставшиеся три операции из намеченных нами в разд. 4.4: 

 скорректировать фильтрами спектр сигнала — тембр звучания; 

 выполнить динамическую обработку сигнала (сжать динами-

ческий диапазон сигнала с целью повышения среднего уровня 

громкости); 

 обработать эффектами (реверберация). 

Средства, необходимые для реализации нашего замысла,  

в SONAR имеются, причем в избытке. Нам потребуются всего 

три виртуальных прибора: эквалайзер, компрессор и ревербера-

тор. В SONAR каждый из них представлен в нескольких экземп-

лярах. Здесь есть плагины нескольких поколений, разработанных 

непосредственно фирмой Cakewalk, но на наш субъективный 

взгляд их графический интерфейс не очень удобен, а качество зву-

ка не вполне соответствует современным требованиям. Неслучай-

но в поставку нескольких последних версий Cakewalk SONAR 
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разработчики программы включают плагины других фирм. Мы 

решили обратить ваше внимание на плагины из пакета Sonitus:fx 

и именно их использовали для обработки аудиотрека с вокалом. 

Вы уже знаете, что в SONAR поддерживаются эффекты ре-
ального времени, выполненные в виде DX- и VST-плагинов. При 
применении эффекта в реальном времени исходные клипы не 
подвергаются никаким изменениям. Любой параметр эффекта 
можно отрегулировать по ходу воспроизведения проекта. Понят-
но, что для получения эффектов в реальном времени задейству-
ются вычислительные ресурсы центрального процессора. Это 
ужесточает требования к производительности процессора и ком-
пьютера в целом. 

Перечень всех имеющихся в системе эффектов вы найдете  

в подменю Audio FX. Оно содержится в контекстном меню, ко-

торое открывается щелчком правой кнопки мыши на поле FX 
аудиотрека. 

Применительно к SONAR аудиоэффекты условно можно раз-
делить на три группы.  
 DX-плагины, которые инсталлируются вместе с программой 

SONAR X1 Producer. Команды вызова эффектов данной груп-

пы размещаются в подменю Audio FX > Cakewalk, а также  

в подменю Audio FX > Sonitus:fx. Применяются в реальном 

времени, если подключены к полю FX трека или шины. 

 DX-плагины, которые инсталлируются как самостоятельные 
приложения или в составе других программных продуктов. 

После инсталляции вызываются из подменю Audio FX.  

 VST-плагины, которые инсталлируются как самостоятельные 
приложения или в составе других программных продуктов. 

После инсталляции вызываются из подменю Audio FX > 

vstplugins. Используются точно так же, как DX-плагины. 

ПРИМЕЧАНИЕ  

Эффекты, разработанные фирмой Cakewalk, а также все эффек-
ты Sonitus:fx, поставляемые в комплекте с SONAR X1 Producer, 
описаны в книге [26]. Некоторые из многочисленных эффектов 
второй и третьей групп рассмотрены в книгах [7, 14, 28, 29]. 

Максимальное количество подключенных одновременно 

DX/VST-плагинов, с которым может справиться ваш компьютер, 
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зависит от вида реализованных в них эффектов, объема оператив-

ной памяти, типа и производительности центрального процессора. 

Некоторые эффекты загружают центральный процессор интен-

сивнее прочих. Кроме того, степень загрузки зависит и от устано-

вок параметров эффектов.  

В SONAR предусмотрена возможность подключения DX/VST-

плагинов к трекам и шинам в окнах Track и Console. Кроме того, 

есть возможность автоматизации параметров DX/VST-плагинов. 

Для подключения плагина в окне Track следует: 

1. Щелчком правой кнопки мыши на поле FX аудиотрека от-

крыть контекстное меню. 

2. В контекстном меню выбрать подменю Audio FX. 

3. В подменю Audio FX выбрать нужную группу плагинов (на-

пример, Sonitus:fx). 

4. В группе выбрать нужный плагин (например, Sonitus:fx Equa-

lizer). 

В комплект поставки SONAR X1 Producer включены одинна-

дцать DX-плагинов Sonitus:fx. Из них нас сейчас интересуют 

только три: 

 Sonitus:fx Equalizer — эквалайзер; 

 Sonitus:fx Compressor — компрессор; 

 Sonitus:fx Reverb — ревербератор. 

Перед тем как перейти непосредственно к описанию плагинов 

Sonitus:fx, необходимых для дальнейшей работы, рассмотрим 

особенности управления ими с применением элементов, общих 

для всех плагинов. 

В верхней части окна плагина Sonitus:fx расположена группа 

кнопок, управляющих банками настроек плагина (например, см. 

рис. 4.14): Bypass, Undo, Setup A / Setup B, Reset, Presets, Help (?). 

Познакомимся с назначением кнопок (кроме кнопки Reset, нажа-

тие которой сбрасывает настройки плагина в состояние по умол-

чанию, и кнопки Help (?), не нуждающейся в пояснениях). 

Если нажать кнопку Bypass, то сигнал будет оперативно на-

правлен в обход плагина. Включение и выключение режима  

Bypass позволяет сравнить звучание аудиоматериала, обработан-

ного и не обработанного плагином.  



Глава 4  340 

Кнопка Undo позволяет отменить последнее изменение в на-

стройках. Повторное нажатие этой кнопки аннулирует отмену. 

Вы можете работать поочередно с двумя вариантами настро-

ек плагина. Один вариант хранится в банке A, другой — в бан- 

ке B. Текущий банк выбирается с помощью кнопки Setup A / 

Setup B.  

Справа от кнопки Setup A / Setup B расположена кнопка  

с треугольной стрелкой. Ее нажатие открывает меню, позволяющее 

переносить настройки из банка A в банк B и обратно. Команды 

Setup A и Setup B обеспечивают быстрое переключение между 

двумя банками (A и B). Это удобно для сравнительной оценки 

результатов обработки при различных значениях параметров 

плагина и для поиска настроек с лучшим звучанием. Исходная 

настройка хранится в банке A. Выбрав в меню команду Copy to B, 

вы скопируете настройку из банка A в банк B. Теперь можно от-

редактировать параметры плагина, с тем чтобы получить еще од-

ну настройку, которая станет текущей и будет соответствовать 

банку B. Щелчком на кнопке Setup A вы вызовете настройку из 

банка B (название кнопки изменится на Setup B). Каждый раз, 

когда вы щелкаете на этой кнопке, настройки переключаются 

между A и B. Меняется также название команды в меню: вместо 

Copy to B появляется Copy to A и наоборот. 

В плагинах Sonitus:fx довольно много внимания уделяется 

работе с пресетами. Имеется специальное меню, открывае- 

мое кнопкой Preset, которое содержит команды работы с пре-

сетами: 

 Add Preset — добавление нового пресета; команда открывает 

диалоговое окно, где следует ввести имя нового пресета и вы-

брать банк, в котором пресет будет сохранен; 

 Preset Manager — всесторонняя работа с пресетами; команда 

открывает диалоговое окно, с помощью которого можно пере-

именовать, сохранить, удалить, импортировать и экспортиро-

вать пресет. 

Теперь настало время непосредственно познакомиться с нуж-

ными нам плагинами Sonitus:fx. 
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4.6.1. Знакомимся с эквалайзером  

Sonitus:fx Equalizer 

С помощью эквалайзера решается задача частотной фильтра-

ции (см. разд. 1.4.2). Окно плагина Sonitus:fx Equalizer, подклю-

ченного к аудиотреку SONAR, представлено на рис. 4.14. 

В плагине реализован шестиполосный параметрический эква- 

лайзер. Элементы управления параметрами каждой из полос 

идентичны. 

ПРИМЕЧАНИЕ  

В плагинах Sonitus:fx, как правило, значения одного и того же па-
раметра можно изменять двумя способами — с помощью ползун-
кового регулятора (слайдера) и с помощью поля ввода.  

 

Рис. 4.14. Окно плагина Sonitus:fx Equalizer 
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На координатном поле представлены интерактивные графики 

АЧХ фильтров эквалайзера в координатах "частота — коэффици-

ент передачи фильтра". Масштаб — логарифмический по обеим 

осям. В плагине имеется 6 фильтров, им соответствуют 6 графи-

ков АЧХ и 6 групп элементов управления. 

Два основных параметра каждого фильтра доступны для гра-

фического редактирования с помощью мыши. Для этого нужно 

захватить узел графика и перемещать его вправо-влево — будет 

изменяться частота настройки (среза АЧХ) фильтра Freq, или 

вверх-вниз — будет изменяться уровень усиления/ослабления 

(коэффициент передачи фильтра) Gain. Эти же параметры можно 

задавать и в числовом виде с помощью соответствующих полей 

ввода, а величину параметра Gain можно также регулировать 

слайдером. Отрицательные значения коэффициента передачи 

фильтра соответствуют ослаблению сигнала, положительные — 

усилению.  

Для каждого из фильтров эквалайзера можно задать еще два 

параметра: 

 величину добротности; 

 вид АЧХ фильтра (тип фильтра). 

Для редактирования добротности предназначено поле ввода 

Q. С добротностью связаны ширина полосы пропускания фильт-

ра (чем больше Q, тем при неизменной частоте настройки фильт-

ра ýже его полоса пропускания) и крутизна АЧХ фильтра в об-

ласти перехода от полосы пропускания к полосе подавления 

(задерживания). Чем больше значение Q, тем круче характери-

стика. 

Выбрать вид АЧХ фильтра можно в раскрывающихся списках 

Filter (с помощью кнопок ).  

В общей сложности доступны фильтры пяти типов: 

 (Peak/Dip) — полосовой фильтр с колоколообразной АЧХ; 

 (Shelving Low) — фильтр с регулируемым усилением  

в области нижних частот; 

 (Shelving High) — фильтр с регулируемым усилением  

в области верхних частот; 



Запись вокальной партии шаг за шагом 343 

 (Lowpass) — фильтр нижних частот;  

 (Highpass) — фильтр верхних частот. 

Каждый из фильтров, кроме Lowpass и Highpass, в зависимо-

сти от знака параметра Gain может быть либо полоснопропус-

кающим, либо полосноподавляющим фильтром. 

Активизация того или иного фильтра осуществляется кнопка-

ми 1, 2, 3, 4, 5, 6 в столбце Band. 

Обратите внимание на кнопку Flat, расположенную в левой 

нижней части окна. Если ее нажать, то АЧХ эквалайзера будет 

приведена в нейтральное состояние.  

Поле ввода и слайдер Output предназначены для регулирова-

ния уровня выходного сигнала. 

В правой части окна находятся измерители уровня выходных 

сигналов левого и правого каналов. Над измерителями распо- 

ложены индикаторы клиппирования. Они становятся красными  

в момент, когда выходной сигнал достигнет или превысит уро-

вень 0 дБ. Выше расположено поле, в котором отображается число 

(в децибелах), показывающее текущее значение максимального 

уровня сигнала относительно уровня 0 дБ. 

4.6.2. Знакомимся с ревербератором  

Sonitus:fx Reverb  

Сущность реверберации мы рассмотрели в разд. 1.4.1. Окно 

плагина Sonitus:fx Reverb, подключенного к аудиотреку SONAR, 

представлено на рис. 4.15. 

В плагине реализован ревербератор. Видно, что для компо-

новки окна характерна строчная организация. Поэтому мы рас-

смотрим назначение элементов графического интерфейса начи-

ная с верхней строки. 

В группе Input содержатся: 

 кнопка заглушения (отключения) входного сигнала Mute; 

 поле ввода и слайдер, предназначенные для регулирования 

уровня сигнала на входе плагина; контролировать его, избегая 

перегрузки плагина по входу, можно с помощью стереофониче-

ского измерителя уровня In (шкалы L и R). 
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Рис. 4.15. Окно плагина Sonitus:fx Reverb 

В следующей строке расположены регуляторы нижней (Low 

Cut) и верхней (High Cut) частот среза полосового фильтра. На 

дисплее справа отображается качественный вид его АЧХ. Часто-

ты среза можно перестраивать и графическим способом, захваты-

вая мышью узлы на графике АЧХ и перемещая их влево-вправо. 

Назначение регуляторов и полей ввода, расположенных в сле-

дующих трех строках: 

 Predelay — задержка между прямым сигналом и началом ре-

верберационного хвоста; 

 Room Size — параметр, связанный с размером моделируемого 

помещения; 

 Diffusion — соотношение уровня реверберации с уровнями 

прямого сигнала и ранних отражений. 
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В очередных четырех строках расположены элементы управле-

ния параметрами двухполосного кроссовера (фильтра, разделяю-

щего спектр сигнала на частотные полосы), через который пропус-

кается сигнал. Это позволяет независимо управлять временем 

затухания его низкочастотных и высокочастотных компонентов. 

Назначение регуляторов, имеющих отношение к кроссоверу: 

 Bass Multiplier — коэффициент передачи низкочастотного 

полосового фильтра кроссовера; чем больше значение этого 

параметра, тем дольше продолжается процесс затухания ре-

верберации низкочастотных компонентов сигнала; 

 Crossover — частота раздела полос кроссовера (см. разд. 1.4.2); 

 Decay Time — постоянная времени реверберации — время  

(в секундах), по прошествии которого реверберация и ранние 

отражения полностью исчезнут из звука (строго говоря, 

уменьшатся до уровня –60 дБ); фактически это значение влия-

ет на общий коэффициент передачи одновременно обоих 

фильтров кроссовера; 

 High Damping — верхняя частота среза высокочастотного 

фильтра кроссовера — параметр, от которого зависит ско-

рость затухания высокочастотных составляющих ревербери-

рующего сигнала. 

АЧХ кроссовера отображается на дисплее, расположенном 

справа. Здесь же с помощью мыши можно редактировать графи-

ческим способом все четыре перечисленных параметра. Попро-

буйте проделать это, и изменения графика, которые вы увидите, 

помогут вам быстрее уяснить смысл параметров АЧХ кроссовера. 

В следующих трех строках расположены группы элементов, 

позволяющие независимо включать/выключать (нажатием кно-

пок Mute) три компонента выходного сигнала и регулировать их 

уровни (с помощью слайдера или поля ввода): 

 Dry — необработанный ("сухой") сигнал; 

 E.R. (от Early Reflections) — ранние отражения; 

 Reverb — реверберационный хвост. 

Поле ввода Width служит для изменения ширины стереоба- 

зы. При значении этого параметра 100 % сохраняется исходная 
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ширина стереобазы. При значениях параметра меньших 100 % 

происходит ее сужение (вплоть до превращения в моносигнал 

при 0 %). Значения параметра, превышающие 100 %, соответст-

вуют расширению стереобазы. 

ПРИМЕЧАНИЕ  

Познакомьтесь со своеобразным элементом управления, часто 
встречающимся в окнах плагинов Sonitus:fx. Разработчики назы-
вают его циклической кнопкой (cycle button): каждое нажатие такой 
кнопки циклически изменяет ее состояние. После нескольких на-
жатий кнопка возвращается к исходному состоянию. Дальше мож-
но начинать все с начала. 

Посредством циклической кнопки Output, имеющей состояния 

Stereo и Mono, переключается формат выходного сигнала. Ясно, 

что он может быть либо стереофоническим, либо монофониче-

ским. Кнопка не случайно расположена рядом с полем ввода 

Width. Увеличение ширины стереобазы связано с внесением фа-

зовых сдвигов в сигналы правого и левого каналов, что вполне 

может сказаться на моносовместимости обработанного таким 

образом сигнала. Простейший способ оценки моносовместимо-

сти стереосигнала заключается в сложении сигналов правого  

и левого каналов, т. е. превращении стереосигнала в моносигнал, 

что и происходит, если вы переключаете кнопку Output в состоя-

ние Mono. Если при сравнении звучания моносигнала со звуча-

нием стереосигнала вы не обнаружите исчезновения звуков ка-

ких-либо музыкальных инструментов или голосов вокалистов, 

значит, моносовместимости не нанесен заметный на слух урон. 

Кнопка Tail включает режим, при котором короткий аудио-

клип автоматически удлиняется на время, необходимое для есте-

ственного завершения процесса реверберации. 

Расположенные в правом нижнем углу окна измерители L и R 

группы Out отображают уровень сигнала в левом и правом сте-

реоканалах на выходе плагина. 

Попробуйте рассмотренный плагин в деле — и вы убедитесь, 

что работать с ним довольно удобно.  
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4.6.3. Знакомимся с компрессором  

Sonitus:fx Compressor 

Окно плагина Sonitus:fx Compressor, подключенного к аудио-

треку SONAR, представлено на рис. 4.16. Из названия плагина 

следует, что он является компрессором (см. разд. 1.4.2), однако 

фактически при определенных настройках плагин может выпол-

нять функции не компрессора, а экспандера — прибора, имею-

щего противоположное по отношению к компрессору назначе-

ние. Кроме того, последовательно с основной динамической 

обработкой можно подключить еще одну — лимитер. Рассмот-

рим назначение элементов управления, имеющихся в окне плаги-

на Sonitus:fx Compressor. 

Самым заметным элементом окна является координатное поле, 

на котором в логарифмическом масштабе отображается график 

характеристики компрессирования/экспандирования: зависимость 

уровня выходного сигнала от уровня сигнала на входе плагина. 

  

 

Рис. 4.16. Окно плагина Sonitus:fx Compressor 
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График подобных зависимостей также называют передаточной 

характеристикой, или амплитудной характеристикой. 

Текущее значение уровня сигнала отображается в виде ма-

ленького белого кружка, скользящего или скачущего по линии 

графика (этот кружок виден только в режимах воспроизведения 

или записи). 

Редактировать форму характеристики можно графическим 

способом: захватите мышью и перемещайте определенный уча-

сток графика. При этом будут изменяться и числовые значения 

некоторых параметров компрессора, отображаемые в полях вво-

да. Чтобы более точно установить нужные значения, воспользуй-

тесь соответствующими слайдерами или полями ввода. 

В левой части окна вертикально располагается стереофониче-

ский измеритель уровня входного сигнала Input. С ним совме-

щен ползунковый регулятор порога срабатывания компрессора. 

Числовое значение порога отображается в поле ввода Threshold. 

В поле Ratio вводится значение отношения (коэффициента) 

компрессии. Если число в поле Ratio меньше единицы, то ком-

прессор превращается в экспандер. В этом случае правильнее 

говорить уже не об отношении компрессии, а об отношении экс-

пандирования. Отметив это, мы все же продолжим впредь гово-

рить о рассматриваемом плагине как о компрессоре (в соответст-

вии с его названием). 

Содержимое поля Knee определяет степень "мягкости" ком-

прессирования. Если в нем отображается значение Hard, то име-

ет место жесткое компрессирование, при котором характеристика 

состоит из двух отрезков прямых линий, образующих в порого-

вой точке явно заметный угол. При изменении в поле Knee числа 

от 1 до 30 дБ область перегиба характеристики все более сглажи-

вается. Компрессирование становится все более мягким. 

Циклическая кнопка Type имеет два состояния — Normal  

и Vintage, соответствующие двум принципиально различным 

типам характеристик компрессора. 

 Характеристика типа Normal соответствует классическому 

способу компрессии, с которым знакомо большинство пользо-

вателей. Обычно применяется, если порог не слишком "глубок" 
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(т. е. если большая часть динамики сигнала находится значи-

тельно ниже установленного порога). Также рекомендуется 

при больших степенях сжатия (4:1 и выше). Отличительная чер-

та такой характеристики — единственный перегиб (рис. 4.17, а). 

 Характеристика типа Vintage соответствует способу компрес-

сии, который следует использовать, если установлено низкое 

значение порога (порядка –30 дБ). Это будет иметь место  

в том случае, когда вы хотите сжать (или расширить) главным 

образом средние уровни входного динамического диапазона, 

оставляя практически неизменной динамику низких и высо-

ких уровней. Типичные значения коэффициента Ratio будут 

находиться приблизительно в интервале между 0,65:1 (рас-

ширение) и 3:1 (сжатие). Отличительная черта такой харак-

теристики — наличие двух перегибов (рис. 4.17, б). 

Измеритель GR, расположенный справа от координатного поля 

(см. рис. 4.16), показывает уровень управляющего сигнала (пре-

вышение текущим уровнем сигнала установленного порогового 

значения). Это вспомогательный измеритель, позволяющий по-

лучить наглядное представление о степени воздействия плагина 

на обрабатываемый сигнал. На самом деле та же самая инфор-

мация содержится в изменении уровня входного сигнала (изме-

ритель Input) относительно положения ползункового регулято-

ра порога срабатывания компрессора. 

 а      б 

Рис. 4.17. Характеристики Normal (а) и Vintage (б) 
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Рядом с измерителем GR расположен совмещенный с изме-

рителем уровня регулятор компенсационного усиления Gain. 

Он нужен для того, чтобы возместить уменьшение уровня сиг-

нала, сопровождающее работу компрессора (или увеличение 

уровня в экспандере). Точное значение уровня компенсацион-

ного усиления отображается в поле Gain, расположенном над 

регулятором. 

В правой части окна находится измеритель уровня сигнала на 

выходе плагина (Output), а над ним — индикатор перегрузки 

Overload. 

Под координатным полем расположены элементы управления 

двумя динамическими параметрами компрессора: 

 Attack — регулятор времени включения компрессора/экспан-

дера после ввода; 

 Release — регулятор времени восстановления компрессо-

ра/экспандера. 

Как обычно, эти регуляторы дублируются соответствующими 

полями ввода. 

Осталось пояснить назначение двух кнопок. 

Кнопка Limiter предназначена для включения/выключения 

пикового ограничителя сигнала (лимитера). Пиковый ограничи-

тель полезен в том случае, когда в звуковом материале содер-

жатся пики — кратковременные быстрые и большие по величи-

не перепады уровня. При определенных настройках компрессор 

может не успевать реагировать на пики, и они будут сохранены 

в обработанном сигнале. Пики представляют опасность для 

мощных акустических систем. И хотя профессиональные усилите-

ли мощности звуковых сигналов, как правило, имеют в своем  

составе аппаратные пиковые ограничители, все же лучше забла-

говременно позаботиться об устранении пиков из обработанно-

го сигнала.  

Кнопка TCR служит для включения/выключения специально-

го алгоритма (Transient Controlled Release) автоматической под-

стройки времени восстановления компрессора, учитывающего 

динамические свойства обрабатываемого сигнала. 
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4.6.4. Подключаем плагины к аудиотреку  
и подбираем их параметры 

Напомним, что в файле SONG_2_11.CWB хранится проект, 

который содержит завершенный аккомпанемент (первый куплет 

и припев) — партии, записанные на нескольких MIDI-треках —  

и отдельный аудиотрек с записью вокала (после шумоподавления).  

Загрузим проект в SONAR и подключим к аудиотреку плаги-

ны Sonitus:fx: Equalizer (эквалайзер), Sonitus:fx: Compressor (ком-

прессор) и Sonitus:fx: Reverb (ревербератор). 

Для этого в окне Track щелчком правой кнопки мыши на поле 

FX аудиотрека № 8 откроем контекстное меню; в нем выберем 

подменю Audio FX > Sonitus:fx, в котором выберем Sonitus:fx 

Equalizer. Затем в этом же подменю последовательно выберем 

Sonitus:fx Compressor и ReverbSonitus:fx Reverb. В поле FX 

аудиотрека появятся названия подключенных плагинов (рис. 4.18).  

Кнопка , расположенная в поле FX левее названия плагина, 

дублирует кнопку Bypass, имеющуюся на его панели (например, 

см. рис. 4.16). 

При таком порядке подключения плагинов аудиосигнал сна-

чала обрабатывается эквалайзером, затем поступает в компрес-

сор, а ревербератор располагается в конце цепочки. Это наиболее 

разумная, на наш взгляд, последовательность обработок. Иногда 

аудиосигнал сначала обрабатывают компрессором, а затем эква-

лайзером. Но в таком случае в сигнале останутся несглаженными 

пики, которые могут возникнуть из-за подъема уровня верхних 

частот эквалайзером. Вы можете попробовать разные варианты, 

благо порядок следования плагинов легко изменить: захватывае-

те в поле FX плагин мышью и перетаскиваете его вверх или вниз.  

 

Рис. 4.18. К аудиотреку подключены 3 плагина 
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Нажмем кнопки  плагинов Compressor и Reverb, временно 

пустив сигнал в обход ревербератора и компрессора. Откроем 

окно плагина Sonitus:fx Equalizer. Включим циклическое вос-

произведение всей песни или ее отдельных фрагментов. Будем 

регулировать АЧХ фильтров эквалайзера. Постараемся устра-

нить низкочастотный гудящий призвук (запись голоса проводи-

лась в небольшом помещении, стены которого не были покры-

ты звукопоглощающим материалом должной толщины). Для 

этого первым фильтром срежем частоты ниже 70—80 Гц. Дру-

гим фильтром немного поднимем уровни частотных состав-

ляющих в области верхних частот. Это придаст голосу несколь-

ко бóльшую звонкость. 

Откроем окно плагина Sonitus:fx Compressor, "отожмем" 

кнопку Bypass, выберем подходящий пресет компрессии и отре-

дактируем параметры обработки так, чтобы голос стал звучать 

громче и плотнее. 

Откроем окно плагина Sonitus:fx Reverb, "отожмем" кнопку 

Bypass, выберем наиболее приятный тип реверберации и устано-

вим для нее небольшую глубину (лишь бы в звучании голоса 

появилось ощущение объемности). 

Возможно, после этого придется поочередно еще несколько 

раз в небольших пределах подстроить параметры компрессора  

и эквалайзера, оценивая результат на слух и добиваясь оптималь-

ного сочетания двух разнородных обработок.  

Подобранные состояния регуляторов в каждом из плаги- 

нов сохраним в пресете (в нашем случае пресеты называются 

Anna 01). 

Результат этого этапа работы мы сохранили в файле 

SONG_2_12.CWB. Здесь записан проект, который содержит ак-

компанемент (первый куплет и припев), состоящий из партий, 

записанных на MIDI-треках. На аудиотреке № 8 находится во-

кальная партия. К аудиотреку подключены плагины Sonitus:fx: 

Equalizer (эквалайзер), Sonitus:fx: Compressor (компрессор) и So-

nitus:fx: Reverb (ревербератор). Подобраны и сохранены в пресе-

тах параметры плагинов. 
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4.7. Завершаем сведéние  

композиции 

Настало время свести всю композицию, существующую в ви-

де проекта SONAR, в один стереофайл. Еще раз внимательно по-

слушаем, как звучит проект и все ли в порядке. Нет! Оказывается, 

в процессе работы с вокальной партией мы удалили из проекта 

мелодическую партию. В файле SONG_2_09.CWB она еще есть 

(рис. 4.9, трек № 1 Мелодия), а в файле SONG_2_10.CWB ее уже 

нет (на рис. 4.11 трек № 1 — это уже трек Бас). Вообще-то неже-

лательно, чтобы в аранжировке голос вокалиста, исполняющего 

мелодию, на протяжении всей песни дублировался музыкальным 

инструментом. И у нас трек с мелодией был предназначен лишь 

для того, чтобы при записи помочь юной певице. Так что удали-

ли мы его совершенно правильно. Вот только не учли, что мело-

дия звучит и во вступлении. Что же делать? Заново записывать  

и редактировать мелодическую партию? Пришлось бы тратить на 

это время, если бы мы не сохраняли промежуточные результаты 

работы в файлах проекта. Но после нескольких досадных потерь, 

случившихся много лет назад, мы приучили себя, не жалея дис-

кового пространства, хранить промежуточные и многократно 

дублировать итоговые результаты. А в данном случае все совсем 

просто: ведь по ходу написания книги мы создавали и сохраняли 

файлы, иллюстрирующие процесс работы над проектом. Поэтому 

делаем так: 

1. Открываем в SONAR файл SONG_2_09.CWB. 

2. Выделяем трек с мелодической партией. 

3. Командой Edit > Copy главного меню копируем содержимое 

трека в буфер обмена. 

4. Закрываем файл SONG_2_09.CWB, отказавшись от сохране-

ния внесенных изменений. 

5. Открываем в SONAR файл SONG_2_12.CWB. 

6. Устанавливаем указатель текущей позиции в начало проекта. 

7. Командой Insert > MIDI Track главного меню создаем новый 

MIDI-трек (получится трек № 9). 
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8. Присваиваем треку имя Мелодия и, захватив мышью, пере-

мещаем его с девятой позиции на первую (делать это не обя-

зательно, но так будет удобнее).  

9. Выбираем для трека в списке Output To выходной порт  

Cakewalk TTS-1, а в списке MIDI Channel выбираем первый 

канал (1: Cakewalk TTS-1). 

10. Командой Edit > Paste главного меню вставляем на трек 

MIDI-сообщения из буфера обмена.  

11. Теперь трек с мелодической партией восстановлен. Но вся 

она нам не нужна. Поэтому выделяем клип, имеющийся на 

треке Мелодия, устанавливаем указатель текущей позиции  

в конец вступления (начало такта № 11) и применяем коман-

ду Split контекстного меню клипа. Исходный клип оказыва-

ется разбит на два. В первом содержится мелодия вступле-

ния. Выделяем второй (правый) клип и удаляем его командой 

Edit > Delete главного меню. Результаты "реставрации" со-

храняем в файле SONG_2_13.CWB. 

Устранив ошибку, приступим к окончательному сведéнию. 

Для этого первым делом нужно уточнить громкостный баланс 

треков аккомпанемента с учетом нового звучания вокальной пар-

тии. Громкость каждого MIDI- и аудиотрека подстроим с помо-

щью регулятора Volume в секции треков окна Track.  

Помним о том, что голос обрабатывается реверберацией, т. е. 

он "помещен" в определенную акустическую обстановку. А вот 

аккомпанирующие инструменты пока "находятся в пространст-

ве", где реверберации нет. Точнее говоря, есть лишь небольшая 

реверберация, обусловленная настройками эффект-процессора, 

встроенного в синтезатор Cakewalk TTS-1. Это неестественно, 

значит, сигналы с выходов всех задействованных синтезаторов 

нужно обработать плагином Sonitus:fx Reverb с реверберацией 

того же типа и приблизительно того же уровня, что у подклю-

ченной к треку с вокалом. 

В нашем примере используется единственный виртуальный 

синтезатор Cakewalk TTS-1 (см. разд. 1.2.2 книги "Музыкальный 

компьютер для начинающих" [30]). Но в общем случае синтезато-

ров может быть несколько. Нет смысла "подвешивать" к каждому 
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синтезаторному треку свой экземпляр плагина реверберации. Ра-

зумнее поступить иначе. Сигнал с выхода каждого задействован-

ного виртуального синтезатора следует послать на общую шину. 

В разд. 4.3.2 мы рассмотрели варианты организации одновре- 

менной обработки нескольких синтезаторных треков. Командой  

Insert > Stereo Bus главного меню создана дополнительная шина. 

По умолчанию программа назвала ее Bus 3. В раскрывающемся 

списке Output каждого из синтезаторных треков (в нашем при-

мере — это единственный трек № 7) выбран порт вывода Bus 3. 

Сигнал с шины Bus 3 направлен на шину Master. К треку шины 

Bus 3 и нужно подключить плагин Sonitus:fx Reverb. Порядок 

подключения плагина к треку шины ничем не отличается от рас-

смотренного применительно к аудиотреку. Для этого экземпляра 

плагина Sonitus:fx Reverb мы также выбрали пресет Anna 01. Ре-

зультат сохранен на диске в файле SONG_2_14.CWB. 

Напомним, что сигнал с выхода аудиотрека, содержащего за-

пись вокала, направлен непосредственно на шину Master. 

ПРИМЕЧАНИЕ  

Для того чтобы после сведения проекта в стерефайл в конце фо-
нограммы не возник неприятный на слух, похожий на щелчок "об-
рыв" звучания, можно искусственно продлить проект во времени. 
Следует захватить мышью и передвинуть примерно на один такт 
вправо правую границу клипа, например, на аудиотреке. Это даст 
возможность "дозвучать", постепенно затихая, инструментам син-
тезатора. В файле SONG_2_14.CWB мы так и сделали. 

Перейдем непосредственно к сведению проекта SONAR в один 

стереофайл. С помощью команды File > Export > Audio главного 

меню откроем окно Export Audio (рис. 4.19). 

В раскрывающемся списке Source Category выберем вариант 

Entire Mix (весь микс) в качестве источника экспортируемых 

аудиоданных. 

ПРИМЕЧАНИЕ  

В поле Source Buses/Tracks в вашем случае будет содержаться 

другая запись, соответствующая названию вашей звуковой карты 
и ее драйверу. 



Глава 4  356 

 

Рис. 4.19. Диалоговое окно Export Audio 

Все доступные флажки группы Mix Enables (кроме 64-bit Engine) 

по умолчанию установлены. Пусть таковыми и остаются, чтобы 

учесть при микшировании состояние атрибутов треков и шин, 

характер изменения огибающих, факт наличия подключенных 

эффектов и значения их параметров. Последнее особенно важно. 

Ведь мы хотим, чтобы звук был обработан плагинами, подклю-

ченными к треку с вокалом и к шине Bus 3. 

В раскрывающемся списке Channel Format оставим формат 

Stereo.  
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Вся предшествующая обработка аудиофайла, содержащего 

вокальную партию, проводилась с 24-битным разрешением. Те-

перь нам такое высокое разрешение ни к чему, ведь мы готовим-

ся свести проект в аудиофайл, который далее будет либо записан 

на 16-битный аудиодиск, либо конвертирован в формат MP3.  

Поэтому в раскрывающемся списке Bit Depth выберем число 16. 

Поскольку такой выбор означает понижение разрядности, есть 

смысл применить дитеринг (см. разд. 1.2.3): в раскрывающемся 

списке Dithering выберем любую строку, кроме None.  

В поле Имя Файла введем, например, SONG_FINAL. В рас-

крывающемся списке Тип файлов оставим Wave. 

Нажмем кнопку Export. Партии аккомпанемента в исполне-

нии виртуального синтезатора, ранее записанные на MIDI-треках, 

и партия вокала, записанная на аудиотреке, будут смикширова- 

ны в один стереофонический аудиотрек и сохранены в файле 

SONG_FINAL.WAV. 

Полюбуемся на результаты своих трудов. Заодно оценим, не при-

вела ли обработка аудиотрека и синтезаторного трека плагинами,  

а также микширование аккомпанемента и вокала к превышению до-

пустимого уровня аудиосигнала и, как следствие, к возникновению 

клиппирования сигнала. Откроем файл SONG_FINAL.WAV в звуко-

вом редакторе Adobe Audition (рис. 4.20).  

ПРИМЕЧАНИЕ  

Предварительно нужно закрыть программу SONAR, иначе при за-

пуске Adobe Audition "выяснит", что драйверы звуковой карты за-

няты другим приложением, и автоматически выберет для себя 

драйвер Audition Windows Sound. В результате при включении 

воспроизведения аудиофайла в Adobe Audition вы, скорее всего, 

звука не услышите. 

Визуально заметно, что микширование выполнено корректно: 

размах колебаний сигналограммы достаточно велик, а отсчетов, 

достигающих уровня 100 %, не видно. Точнее можно сказать, если 

воспользоваться анализатором статистических свойств аудиосиг-

нала. Для этого нужно выделить всю сигналограмму и применить 

команду Window > Amplitude Statistics главного меню.  
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Рис. 4.20. Сигналограмма файла SONG_FINAL.WAV  
в звуковом редакторе Adobe Audition 

В открывшемся одноименном диалоговом окне содержатся 

статистические сведения о загруженном аудиофайле. В частно-

сти, там есть строка Possibly Clipped Samples, в ней отдельно 

для левого и правого каналов указывается число отсчетов, кото-

рые, скорее всего, являются клиппированными. В данном случае 

клиппированы лишь 9 отсчетов сигнала левого канала. На слух 

это будет совершенно незаметно. 

По внешнему виду сигналограммы (см. рис. 4.20), а также су-

дя по малым значениям параметра Average RMS Power в окне 

Amplitude Statistics, характеризующего среднюю энергию ау-

диосигнала (порядка –16 дБ), можно сделать вывод о его относи-

тельно большом динамическом диапазоне. Во всяком случае, 

имеется запас, который, в принципе, позволяет применить к такому 

сигналу компрессор (мы применяли компрессор только к треку 

вокала). Большинство коммерческих фонограмм сжаты до такой 

степени, что их динамический диапазон в лучшем случае состав-



Запись вокальной партии шаг за шагом 359 

ляет 20 дБ. Такова современная мода, возникшая не на пустом мес-

те. Ведь давно доказано, что из двух примерно равноценных му- 

зыкальных композиций слушателю лучшей кажется та, которая 

звучит громче. Но мы не сторонники излишнего сжатия динамиче-

ского диапазона, поэтому будем считать полученный аудиофайл 

итоговым.  
Так что можно поздравить себя: проект успешно сведен.  

Но не забудем, что в файле SONG_2_14.CWB сохранен несве-

денный проект, с которым можно делать все, что угодно. Можно 

дописывать новые инструментальные партии, можно весь акком-

панемент свести в один аудиотрек проекта, а на втором аудиотреке 

оставить вокальную партию. Вообще говоря, пока не произведено 

окончательное сведéние, т. е. аккомпанемент и вокал находятся на 

разных треках, к каждому из них можно по отдельности приме-

нить еще какие-либо обработки. Например, для окончательного 

балансирования звучания аккомпанемента и вокала могут пона-

добиться те же эквалайзер и компрессор, подключенные к треку, 

на котором записан аккомпанемент.  

К треку с вокалом можно применить и специфические обра-

ботки, например, эксайтер. В составе SONAR ранних версий та-

кого плагина нет, в SONAR X1 имеется плагин под названием  

HF Exciter, но результаты его работы проявляют себя лишь как 

искажения. Поэтому ни в одном из последовательных проектов, 

представленных в файлах на диске, сопровождающем книгу,  

в каталоге EXAMPLES, вы не найдете примеров его применения. 

А вот при доработке того варианта песни, который размещен на 

диске в папке SONGS, эксайтер использовался. 

Для чего потребовался эксайтер? Голос, записанный в услови-

ях домашней студии (небольшого, необорудованного в акустиче-

ском отношении помещения), становится навязчиво бубнящим. 

Частично устранить последствия этого эффекта можно, пропус-

кая сигнал от микрофона через фильтр, подавляющий колебания 

с частотами ниже 60—80 Гц (что мы уже сделали). Но одной 

фильтрацией проблема не решается. Тембр звука исходно оказы-

вается здорово подпорчен плохим помещением. Голос звучит 

тускло. Ему не хватает звонкости и прозрачности. Но эту пробле-

му можно решить. Например, в составе плагина iZotope Ozone 3 
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имеется модуль MULTIBAND HARMONIC EXCITER (см. 

разд. 2.2.3, рис. 2.14), в переводе на русский — "многополосный 

возбудитель гармоник". Он позволяет разделить весь диапазон 

звуковых частот на четыре полосы и в каждой полосе отдельно 

сгенерировать дополнительные новые составляющие для спектра 

существующего сигнала. Причем имеется возможность изменять 

несколько параметров, влияющих на уровень "гармоник" и их 

временные свойства. Экспериментальным путем мы установили, 

что при формировании гармоник с уровнем 3—4 дБ в полосе час-

тот, расположенной выше частоты 2 кГц, в голосе, искалеченном 

"студией", восстанавливаются яркость, прозрачность и оконча-

тельно маскируется "бочковость", "недодавленная" фильтром. 

Полностью песня "Монолог куклы" представлена на диске, 

сопровождающем книгу, в папке SONGS. Там же есть несколько 

детских песен, сочиненных и спетых Анной Петелиной. Они  

записаны с помощью программ, рассмотренных в данной книге  

и в книге "Музыкальный компьютер для начинающих" [30].  

Вы можете послушать песни с помощью любого аппаратного или 

программного плеера.  

Вот и все. 
 



 

  

 

  

 

Заключение  
 

 

Мы благодарим уважаемых читателей за конструктивные за-

мечания и предложения, поступающие на сайт  

http://www.petelin.ru 

http://музыкальный-компьютер.рф/ 

http://петелин.рф/ 

и по электронной почте: 

 yury@petelin.ru (Юрию Петелину); 

 roman@petelin.ru (Роману Петелину). 

Приносим свои извинения за то, что очень редко отвечаем на 

конкретные вопросы. Писем приходит столько, что для ответа на 

все не хватает времени. Чтобы помочь начинающим компьютер-

ным музыкантам, мы поддерживаем на сайте группу форумов, 

которые постоянно посещают многие опытные и грамотные лю-

ди. Уверены, что здесь вы найдете ответ на любой самый неожи-

данный вопрос.  

При формировании тематики и содержания каждой очередной 

книги мы стараемся учесть трудности, с которыми сталкиваются 

читатели, а также самые интересные вопросы, разбираемся в сути 

проблемы и стремимся ее разъяснить.  

Будьте здоровы и счастливы! И да поможет вам музыка. 

Авторы 
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Приложение 1 

 

Краткий толковый словарь 
музыкально-компьютерных 
терминов 

API (Application Programming Interface) — интерфейс при-
кладного программирования, регламентирующий взаимодействие 
приложения-хоста с плагином. Наиболее популярными "музы-
кальными" API на платформе PC можно считать DX и VST. 

ASIO — API фирмы Steinberg для высокоскоростного обмена 
данными со звуковыми картами. Если звуковая карта совместима 
с ASIO, то есть смысл использовать именно ASIO-драйверы. 

DX — технология, обеспечивающая взаимодействие прило-
жений-хостов с виртуальными эффектами и инструментами (син-
тезаторами; сэмплерами; эффектами, управляемыми по MIDI,  
и др.) посредством интерфейса прикладного программирования 
Microsoft DirectX. 

DX-инструмент, DXi — виртуальный инструмент, поддержи-
вающий DX. 

Envelope — генератор огибающей (непериодического сигна-
ла, который относительно медленно изменяется во времени),  
используемый для модуляции различных параметров синтеза: 
амплитуды аудиосигнала, высоты тона, ширины спектра и т. д. 
Состоит из нескольких фаз, например: Attack — фаза атаки, 
Decay — фаза спада, Release — фаза затухания. От формы оги-
бающей зависит тембр звука. Также под термином Envelope мо-
гут понимать амплитудную огибающую звукового колебания (не 
обязательно синтезированного). Кроме того, в виртуальных сту-
диях термин Envelope означает график изменения во времени ка-
кого-либо параметра (например, громкости, панорамы).  
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FM-синтез — синтез на основе частотной модуляции. 

Freeze — см. Замораживание. 

GM (General MIDI), GS (General Synth), XG (eXtended  

General) — стандарты, определяющие набор обязательных MIDI-

инструментов, голосами которых должен звучать синтезатор.  

Linux  — операционная система, альтернативная по отноше-

нию к Windows. Для Linux выпускается большинство бесплатных 

программ. 

Mid/Side (M/S) — форма представления стереофонического 

аудиосигнала в виде пары сигналов среднего канала (Mid, моно-

компонента — сумма сигналов левого и правого стереоканалов) 

и бокового канала (Side, стереокомпонента — разность сигналов 

левого и правого стереоканалов). Сигнал, представленный в форме 

Mid/Side, можно особым образом обрабатывать, например, при-

меняя к моно- и стереокомпонентам неодинаковые эффекты либо 

одни и те же эффекты, но с различными значениями параметров. 

MIDI (Musical Instrument Digital Interface) — стандартный 

интерфейс цифровых музыкальных инструментов. 

MIDI-кабель — стандартный кабель для соединения MIDI-

устройств. 

MIDI In — вход MIDI-устройства. 

MIDI Out — выход MIDI-устройства. 

MIDI-байт — элементарное семибитное сообщение, которое 

служит для передачи информации в MIDI-системе.  

MIDI-инструмент (синонимы: патч, тембр, звук, пресет) — 

отдельно взятый синтезированный музыкальный инструмент. 

Возможно, один из нескольких (или даже из многих) музыкаль-

ных инструментов, реализованных в синтезаторе. Так, например, 

согласно стандарту General MIDI, синтезатору положено форми-

ровать 128 MIDI-инструментов (фортепиано, органы, гитары, 

скрипки и т. д.). 

MIDI-клавиатура — клавиатура, подобная фортепианной, 

формирующая MIDI-сообщения при нажатии на клавиши. 

MIDI-контроллер — разновидность MIDI-сообщения, пред-

назначенного для управления параметрами синтеза. В реальных 

MIDI-устройствах формируются с помощью переключателей, 

регуляторов, педалей. Также MIDI-контроллером часто называют 
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устройство управления, снабженное различными элементами 

управления (клавишами, кнопками, регуляторами, переключате-

лями) и вырабатывающее MIDI-сообщения. В этой терминологии 

MIDI-клавиатура является разновидностью MIDI-контроллера.  

MIDI-сообщение — сигнал, в котором содержится закодиро-

ванная в виде числа информация, адресованная синтезатору (на-

пример, сообщение о нажатии или освобождении клавиши, сооб-

щение о силе, с которой клавиша нажата) либо любому другому 

MIDI-устройству. 

MIDI-трек — условный элемент структуры MIDI-композиции, 

введенный для наглядности и подобный дорожке на магнитной 

ленте. Служит для записи отдельной партии в партитуре. С тре-

ком связывается определенный MIDI-канал. 

MIDI-устройство — устройство, снабженное MIDI-интерфейсом. 

Pitch Bend — регулятор высоты тона, расположенный на па-

нели MIDI-клавиатуры. 

ReWire — программная технология, разработанная совместно 

фирмами Propellerhead и Steinberg. Предназначена для обмена 

звуковыми и MIDI-данными между программными приложения-

ми в режиме реального времени с точностью до одного звукового 

отсчета. Приложения, объединяемые по ReWire, являются нерав-

ноправными. Основным является приложение-хост. Именно оно 

взаимодействует с аппаратными MIDI- и звуковыми портами 

компьютерного аудиоинтерфейса. Именно через приложение-

хост звук в конечном счете попадает на динамики наушников или 

акустических мониторов. К приложению-хосту подключается 

приложение-клиент, все MIDI- и звуковые данные которого пере-

даются приложению-хосту. Транспорты обоих приложений син-

хронизированы. Если нажать кнопку Play на транспортной панели 

любого из приложений, то воспроизведение запустится одновре-

менно во всех приложениях. К приложению-хосту можно под-

ключить сразу несколько приложений-клиентов. Например,  

к SONAR или Cubase по ReWire одновременно можно подклю-

чить и Reason, и FL Studio, и другие приложения, поддерживаю-

щие работу в режиме клиента ReWire. Однако, в отличие от пла-

гинов, одновременно можно использовать только по одному 
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экземпляру приложения-клиента (например, только одно прило-

жение Reason и только одно приложение FL Studio). 

RIFF (Resource Interchange File Format — формат файла для 

обмена ресурсами) — формат т. н. файлов-контейнеров, которые 

позволяют хранить мультимедиаданные, закодированные раз-

личными способами. 

RM-синтез — синтез на основе кольцевой балансной модуляции, 

при котором происходит перемножение нескольких колебаний. 

SMPTE (Society of Motion Picture and Television Engineers — 

Общество инженеров кино и телевидения) — протокол синхро-

низации аудио- и видеопотоков, разработанный одноименной 

стандартизирующей организацией. 

Velocity — параметр MIDI-сообщения, содержащий информацию 

о силе удара по клавише. Обычно ассоциируется с громкостью зву-

чания ноты. В синтезаторах, поддерживающих многослойность, раз-

личные значения Velocity вызывают воспроизведение сэмплов, соот-

ветствующих различному характеру извлечения звука (например, от 

слабого касания гитарной струны до сильнейшего удара по ней). 

VST (Virtual Studio Technology) — API фирмы Steinberg. 

VST System Link — технология, обеспечивающая объединение 

студийных компьютеров в сеть посредством цифровых аудиоин-

терфейсов. 

VST-инструмент, VSTi — виртуальный инструмент, поддер-

живающий VST. 

VST-плагин — плагин, поддерживающий VST. 

WAV-файл (от wave — волна) — файл формата RIFF с рас-

ширением WAV, содержащий звуковые данные. Обычно под 

"WAV-файлами" музыканты подразумевают те файлы, которые со-

держат звуковые данные в кодировке PCM (Pulse-code modulation — 

импульсно-кодовая модуляция), т. е. звуковые данные без какого-

либо сжатия и без каких-либо потерь в качестве. Хотя в WAV-

файле могут храниться звуковые данные (и формат RIFF это до-

пускает), сжатые по любому существующему алгоритму (напри-

мер MP3). 

WDM-драйверы (от Windows Driver Model) — связывают ис-

пользующее их программное обеспечение и звуковую карту. Ра-

ботают в Windows 98SE/ME/2000/XP/Vista/7. 
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Автоматизация параметров — возможность записывать 

действия пользователя по изменению параметров проекта и пла-

гинов во время воспроизведения проекта, редактировать эти  

записи (обычно в виде графиков) и воспроизводить их уже без 

участия пользователя. 

Аддитивный синтез — метод синтеза, основанный на сложе-

нии нескольких колебаний произвольной формы. 

Амплитуда колебания — наибольшее отклонение колеблю-

щегося объекта (либо точки графика, отображающего колебание) 

от первоначального положения (состояния покоя). 

Аранжировка (в традиционной музыке) — переработка му-

зыкального произведения, написанного для определенных голо-

сов или инструментов, с целью приспособления его к исполне-

нию другими средствами.  

Аранжировка компьютерная — сочетание гармонизации, 

оркестровки, переработки партий для исполнения их другими 

инструментами, а также синтез новых тембров, панорамирование 

источников звука, балансировка уровней их громкости, обработ-

ка звука эффектами.  

Арпеджиатор — программа, формирующая на основе после-

довательности аккордов последовательность отдельных нот, ха-

рактеризующуюся определенным ритмом, а иногда и соответст-

вующую определенному музыкальному стилю.  

Арпеджио — последовательное исполнение звуков аккорда. 

Атрибуты трека — параметры, ассоциированные с треком: 

имя трека, источник сообщений для трека, выходной MIDI-порт, 

банк MIDI-инструментов, собственно MIDI-инструмент и др. 

АЦП — аналого-цифровой преобразователь. 

Банк инструментов — набор MIDI-инструментов, объеди-

ненных в группу. 

Барабанная карта — таблица соответствия ударных инстру-

ментов MIDI-нотам, MIDI-каналам и MIDI-инструментам (рас-

кладка ударных инструментов по MIDI-клавиатуре). 

Браузер (browser) — средство (окно) для поиска и загрузки  

в программу файлов. 
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Вибрато — периодическое изменение одного из параметров 

звукового колебания (амплитуды, частоты или фазы). 

Виртуальная студия — программа, совмещающая в себе 

функции секвенсора; MIDI-редактора; устройства записи, редак-

тирования, воспроизведения звука; коммутатора сигналов; мик-

шера; приборов обработки; эффект-процессоров; синтезаторов. 

Виртуальный синтезатор (синоним: виртуальный инструмент) — 

программа, которая моделирует работу синтезатора (формирует 

синтезированный звук).  

Вокодер (от voice coder — кодировщик голоса) — устройство 

синтеза речи на основе произвольного сигнала с богатым спек-

тром. Вокодеры были разработаны в целях экономии частотных 

ресурсов радиолинии системы связи при передаче речевых сооб-

щений. Экономия достигается за счет того, что вместо собствен-

но речевого сигнала передают только значения его определенных 

параметров, которые на приемной стороне управляют синтезато-

ром речи. Вокодер как эффект, применяемый в музыке, позволяет 

перенести свойства одного (модулирующего) сигнала на другой 

сигнал, который называют носителем (carrier). Часто в качестве 

сигнала-модулятора используется голос человека, а в качестве 

носителя — сигнал, формируемый музыкальным синтезатором. 

Время атаки компрессора — время реакции компрессора на 

возникновение сигнала с уровнем выше порогового.  

Время восстановления компрессора — время, за которое 

компрессор выходит из активного состояния после падения уров-

ня сигнала ниже порогового.  

Гармонизация — сопровождение мелодии последовательно-

стью аккордов. 

Гармонический синтез — синтез на основе комбинирования 

гармоник основного колебания — синусоидальных колебаний,  

с частотами в целое число раз превышающими частоту основного 

колебания.  

Гармония — последовательность аккордов. 

Гейт — устройство динамической обработки, у которого ко-

эффициент передачи изменяется так, что при уровне входного 

сигнала меньше порогового амплитуда сигнала на выходе близка 

к нулю. 
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Гистограмма распределения уровней аудиосигнала — гра-

фик, показывающий, насколько часто уровень анализируемого 

сигнала принимает определенные значения. В звуковых редакто-

рах используется для оценки свойств аудиосигнала при выборе 

параметров динамической обработки. 

Гранулярный синтез — синтез на основе комбинирования 

коротких фрагментов сэмплов (гранул). Тембр синтезируемого 

звука зависит от свойств отдельных гранул и порядка их чередо-

вания. 

Графический эквалайзер — набор полосовых фильтров с фик-

сированными центральными частотами и переменным коэффи-

циентом усиления, которым можно управлять при помощи слай-

дера (ползунка). 

Грув (groove) — сэмпл одного или нескольких музыкальных 

тактов инструментальной партии, исполненной в определенном 

музыкальном стиле. 

Децибел — логарифмическая единица измерения отношения 

двух величин (мощностей, уровней сигнала, амплитуд токов или 

напряжений). 

Дилэй — эффект, имитирующий задержку звука при распро-

странении и его отражение от имеющихся препятствий. 

Динамический диапазон звука — разница между наиболее 

громким и наименее громким звуками (обычно измеряется в ло-

гарифмических единицах). 

Динамическая обработка — обработка сигнала с целью из-

менения его динамического диапазона (разности между макси-

мальным и минимальным уровнями).  

Дискретизация сигнала во времени — замена непрерывно 

изменяющегося во времени сигнала рядом отсчетов его значений. 

Дистошн — эффект, заключающийся в намеренном искаже-

нии звука с целью обогащения его тембра. 

Дитеринг (dithering) — добавление к цифровому сигналу сла-

бого шума, что позволяет путем незначительного повышения об-

щего уровня шума обеспечить независимость шумов квантования 

и сигнала. Это создает эффект сохранения динамического диапа-

зона сигнала при понижении разрядности его представления. 



Приложения  372 

Добротность — отношение центральной частоты фильтра  

к его полосе пропускания. 

Драм-машина — устройство или программа, объединяющая 

в себе синтезатор звуков ударных инструментов и секвенсор для 

записи и воспроизведения партии ударных. 

Замораживание, Freeze — функция виртуальной студии, позво-

ляющая экономить ресурсы процессора за счет замены синтеза 

звука в реальном времени воспроизведением предварительно вычис-

ленных звуковых данных. 

Звуковая карта — карта расширения, подключаемая в разъем 

на материнской плате и предназначенная для записи, воспроизве-

дения, синтеза звука и подключения MIDI-клавиатуры. 

Звуковой движок — алгоритм, на основе которого в про-

грамме реализована обработка звука, представленного в цифро-

вой форме. 

Звуковой модуль (синонимы: модуль сопряжения, MIDI-, ау-

диоинтерфейс) — то же, что звуковая карта, но оформлен в виде 

внешнего устройства, подключаемого к компьютеру посредством 

одного из стандартных интерфейсов. 

Инструментовка — изложение музыки для исполнения ее ка-

ким-либо составом оркестра или инструментальным ансамблем. 

Каподастр — специальный зажим, закрепляемый на грифе 

гитары для изменения тональности звучания (транспонирования 

лада) путем искусственного укорачивания звучащей части струн. 

Квантизация — замена длительностей реально сыгранных 

нот стандартными. Позволяет сгладить ошибки исполнителя.  

Гуманизация мелодии — разновидность квантизации, в алгорит-

ме которой предусмотрены небольшие отклонения от механиче-

ской идеальности. 

Квантование аналогового сигнала по уровню — замена ре-

альных значений сигнала приближенными значениями, соответ-

ствующими разрешенному ряду чисел. Шум квантования — раз-

ность соответствующих значений реального и квантованного 

сигналов.  

Клип (в Cakewalk SONAR) — совокупность объединенных  

в группу сообщений, к которым можно применять операции 

редактирования как к единому целому. 
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Клиппирование отсчетов  — искажение сигнала, вызванное 

переполнением разрядной сетки аналого-цифрового преобразо-

вателя (АЦП); возникает, если на вход АЦП подается сигнал 

слишком большого уровня.  

Кодово-импульсная модуляция (КИМ, PCM) — один из 

наиболее распространенных способов цифрового представления 

аудиосигнала. Сначала непрерывный сигнал преобразуется в дис-

кретный — заменяется последовательностью отсчетов, т. е. пре-

вращается в последовательность импульсов, причем, амплитуда 

(величина) каждого импульса равна значению сигнала в момент 

взятия отсчета. Затем амплитуда каждого импульса измеряется,  

а результат измерения преобразуется в код (число). Чем выше час-

тота взятия отсчетов и чем больше разрядность кода — тем точнее 

исходный сигнал будет представлен в цифровой форме. 

Компрессор — устройство, сужающее динамический диапа-

зон звука. 

Корреляция — величина, характеризующая взаимную зави-

симость двух случайных величин. Автокорреляция — корреля-

ционная связь между значениями одного и того же сигнала в раз-

ные моменты времени. Функция, характеризующая эту связь, 

называется автокорреляционной функцией. 

Коррелометр — вычислитель нормированного коэффициента 

взаимной корреляции сигналов левого и правого каналов в целях 

оценки степени моносовместимости стереосигнала. 

Котельникова теорема — основное правило, определяющее 

частоту, с которой следует измерять значение сигнала при его 

преобразовании в цифровую форму. Суть теоремы: сигнал, пред-

ставленный последовательностью дискретных отсчетов, можно 

вновь преобразовать в исходный (непрерывный) вид без потери 

информации только в том случае, если интервал межу соседними 

отсчетами не превышает половину периода самого высокочас-

тотного колебания, содержащегося в спектре исходного сигнала. 

Коэффициент компрессии — степень сжатия компрессором ди-

намического диапазона сигнала, уровень которого выше порогового. 

Кроссовер — устройство, которое разделяет входной сигнал 

на несколько выходных, причем каждый выходной сигнал со-

держит колебания только определенного диапазона частот. 
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Кроссфейд (crossfade) — уменьшение амплитуды сигнала 

предшествующего фрагмента с одновременным увеличением ам-

плитуды сигнала текущего фрагмента. 

Латентность — задержка аудиосигнала при прохождении 

устройства записи и обработки звука. 

Лимитер — устройство, ограничивающее уровень громкости 

звука. 

Луп (loop) — фрагмент фонограммы, воспроизводимый в цик-

ле. Границы лупа подбираются таким образом, чтобы между 

концом предыдущего и началом следующего повтора не было 

ощутимой на слух разницы. Длительность лупа обычно соответ-

ствует одному или нескольким музыкальным тактам. Лупы могут 

содержать партии барабанов, какие-то музыкальные фразы, гру-

вы, перкуссию, специальные эффекты — любые звуки, которые 

имеет смысл воспроизводить в цикле.  

Максимайзер — устройство, увеличивающее громкость звука. 

Маркер — именованный значок, которым можно пометить 

любую временнýю позицию в проекте. 

Мастеринг (mastering) — финальная стадия обработки фоно-

граммы перед ее тиражированием на CD, DVD, в теле-, видео-, 

кинофильмах, воспроизведением на радио и т. п. Изначально 

мастерингом назывался технологический процесс на заводе ви-

ниловых пластинок или компакт-дисков. В ходе этого процесса 

создавался т. н. "мастер" — образец, который использовался для 

тиражирования. Финальная стадия обработки фонограммы назы-

валась премастерингом. Однако так уж повелось, что ныне мас-

терингом называют то, что следовало бы называть премастерин-

гом. Во-первых, так короче. Во-вторых, большинство людей, 

связанных с производством музыки (музыканты, певцы, компо-

зиторы, продюсеры, аранжировщики, инженеры, звукорежиссе-

ры), отделены от того, что происходит на заводах. Их конечный 

продукт — это музыкальные треки в виде звуковых файлов. Це-

лью мастеринга является достижение максимально высокого 

субъективного качества звучания композиции не в условиях зву-

ковой студии, а на бытовой звуковоспроизводящей аппаратуре 

(радиоприемник, телевизор, CD/MP3-плеер и т. д.) конечного 

слушателя. 
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Медиафайл — термин, объединяющий в себе представление 

о MIDI-файлах, аудиофайлах, видеофайлах, файлах в формате 

проекта конкретной виртуальной студии. 

Микрофон — прибор, предназначенный для преобразования 

изменения звукового давления в электрическую форму. 

Микширование — суммирование нескольких потоков звуко-

вых данных. Обычно под "микшированием" понимается процесс 

сведéния. 

Многослойность — возможность воспроизведения одновре-

менно нескольких тембров для озвучивания одного инструмента.  

Модульный синтезатор — синтезатор, архитектуру и панель 

управления которого пользователь может самостоятельно проек-

тировать, комбинируя различные блоки. 

Модулятор — аппаратное или программное устройство, в ко-

тором реализована модуляция — процесс изменения параметров 

одного колебания под воздействием другого колебания. Напри-

мер, с помощью модулятора можно формировать огибающую 

звукового колебания; периодически изменять амплитуду, часто-

ту, фазу, задержку аудиосигнала; перестраивать фильтр; переме-

щать по стереопанораме положение кажущегося источника звука. 

Мультитембральный виртуальный инструмент — инст- 

румент, которым можно управлять по нескольким MIDI-каналам 

с нескольких MIDI-треков. 

Нормализация (аудиосигнала, аудиофайла) — преобразова-

ние аудиосигнала, при котором его наибольший по величине от-

счет становится равным заданному значению. Величины осталь-

ных отсчетов при этом изменяются пропорционально. Например, 

если наибольший отсчет составляет 50 % от максимального до-

пустимого значения (100 %), то при нормализации к уровню 

100 % величины всех отсчетов будут удвоены. В звуковых редак-

торах при выполнении нормализации наибольшая величина от-

счета измеряется программой автоматически.  

Нойзшейпинг — применение специальных алгоритмов округ-

ления значений звуковых отсчетов при понижении разрядности. 

Обработка — преобразование исходного аудиосигнала, на-

правленное на повышение его качества (в некотором оговорен-

ном смысле).  
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Обратная связь — подача сигнала с выхода какого-то эле-

мента на его вход. 

Огибающая автоматизации — график изменения какого-

либо параметра синтеза. 

Октава — интервал между тонами, соответствующий изме-

нению частоты в 2 раза. 

Оркестровка — изложение для исполнения оркестром инст-

рументальной пьесы, исходно написанной для фортепиано.  

Осциллятор (генератор сигнала) — источник звука в синтеза-

торе (осцилляторов может быть несколько). Основные характе-

ристики: форма генерируемой волны, частота, амплитуда. 

Пакетная обработка — поочередная автоматическая обра-

ботка нескольких аудиофайлов в соответствии со сценарием (по-

следовательностью алгоритмов). 

Параметрический эквалайзер — фильтр, допускающий 

управление не только коэффициентом усиления, но и его цен-

тральной частотой, а также добротностью (по существу, шириной 

полосы пропускания). Параграфический эквалайзер — несколько 

параметрических эквалайзеров, объединенных в единый модуль. 

Паттерн (pattern) — заранее записанный или запрограммиро-

ванный в паттерновом секвенсоре фрагмент музыкального про-

изведения (обычно один или несколько музыкальных тактов)  

в исполнении одного или нескольких MIDI-инструментов. 

Паттерновый, или пошаговый секвенсор — программный 

секвенсор, работающий по принципу аналоговых аппаратных 

секвенсоров. Обычно у таких секвенсоров имеется ряд кнопок 

(например, от 1 до 16), каждая из которых соответствует одному 

шагу секвенсора (или доле музыкального такта). Пользователь 

нажимает нужную кнопку и задает параметры синтеза (громкость, 

высота тона и т. п.) для соответствующего шага. Запрограммиро-

ванная таким образом последовательность звуков называется пат-

терном. В режиме воспроизведения секвенсор последовательно (по 

шагам) воспроизводит звуки паттерна. Обычно имеется возмож-

ность циклического воспроизведения паттерна. Программирова-

ние подобного секвенсора — процесс не быстрый, и последова-

тельности из 16 (или даже 32) звуков недостаточно для того, 

чтобы выразить какую-то музыкальную идею. Поэтому обычно 
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паттерны можно сохранять в банках памяти, чтобы потом, в ходе 

воспроизведения композиции (или "живого" выступления) быст-

ро извлекать их из памяти секвенсора и воспроизводить в нуж-

ном порядке. 

Переходный процесс — реакция (отклик) какой-либо электри-

ческой цепи или устройства на изменяющийся входной сигнал. 

Обычно оценивается на основании анализа импульсной характери-

стики (отклика на идеальный одиночный прямоугольный импульс). 

Период  колебания — время (в секундах), в течение которого 

происходит одно полное колебание.    

Плагин (plug-in) — дополнительный модуль, подключаемый 

к основной программе, благодаря которому эта программа полу-

чает новые возможности. 

Порог слышимости стандартный — эффективное значение 

звукового давления, создаваемого гармоническим звуковым ко-

лебанием частоты 1000 Гц, едва слышимым человеком со сред-

ней чувствительностью слуха. 

Порог срабатывания компрессора — уровень, при превы-

шении которого компрессор начинает управлять усилением. 

Портаменто — плавное скольжение высоты звука от тона  

к тону.  

Посыл (Send) — ответвление (копия) потока звуковых данных 

трека, подаваемое на специальную общую шину, к которой под-

ключен один или несколько (по цепочке) эффектов. После обра-

ботки звуковые данные обычно возвращаются в общий микс. 

Благодаря существованию посылов звуковые данные нескольких 

(двух и более) треков могут быть обработаны одним и тем же 

эффектом (например, реверберацией) или одним и тем же набо-

ром из нескольких эффектов. 

Пресет (preset) — совокупность настроек плагина, которая 

сохраняется в его памяти и в специальном файле. 

Приложение-хост — программа, которая позволяет подклю-

чать к ней плагины. 

Программа-аранжировщик — специализированная програм-

ма, предназначенная преимущественно для аранжировки и оркест-

ровки музыкальных композиций на основе заданной гармонии  

и мелодии. 
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Программа — звуковой редактор — специализированная про-

грамма, предназначенная для записи, редактирования, монтажа 

звука, а также для его обработки различными эффектами. 

Проект — файл (файлы), в котором(ых) кроме звуковых и 

MIDI-данных содержатся всевозможные установки (созданные 

треки, подключенные эффекты, данные автоматизации управле-

ния виртуальным микшером, выбранные параметры, перечень 

открытых окон, установленные режимы, позиция, с которой нач-

нется запись или воспроизведение, и многое другое). 

Псевдоаналоговый синтезатор — синтезатор, в котором 

цифровыми методами смоделирована работа аналогового синте-

затора. Сочетает в себе возможность получения тембров рари-

тетных синтезаторов с гибкостью современных средств редакти-

рования параметров синтеза. 

Психоакустическая обработка — направленный на улучше-

ние субъективного качества звука алгоритм обработки звуковых 

данных, учитывающий особенности слухового восприятия звука 

человеком. Примеры таких особенностей: маскировка тихого звука 

более громким; неодинаковая чувствительность слуха человека к 

звукам различных частот; способность мозга человека "генериро-

вать внутри себя" отсутствующие в реальном аудиосигнале низко-

частотные компоненты на основе анализа их гармоник.  

Разрядность представления звуковых данных — количест-

во разрядов (битов), которое используется для представления 

оцифрованного и синтезированного звука. Сейчас носителем  

конечного музыкального продукта, как правило, является 16-

битный CD Digital Audio (аудиодиск) или MP3-файл. Различают 

форматы представления с фиксированной и плавающей запятой. 

Для воспроизведения готовой фонограммы на бытовой аппарату-

ре достаточен 16-битный формат с фиксированной запятой. При 

обработке звуковых данных используются сложные, многократно 

применяемые численные алгоритмы, которые принципиально 

вызывают возникновение и наращивание погрешности. Для ее 

снижения до пренебрежимо малого уровня используется 32-

битный формат с плавающей запятой. Лучшие современные пла-

гины эффектов обеспечивают обработку в 64-битном формате  

с плавающей запятой. Увеличение разрядности приводит к росту 
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загрузки компьютера и ограничивает возможное число обрабаты-

ваемых аудиотреков и подключенных эффектов. 

Ранние отражения — компоненты аудиосигнала, отраженно-

го от стен, потолка, пола помещения, а также от имеющихся  

в помещении предметов, приходящие к слушателю вслед за пря-

мым (распространяющимся по кратчайшему расстоянию и не 

претерпевающим отражений) звуком. Их уровень велик (сравним 

с уровнем прямого звука). При большом объеме помещения они 

могут восприниматься как отдельные звуки (не сливаться друг  

с другом), подобные эху.   

Реверберация — эффект многократного отражения звука, со-

провождающийся его постепенным затуханием. Имитируется 

аппаратными или программными ревербераторами. 

Реверберационный хвост — постепенно затихающие компо-

ненты аудиосигнала, получающиеся в результате наложения звуко-

вых колебаний, многократно отраженных элементами помещения.    

Рифф — короткая повторяющаяся последовательность нот, ис-

пользуемая, в частности, бас-гитаристами при обыгрывании аккорда. 

Ромплер (от ROM — ПЗУ и player — проигрыватель) — про-

грамма (или устройство), представляющая собой синтезатор,  

в качестве осцилляторов которого используются сэмплы. Для ре-

дактирования доступны лишь параметры синтеза, но не звуковые 

данные сэмплов. 

Рэковая стойка, рэк (rack) — стойка, предназначенная для 

закрепления на ней группы аппаратных модулей, имеющих стан-

дартные габариты. Соединения между модулями осуществляются 

кабелями. В виртуальных студиях аналогичную функцию выпол-

няет виртуальная рэковая стойка. Виртуальные инструменты, ус-

тановленные в нее, считаются подключенными к проекту. 

Сведéние — этап создания музыкальной композиции/песни, 

следующий после аранжировки и записи отдельных треков (т. н. 

трекинга) проекта. В ходе сведения исправляются/компенси-

руются ошибки, допущенные во время записи. За счет примене-

ния обработок и эффектов достигается максимально высокое 

субъективное качество звучания композиции. После того как 

нужное звучание проекта достигнуто, весь мультитрековый про-

ект экспортируется в единый стереофонический или многока-
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нальный (например, 5.1) трек. Иными словами, сведение — это 

превращение множества треков, существующих в формате про-

екта виртуальной студии, в один аудиотрек. 

Сверточный ревербератор — ревербератор, имитирующий 

распространение звука в конкретном помещении. Информация об 

акустических свойствах помещения заключена в его импульсной 

характеристике. Обычно в поставку такого ревербератора входит 

библиотека импульсных характеристик, полученных эксперимен-

тальным путем. Математической основой алгоритма обработки слу-

жит операция свертки аудиосигнала и импульсной характеристики.  

Секвенсор — устройство (или программа) для записи, редакти-

рования и воспроизведения последовательности MIDI-сообщений. 

Сигналограмма — графическое отображение звукового ко-

лебания, фактически — зафиксированная в памяти программы 

осциллограмма (временная развертка колебания).  

Скретч — эффект особого приема игры на виниловой пла-

стинке, применяемого диджеями: пластинку вручную "дергают" 

в разных направлениях, а игла проигрывателя при этом остается 

в канавке. 

Соло (Solo в Cakewalk SONAR) — режим, при котором слы-

шен только один трек, остальные треки заглушены. 

Сонограмма — графическое отображение спектра звукового 

колебания в координатах "время–частота–интенсивность". Ин-

тенсивность спектральных составляющих отображается либо 

градациями яркости, либо различными цветами. 

Спектр — математическое представление аудиосигнала в ви-

де суммы гармонических (синусоидальных и косинусоидальных) 

колебаний с различными частотами. Спектр аудиосигнала полу-

чают с помощью анализаторов спектра (аппаратных или про-

граммных). Спектрограмма показывает интенсивность колебаний 

на различных частотах. Слуховой аппарат человека фактически 

позволяет различать звуки по их спектру. Субъективным анало-

гом спектра является тембр звука. 

Спектральный анализ (преобразование Фурье) — разложение 
сигнала в ряд по тригонометрическим функциям, т. е. представ-
ление его в виде суммы слагаемых, каждое из которых соответст-
вует косинусоидальному колебанию с определенной амплитудой  
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и начальной фазой. Текущий спектр — результат преобразования 
Фурье с переменным верхним пределом интегрирования, в каче-
стве которого фигурирует текущее время. Мгновенный спектр — 
спектр короткого отрезка процесса, непосредственно предшест-
вующего данному моменту времени. Взвешенный спектр — 
спектр, вычисленный с учетом свойств памяти анализатора спек-
тра. Весовая функция — временнáя зависимость вклада предше-
ствующих отсчетов исследуемого сигнала в вычисляемый спектр. 

Статус трека (в Cakewalk SONAR) — состояние, в котором 
находится трек (возможные варианты: солирует, заглушен, архи-
вирован,  заморожен, подготовлен к записи). 

Стереогониометр — прибор, позволяющий измерять и ото-
бражать фазовые соотношения между сигналами правого и лево-
го стереоканалов для оценки свойств стереополя и моносовмес-
тимости стереофонического аудиосигнала.  

Стереообраз — определенное размещение кажущихся источ-
ников звука на стереопанораме. 

Стиль в программе-аранжировщике — заранее записанный 
разработчиками фрагмент музыкального произведения (паттерн)  
в исполнении группы MIDI-инструментов. Стиль характеризуется 
определенным ритмическим рисунком, сочетанием партий отдель-
ных инструментов, набором собственно инструментов и приемами 
звукоизвлечения. 

Субтрактивный синтез — метод синтеза, основанный на том, 
что новый тембр создается путем изменения соотношения между 
отдельными составляющими в спектре первоначального колебания. 
Первоначальное колебание должно иметь широкий спектр (богатый 
тембр). Из него с помощью фильтров выделяют спектральные со-
ставляющие, характерные для синтезируемого инструмента. 

Сэмпл (sample) — оцифрованный образец звуков (в частности, 
музыкального инструмента). 

Сэмплер — программа (или устройство), позволяющая запи-
сывать/загружать, редактировать и воспроизводить сэмплы. 

Тембр — специфическая окраска звука, свойственная кон-
кретному музыкальному инструменту или голосу. Тембру соот-
ветствует определенный спектральный состав аудиосигнала. 

Тик — наименьшая единица изменения музыкального време-
ни в секвенсоре, часть доли такта. 
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Транкейт (truncate) — неконтролируемое понижение разряд-

ности представления цифрового звука. 

Трекинг (tracking) — этап создания музыкальной компози-

ции, следующий после аранжировки, когда осуществляется одно-

временная или последовательная запись треков проекта. Здесь 

имеется в виду запись не виртуальных, а реальных инструментов 

и вокала в студийных условиях. 

Унисон — эффект, имитирующий исполнение музыкальной 

партии двумя голосами. За счет небольших временны́х и частот-

ных различий возникают биения (очень медленные изменения 

спектра, вызванные взаимодействием колебаний). В результате 

этого тембр звука приобретает свойство переливчатости. 

Уровень аудиосигнала — выраженное в децибелах выпрям-

ленное и усредненное за некоторый предшествующий промежуток 

времени напряжение аудиосигнала. При малых значениях интер-

вала усреднения речь идет о квазипиковых измерителях (часто их 

обозначают как PEAK). Большое значение интервала усреднения 

соответствует среднеквадратическому измерителю уровня (Root 

Mean Square, RMS). 

Фейзер и Флэнжер — эффекты, заключающиеся в периодиче-

ском изменении фазы аудиосигнала (фактически вносят очень не-

большую по величине периодически изменяющуюся задержку). Для 

флэнжера время задержки значительно больше, чем для фейзера. 

Физическое моделирование — метод синтеза, основанный 

на математических моделях реальных физических объектов 

(струн, корпусов музыкальных инструментов, электронных схем 

аналоговых синтезаторов). 

Фильтр — устройство, позволяющее выделять определенные 

полосы частот из воспроизводимого спектра и работать с ними. 

Фильтрация — процесс обработки электрического звукового 

сигнала частотноизбирательными устройствами с целью измене-

ния спектрального состава (тембра) сигнала. 

Фильтр присутствия — фильтр, выделяющий частотные со-

ставляющие в области от 500 до 4000 Гц, характерной для частот 

человеческого голоса. В итоге возникает эффект приближения 

вокалиста к слушателю, что позволяет выделить его голос на фо-

не аккомпанемента. 
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Хорус — эффект, имитирующий звучание хора вокалистов 

или группы музыкальных инструментов. 

ЦАП — цифроаналоговый преобразователь. 

Частота колебаний — количество полных колебаний в се-

кунду. 

Частота среза — граничная частота, разделяющая полосы 

пропускания и подавления сигнала фильтром. 

Частота сэмплирования (частота дискретизации) — часто-

та, с которой представлены цифровые отсчеты звука. Согласно 

теореме Котельникова, она должна как минимум вдвое превы-

шать наибольшую частоту в спектре сигнала. Стандартная часто-

та сэмплирования для звуковых компакт-дисков — 44 100 герц. 

При этом гарантируется неискаженное воспроизведение звуко-

вых частот, не превышающих 20 000 герц. 

Частотное вибрато — периодическое изменение высоты тона. 

Эквалайзер — устройство (аппаратное или программное), со-

стоящее из нескольких фильтров. 

Эксайтер, энхансер — устройства (аппаратные или программ-

ные), предназначенные для улучшения субъективно воспринимае-

мого качества звука. Например: устройства, улучшающие воспри-

ятие низкочастотных компонентов звука при воспроизведении 

фонограмм через акустические системы низкого качества за счет 

формирования гармоник басовых звуков; устройства, создающие 

эффект улучшения "звонкости" и "прозрачности" звука за счет 

формирования гармоник звуков среднечастотного диапазона. 

Экспандер — устройство, предназначенное для расширения 

динамического диапазона. 

Эффект — обработка, в результате которой у звука появляются 

свойства, исходно у него отсутствующие. Часто эффектами искусст-

венно имитируются реальные физические процессы и явления. На-

пример, эффект реверберации имитирует реверберацию, имеющую 

место при распространения звука в помещении; сдвигом высоты то-

на имитируется эффект Доплера (изменение частоты аудиосигнала 

при взаимном перемещении его источника и приемника).  

Эффект-процессор — устройство, реализующее обработку 

эффектами звука, представленного в цифровой форме. 
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Описание компакт-диска 
 

Информацию с компакт-диска можно считать в компьютер 

посредством привода CD-ROM.  

Системные требования  

для работы с компакт-диском 

 Привод CD-ROM. 

 Видеорежим — 1024 768 или выше. 

 Любой интернет-браузер — Microsoft Internet Explorer, Mozilla 

Firefox, Google Chrome, Opera и т. п. 

 Любой MP3-плеер, например, Winamp. 

 Программы Adobe Audition и Cakewalk SONAR. 

Содержание компакт-диска  

 Папка ARTICLES — электронные версии наших книг и ста-

тей, посвященных применению компьютера в музыкальном 

творчестве. 

 Папка EXAMPLES — файлы с примерами, иллюстрирующи-

ми последовательность действий при работе над проектом 

песни. 

 Папка SONGS — примеры песен, созданных с помощью про-

грамм, рассмотренных в книге. 
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Перечень файлов с примерами 

Файлы с примерами хранятся на диске, сопровождающем 

книгу, в папке EXAMPLES. В целом примеры иллюстрируют 

всю последовательность основных действий, которые следует 

выполнить в процессе дополнения MIDI-композиции вокальной 

партией. Автором музыки и слов песни "Монолог куклы" являет-

ся Юрий Петелин. Читатели книги могут использовать файлы, 

содержащиеся на диске, исключительно в целях обучения. 

Проекты, созданные в предыдущих версиях  программы, без 

каких-либо потерь загружаются в SONAR X1. А вот обратная 

совместимость отсутствует. Если вы работали в SONAR X1 и со-

хранили проект в файле, то ни в одной из предыдущих версий 

программы открыть его не удастся. Мы не знаем, какой версией  

программы пользуетесь вы. Поэтому решили примеры задубли-

ровать. Файлы проектов, совместимые только с SONAR X1, на-

ходятся в папке EXAMPLES\ SONAR X1, а файлы проектов, со-

вместимые с любой версией программы —  в папке EXAMPLES\ 

SONAR. 

1. TEMPLATE_2_01.CWT — шаблон проекта SONAR, содер-

жащий 4 MIDI-трека. В качестве выходного порта в каждом 

треке выбран DX-инструмент Cakewalk TTS-1. Для треков  

в этом шаблоне назначены MIDI-инструменты: для трека № 1 

(Мелодия) — инструмент Piano 1; для трека № 2 (Бас) — ба-

совый инструмент Fingered Bs; для трека № 3 (Гармония) — 

инструмент Detuned EP 1; для трека № 4 (Ударные и перкус-

сия) — стандартный набор ударных Standard Set. Панорамы 

треков Мелодия и Гармония немного смещены в разные сто-

роны, чтобы в будущем лучше различать их на слух. Шаблон 

может пригодиться при создании собственных проектов. 

Шаблон удобен тем, что скрыты те элементы интерфейса, без 

которых начинающий пользователь может обойтись. 

2. SONG_2_01.CWP — исходная MIDI-аранжировка (акком- 

панемент песни). Проект размечен маркерами и содержит 

MIDI-треки, к которым подключен виртуальный синтезатор  

Cakewalk TTS-1; записаны обозначения аккордов; записаны ба-

зовые ноты аккордов, после чего с помощью подпрограмм CAL 
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сформированы аккорды, затем в целях устранения нарушений 

правил голосоведения некоторые аккорды заменены их обра-

щениями; записана мелодическая партия; записаны партии 

ударных инструментов и баса; добавлены дополнительные 

партии; выполнено сведение средствами MIDI-редактирова-

ния. Содержимое файла служит исходным материалом для про-

должения работы над песней (записи, редактирования, монтажа, 

обработки эффектами вокальной партии).  

3. SONG_2_02.CWP — на треке мелодии записаны слова перво-

го куплета и припева песни. Иллюстрирует процесс работы 

над проектом (см. разд. 4.1). 

4. SONG_2_03.CWP — в проект добавлен аудиотрек. Иллюст-

рирует процесс работы над проектом (см. разд. 4.3.1). 

5. SONG_2_04.CWB — в проекте трек № 4 Ударные и прекус-

сия перемещен: теперь партия ударных расположена на треке 

№ 7. На треках №№ 1—6 подряд располагаются партии ме-

лодических инструментов. Так их удобнее выделять, чтобы 

одновременно транспонировать при подборе наиболее удоб-

ной для вокалиста тональности. Изменен темп композиции  

с 150 до 160 долей в минуту. Иллюстрирует процесс работы 

над проектом (см. разд. 4.3.2). 

6. SONG_2_05.CWB — на панели управления отображен мо-

дуль привязки к тактовой сетке (Snap Module), выделен 

фрагмент, включающий в себя такты с 9 по 19; записаны 

дубли первой части куплета. Иллюстрирует процесс работы 

над проектом (см. разд. 4.4). 

7. SONG_2_06.CWB — записаны дубли второй части куплета. 

Иллюстрирует процесс работы над проектом (см. разд. 4.4). 

8. SONG_2_07.CWB — записаны дубли припева. Иллюстрирует 

процесс работы над проектом (см. разд. 4.4). 

9. SONG_2_08.CWB — из записанных дублей фрагментов во-

кальной партии выбраны лучшие. Остальные удалены. Ил-

люстрирует процесс работы над проектом (см. разд. 4.4). 

10. SONG_2_09.CWB — удалены перекрывающиеся фрагменты 

клипов. Иллюстрирует процесс работы над проектом (см. 

разд. 4.4). 
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11. SONG_2_10.CWB — расположенные на разных треках кли-

пы, в которых записаны фрагменты вокальной партии, сведе-

ны в один клип. Исходные клипы удалены. Тем самым за-

вершен монтаж заготовки вокальной партии (первого куплета 

и припева). Иллюстрирует процесс работы над проектом (см. 

разд. 4.4). 

12. VOCAL_2_01.WAV — аудиотрек с записью вокальной пар-

тии экспортирован в аудиофайл, предназначенный для за-

грузки в звуковой редактор Adobe Audition с целью шумопо-

давления. Иллюстрирует процесс работы над проектом (см. 

разд. 4.5). Файл VOCAL_2_01.PK, автоматически созданный 

программой Adobe Audition, позволяет ускорить повторную 

загрузку в нее аудиофайла VOCAL_2_01.WAV. 

13. VOCAL_2_02.WAV — аудиотрек с записью вокальной пар-

тии после шумоподавления и устранения мелких дефектов 

записи. Иллюстрирует процесс работы над проектом (см. 

разд. 4.5). Файл VOCAL_2_02.PK, автоматически созданный 

программой Adobe Audition, позволяет ускорить повторную 

загрузку в нее аудиофайла VOCAL_2_02.WAV. 

14. SONG_2_11.CWB — в проект песни импортирован аудио-

файл с записью вокальной партии, полученный в результате 

шумоподавления. Иллюстрирует процесс работы над проек-

том (см. разд. 4.5). 

15. SONG_2_12.CWB — к аудиотреку с вокальной партией под-

ключены плагины: эквалайзер Sonitus:fx Equalizer, компрес-

сор Sonitus:fx Compressor и ревербератор Sonitus:fx Reverb.  

В каждом из плагинов выбраны и сохранены в пресетах зна-

чения параметров. Иллюстрирует процесс работы над проек-

том (см. разд. 4.6.4). 

16. SONG_2_13.CWB — в проект вставлен MIDI-трек с мелодией 

вступления. Иллюстрирует процесс работы над проектом (см. 

разд. 4.7). 

17. SONG_2_14.CWB — к шине Bus 3 подключен ревербератор 

Sonitus:fx Reverb. Правая граница аудиоклипа передвинута 

вправо. Иллюстрирует процесс работы над проектом (см. 

разд. 4.7). 
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18. SONG_FINAL.WAV — сведенный проект экспортирован  

в аудиофайл, пригодный для воспроизведения любым про-

граммным плеером. Иллюстрирует процесс работы над про-

ектом (см. разд. 4.7). Файл SONG_FINAL.PK, автоматически 

созданный программой Adobe Audition, позволяет ускорить 

повторную загрузку в нее аудиофайла SONG_FINAL.WAV. 

Перечень песен 

В папке SONGS в файлах формата MP3 хранятся примеры пе-

сен, созданных с участием начинающего компьютерного музы-

канта и с помощью программ, рассмотренных в книге: 

 "Дождь" (музыка, слова и вокал — Анна Петелина, аранжиров-

ка — Юрий Петелин, запись и сведение — Роман Петелин); 

 "Радость маме" (музыка, слова и вокал — Анна Петелина, 

аранжировка — Юрий Петелин, запись и сведение — Роман 

Петелин); 

 "Маленькая школа" (музыка, слова — Анна Петелина, Юрий 

Петелин, вокал — Анна Петелина, аранжировка — Юрий Пе-

телин, запись и сведение — Роман Петелин); 

 "Монолог куклы" (музыка, слова, аранжировка, запись и све-

дение — Юрий Петелин, вокал — Анна Петелина). 
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